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IMPORTANT INFORMATION !

This publication is an illustrated version of EPIC online help. Since the user can
access and print online help directly from the application, online help is considered
the primary source for information about EPIC.

When you print online help directly from the application, the format is different from
this illustrated version; however, the text is the same. Therefore, NFC provides the
illustrated version only upon customer request.

For information about this publication, please contact the Government Employees
Services Branch (GESB). Instructions for contacting GESB and other support
sources are provided in the About This Procedure section of this publication.

Published and printed by the Directives and Analysis Branch
National Finance Center, U.S. Department of Agriculture

New Orleans, Louisiana
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iLatest Update InformationUpdated 01/08

Latest Update Information

The following change has been made to the EPIC procedure:

Description of Change Page

Table Of Contents iv

Correcting A Social Security Number And Employee Name 3:14

Field Instructions For Payroll Documents 6:86, 6:108

Payroll Document Code Tables 7:70

Index 2

Changes are identified by “  ”. Deletions are indentified by “* *”.
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About This Procedure

This procedure provides instructions for accessing and operating the Entry Processing Inquiry
and Correction System (EPIC). The following information will help you use the procedure more
effectively and locate further assistance if needed.

How The Procedure Is Organized

The major sections of this procedure are described below:

Introduction presents an overview of EPIC and the Payroll/Personnel System (PPS),
including security access information and instructions for accessing the system. It also
provides basic operational information including how to get help using EPIC.

Personnel Actions provides a brief description of the various personnel actions and
includes entry guidelines and steps for entering data to facilitate processing personnel
actions with a minimal rejection rate.

Payroll Documents describes the various payroll documents and includes entry guidelines
and steps for entering data to facilitate processing payroll documents with a minimal
rejection rate.

Requesting EPIC Reports And Correcting Data includes instructions for correcting payroll
documents and personnel actions that failed the EPIC front-end errors and PINE database
errors.

Field Instructions contains instructions for completing each EPIC window.

Reference Tables includes valid values for personnel action and payroll document
processing.

Heading Index provides an alphabetical list of all headings in the procedure. When a
heading is referenced, you can use this index to locate the page number.

To keep you informed about new or changed information related to this system, NFC issues short
publications called bulletins. This procedure and all related bulletins are listed in the NFC
External Publications Index, issued semiannually.

If you receive this procedure after it has been amended, you will receive the publications with all
bulletins.
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What Conventions Are Used

This procedure uses the following visual aids to identify certain kinds of information:

Convention Example

Messages displayed by the system
are printed in italics.

The message Changes have been made. Save
changes? is displayed.

Important extra information is
identified by a note, warning, caution,
or reminder icon in the left margin.

Note

If the transaction is coded I (incomplete), no
edits are performed.

Figure references link figures with the
text. These references are printed in
bold sans serif font.

The Logon pop-up (Figure 1.1) is displayed.

References to headings in the
procedure are printed in the same font
as figure references.

Note: When a heading is referenced
in the procedure, you can use the
Heading Index to locate the page
number.

To obtain information on help text and
windows display, see EPIC Menu Bar.

References to menu options are
printed in bold italics.

To view EPIC status and suspense reports
select: File > Reports

References to command buttons or
keyboard keys are printed in bold and
enclosed in brackets.

To return to the previous window, click
[Close].

At any time during the entry process, you can
get help with completing a field by pressing
[F1].

Field names are printed in the margin.
Field specifications are printed in
italics.

Note: Field entries are identified as
required1, conditional2, optional3,
optional default4, or no entry5.

Last Character
Of Job Name

Required, alphanumeric, 3 positions

The sixth character of the job name (e.g.,
NFC03A). Type A, B, or C to identify the
report from other reports being requested.

1Required You must enter data in the field. (Note: All mandatory fields on EPIC screens are highlighted to distinguish
required entries from optional entries. The highlighted fields must be completed to avoid rejection.)

2Conditional You may be required to enter data, based on criteria indicated in the field instructions.
3Optional You may elect to enter data in the field. If the field is left blank, no data is system generated.
4Optional default You may elect to enter data. If the field is left blank, the system generates a default entry.
5No entry You do not enter data in the field. The field instruction states the reason for no entry.

Who To Contact For Help

For questions about the system (including help with unusual conditions), contact the
Payroll/Personnel Call Center personnel at 504−255−5230.

For questions about NFC payroll processing, contact the Payroll/Personnel Operations Section at
504−255−4630. For questions about Personnel processing, contact your agency CAPPS
Representative.

For access to EPIC, contact your agency’s ADP security officer.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 1

In
tro

d
u

ctio
n

1:1Updated 01/08

PART 1.

Introduction

This part is divided into the following sections:

EPIC Overview

Getting Started In EPIC
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EPIC Overview

This section presents the following topics:

About EPIC

Payroll/Personnel External Processing Systems

Payroll/Personnel Internal Processing Systems

Payroll/Personnel Processing Cycle

Agency/NFC Responsibilities

Access, Security, And Installation

Reports Of EPIC Data

About EPIC

EPIC is a Windows-based payroll/personnel database entry, processing, correction, and
inquiry application of the National Finance Center (NFC). This system allows customers to:

1. Enter payroll and personnel transactions for processing in the Payroll/Personnel
System (PPS).

2. Correct transactions that have failed the database edits.

3. Execute status and suspense reports.

4. Delete and restore transactions.

5. View future and current payroll/personnel transactions to be processed.

6. Cancel and change history records.

7. Roll back applied documents.

EPIC runs on Microsoft Windows 95, 98, 2000, NT, and XP platforms and requires a
secured telecommunications link to NFC.

Payroll/Personnel External Processing Systems

The PPS is an integrated system that links payroll and personnel transactions through
subsystems that interface with each other. Below is a list of systems available to PPS users.

Administrative Billings And Collections (ABCO). An entry system used for the automatic
handling of bills which, once recorded, are monitored until collected through and automated
system

Dispatch
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Employee Personal Page (EPP). The Employee Personal Page (EPP) allows employees
serviced by NFC to view their payroll, leave, travel, health and life insurance, savings bond,
W−2, and other personal information.

Employee Self Service (ESS). This option of the EPP provides employees the ability to
make online change request to their residence address, federal and state tax withholding,
financial allotments, direct deposit, health insurance, savings bonds, and Thrift Savings Plan
(TSP) contribution information effective for the current or future pay period.

Entry Processing Inquiry And Correction (EPIC). An entry system deployed in a
Windows environment that allows agencies to enter, correct, and inquire key data, and
execute payroll/personnel status and suspense reports.

FOCUS Reporting System (FOCUSRPT). An online reporting system used to create and
generate on an as-needed basis, ad hoc reports using database elements.

Information/Research Inquiry System (IRIS). An online system used to view by social
security number, current and historical payroll, personnel, and position data contained in the
PPS database. Most of the data displayed in IRIS is the result of payroll/personnel
transactions entered through an entry system or transmitted by magnetic tape; other data is
system generated based on processed transactions.

Locator Information System (LIST). An online entry system used to enter the exact
location of an employee’s workplace.

Position Management System (PMSO). An online entry system used to add, change,
inactivate, reactivate, and delete position data.

Remote Forms Queuing System (RFQS). An online system used to obtain processed forms
and tickler reports at agency sites.

Report Generator System (CULPRPT). An online reporting system used to generate
formatted payroll and personnel related reports.

Reduction In Force Register (RIFR). An online reporting system that produces retention
registers based on selected criteria. This report is available on the Workforce Reports menu of
the Reporting Center.

Reporting Center. An interactive Web site that enables agencies to produce predefined and
customized reports.

Retirement Tracking System (RETM). An online entry system used to track the processing
of retirement applications and death cases.

Special Payroll Processing System (SPPS). An online data processing system used to
process quick service payments, final salary payments for indebted employees, and payments
to the estate of a deceased employee and requests for manual processing.

SPPS Web. Is a Web−based application that allows establishment, adjustment, inquiry,
retrieval, and deletion of certain manual payment and adjustment transactions.
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Statement of Earnings and Leave (EARN). An inquiry system deployed in a Windows
environment used to view and print Form AD−334, Statement of Earnings and Leave, for
employees payrolled by NFC included in the Reporting Center.

Table Management System (TMGT). A menu-driven database management system used to
inquire and update data used in application programs and to request predefined reports.
Certain tables are accessible to customers while others are for NFC use only. Table 001,
Personnel Office Identifier Name and Address, includes the field, EPIC Indicator, which
identifies EPIC records in the PPS.

Time Inquiry System (TINQ). An online leave entry and correction system used to update
leave data in lieu of submitting a leave audit to NFC. It is also used to transfer leave data
from donors to approved leave recipients participating in the Leave Sharing Program.

Training Information System (TRAI). An online entry system used for entering and
tracking employee training records and for processing training payments to vendors for
employee training.

Unemployment Compensation For Federal Employees (UCFE). An online entry system
used for entering unemployment data needed by the state to pay unemployment compensation
benefits.

W−2 (Yr.). An online inquiry system used to view employee’s W−2, Wage And Tax
Statement, data. Two years of data are maintained on the Reporting Center.

Payroll/Personnel Internal Processing Systems

The data transmitted from agencies to NFC is processed in NFC’s internal processing
systems. These systems edit, reject/accept, retain/release transactions then update the
database. Other internal systems (1) calculate payroll, (2) process adjustments, (3) produce
output data that is disseminated to agencies and the Office of Personnel Management (OPM)
and (4) prepare the database for the next pay period’s processing. Below is a list of the
internal data processing systems.

Adjustment Processing System (ADJP). The PPS automatic adjustment system that
revalidates T&A’s and late personnel actions, performs the debit and credit routine, calculates
the difference, and compensates or collects accordingly. The automatic adjustment period is
26 pay periods.

Bi-weekly Examination Analysis & Reporting System (BEAR). A system that sets up the
current pay period for payroll- and personnel-related information and closes out the prior pay
period. BEAR generates notifications that affect employees’ database records.

Central Accounting System (CAS). A database system that produces a complete range of
financial management reports for agencies to control budget and operating plans, obligations,
accrued expenditures, disbursements, and accomplishments.

MASC
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Payroll Accounting System (PACS). A financial management data collection and reporting
system. It also has the capability to correct forced released accounting data. PACS is a feeder
system that interfaces with other subsystems.

Payroll Processing System (PAYE). A calculation system that performs complicated
computation routines required to produce net salary data for disbursement and transmission to
the Department of the Treasury. PAYE computes employees’ gross salary, makes applicable
deductions, applies adjustments from the Adjustment Processing System (ADJP), develops
the net amount due, and prepares data for subsequent issuance of salary payments by
Treasury. PAYE updates the database to reflect salary payments as well as leave. It also
creates accounting records that are processed and reported through the payroll accounting
system.

Personnel Edit Subsystem (PINE). A system that performs edits on all payroll and
personnel transactions processed in the PPS. Errors are corrected in EPIC, or an agency’s
front-end system.

Personnel Processing System (PEPL). Updates the personnel areas of the database. All
documents successfully processed are released to PEPL, which updates the PPS database.
PEPL also produces a log of all transactions applied to the database as well as statistics and
management reports.

T&A On-line Suspense Correction and Document Addition System (TSUS). A correction
system used by NFC personnel to correct time and attendance (T&A) reports that failed the
TIME edits.

T&A Validation System (TIME). An edit system for time and attendance data transmitted
for processing. The errors are corrected by NFC personnel through TSUS.

Payroll/Personnel Processing Cycle

The payroll/personnel processing cycle consists of:

• The entry and transmission of payroll/personnel data by the agency

• The processing of this data by NFC through the PPS

For more information, see:

Entry And Release Of Data By The Agency

Processing Of Data By NFC

Entry And Release Of Data By The Agency

During each 2-week pay period, agencies enter payroll and personnel transactions using a
variety of entry systems:

• Payroll and personnel transactions may be entered through EPIC or the agency’s
front-end system (FESI) that interfaces with the PPS. Selected payroll documents are
entered through Employee Express (EEX) and Employee Self Service (ESS).
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• Position data is entered through PMSO, or a FES.

• Time and attendance (T&A) data is entered in NFC’s time and attendance remote entry
system or an agency’s time and attendance FES.

Transactions may be entered and transmitted at any time; however, to be applied in the
processing pay period, the transactions must be entered and transmitted before the last PAYE
pass. All errors resulting from edits must be corrected before transactions are released and
transmitted for further processing.

Warning: Waiting until the end of the processing cycle to transmit data increases the chance
of the transactions rejecting in PINE and not applying to the database, which could result in
inaccurate or late salary payments.

Transactions should be released when entered unless there is a need to place the transaction in
a hold or incomplete status. For example, an accession action should not be released without
the associated payroll documents (e.g., DD/EFT or check mailing address, applicable tax
documents, time and attendance data, etc.).

Prior and future payroll and personnel transactions can be released when entered regardless
of the effective pay period. The PPS automatically processes prior actions in the processing
pay period and sends future actions to the future file.

Processing Of Data By NFC

As transactions are transmitted, NFC processes them through its internal systems PINE,
TIME, PAYE, and BEAR. The table below shows when these systems run during the
processing cycle.

Pay Period Sun. Mon. Tues. Wed. Thurs. Fri. Sat.

XX/Week 1 PINE 1 PINE 2 PINE 3 PINE 4 PINE 5

YY/Week 2 PINE 6

TIME

PINE 7

TIME

PINE 8

TIME

PINE 9

TIME/PAYE

PINE 10

TIME/PAYE

PINE 11

TIME/PAYE

YY/Week 3 BEAR

Note: PAYE runs on Thursday and Friday or Saturday, depending on the number of
suspended transactions and/or the number of unpaid employees.

PINE Processing

The processing cycle begins with the editing of payroll documents and personnel actions in
PINE, where the data transmitted is compared to the employee’s database record. Data
transmissions pass through PINE daily during the first 2 weeks (except Saturdays and
Sundays) of the processing cycle. This schedule allows agencies ample time for correcting
transactions so the data can apply to the database.

Transactions that fail PINE edits are placed in suspense and must be corrected by the agency
in EPIC or the agency’s front-end system. Every attempt should be made to correct all errors
with each PINE pass to ensure the employee receives his/her salary timely.
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The following sources are used to correct PINE errors:

• PINE Edit Messages procedure (Title I, Chapter 10, Section 2). This procedure lists
all the PINE errors by document type with a description of each error and other helpful
information for correcting suspense.

• Suspense reports. These reports are available through EPIC. The suspense reports
provide the actual errors that are preventing the document from applying to the
database as well as other suspense-related information. Agencies that user their own
front-end system must run their own reports. EPIC suspense reports are produced for
EPIC users only.

After all errors have been corrected, personnel and payroll transactions are reedited and,
based on the effective pay period, either apply to the database or the future file.

TIME Processing

On the Friday of the close of the pay period (week 1), agencies should begin T&A
transmission, completing all transmissions by the following Tuesday (week 2) unless
instructed otherwise by NFC. T&A data is edited in TIME through the Saturday, which ends
the pay period processing of transactions before applying to the PPS database. Like PINE,
TIME edits data before it applies to the database comparing the employee’s database record
to the data transmitted.

T&A’s that fail the TIME edits are corrected by NFC during this timeframe. TIME edit
messages are published under Title I, Chapter 7, Section 6. Each edit message is provided
with the error and the NFC action taken to release the error. Transactions released from TIME
are sent to PAYE for calculation.

PAYE Processing

On the first Thursday and Friday or Saturday after the pay period (week 2), PAYE produces
net salary data for disbursement and transmission to the Department of the Treasury. PAYE
also produces the data for disbursement of Thrift Savings Plan (TSP) garnishments, Federal
Employees Health Benefits (FEHB), retirement, taxes, etc. This data is submitted biweekly.
Customers can access IRIS to confirm that the data processed correctly and applied to the
database.

BEAR Processing

On the Sunday of week 3, BEAR generates output and notification to agencies based on the
data processed during the pay period.

Agency/NFC Responsibilities

Listed below are the responsibilities of the primary organizations involved in data processing
and system maintenance.

The agency:

• Enters, transmits, and corrects transactions.
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• Communicates with timekeepers and other applicable staff when processing
transactions that affect time and attendance, positions, etc.

• Uses NFC procedures and online help as needed to assist in entering and correcting
transactions.

The National Finance Center:

• Provides adequate security to prevent access from unauthorized personnel.

• Accepts payroll and personnel transactions from agencies for processing in the PPS.

• Provides agencies with the capability to view and modify payroll and personnel
transactions that have been transmitted.

• Maintains suspense transactions in the database until they have been corrected or
deleted.

• Applies all successfully processed transactions to the PPS database.

• Provides a tutorial and help screen text to assist users in operating the system, entering
data, and correcting suspense.

• Provides reporting capabilities either on demand or automatically.

• Develops regularly scheduled back-ups and recovery procedures.

• Provides documentation of the system.

Access, Security, And Installation

Security is designed to prevent the unauthorized use of systems and databases. For security
information, including user identification numbers (user ID’s), passwords, and obtaining
access to a specific system, see the Security Access procedure (Title VI, Chapter 1,
Section 1).

For more information, see:

Requesting Access To EPIC

Database Security

Installation

Requesting Access To EPIC

To access EPIC, you must have:

• A PC with a secured telecommunications link to NFC

• Authorized security clearance

For information about connecting and disconnecting from your telecommunications network,
see instructions for your specific network.

Users must request access through their agency’s security officer. The request should provide
the following information:
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• User name

• User social security number

• User ID

• Agency name

• User access request level (payroll; personnel)

• Telephone number

• Application name (EPIC and EPIC History Correction)

The access level requested for the user should be based on the individual’s assigned work
requirements and job functions.

Database Security

The following information describes the security environment at NFC.

Security Software. System security at NFC is managed by CA TOP SECRET, a commercial
access control package operated in an Operating System (OS) 390 environment. CA TOP
SECRET provides protection for dataset, library programs, input/output devices, and most
system resources. It also controls access to data processing resources and facilitates through a
three-step process as follows:

1. CA TOP SECRET validates the user to determine if he/she is authorized to use EPIC.
The user’s logon access (user ID and password) is validated during the logon process.

2. CA TOP SECRET confirms that the user is authorized to use the requested facility.

3. CA TOP SECRET determines if the user is authorized to use the requested resources
(i.e., datasets, programs, transactions, database subschemas, DB2 resources, Security
Access Code (SAC), etc.).

Validation Process. To facilitate user access to NFC maintained systems, significant
interaction/interface among software packages is necessary to control access. The following
steps occur during a logon to EPIC.

1. CA TOP SECRET validates the user ID, password, and access authorization to EPIC.

2. Upon verification/validation of the user ID and password, the user is logged onto the
NFC mainframe computer and into EPIC.

3. IDMS security controls are then checked. The user must be established in the data
dictionary (the user record name is the same as the access or identification (ACID)
name) in order to proceed.

4. The user is allowed to execute the EPIC program which will perform his/her assigned
function as long as his/her security access for the program match.

5. The CA TOP SECRET profiles are used to determine if the user can access the
subschema where the data is stored. The CA TOP SECRET user’s permissions are read
to determine if access is allowed.
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6. The SAC is used to verify if access is to be granted to a particular record. The primary
SAC entry path is:

SAC: E1XXAABBBBCC Where XX=Department, AA=Servicing agency,
BBBB=Personnel Office Identifier (POI), CC=Agency serviced.

The SAC entry in the user’s TOP SECRET profiles is read to determine if the access should
be allowed.

Note: Steps 3 through 6 are transparent to the user.

Installation

Instructions for installing EPIC are provided with the software. Be sure to read the hardware
and software requirements to ensure you have the proper equipment and adequate disk space
for successful installation.

If you encounter problems after installation, see the NFC Support Center technical guides on
the NFC Website for troubleshooting tips and/or contact your Information Technology office.

Reports Of EPIC Data

EPIC data is available through reports generated in EPIC and system-generated recurring
reports. For information about the methods for obtaining reports, see:

Reports Through EPIC

System-Generated Recurring Reports

Reports Through EPIC

EPIC includes an option for requesting statistical and suspense reports that can be printed at
agency locations. For information about EPIC reporting, see Requesting EPIC Reports. This
is for use only by agencies using EPIC, not agencies using their own entry system.

System-Generated Recurring Reports

The PPS generates recurring reports relating to pay, leave, employment status, etc. These
reports are produced from information stored in the database. For exhibits of the reports, see
the Payroll/Personnel Output procedure (Title I, Chapter 20, Section 5). The reports are sent
to printers/locations identified in the Dispatch System.
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Getting Started In EPIC

This section presents the following topics:

Learning About EPIC

Starting EPIC

Changing Your Password

The EPIC Navigation Window

Exiting EPIC

Using Online Help

EPIC Operating Features

Processing Functions

Learning About EPIC

To use EPIC, you must have some knowledge of Microsoft Windows. Use your Windows
user guide or Windows online help for help with the Windows environment.

For help with the EPIC application, consult this procedure and/or one of the following online
sources:

Online Tutorial

Online Help

Online Tutorial

An online tutorial is included with EPIC to help you to learn how to use the application. The
tutorial walks you through EPIC’s functions and navigating features, including how to use
tool buttons, command buttons, special function keys, and directional keys.

Through hands-on examples, you will learn how to:

• Enter a transaction for one or more employees

• Change, delete, and reactivate transactions

• Complete the entry of a payroll or personnel transaction

• Generate reports

• View EPIC transactions

The tutorial can be run directly from CD−ROM, or installed to individual PCs or a shared
LAN drive. Both installation methods create icons on the Start Programs menu under a
specified folder. To access the tutorial, at your Windows desktop, click the icon or select Start
> Programs > National Finance Center > EPIC Tutorial
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Online Help

The online help feature is available as a reference tool when you are processing data in EPIC.
To use online help, select Help from the menu bar at any window or place the cursor in a field
and press [F1]. For more information, see Using Online Help.

Starting EPIC

To start EPIC, at your Windows desktop:

1. Select Start > Programs > National Finance Center > NFC Logon. The NFC logon
banner (Figure 1:1) is displayed.

Figure 1:1. NFC logon banner

2. Complete the fields in the Logon box as indicated under NFC Logon Banner Field
Instructions.

3. After completing the fields, click [Logon]. A list of payroll/personnel applications is
displayed.

The Password Check pop-up (Figure 1:2) appears when your password is near
expiration. Click [OK] to close the pop-up. As needed, change your password using the
instructions under Changing Your Password.
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Figure 1:2. Password Check pop-up

4. Select EPIC (Entry, Processing, Inquiry, and Correction System) and click [Start]. The
EPIC Navigation window (Figure 1:4) is displayed.

Note: If the current version is not installed, a message appears indicating that access is
denied and the current version must be installed. You cannot access the application
with the prior version software.

Changing Your Password

You may change your password at any time but not more than once a day.

To change your password:

1. At the NFC Logon banner (Figure 1:1), select File > Change Password. The Change
Password pop-up (Figure 1:3 ) appears.

Figure 1:3. Change Password pop-up

2. Complete the fields on the Change Password pop-up (Figure 1:3) as indicated under
Change Password Pop-up Field Instructions.

3. After completing the fields, click [OK] to save the change and exit the pop-up.

EPIC Navigation Window

After you start EPIC, the EPIC Navigation window (Figure 1:4 ) is displayed with a list of all
transactions associated with your user-ID.
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Note: If you need to perform a specific search (e.g., all new documents, all deleted
documents, etc.), use the Search pop-up.

Figure 1:4. EPIC Navigation window

The Entered Documents list is updated after:

• A new document is successfully added. It appears on the list after you select View >
Refresh Entered Documents on the EPIC Navigation menu.

• A pending document remains on the list for 30 days. The document is automatically
deleted.

• PINE processes. All documents coded released that failed the PINE edits are
suspended. Those documents that cleared PINE are coded as applied.

• A document is rolled back. The status changes from applied to new.

• BEAR processes. All applied and deleted documents are deleted from the list.

The menu bar on the EPIC Navigation window displays the following options:

• File. Used to access a different database (NFC only), request reports, print, and exit
EPIC.

• Edit. Used to add or update a personnel action or payroll document and rollback
documents in EPIC.

• Go To. Used to go to the History Correction Navigation window.

• View. Used to:

• Search for existing transactions

• Refresh to the last-entered transaction(s) on the EPIC Navigation window,
Entered Document list.
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• Window. Used to arrange the display of windows. For more information
about this option, see your Windows user’s guide.

• Help. Provides online help for using the system. For more information, see
Using Online Help.

The above options appear on the menu bar in most EPIC windows. For more information
about the menu bar, see the EPIC Menu Bar.

Exiting EPIC

To exit EPIC:

1. At any EPIC menu bar, select File > Close to return to the EPIC Navigation window.

2. Click [X] on the EPIC Navigation window (Figure 1:4) to return to your Windows
desktop.

3. To disconnect from NFC, click the NFC Logon banner button on your task bar to
display the NFC Logon banner (Figure 1:1) and click [Logoff].

Using Online Help

When you need help with processing EPIC data, click Help at any EPIC menu bar. A
drop-down menu is displayed with the following options:

• Help For This Window. Provides instructions for the current window.

• Help Contents. Provides complete online documentation for EPIC.

• Help For Help. Provides instructions for using online help.

Note: When you select Help Contents, the EPIC Help window (Figure1:5 ) is displayed.
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Figure 1:5. EPIC Help

This window provides three methods for locating information:

• Contents. Displays the table of contents for online documentation.

• Index. Provides an index of key words.

• Find. Provides word search capability.

For instructions on using these features, select Help > Help For Help at the menu bar.

For help with a field at any EPIC window, press [F1].

EPIC Operating Features

EPIC operates in a Windows environment, providing mouse-driven, point-and-click
functionality; command buttons; and other windows features. Use your Windows user guide
or Windows online help for information about basic Windows features. For descriptions of
operating features that are specific to EPIC, see:

EPIC Menu Bar

EPIC Toolbar

EPIC Pop-up Command Buttons

EPIC Functional/Directional Keys

EPIC Menu Bar

The menu bar appears below the title bar on all EPIC windows except pop-ups. Each option
on the menu bar displays other options for viewing and/or processing transactions. Options
may vary depending on the window. For more information, see EPIC Navigation Window.
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EPIC Toolbar

The toolbar includes buttons to initiate activities. Each tool button displays an icon that
depicts its processing function. In most cases, the tool button can be used in lieu of the menu
bar. The toolbar includes the following tool buttons used throughout EPIC. Those that are
unique to the particular transaction are discussed where they apply.

Tool Buttons For Multiple Or Specific EPIC Windows

Button Description
Used to enter the same transaction for a different social
security number.

Used to create a new transaction.

Used to update a transaction or data.

Used to delete a transaction or data.

Used to perform a search.

Used to refresh to display the last entered transaction(s).

Used to save a document or data.

Used to print a window.

Used to display a list of EPIC front-end errors.

Used to enter notes pertaining to the transaction.

Used to scroll to the previous record or to scroll up a list.

Used to scroll to the next record or to scroll down a list.

Used to display help about the window.

Used to exit a window.

Tool Buttons For Personnel Actions

Button Description

Award
Used to display the Award Data pop-up of a personnel
action which includes all data required to process
various awards.

Bonus
Used to display the Bonus pop-up of a personnel
action which includes all data required to process
various bonuses.

Employee
Used to display the Employee Data window of a personnel
action which includes employee data such as gender, date of
birth, education, etc.
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Tool Buttons For Personnel Actions

DescriptionButton

Position
Used to display the Position Data window of a personnel
action which includes the employee’s master record,
individual position number, and other position-related data.

Salary
Used to display the Salary Data window of a personnel
action which includes quarters deductions, appointment
limitation totals and balances, retained grade data, and rates
for cooperative type employees.

Benefits
Used to display the Benefits window of a personnel action
which includes Federal Employees Group Life
Insurance (FEGLI), FEHB, TSP, and other benefit-related
data.

Misc
Used to display the Miscellaneous window of a personnel
action which includes data elements such as probationary
period, supervisory/managerial, career tenure start dates,
service computation dates for leave and RIF, leave data, etc.

Remark
Used to display the Remark window of a personnel action to
enter remarks codes.

Used to scroll to the previous set/window of a personnel
action.

Used to scroll to the next set/window of a personnel action.

Used to enter the same transaction for a different social
security number.

Used to display the Edit Error Listing pop-up.

Used to refresh the Remark Code field.

Used to copy PMSO data.

Used to update position data.

Tool Buttons For Payroll Documents

Tool
Button

Tool Button
Description

Document Purpose

Family
Member

Health
Benefit

Enter family members data

Remark Health
Benefits

Enter remarks applicable to the transaction

Owner Savings
Bond

Enter owner information

Coowner Savings
Bond

Enter coowner information
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Tool Buttons For Payroll Documents

Accounting
Data

Lump Sum
Payments

Enter accounting data.

Edit Error
Listing
pop-up

All Used to display the Edit Error Listing pop-up.

EPIC Pop-Up Command Buttons

EPIC pop-ups do not have a menu bar or tool bar. However, they do have command buttons
that usually carry out an action described in the button’s name. The following command
buttons are used throughout EPIC.

EPIC Command Buttons

Button Description

Yes
Used to close the window and save the data.

No
Used to close the window without saving the data.

X Cancel
Used to cancel an exit from an active window and save the entries at
the active window or close a window where no entries were made.

? Help
Used to display help text.

OK
Used to advance to the next window.

Close
Used to close the error pop-up listing.

Save
Used to save entered data.

EPIC Functional/Directional Keys

Your keyboard includes the following function keys that can be used in EPIC.
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Key Description

Enter
Used to accept/process data.

Delete
Used to delete data.

Tab
Used to move to the next field.

Space
Bar

Used to create a space or tab to the next field.

Used to move to the next character within a field.

Used to move the previous character within a field.

F1
Used to display help.

F3
Used to close a window.

F7
Used to scroll backward.

F8
Used to scroll forward.

Processing Functions

During processing, EPIC users can search for, modify, delete, and activate transactions. Users
also employ transaction status codes to indicate the transaction’s processing status. For
instructions on these functions, see:

Saving Data

Using Transaction Status Codes

Searching For/Viewing EPIC Transactions

Modifying EPIC Transactions

Deleting EPIC Transactions

Activating EPIC Transactions

Refreshing A Window For Another Entry

Saving Data

EPIC includes a Save Changes pop-up(Figure 1:6 ) which displays when File > Close is
selected.
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Figure 1:6. Save Changes pop-up

To use the Save Changes pop-up:

1. On the applicable EPIC window/pop-up click . The Save Changes pop-up (Exhibit 1:6)
appears.

2. On the Save Changes pop-up (Exhibit 1:6), click [Yes] to save the changes.
OR

Click [No] to exit the Save Changes pop-up (Exhibit 1:6) and not save the changes.

OR

Click [Cancel] to return to the previous window/pop-up.

Using Transaction Status Codes

The status of a transaction is identified by a status code and generated by PINE and the EPIC
status. For a list of status codes, see Status Codes.

Status Codes

The status code indicates if the transaction is:

• Held until released by the agency.

• Released for PINE processing.

• Placed in suspense when failed edits.

• Released to the future file.

• Deleted from the system.

• Applied to the database.

Certain status codes are entered by the user when the transaction is initially entered; others
are entered or system generated when the transaction fails PINE edits. The status code
appears on the EPIC Navigation window (Exhibit 1:4) and on each personnel action and
payroll document window.

New documents can be modified or released in the hold, waiting remarks, incomplete, or
released status. Suspense documents can be modified in a 9 status. Applied transactions can
be viewed but cannot be changed.
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EPIC Status

An EPIC status code indicates the status of a personnel action or payroll document after it has
been entered for processing. The EPIC status appears in the bottom right corner of the status
bar of each personnel action and payroll document, on the EPIC Navigation window
(Exhibit 1:4), and the Search pop-up (Exhibit 1:7).

The table below depicts the EPIC Status with the compatible PINE Status Codes as they
appear on the EPIC Navigation window (Exhibit 1:4). See Status Codes for definitions of the
status codes.

Searching For/Viewing EPIC Transactions

The search function allows you to locate transactions that were entered for processing in the
PPS, regardless of the entry system. These transactions are listed on the EPIC Navigation
window (Exhibit 1:4). You may scroll through the list or use the Search pop-up (Exhibit 1:7)
to narrow the search.

To search for a transaction:

1. Select View > Search at the EPIC Navigation window (Figure 1:4 ). The Search
pop-up (Figure 1:7) appears.

Figure 1:7. Search pop-up

2. Complete the Search Criteria fields as indicated under Search Pop-up Field
Instructions. You must complete at least one field; completing more fields narrows the
search.

If you are searching for multiple transactions and want them sorted by document type,
click Document Type. If you want them sorted by SSN, leave SSN selected.
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3. After completing the applicable fields, click [OK]. The EPIC Navigation window
appears with a list of transactions based on the selection criteria.

The EPIC Navigation window (Figure 1:4 ) is used to view all payroll and personnel
transactions entered for processing in the PPS. The Orig System column identifies the
entry system.

To view transaction details:

1. At the EPIC Navigation window (Figure 1:4 ), double-click the transaction listing to
display the detail window. (See the example in (Figure 1:8 )

Figure 1:8. Detail Window (Sample of Employee Address)

2. After viewing the data:

• To display the previous document, click .

• To display the next document, click .

• To close the window and return to the EPIC Navigation window, select File >
Close.

• To change the search criteria, at the EPIC Navigation window, select View >
Search.

Modifying EPIC Transactions

During the processing cycle, you can modify a transaction in EPIC at any point prior to the
transaction applying to the database.

Caution: If the status code is X, Applied, see Rollback Action Types for instructions.
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To modify a personnel action or payroll document:

1. At the EPIC Navigation window, select View > Search to display the Search
pop-up (Exhibit 1:7). Complete the fields as indicated under Search Pop-up Field
Instructions.

2. Double click to select the personnel action to be updated from the list of personnel and
payroll transactions.

3. At the transaction detail window, modify the data.

4. Click [Save].

5. Click [Close] to save the changes and exit the window.

Note: When an EPIC transaction is modified, deleted, or activated, a message is
displayed on the status bar indicating the action was successful.

After the processing cycle is completed:

• To modify an original personnel action, enter an official correction or cancellation
action in EPIC History Corrections.

• To modify a payroll document, enter a corrected payroll document in EPIC.

Deleting EPIC Transactions

During the processing cycle, a personnel action or payroll document can be deleted
depending on the status of the transaction. The processor may delete all transactions except
those that are in pending status waiting to apply to the database (EPIC Status code P). If an
action has applied, the action must be rolled back before it can be deleted.

To delete a personnel action or payroll document:

1. At the EPIC Navigation window, select View > Search to display the Search
pop-up (Exhibit 1:7). Complete the fields as indicated under Search Pop-up Field
Instructions.

2. Select the personnel action or payroll document to be deleted from the list.

3. At the transaction window, click Edit > Delete. The status code changes to 4 (delete)
and the data in the fields change to light gray.

4. Click File > Close to save the delete and exit the window.

To confirm the deletion:

1. At the EPIC Navigation window (Figure 1:4), select View > Search. The Search
pop-up (Exhibit 1:7) appears.

2. Complete the fields as indicated under Search Pop-up Field Instructions.

• Enter the SSN and/or document type for the document that was deleted.
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• At the EPIC Status field, select Deleted Documents.

3. Click [OK]. The deleted document(s) appears in the document list box.

After the processing cycle is completed:

• To delete an original personnel action, enter a correction or cancellation action. For
more information on deleting a personnel action after the processing cycle is
completed, see Rollback Applied Documents And Correcting History Data.

• A payroll document cannot be deleted. To change payroll data, enter a new payroll
document in EPIC to replace the original document.

Activating EPIC Transactions

A payroll or personnel transaction that was deleted or a transaction that is in the future file
can be activated/restored for modification during the processing pay period.

To activate a transaction:

1. At the EPIC Navigation window (Figure 1:4), select View > Search from the menu bar.
The Search pop-up (Figure 1:7) is displayed.

2. Complete the applicable fields (see instructions under Searching For/Viewing EPIC
Transactions) and click [OK].

3. Select the transaction to be activated. The window for the selection is displayed.

4. Click Edit > Activate. The gray fields are converted to black and are accessible for
entry. A message is displayed on the message line indicating the transaction is
activated. If necessary, modify the transaction before going to the next step.

5. Click File > Close and exit the window.

To verify the activation:

1. Return to the Search pop-up (Figure 1:7) and select New Documents at the EPIC
Status field.

2. Complete the applicable fields using the instructions under Searching For/Viewing
EPIC Transactions, entering the SSN and/or document type for the transaction that was
activated. Click [OK]. The EPIC Navigation window is displayed with the restored
transaction on the list.

Refreshing A Window For Another Entry

After successfully entering a transaction, you may enter the same transaction for another
employee.

To enter the same type personnel action for another employee:

1. Select File > Save at the applicable Personnel Action window. A message displays
indicating the action was successfully added.
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2. Select File > New > Current Action . The applicable fields are refreshed for the next
entry. The 1st NOA field retains the NOAC.

To enter the same payroll document for another employee:

1. Select File > New at the payroll document menu bar. The key data is retained and all
other entries are refreshed.

2. Type the applicable data for the employee.

To enter another personnel action or payroll document for the same or another
employee:

1. Select File > Save at the document window. A message displays indicating the
document was successfully added.

2. Select File > Close. You are returned to the EPIC Navigation window.

After a document has processed, you may confirm that it successfully applied to the database
by viewing the applied documents. Use the Search pop-up (Figure 1:7) to select documents
that applied in the processing pay period. You may also view applied documents in the
various Reporting Center or IRIS programs.
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PART 2.

Personnel Actions

This section presents the following topics:

About Personnel Actions

Types Of Personnel Actions

Entering Personnel Actions



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

2:2 Updated 01/08



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 2

P
erso

n
n

el A
ctio

n
s

2:3About Personnel ActionsUpdated 01/08

About Personnel Actions

This section presents the following topics:

Nature Of Action Codes

Official And Unofficial Personnel Actions

Effective Date Of Personnel Actions

Using IRIS To Research Personnel Actions

Processing Tips For Personnel Actions

About Agency-Entered Personnel Actions

About System-Generated Personnel Actions

Entry Guidelines For Personnel Actions

Nature Of Action Codes

OPM uses nature of action codes (NOAC) to identify the different types of personnel actions.
NOACs in the 9XX series facilitate certain payroll/personnel processes and agency unique
requirements. All NOAC’s are listed in TMGT Table 061, NOAC.

Personnel processing manuals provide guidance for preparing personnel actions. This
procedure does not include the requirements and instructions for processing individual
personnel actions. Therefore, it does not include instructions for each NOAC. It does,
however, include special processing instructions for certain personnel actions and unique
processes that may occur due to the PPS design.

Official And Unofficial Personnel Actions

Personnel actions are entered in EPIC to establish and update an employee’s database record.
After the record is established by processing an accession action or conversion to USDA’s
PPS, it is updated as other personnel actions are processed.

Personnel actions may be official or unofficial. An official action is an OPM required
personnel action. Guidelines for processing all personnel actions are provided in OPM’s
Guide To Processing Personnel Actions. An unofficial action is a personnel action that
updates a non-CPDF element in the employee’s database record and is not reported to OPM.

Effective Date Of Personnel Actions

The effective date of a personnel action determines the pay period the action will be
processed. If the effective date is prior or equal to the processing pay period number, the
action is processed in the current processing pay period. (See Correcting History Data for
instructions on processing late actions.) If the effective date is after the processing pay period
inclusive dates (i.e., a future pay period), the action is edited, corrected if necessary, then
released to the future file until the effective pay period’s processing.
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Note: The system does not automatically make adjustments in salary payments when the 002
correction process is used to correct the effective date. It is recommended that the
cancellation process be used and the document reentered with the correct effective date.

The system automatically compensates or collects from the employee’s salary for personnel
actions that are effective within the last 26 pay periods, as appropriate. Any personnel action
after this timeframe must be entered in EPIC History Correction in addition to processing an
SPPS document for the adjustment.

When a retroactive personnel action is processed that affects an employee’s salary
(e.g., promotion, change to lower grade, within-grade increase), the salary is recomputed and
the system compensates or collects, in accordance with the Debt Collection Act, in the pay
period the retroactive action is processed. The system also automatically adjusts the
employee’s pay record when a retroactive personnel action affects allowances and deductions
(retirement coverage, cost of living allowance, post differential, quarters deduction rate,
relocation/recruitment bonuses, etc.) or salary.

Using IRIS To Research Personnel Actions

IRIS contains data from personnel action processing and can be used to research actions
before and after they are processed.

IRIS Programs IR122, SF−50B Data Elements; IR123 Personnel Supplements; and IR125,
Personnel Actions Summary, display current personnel action data that have been processed.
IRIS Programs IR522, SF−50B Data Elements, IR523, Personnel Supplements, and IR525,
Personnel Actions Summary, are the history counterparts of the IRIS current data programs.

Processing Tips For Personnel Actions

Review this checklist before entering a personnel action.

1. Establish the position. Check the status of the position. Enter the data in PMSO for
new positions and ensure that new and existing positions are vacant, active, and all
information is current. For position-related instructions, see the Position Management
System procedure, Title I, Chapter 3.

2. Determine if the employee should be paid in the automated system. Certain
employees must be paid manually due to the type of appointment or other conditions.
These employees are paid manually every pay period; however, their records exist on
the PPS database for reporting purposes. The special employee code on the personnel
action identifies manually paid employees and prevents payment in the automated
system in the event the time and attendance data is inadvertently entered in the system
for processing. For more information on manual processes, see Title I, Chapter 11,
Nonautomated Processing.

3. Enter the required/optional payroll transactions, as applicable. The following
payroll transactions are the minimum required when processing personnel actions.

• Residence address (required). The Earnings and Leave Statement and Personal
Benefits Statement are mailed to the residence address.
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• Direct Deposit/Electronic Funds Transfer (DD/EFT). Used for salary deposits
and voluntary allotment deposits in an employee’s checking or savings account.

• Federal/local tax. The system withholds the maximum amount if this data is not
entered. Further, local taxes are based on the duty station unless the duty station
taxing entity has been waived.

• Health/life insurance. Health and life insurance eligibility codes are entered on
the personnel action; however, the health insurance and non-Federal life insurance
coverage types must be processed to begin premium withholdings or to waive
election.

• Thrift Savings Plan. TSP is an optional tax-deferred investment for Federal
employees. The TSP Status Code is required on all accession actions. This code
indicates the employee’s eligibility and participation. The TSP election form must
be processed to begin contributions.

• Charitable contributions. Voluntary charitable contributions through payroll
deductions to the Combined Federal Campaign (CFC) organizations are initiated
by processing the CFC form. The uncollected balance of an employee’s pledge
through payroll deductions can be continued when an employee transfers from
one department to another by processing a voluntary charitable contribution
transaction.

• Union/association membership dues. Union/association dues are collected each
pay period through payroll deductions. TMGT Table 010, Union and Association
Code Address, lists the valid unions/associations in the PPS. If the organization is
not listed in TMGT, refer to the TMGT procedure for instructions. The position
record must include the bargaining unit status code.

• U. S. savings bonds. The PPS facilitates up to nine bond authorizations and up to
nine co-owners/beneficiaries.

• Transfer leave balances. The system begins annual and sick leave accruals based
on employee eligibility and information entered in the leave related fields on the
accession action. Leave balances from prior service, as applicable, should be
transferred to prevent leave discrepancies.

• Debt collection. Any outstanding debts collected through salary offset from the
previous employer can continue without interruption by entering the transaction in
DOTSE. For child support and alimony payments, see the child support and
alimony document in EPIC. For employee indebtedness, see Chapter 11,
Nonautomated Processing.

• Transfer-In. Re-enter payroll documents in effect when an employee separates
and is rehired by different departments serviced by NFC (e.g., transfer from
USDA to DOJ).

Other payroll-related transactions (e.g., education and professional certification
documents, alimony deductions, etc.) may also need to be processed.

To enter payroll documents, at the EPIC menu, select:

File > New Payroll Documents > [applicable document]

4. Enter year-to-date (YTD) totals. YTD cumulative totals, counters, and certain
processing indicators should be transferred to the PPS for new employees with prior
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Federal service to assure balances, calculations, etc., are current and accurate. To enter
this data, select File > New Payroll Documents > Master File Change.

5. Ensure time and attendance is reported. The timekeeper should transmit the time
and attendance (T&A) data for the effective pay period of the accession. The effective
dates for both the T&A report and the accession must be the same to prevent the T&A
report from rejecting in the system.

6. Verify the data on the database. Access the applicable IRIS program to ensure the
action being processed is not currently on the database. Also, if a specific field is being
changed, verify the data on the database and on the action are not the same.

About Agency-Entered Personnel Actions

Agency human resource offices enter personnel actions for processing in the PPS to establish
and update employees database records. Most manually paid employees personnel actions are
entered in the system to record their personnel record in the database. All personnel actions
listed on the New Personnel Action menu are used for entry of agency-entered personnel
actions.

The PPS automatically processes certain personnel actions in lieu of agencies entering the
data (e.g., within-grade increase). Occasionally, agencies send NFC a file for processing
personnel (and payroll) data in the PPS (e.g., conversion file for new customers). Though
these types of actions are automatically processed, they also appear on the New Personnel
Action menu in EPIC for agency entry, as needed.

About System-Generated Personnel Actions

Personnel actions are processed each pay period from actions entered and transmitted by
agencies. Other personnel actions are system generated and require little or no action by the
agency. This section describes the general processing of system-generated actions and certain
unique personnel action processes.

The PPS generates the following official actions. Agencies are not required to enter these
actions, except for a few special category employees.

• Federal Pay Increase/Locality-Based Comparability Payment. For information on
the pay adjustment for the Federal pay increase and locality pay, see Federal Pay
Increase And Locality Pay.

• Federal Wage System Area Increase. For information on the Federal Wage
System (FWS) area increase, see Federal Wage System Area Increase.

• Conversion To Career Tenure. For information on career tenure, see Conversion To
Career Tenure.

• Service Computation Date Adjustments. For more information see Change In SCD
(Service Computation Date).

For more information on system generated actions, see:

System-Generated Change In PMSO

System-Generated Mass Actions
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System-Generated Change In PMSO

The PPS generates a Change In Non-CDPF Data Element (NOAC 903) personnel action
when the position sensitivity code or official title code changes in PMSO. If a personnel
action is being processed in the pay period of the change, the system will not generate the
Change in PMSO Element personnel action.

System-Generated Mass Actions

Mass changes for 50 or more employees can be system generated with a special request from
an agency and may result in a reimbursable agreement. The mass action request must be
based upon a singular item such as all employees in a specific occupational series code, duty
station, organizational structure, etc. NFC will not process any mass action requests that are
based strictly on selected social security numbers, names, etc.

The system-generated mass change process is as follows:

• Agency submits the request to USDA, OCFO, NFC, ASD.

• The agency provides any special requirements needed to process the mass change and
the following data for the personnel action:

• Nature of action code

• Authority code and authority code description

• Effective date

• Authentication date

• Selected criteria being changed

• The agency updates the employees’ Master Record or Individual Position in PMSO, if
applicable before the mass action is processed.

• NFC updates PMSO (as applicable) and generates the personnel actions in the first
pass of PINE for the effective processing pay period.

Entry Guidelines For Personnel Actions

You must enter the four-digit year.
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In general, the pay plan, grade, and step must be compatible as shown below.

Pay Plan Grade Step

AD 00 00

AD (Agency AR) 01−10 01−28

AD (Agency AQ) 01 01−99

02, 03, 04 00−99

05 01−32

AD (Agency 63) 60−80 00−10

E (space) 01−05 00

ES (Agency 97) 00 01−08

ES, VE 00 01−06

EX, IE 02−05 00

FC 01−12 01−10

13 01−07

14 01−06

FE 01 06

02 04−05

03 01−03

FP 01−09 01−14

10−14 01−05

FS, FO 01−09 01−14

GH, GM, VH 13−15 00

GG, GS, GT, GW, IS, LG, NF, VG 01−15 01−10

16 01−09

17 01−05

18 01

IJ 00 00−04

SP 01 − 04; 06, 08, 10, 12, 14, 16 01−16

TG 01−30 01−04

ZP 07−10 01−05

Note: If the special employment programs code is V8, Americorps Volunteer, the pay plan
field is AD, and the grade is 00, the step can be 00,03, or 04.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 2

P
erso

n
n

el A
ctio

n
s

2:9Types Of Personnel ActionsUpdated 01/08

Types Of Personnel Actions

This section presents the following topics:

Accession Actions

Awards

Benefits

Bonuses And Incentives

Changes

Conversions

Extensions

Nonpay/Nonduty

Pay

Position Changes

Return To Duty

Separations

Within-Grade Increase

Accession Actions

An accession action establishes an employee’s database record in the PPS. For PPS purposes,
an accession can be a new hire to a department or a department converting to USDA’s PPS
from another payroll/personnel system. When a department converts to USDA’s PPS,
NOAC 900, Conversion to USDA, establishes an employee’s database record in the PPS. The
900 NOAC is listed under Conversions on the List of Personnel Actions menu.

All associated documentation must be processed before an employee’s database record is
established. After the record is established, it is updated as other personnel actions are
processed.

Payroll documents are processed to establish and update payroll data in the employee’s
database record.

Pay day for a specific pay period falls on Thursday of the second week following the close of
the pay period. For example, if Pay Period 1 closes on Friday, January 17, payday falls in the
week of January 25. If a new employee will experience hardship awaiting the interval
between the enter on duty date and the pay date, an advance in pay may be authorized by the
agency. For more information on advances, see Title I, Chapter 11, Nonautomated
Processing.

For more information see, Entry Guidelines For Accession Actions.

Entry Guidelines For Accession Actions

Following are guidelines that apply to processing accession actions.

• The pay plan must be ES when processing an SES career appointment.
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• Do not enter an accession action if the employee has a dual appointment with the same
agency and the first appointment has been established in the system; the second
appointment must be paid manually. For instructions, see Title I, Chapter 11,
Nonautomated Processing.

• The birthdate must be at least 16 years but not more than 90 years prior to the effective
date.

• The Agency field must be identical to the PMSO key agency code and the first level of
the organizational structure code in PMSO.

• Process a multielement update payroll document for law enforcement and firefighter
retirement plans to establish a 6C retirement date. The 6C retirement date identifies the
retirement service computation date for employees appointed to law enforcement and
firefighter positions entailing a special retirement deductions rate. The personnel action
remains in suspense for three PINE passes as a reminder to process the multielement
update document. After the third PINE pass if no other errors exist, the personnel
action is released and applied to the database. Any subsequent action entered or
generated for the employee will reject in PINE until the multielement document is
processed.

Reminder: If the 6C retirement date is not established, the employee will not receive a
Benefits Statement For Law Enforcement Officers and Firefighters.

• If an employee is transferring from one department to another and both departments
are serviced by NFC, the losing department must process the transfer-out separation
action before the gaining department processes the transfer-in accession action. The
losing and gaining departments cannot be the same as on the database.

Awards

Employees are granted awards as determined by the agency. All award NOAC’s are listed on
the List of Personnel Actions menu. This list is updated, as appropriate, when TMGT
Table 061 is updated. All awards are discussed in the Federal personnel manuals.

For more information on awards, see:

Entry Guidelines For Awards

Time Off Awards

Entry Guidelines For Awards

Following are entry guidelines for processing award actions.

• Enter only one time off award per pay period for an employee.

• For USDA employees, the performance rating must be superior, outstanding, or
equivalent in rating pattern (e.g., pass or fail) to receive a performance award.

• For DOJ employees, the performance rating must be outstanding to receive a
performance award.

• For USDA employees, the performance rating must be outstanding or equivalent in
rating pattern to receive a quality step increase (QS).
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• The bottom part of the Awards pop-up (Figure 2:9) must be completed if the Pay Code
is process award.

• The award amount must be between $10 and $10,000. If the amount is outside this
range and is approved, type H in the Status Code field when the action fails the PINE
edits.

• When the Accounting Station Charge field is completed, the Agency Charged field
must also be completed and vice versa.

• For USDA agencies the Accounting Station Charge field and the Agency Charge field
must be blank.

• If a cash award must be entered for a separated employee, the separation action must
be entered before any SPPS record is established and the award must be entered after
the SPPS record is established.

• Do not enter a case number that already exists for this employee.

• The cash award amount is disbursed to the database check mailing/DD/EFT address.
The address for the cash award can be changed to a specified address or designated
agent. To change the cash award address to a street address, post office box, or
designated agent, go to Specification Of Mailing Address Pop-up Field Instructions.

Reminder: Changing the cash award address does not change the employee’s salary
address in the database. The salary will continue to be mailed or electronically
transmitted based on the address in the database until an address change or DD/EFT
document is processed.

• The accounting data for the payment must be located in the Management Account
Structure Codes System (MASC) or must be valid for the agency.

• Tangible Benefits or Intangible Benefits field must be completed for employee
suggestion and special act or service awards. If tangible, the First Year Savings field
must be completed; if intangible, the First Year Savings field must be blank.

• The cash award “from date” must be equal to, or earlier than the cash award “to date”.

• The cash award “to date” and “from date” must be completed for sustained superior
performance and special act or service awards.

Note: State income tax is grossed up at the rate of 2% on all individual and group spot
cash awards and bonuses.

Time Off Awards

A time off award is an excused absence that may be granted to an employee without charge to
leave or loss of pay. Time off eligibility and usage during a leave year is at the discretion of
the agency.

Unused time off hours cannot be converted to a cash payment upon separation from Federal
service. Time off awards cannot be transferred when an employee transfers between Federal
agencies.

Entry Guidelines For Time Off Awards

Following are guidelines for processing time off award actions.
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• If time off hours are on the database and a time off action is being entered, the
combined hours cannot exceed the maximum allowed for the leave year for the agency.

• Time off hours must be in the database to cancel or correct the hours.

• Enter the whole hours in the first 3 positions; enter fractional hours in the last
2 positions.

• Do not enter a time off award for a separated or deceased employee.

Benefits

Federal benefits include life, health, TSP, etc. The Benefits option includes living benefits for
life insurance and health insurance coverage only. For instructions on Federal benefits,
see Entering Personnel Actions.

For more information on benefits, see:

Living Benefits

Health Benefits Coverage

Living Benefits

Living benefits is payment of the life insurance coverage amount to an employee before death
rather than disbursing the monies to a survivor or beneficiary after the death of the employee.
Living benefits can be paid in full or in part in multiples of $1000. For detailed information,
see Title I, Chapter 11, Nonautomated Processing.

After the Office of Federal Employees Group Life Insurance (FEGLI) approves the request,
process the personnel action.

FEGLI premiums will continue to be deducted in the PPS. To reimburse the employee for the
withholdings, enter Form AD−343, Payroll Action Request, in DOTSE.

Health Benefits Coverage

The Federal Employees Health Benefits Program (FEHB) coverage code is initially entered
on an accession action to indicate eligibility and participation in the FEHB program. The
code entered on the personnel action does not start or end premium withholdings; processing
the applicable FEHB form does. To enter health benefits documents, see Federal Benefit:
Health Document.

Bonuses And Incentives

The Bonus/Incentive option includes foreign language bonus, recruitment incentive,
recruitment bonus, relocation bonus, retention allowance, and separation incentive. These
bonuses/incentives are offered to recruit, retain, reward, and encourage employees to accept
and retain Federal employment, or retire from Federal service.
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For more information on bonuses and incentives, see:

Foreign Language Bonuses

Recruitment Bonuses

Relocation Bonuses

Retention Allowances

Separation Incentives

Student Loan Repayment

Foreign Language Bonuses

A foreign language bonus is an incentive offered to bilingual law enforcement officers in
addition to basic pay. This bonus is a one-time payment of up to 5 percent of basic pay.

Entry Guidelines For Foreign Language Bonuses

Following are guidelines for foreign language bonuses:

• Must be a law enforcement officer.

Recruitment Bonuses

Recruitment incentive is used to hire a Federal employee while competing with the salary
offered for comparable positions in the private sector.

Entry Guidelines For Recruitment Bonuses

• The recruitment incentive is computed based on the employee’s adjusted salary.

• For employee’s on pay retention (J, K, U, V, 3, or R), the adjusted salary is not used in
the computation. For these employees, the relocation incentive is computed on step 10
of the employee’s current grade on the locality pay table or the special rate table,
whichever is higher.

• This bonus is a one-time payment of up to 25 percent of basic pay, and may be
offered to newly-appointed employees or individuals to whom a written offer of
employment has been made by the agency. This incentive may be used only if the
absence of such a bonus would make it difficult to fill the position with a highly
qualified candidate.

• The recruitment incentive may not exceed 25 percent of an employee’s adjusted salary
(including locality pay or special rate supplement) in effect at the beginning of the
service period multiplied by the number of years in the service period. With OPM
approval, the payment may be increased not to exceed 50 percent of the employee’s
adjusted salary (including locality pay or special rate supplement) at the beginning of
the service period multiplied by the number of years in the service period.

• The recruitment incentive may be paid as a lump sum, in installment payments, or a
combination of the two. The payment may be made in installment payments, in balloon
payments, or a combination thereof.

• Political appointees (Presidential appointees, Noncareer Senior Executive
Service (SES), and Schedule C employees) are not eligible to receive recruitment
incentive.
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• The annual reporting requirement for Calendar Year 2005 thru Calendar Year 2009 is
the number and dollar amount for the calendar year.

• If the recruitment incentive is less than or equal to 25% of the adjusted salary,
NOAC 815 with Authority Code VPF is used.

• If the recruitment incentive is greater than 25% of the adjusted salary, NOAC 815 with
Authority Code VPO is used.

• If the recruitment incentive is terminated and the percentage equals zero, NOAC 815
with Authority Code VPT is used.

Relocation Bonuses

Relocation incentive is used to hire an individual to work in the Federal sector who currently
lives outside of commuting distance from the duty station.

Entry Guidelines For Relocation Bonuses

• The relocation incentive is computed based on the employee’s adjusted salary.

• For employee’s on pay retention (J, K, U, V, 3, or R), the adjusted salary is not used in
the computation. For these employees, the relocation incentive is computed on step 10
of the employee’s current grade on the locality pay table or the special rate table,
whichever is higher.

• The relocation incentive may not exceed 25 percent of an employee’s adjusted salary
(including locality pay or special rate supplement) in effect at the beginning of the
service period multiplied by the number of years in the service period. With OPM
approval, the payment may be increased not to exceed 50 percent of the employee’s
adjusted salary (including locality pay or special rate supplement) at the beginning of
the service period multiplied by the number of years in the service period.

• The relocation incentive may be paid as a lump sum, in installment payments, or a
combination of the two. The payment may be made in installment payments, in balloon
payments, or a combination thereof.

• The employee receiving the relocation incentive must have a fully successful or higher
performance rating.

• Political appointees (Presidential appointees, Noncareer Senior Executive Service
(SES), and Schedule C employees) are not eligible to receive relocation incentive.

• The annual reporting requirement for Calendar Year 2005 thru Calendar Year 2009 is
the number and dollar amount for the calendar year.

• If the relocation incentive is less than or equal to 25% of the adjusted salary,
NOAC 816 with Authority Code VPF is used.

• If the relocation incentive is greater than 25% of the adjusted salary, NOAC 816 with
Authority Code VPO is used.

• If the relocation incentive is terminated and the percentage equals zero, NOAC 815
with Authority Code VPW is used.
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Retention Allowances

Retention incentive is used to hire a Federal employee while completing with the salary
offered for comparable positions in the private sector.

Entry Guidelines For Retention Allowances

Following are guidelines for processing retention allowance actions.

• The recruitment incentive is computed based on the employee’s adjusted salary.

• For employee’s on pay retention (J, K, U, V, 3, or R), the adjusted salary is not used in
the computation. For these employees, the relocation incentive is computed on step 10
of the employee’s current grade on the locality pay table or the special rate table,
whichever is higher.

• The retention incentive may not exceed 25 percent of the employee’s adjusted salary
(including locality pay or special rate supplement) in effect at the beginning of the
service period multiplied by the number of years in the service period. With OPM
approval, the payment may be increased not to exceed 50 percent of the employee’s
adjusted salary (including locality pay or special rate supplement) at the beginning of
the service period multiplied by the number of years in the service period.

• The retention incentive may be paid as a lump sum, in installment payments, or a
combination of the two;however, it may not be paid as an initial lump sum at the start
of the service period. If the retention incentive is paid in installment payments, the
installments may be computed at the full retention percentage rate or at a reduced rate
with the excess deferred to be paid at the end of the service period. The payment may
be made in installment payments, in balloon payments, or a combination thereof.

• Excess retention incentive payments that exceed the applicable aggregate pay
limitation may be deferred and paid in subsequent calendar year.

• The employee receiving the retention incentive must have a fully successful or higher
performance rating.

• Political appointees (Presidential appointees, Noncareer Senior Executive Service
(SES), and Schedule C employees) are not eligible to receive relocation incentive.

• The annual reporting requirement for Calendar Year 2005 thru Calendar Year 2009 is
the number and dollar amount for the calendar year.

• If the retention incentive is where the employee receives biweekly payments in equal
percentages and no service agreement is required, the incentive must be 25% or less or
individuals and 10% or less for a group.

• If the NOAC 827/VPN is terminated, and the percentage equals zero, NOAC 827 is
used with Authority Code VPX.

• If the retention incentive is where a service agreement is required, the retention
incentive must be 25% or less for individuals and 10% or less for a group.

• If the retention incentive is greater than 25% for individuals or greater than 10% for a
group, NOAC 827 with Authority Code VPS is used.

• If the NOAC 827 with Authority Code VPR or NOAC 827 with Authority Code VPS
and the percentage equals zero, NOAC 827 with Authority Code VPY is used.
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Separation Incentives

A separation incentive is a one-time payment offered to an employee to encourage
retirement or resignation from Federal service.

Entry Guidelines For Separation Incentives

Following are guidelines for processing separation incentive actions.

• A separation incentive cannot be processed for a deceased employee nor for an
involuntary separation.

• The amount of the award cannot be less than $10,000 nor exceed $25,000. If the
amount is less than $10,000 and is approved, type H in the Status Code field when the
action fails the PINE edits.

• The separation action must be processed before the separation incentive action can be
processed.

• The effective date of the separation incentive personnel action must be equal to, or
later than, the effective date of the separation personnel action.

• If the amount entered on the original action was incorrect, enter Form AD−343 in
DOTSE.

• To verify the separation action processed, access IRIS Program IR132, Separation
Information. If no separation record exists, process the separation personnel action
then process the separation incentive action.

Student Loan Repayment

NOAC 817, Student Loan Repayment, is used when a Federal Government agency pays back
an employee’s student loan. EPIC is only used to record student loan repayments for agency
recordkeeping/documentation purposes. SPPS Web must be used to enter and process the
payment of a student loan.

Entry Guidelines For Student Loan Repayments

Following are guidelines for recording student loan repayments.

• The dollar amount of the repayment is entered in the Recruitment Bonus field.

• The amount in the field is the amount to be paid for the calendar year.

• The maximum annual amount is $10,000 with a maximum total amount of $60,000.

• To verify the dollar amount access IRIS Program IR123, Personnel Supplements; IRIS
Program IR223, Personnel Supplements Transaction; or IRIS Program IR523, PERHIS
Personnel Supplements.

Changes

An official change action is a required OPM personnel action. The Changes option in EPIC
includes a list of multiple change actions not listed on other menus.
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For more information about changes, see:

Change In Data Element

Change In Duty Station

Change In FEGLI

Change In Hours

Change In PMSO Element

Change In Retirement Plan

Change In SCD (Service Computation Date)

Change In Tenure Group

Change In Title

Change In Veterans Preference

Change In Work Schedule

Name Change

Realignment

Change In Data Element

A change in data element is processed to change the data in the database for the specific data
elements. These are optional fields on the applicable data set.

Agency Code Occupational Code

Annuitant Indicator Pay Rate Determinant

BUS Personnel Office Identifier (POI)

FLSA Category Position Occupied

Change In Duty Station

A change in duty station is processed to change an employee’s duty station in the database.

The duty station does not appear on any window for a change action. The change in PMSO
(in conjunction with the processing of the personnel action) updates the duty station in the
database.

Entry Guidelines For Change In Duty Station

Following are guidelines for processing change in duty station actions.

• Before entering the personnel action in EPIC, change the duty station in PMSO.

Change In FEGLI

A change in FEGLI is processed when the FEGLI coverage code changes.

Entry Guidelines For Change In FEGLI

Following are guidelines for processing FEGLI change actions.
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• Type AO in the FEGLI Coverage field only if the employee (including reemployed
annuitants) is excluded from coverage by law or regulation (no deductions for life
insurance will be made) or if the employee is eligible for non-Federal life insurance.
For instructions on non-Federal life insurance, see Non-Federal Benefit: Life Insurance
Document.

• Type BO only if the employee (including reemployed annuitants) elects to waive all
insurance coverage or has previously waived all insurance coverage during prior
employment and the waiver is still in effect.

• Type CO when the employee (including reemployed annuitants) is not excluded from
coverage by law or regulation, has not waived coverage, and has elected not to be
covered by any of the optional insurance coverage plans.

• Type 90 or DO through Z1 if the employee:

• Is not excluded from coverage by law or regulation.

• Has not waived coverage.

• Has elected to be covered by one of the optional insurance plans in addition to the
basic coverage.

Change In Hours

A change in hours is processed when a part-time employee’s duty hours change
(e.g.  32 hours per pay period changes to 64 hours per pay period). The system generates
80 hours for full-time employees; therefore, duty hours are not required for full-time
employees. Intermittent employees usually work on an as-needed basis; therefore, the duty
hours are not required for intermittent employees.

Entry Guidelines For Change In Hours

Following is the guideline for change in hours.

• Type the new pay period duty hours in the Tour Of Duty Hours field of the Salary Data
pop-up (Figure 2:8).

Change In PMSO Element

A PMSO change is processed to update the position record.

Entry Guidelines For PMSO Changes

Following are guidelines for PMSO element changes:
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• An official change action is required when any of the following PMSO data elements
change.

Bargaining unit status (BUS) code Occupational function code

Duty station code Organizational structure code

FLSA code PATCO code

Interdisciplinary assigned series code Pay plan

LEO indicator Pay table code

Occupational series code Supervisory code

• The following data elements must be entered in PMSO and EPIC to link position data
to personnel data. If an action is not processed, a message will display on the suspense
report indicating that a personnel action is required.

• Agency

• Department

• Grade

• Individual Position Number

• Master Record Number

• Personnel Office Identifier

Change In Retirement Plan

A change in retirement plan is processed when a change from one retirement plan to another
retirement plan occurs.

Adjusting Sick Leave Balances For Late Transfers

The frozen sick leave balance that is reported to OPM when an employee transfers to Federal
Employees Retirement System (FERS) should correspond to the employee’s sick leave
balance as of the day before the effective date of the personnel action. If the action will be
processed later than the effective pay period, the sick leave current balance may need to be
adjusted.

To ensure the correct balance is reported to OPM, follow the steps below:

1. Enter the sick leave balance as of the day before the effective date of the personnel
action in TINQ. This is a temporary adjustment until the action applies to the database
(see Step 3 below).

2. Enter the action that allows participation in FERS. Access IRIS Program IR125 to
verify that the transfer action applied to the database.

3. After the action has applied to the database, enter the current sick leave balance in
TINQ.

Note: The Sick Leave Current Balance field in TINQ can be corrected only by
adjusting one or more of the following fields:
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• Sick Leave Carryover Balance

• Sick Leave Accruals Year To Date

• Sick Leave Used Year To Date

• Sick Leave Accrual Reduction

If the transfer action is processed and the frozen sick leave balance reported to OPM is not
the correct balance, the following steps must be taken:

1. Correct the frozen sick leave balance in TINQ.

2. Process a correction to the transfer action (NOAC 002/803).

3. Submit Form AD−343 to NFC at the following addresses requesting a manual
correction of the frozen sick leave balance on the employee’s closeout Civil Service
Retirement System (CSRS) retirement card.

For regular mail submission send to:

Payroll Accounting Section
Fringe Benefits Processing Unit
National Finance Center, USDA
P.O. Box 29310
New Orleans, LA 70189

For express mail submission send to:

Payroll Accounting Section
Fringe Benefits Processing Unit
National Finance Center, USDA
13800 Old Gentilly Road
New Orleans, LA 70129

Change In SCD (Service Computation Date)

A change in an SCD is processed when an SCD for leave, reduction in force (RIF), wage
grade increase (WGI), TSP, or retirement requires changing due to creditable or noncreditable
service. The PPS stores service computation dates in the database for creditable/noncreditable
service, salary changes, and appointment related processes. SCD’s are automatically adjusted
during the year or at the end of the leave year. 

For more information on service computation date adjustments, see:

Adjustments During The Year

End-Of-Leave Year Adjustments

Change In Probationary Period Start Date/Supervisory−Managerial Probationary Period
Required

Remarks Codes For SCD Adjustments

Adjustments During The Year

The SCD for leave is automatically adjusted when an intermittent employee changes to
full-time or part-time.
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The SCD−WGI is automatically adjusted based on creditable and noncreditable service. Each
pay period the PPS performs the calculation below to adjust the SCD−WGI.

• Intermittent days worked are converted to the equivalent elapsed calendar days. The
difference between the two is used to extend the waiting period until such time as no
difference occurs.

• Nonpay status is creditable in the computation of the required waiting period for
full-time and part-time employees when it does not exceed:

80 hours if the waiting period is 260 days/52 weeks

160 hours if the waiting period is 520 days/104 calendar weeks

240 hours if the waiting period is 780 days/156 calendar weeks

If the nonpay status hours (excluding military furlough and compensable injury)
exceed the amounts shown above, the waiting period is extended for every 80 hours in
nonpay status depending on the step of the grade. If the nonpay status hours do not
exceed the number of hours that are forgiven for the waiting period, the PPS will not
adjust the WGI service computation date.

If the number of nonpay hours exceed the forgiven hours, the SCD−WGI is adjusted as
follows:

1. Total all nonpay hours for the calendar year since the last WGI.

2. Subtract the hours forgiven from the nonpay status hours.

3. Divide the result of the above step by 8 to convert to days.

4. Adjust the SCD−WGI to reflect the converted calendar days in accordance with
the 2087−Hour Work Year Chart located in the Guide To Processing Personnel
Actions. The adjusted SCD appears in IRIS Program IR122.

End-Of-Leave Year Adjustments

The SCD for leave, RIF, retirement, and TSP are automatically adjusted at the end of each
leave year for employees who are on the agency rolls at the time of the adjustment. When a
SCD is adjusted a personnel action is generated, NOAC 882, Change In SCD, in Pay
Period 1.

The SCD’s for full-time and part-time employees are adjusted for all nonpay status
(excluding military furlough or compensable injury time) that exceeds 6 months and which
occurred during the calendar year (January through December).

The SCD’s for intermittent employees are adjusted to record the number of days worked
under the intermittent appointment during the calendar year as follows:

1. Convert the number of intermittent hours worked since the last adjustment in SCD (if
applicable) to calendar days using the 2087−Hour Work Year Chart located in the
Guide To Processing Personnel Actions (hours do not include premium pay).

2. Subtract the calendar days from the intermittent elapsed calendar days worked since
the last adjustment in SCD (if applicable).
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3. Adjust the SCD’s by the total obtained from the above step.

4. Compute the total number of intermittent days worked and intermittent elapsed
calendar days worked since the last recorded WGI.

5. Convert the total number of intermittent days worked to calendar days.

6. The total number of calendar days are subtracted from the total number of intermittent
elapsed calendar days.

Example:

The following is an example of how the PPS adjusts the SCD−WGI for an intermittent
employee whose rate of basic pay is less than the rate of basic pay at step 4. In this example,
the employee must have 52 calendar weeks in pay status to receive a within-grade increase,
and the number of nonpay status hours creditable in the computation of the employee’s
required waiting period cannot exceed 80 hours.

The total number of intermittent days worked and intermittent elapsed calendar days
worked since the last recorded WGI are computed (125 intermittent elapsed calendar
days and 50 calendar days worked).

The total number of intermittent days worked are converted to calendar days
(50 days worked x 7 = 350 ÷�5 = 70).

The total number of calendar days are subtracted from the total number of intermittent
elapsed calendar days (125 − 70 = 55).

The employee’s SCD is adjusted by 55 days.

The PPS adjusts the SCD’s for leave, RIF, retirement, and TSP for full-time and part-time
employees as follows:

1. Total all nonpay hours for the calendar year.

2. Subtract 1044 (6 months) from the total number of nonpay hours. If the result is zero
or minus, no adjustment is made.

3. Convert the number of excess hours to days (divide the total by 8).

4. Multiply the total number of days by 7 then divide that total by 5 to convert to calendar
days.

5. Divide the total number of calendar days by 30 to convert to months.

6. The SCD’s are then adjusted by the total number of months and/or calendar days.

Change In Probationary Period Start Date/Supervisory−Managerial Probationary
Period Required

When the probationary period start date or the Supervisory-Managerial Probationary Period
Required date is initially furnished, the PPS begins maintaining two records, creditable
service and nonpay status, as shown on the time and attendance report and as recorded on
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personnel actions. If previous service is unknown, enter the effective date of the accession
personnel action. Creditable service is recorded on the employee’s database intermittent
record (IRIS Program IR129, Intermittent), and nonpay status is recorded on the employee’s
leave record (IRIS Program IR140, Non Pay Leave).

If a personnel action is processed to change or correct these dates, the PPS disregards the
previous record of creditable service stored on IRIS Program IR129 and begins (during the
pay period in which the personnel action is processed) maintaining a new record. However,
the excess nonpay status recorded on IRIS Program IR140 will remain the same.

If a personnel action is processed to remove this date, both the creditable service and excess
nonpay status records are removed from the employee’s database record.

The PPS automatically removes the probationary period start date or the Supervisory -
Managerial Probationary Period Required date at the completion of the required time of
creditable service. Do not process a personnel action to remove this date upon completion of
the probationary or trial period for those employees who are on the agency rolls at the time
the waiting period expires.

Employees who have previous service which is creditable toward these dates may not be
required to serve the complete probationary period. Agency personnel offices must maintain
manual records for these employees.

The PPS credits full calendar time for periods of full-time and part-time service, and 7 days
of calendar time for every 5 days of intermittent service. Creditable service is reduced for
each workday in nonpay status (other than for military furlough or compensable injury)
which exceeds 22 workdays (e.g., up to 22 days of nonpay is considered creditable service
since it is forgiven).

Report Number AECO36T2, Notification of Expiration of Probationary or Trial Period, is
produced each pay period and distributed to agency personnel offices to identify those
employees approaching expiration of probationary or trial periods. This report is produced 4
months prior to the expiration date.

Remarks Codes For SCD Adjustments

The following remarks code(s) are shown on the Standard Form (SF)−50−B output indicating
that the SCD was adjusted.
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Remarks
Code Description

B31 Changes SCD from (date) to reflect (number) hours worked under
intermittent appointment(s)

B32 Changes SCD from (date) to reflect excess time in nonpay status
during calendar year (XX)

G29 Intermittent employment totaled (number) hours in pay status from
(date) to (date)

G30 Intermittent employment totaled (number) hours in work status from
(date) to (date)

540 SCD Dates for Leave, RIF, Retirement, and TSP adjusted by (number)
days computed from (number) intermittent hours worked during
(number) elapsed calendar days. Previous dates were leave (date),
RIF (date), and/or retirement (date).

Change In Tenure Group

A change in tenure is processed when the tenure group changes. The PPS generates a
conversion to career tenure for most employees once the waiting period has been met. The
PPS adjusts the tenure and type of appointment codes based upon the completion of the
required waiting period. For more information, see Conversion To Career Tenure.

Entry Guidelines For Tenure Group

If
Tenure is: Then:

0 Career Tenure Start Date must be blank.

Type Appointment must be 04 or 09.

Type Appointment must be 08 or 09 when current
appointing authority is ANM (presidential appointment with
advice and consent of Congress).

1 Type Appointment must be 01 or 06.

Probationary Period Start and Career Tenure Start dates
must be blank.

2 Career Tenure Start Date must be present.

Type Appointment must be 01, 02, 06, or 07.

3 Type Appointment must be 03, 08, or 09.

3 and Type
Appointment is 08

Career Tenure Start Date must be blank.

3 and Type
Appointment is 09

SCD−RIF must be completed.

Tenure 
must be: If:

0 Pay Plan is ES.

0 or 3 Auth Code is WXM, W5M, or W7M or begins with M or N
(except NUM).

1 Pay Pan is VM, VN, or VP.
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Entry Guidelines For Tenure Group

If:
Tenure 
must be:

1 or 3 Auth Code begins with K (except KLM).

2 Auth Code is J8M, YAM, Y1M, Y2M, Y3M, or Y4M.

Change In Title

A change in title is processed to change the official title of a position. Before entering the
personnel action in EPIC, change the official title in PMSO.

Only the Personnel Action window (Figure 2:2) and the Agency Use field of the Benefits
pop-up (Figure 2:3) are accessible for a Change in Title since the element being changed is in
PMSO, not on the personnel action.

Entry Guidelines For Change In Title

Following are guidelines for processing change in title actions.

• Official title code and the occupational series must be compatible.

• Pay plan and official title code must be compatible.

• Official title must be completed in PMSO if the official title code is Z8888 or Z9999.

Change In Veterans Preference

A change in Veterans Preference is processed when the veterans preference changes.

Entry Guidelines For Change In Veterans Preference

Following are guidelines for processing change in veterans preference actions.

• The veterans preference must be 6 for Special Employment Programs Code 60.

• The veterans preference RIF must be different than the veterans preference RIF on the
database.

Change In Work Schedule

A change in work schedule is processed when an employee’s work schedule changes (e.g.,
full-time to full-time seasonal; part-time to full-time, etc.).

Entry Guidelines For Change In Work Schedule

Following are guidelines that apply to processing change in work schedule actions.

• Type the new work schedule code in the Work Schedule field on the Salary Data
pop-up (Figure 2:8).
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• If the employee is changing to part-time, enter the duty hours in the Tour Of Duty
Hours field.

• Enter I in the Work Schedule field if the employee is hired without compensation.

• Have the timekeeper prepare a split time and attendance report if the change is
effective other than the first Sunday of the pay period.

Name Change

A name change is processed when an employee’s name changes due to marriage, divorce, etc.
A name change is entered to change the employee’s name on the database. A name change is
not to be confused with a name correction. A name correction is processed to correct the
name on the database because it was entered incorrectly.

Entry Guidelines For Name Change

•  Type the new name in the Name Last, First, and Middle fields.

Realignment

A realignment is the movement of an employee and employee’s position within the
organization as defined in the Guide To Processing Personnel Actions.

Entry Guidelines For Realignment

Following are guidelines for processing realignment actions.

• Before entering the realignment, be sure to update the position data in PMSO.

• Type the new data for the realignment at the applicable window(s). A realignment for
50 or more employees can be system generated with a special request from the agency.
For more information, see System-Generated Mass Actions.

Conversions

Conversions are processed to convert an employee from one type of appointment to another.

For more information on conversions, see:

Entry Guidelines For Conversions

Conversion To Career Tenure

Entry Guidelines For Conversions

Following are guidelines for processing conversion actions.

• The last 2 digits of the occupational series must be 99 for authority codes YAM and
Y1M.

• The occupational series code must be 3506 for authority codes WVM and ZVM.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 2

P
erso

n
n

el A
ctio

n
s

2:27Types Of Personnel ActionsUpdated 01/08

• The pay plan must be ES when processing an SES conversion.

• Tenure cannot be 0 for a conversion to a permanent appointment.

• Type Appointment must be 01 for conversion to career.

• Type Appointment must be 02 for conversion to career-conditional.

• The Date NTE field must be more than 1 year but less than 5 years from the effective
date of the action for a conversion to the senior foreign service non-career
appointment−NTE.

• Do not process a conversion for Special Employee Code 45 or 46.

• The position occupied must be 3 for a conversion to SES career appointment.

Conversion To Career Tenure

The employee is converted to career tenure after the required waiting period is served. The
PPS automatically processes a conversion to career tenure once the waiting period has been
met. The PPS adjusts the tenure and type of appointment code based upon the completion of
three years of creditable calendar time. This adjustment does not apply to Taper or indefinite
appointments since there is no change in tenure group under a taper or indefinite
appointment.

The PPS credits full calendar time for periods of full-time and part-time service, and seven
days of calendar time for every 5 days of intermittent service. When the career/permanent
tenure start date is initially entered on a personnel action, the PPS begins maintaining two
records, creditable service and nonpay status, as recorded on time and attendance reports and
personnel actions. If the date is unknown because of previous service, the effective date of
the accession action should be entered.

If a personnel action is processed to change or correct this date, the PPS disregards the
previous record of creditable service and begins (the pay period in which the personnel action
is processed) maintaining a new record. However, the excess nonpay status recorded in the
database will remain the same. If a personnel action is processed to remove this date, both the
creditable service and excess nonpay status records are removed from the database.

For each period of nonpay status (except military furlough or compensable injury), creditable
service is reduced for each calendar day of nonpay status which is in excess of 30 calendar
days. For example, if an employee was in a continuous nonpay status for 90 calendar days
and then returned to duty, this period of nonpay status would extend the waiting period by 60
calendar days.

When a period of nonpay status is terminated by pay status, the PPS examines the total
amount of nonpay status to see if it exceeds 30 calendar days. The total amount of nonpay
status is then removed from the employee’s database record so that a new period of nonpay
status (if it occurs) can be recorded. If the period of nonpay status exceeds 30 calendar days,
the excess time is placed in a separate record and is used in determining completion of the
waiting period. This separate record of excess nonpay status is increased accordingly each
time a period of nonpay status exceeds 30 days. If the period of nonpay status is 30 days or
less, the record of nonpay status is not changed.
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Extensions

Extensions are processed to extend an appointment, detail, or nonpay status. The Extensions
option includes a list of extension actions, and includes NOAC’s 750 Continuance NTE, and
755 Exception To RIF Release.

Entry Guidelines For Extensions

Following are guidelines for processing extension actions.

• The last 2 digits of the occupational series must be 99 for authority codes YAM and
Y1M.

• The occupational series code must be 3506 for authority codes WVM and ZVM.

• An extension cannot be processed if the applicable initiating personnel action has not
processed (e.g., processing an extension to a temporary promotion when the temporary
promotion was not processed).

• Complete the Date NTE field on the Personnel Action window (Figure 2:2) and other
required fields.

Nonpay/Nonduty

Nonpay/nonduty actions are processed to place an employee in nonpay/nonduty status for
30 days or more.

Entry Guidelines For Nonpay/Nonduty

Following are guidelines for processing nonpay/nonduty actions.

• Adverse remarks codes are required for suspension actions.

• T&As are not submitted for employees placed in nonpay status via a personnel action.

Pay

Pay actions are processed when a salary change or adjustment occurs as a result of an
executive order or regulation, change in step, entitlement to allowances or differentials, etc.

For more information on payments, see:

Administratively Uncontrollable Overtime

Availability Pay

Grade Retention

Federal Pay Increase And Locality Pay

Federal Wage System Area Increase

Administratively Uncontrollable Overtime

Administratively Uncontrollable Overtime (AUO) is premium pay on an annual basis for
hours of duty that cannot be administratively controlled and which require substantial
amounts of irregular, unscheduled overtime duty.
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Entry Guidelines For Administratively Uncontrollable Overtime

Following are guidelines for processing AUO actions.

• The personnel action establishes entitlement to AUO; coding the T&A begins the
actual payment of AUO. Process the personnel action in the same (or prior) pay period
that the T&A is coded, otherwise the T&A will reject indicating that the employee is
ineligible.

• Type the applicable special employee code (i.e., 02 [nonexempt from FLSA]; 03
Scheduled Standby−AUO exempt/nonexempt from FLSA]; 08 [AUO other than law
enforcement personnel]) in the Special Employee field at the Miscellaneous
pop-up (Figure 2:7).

• To permanently terminate AUO entitlement, process an action, NOAC 818, and enter
00, or the applicable special employee code that terminates entitlement, in the Special
Employee field.

• To temporarily terminate AUO entitlement, do not process a personnel action. Code
the T&A as instructed under Coding The Time And Attendance Report to generate an
SF-50−B.

Note: AUO must be terminated before availability pay can begin.

Coding The Time And Attendance Report

The timekeeper should follow the guidelines below for coding the T&A to begin, change, or
terminate AUO.

• Enter the hours and percentage rate on the T&A in the AUO Hours/Percent fields.

• To change the AUO hours and/or percentage rate, process a T&A for the effective pay
period, entering the new hours/percent in the AUO Hours/Percent fields. An SF−50B,
NOAC 818, will be generated.

• To terminate AUO payments, process a T&A for the effective pay period and enter 99
in the Percent field.

• To retroactively begin AUO, correct AUO hours and/or percentage rate, or
retroactively terminate AUO, process a corrected T&A for each pay period that the
correction applies. Enter the correct hours/percent in the AUO Hours/Percent fields or
enter 99 in the Percent field to terminate AUO. If the corrected T&A is starting,
changing, or correcting AUO hours and/or percentage rate, the database must be coded
eligible for the pay period of the corrected T&A. If the T&A is terminating entitlement
by deleting the AUO hours and percentage rate, the database must be coded ineligible
for the pay period of the corrected T&A. For the eligibility code, see IRIS Program
IR102, Dates & Misc Sal/Pers Data.

For detailed instructions for recording AUO on the T&A, see Title I, Chapter 7 Section 1,
Time and Attendance Instructions.

Availability Pay

Availability pay is a form of premium pay for covered criminal investigators. Availability pay
is fixed at 25 percent of basic pay.
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Note: AUO must be terminated before availability pay can begin.

For more information, see Entry Guidelines For Availability Pay.

Entry Guidelines For Availability Pay

Following are guidelines for processing availability pay actions.

• Type 26 in the Special Employee field at the Miscellaneous pop-up (Figure 2:7) to
begin payment. 

• To terminate payment and entitlement, process a personnel action, NOAC 819 and type
00 or the applicable special employee code that terminates entitlement, in the Special
Employee field.

• The T&A is coded only for unique cases. For instructions, see the T&A chapter.

Grade Retention

Grade retention applies when the employee’s position is reduced in grade as a RIF,
reclassification, or reorganization, and the employee is eligible to retain the current grade.

The Grade And Pay Retention Tables show which PRD code(s) can be used when certain
NOAC’s are processed for employees whose database salary data record indicates grade
and/or pay retention. Also included are definitions for the nature of action codes and remarks
codes. For examples of how to determine the rate of basic pay, see Examples of Grade
Retention.

For more information on grade retention, see:

About Grade Retention

Processing Tips For Determining The Retained Grade

Processing Tips For Determining The Applicable Rate Schedule

Processing Tips For Determining The Rate Of Basic Pay

Entry Guidelines For Grade And Pay Retention

Examples Of Grade Retention

About Grade Retention

The instructions for grade retention are based upon OPM regulations, which are contained in
Part 536 of Title 5, Code of Federal Regulations, and OPM’s Guide to Processing Personnel
Actions, Chapters 14 and 17. To determine the applicable pay rate determinant (PRD) code
for grade and/or pay retention, refer to OPM’s Guide to Processing Personnel Actions,
Chapter 4, Table 4.

Once the appropriate personnel action to establish grade and/or pay retention has been
successfully processed (NOA 740) and applied to the database, the retained grade data is
recorded on IRIS Program IR128, Retained Grade Data. The PRD Code is recorded on IRIS
Program IR101, Salary Data. The retained grade data recorded on IRIS Program IR128
displays data for the position the employee is currently occupying during the period of grade
retention and data for the pay plan, occupational series, and grade being retained.

An employee who meets specific eligibility requirements is eligible to retain his/her grade for
a period of 2 years if:



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 2

P
erso

n
n

el A
ctio

n
s

2:31Types Of Personnel ActionsUpdated 01/08

• The employee is placed in a lower-graded position as a result of reduction-in-force
procedures.

• The employee’s position is reduced in grade as a result of a reclassification process.

• The agency offers grade retention to employees who are placed in lower-graded
positions as a result of a reclassification or reorganization decision which is announced
by management in writing as defined in 5 CFR 536.103(b).

An employee placed in a lower-graded position as a result of a reduction-in-force procedure
or reorganization decision (which was announced by management in writing) is eligible for
grade retention only if the employee served 52 or more consecutive weeks in a grade or
grades higher than the grade of the lower-graded position. The requirement for 52 or more
consecutive weeks may be in one or more positions, in one or more agencies, and at more
than one grade level.

An employee placed in a lower-graded position as a result of a reclassification process is
eligible for grade retention only if the previous position had been classified at a higher level
grade(s) for a continuous period of at least 1 year prior to the reclassification process. The
previous position may have been classified at more than one higher grade level during the
1-year period, and in any pay schedule. (The employee is not required to have 52 consecutive
weeks or more in the previous position to be eligible for grade retention as a result of a
reclassification process.)

Grade and pay retention will not apply if the employee:

• Moves from a position that is not in an agency defined in U.S.C. 5102.

• Is identified under 5 U.S.C. 2105(c), except prevailing rate employees included under
5 U.S.C. 5361.

• Is reduced in grade or pay for personal cause or at the employee’s request.

• Is removed from a supervisory or managerial position because the probationary period
for the position was not successfully completed.

• Is other than a prevailing rate employee under 5 U.S.C. 5342(a)(2)(B) and is paid from
nonappropriated funds under the jurisdiction of the Armed Forces.

• Is entitled to receive basic pay under 5 U.S.C. 3594(c) because of removal from the
Senior Executive Service (SES) and placement in a civil service position (other than an
SES position) under 5 U.S.C. 3594(b)(2).

Processing Tips For Determining The Retained Grade

Before a personnel action is processed to establish grade retention, the employee’s retained
grade, the applicable rate schedule, and the rate of basic pay must be determined.

Note: For purposes of grade and pay retention in this section, rate schedule refers only to
(1) the General Schedule (or equivalent pay plan), (2) special salary rate schedules for
employees who are paid at a special salary rate (e.g., PRD Code 6), and (3) Federal Wage
System schedules. It does not include areas designated as locality pay areas; therefore, the
rate of basic pay must not include locality-based comparability payments.

An employee entitled to grade retention retains the grade of the position held immediately
prior to the position change if the position was under a covered pay schedule immediately
prior to the position change.
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If the position held immediately prior to the position change was not under a covered pay
schedule immediately prior to the position change, the employee retains:

• The lowest grade of the covered pay schedule for the position (in which the employee
is placed) which has a representative rate equal to, or higher than, the representative
rate of the grade held immediately prior to the position change,

OR

• The highest grade of the covered pay schedule for the position (in which the employee
is placed) if there is no grade in the covered pay schedule that has a representative rate
equal to, or higher than, the representative rate of the grade held immediately prior to
the position change.

Processing Tips For Determining The Applicable Rate Schedule

Careful review of the eligibility requirements that entitle the employee to grade retention is
necessary to determine the applicable rate schedule during the period of grade retention.

When an employee entitled to grade retention is placed in a lower-graded position in a
different geographical area, the employee is covered by the rate schedule for the position in
the new geographical area.

Note: The rate schedule for the position in the new geographical area refers only to: (1) the
General Schedule (or equivalent pay plan), (2) special salary rate schedules for employees
who are paid at a special salary rate (e.g., PRD Code 6), or (3) Federal Wage System
schedules.

If the employee is paid under the General Schedule or a special salary rate schedule (e.g., PRD
Code 6), and is placed in a lower-graded position that is not covered by a special salary rate
schedule, the applicable rate schedule will be the General Schedule.

If the employee is paid under the General Schedule or a special salary rate schedule
(e.g., PRD Code 6), and is placed in a lower-graded position that is covered by a special
salary rate, the applicable rate schedule will be the special salary rate schedule for the new
geographical area.

When an employee entitled to grade retention is placed in, or the position is changed to, a
different occupational series code, the applicable rate schedule is generally the rate schedule
for the new occupational series code.

If the employee is paid under the General Schedule or a special salary rate schedule (i.e.,
PRD Code 6, etc.), and is placed in a lower-graded position under the Federal Wage System,
the applicable rate schedule will be under the General Schedule or the special salary rate
schedule that applies to the retained occupational series code and grade, and new
geographical area (if changing).

If the employee is paid under the Federal Wage System, and is placed in a lower-graded
position in a new geographical area, the applicable rate schedule will be the Federal Wage
System schedule for the new geographical area.

If the employee is paid under the Federal Wage System and is placed in a lower-graded
position under the General Schedule or a special salary rate schedule, the applicable rate
schedule will be the Federal Wage System schedule for the new geographical area (if
changing).
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Processing Tips For Determining The Rate Of Basic Pay

When an employee becomes eligible for grade retention or moves to another position during
a period of grade retention under circumstances that permit the continuation of grade
retention, the employee is entitled to the greatest of:

• The rate of basic pay before the position change.

• The rate of basic pay from the applicable rate schedule for the grade and step held by
the employee before the position change. (See Processing Tips For Determining the
Applicable Rate Schedule.)

• The lowest rate of basic pay from the applicable rate schedule for the retained grade
which equals or exceeds the rate of basic pay before the position change. For more
information, see Processing Tips For Determining The Applicable Rate Schedule.

When a GM employee becomes eligible for grade retention, the employee no longer retains
the GM pay plan. Under 5 CFR 536.308, the retained grade cannot be used “to determine
whether an employee retains status as a GM employee (as defined in 5 CFR 531.202).” The
GM employee must be placed in the GS pay plan at the retained grade and placed in a step of
that grade that equals or exceeds the existing rate of basic pay. See Examples Of Grade
Retention.

Entry Guidelines For Grade And Pay Retention

Following are guidelines for processing grade and pay retention actions.

• The following processing instructions are based upon the requirements of the PPS
when certain types of personnel actions are processed for an employee who is in grade
retention or grade and pay retention. These edits will apply only if the following
conditions are present:

• The NOAC for the processing personnel action is listed on the Grade And Pay
Retention Tables.

• The PRD code on the employee’s database salary data record (IRIS
Program IR101) is A, B, E, F, U, or V and/or the PRD code on the processing
action is A, B, E, F, U, or V.

• If any of the PMSO key fields (i.e., Dept, Agency, POI, etc.) are changing, the NOAC
for the processing action must be a grade retention NOAC or NOAC 790, 800, or 903.

• When the NOAC for the processing action is 770, the following data elements must
not change:

• The PRD Code, occupied series, and occupied grade, which are recorded on the
employee’s database salary data record (IRIS Program IR101).

• The occupied position, which is recorded on the employee’s retained grade data
record (IRIS Program IR128).

• The pay rate determinant code must be U or V to receive retained grade and pay.

• The pay rate determinant code must be 2, 3, 4, J, K, or R to receive retained pay.

• When the NOAC on the processing action is one of the NOAC’s listed below, the
grade of the occupied position recorded on the employee’s retained grade data record
(IRIS Program IR128) must not change.
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NOAC Description

790 Realignment

892 Quality Increase

893 Within-Grade Increase

894 Pay Adjustment

888 Denial Of Within-Grade Increase

• Before a promotion, position change, or reassignment is processed for an employee
who is currently in grade and/or pay retention, it is very important to determine the
appropriate PRD code that will be used on the processing action. In addition, certain
data must also be established in the employee’s database.

• A personnel action with NOAC 721, Reassignment, or NOAC 713, Change to Lower
Grade (without Remarks Code X37) cannot be processed to:

• Place an employee into grade retention

• Place an employee into grade and pay retention

• Terminate grade retention

• Terminate grade and pay retention

• In addition, when a cancellation of NOAC 721, Reassignment, or NOAC 713, Change
to Lower Grade (without Remarks Code X37), is processed, the employee cannot be
placed into grade retention or grade and pay retention (PRD Code A, B, E, F, U,or V).
Refer to OPM’s Guide To Processing Personnel Actions, Table 14G, Rule 2, and Table
14H, Rule 5, for additional information on the exceptions that apply to NOAC 713.

• When the pay plan recorded in the employee’s database salary data record (IRIS
Program IR101) indicates a Federal Wage System pay plan, a personnel action cannot
be processed with a PRD Code of 2, 4, 5, 6, 7, E, F, R, or S.

• An employee is entitled to grade retention with a PRD Code of E or F only if the
geographical location the employee is actually assigned to and the occupational series
code of the position the employee is occupying is covered by a special salary rate
schedule.

Note: If the pay plan on the processing personnel action indicates a change to another
pay system, then the employee would be entitled to grade retention with a PRD Code
of E or F if the geographical location in which the employee is assigned to and the
occupational series of the position employee is retaining is covered by a special salary
rate schedule.

• Remarks Code X36 must be present when the NOAC and PRD code indicate
termination of grade retention except for NOAC 866/VKJ for another period of grade
retention or 866/VRJ for entitlement to pay retention.
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Examples Of Grade Retention

Examples Of Grade Retention
The following are examples of how to determine the rate of basic pay using the criteria outlined above.
The examples also contain guidance on determining the PRD code that would apply for each example.

Employee Entitled To Receive Rate Of Basic Pay Before Position Change.
A WS−09/05 employee, whose duty station is located in San Francisco, California, is paid $24.32 per
hour (Federal Wage System Pay Table 0607).

The employee is placed in a lower-graded position as a WS−08, in Santa Barbara, California (Federal
Wage System Pay Table 0608).

The rate of basic pay before the position change was $24. 32 per hour.
The rate of basic pay for a WS−09/05 (the grade and step held by the employee before the
position change) in Santa Barbara, California (Federal Wage System Pay Table 0608), is $20.00
per hour.
There is no lower rate of basic pay from the Federal Wage System Pay Table 0608 for the
retained grade (WS−09/05, in this example) which equals or exceeds the rate of basic pay before
the position change ($24. 32 per hour).

Because there is no rate at the WS−09 level in the Federal Wage System Pay Table 0608 that equals
or exceeds $24.32 per hour, the employee would be entitled to retain $24. 32 per hour, which is the
basic pay before the position change. PRD Code V would be used in this example, because the
employee is moving to a different position and will receive retained pay while in grade retention, and
the employee’s step should be changed to 00.

Employee Entitled To Receive Rate Of Basic Pay From Applicable Rate Schedule For
Grade And Step Held Before Position Change
A GS−0462−04/08 employee, whose duty station is located in San Francisco, California, is paid a
special salary rate of $24,037 per annum (Special Salary Rate Schedule 0256).

The employee is placed in a lower-graded position as a WG−3502, Grade 03, in San Francisco,
California.

The rate of basic pay before the position change was $24,037 per annum.
The rate of basic pay for a GS−0462−04/08 (the grade and step held by the employee before the
position change) in San Francisco, California, is $24,037 per annum (Special Salary Rate
Schedule 0256).
The lowest rate of basic pay from the Special Salary Rate Schedule 0256 for the retained grade
(GS−04/08, in this example) which equals or exceeds the rate of basic pay before the position
change is $24,037 per annum.
The employee would be entitled to retain the special salary rate of a GS−0462−04/08, which is
$24,037 per annum. PRD Code E would be used for this example, because the employee is
moving to a different position and is entitled to a special salary rate in the new position while in
grade retention.
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Employee Entitled To Receive Lowest Rate Of Basic Pay Equal To Or Exceeds Rate Of
Basic Pay Before Position Change
A GS−0303−06/04 employee, whose duty station is located in San Francisco, California, is paid a
special salary rate of $24,814 per annum (Special Salary Rate Schedule 0024).

The employee is placed in a lower-graded position as a GS−0303, Grade 05, in Missoula, Montana.

Note: The employee will be paid under the General Schedule because there is no special salary rate
schedule for a GS−0303, Grade 06, in Missoula, Montana.

The rate of basic pay before the position change was $24,814 per annum.

The rate of basic pay from the General Schedule for a GS−0303−06/04 (the grade and step held by
the employee before the position change) in Missoula, Montana, is $23,396 per annum. (A
GS−0303−06 position is not covered by a special salary rate schedule in Missoula, Montana.)

The lowest rate of basic pay from the General Schedule for the retained grade (GS−06, in this
example) which equals or exceeds the rate of basic pay before the position change is $24,814 per
annum (the basic pay for a GS−06/06 under the General Schedule).

The employee would be entitled to receive $24,814 per annum, and should be placed in step 6. PRD
Code A would be used for this example, because the employee is moving to a different position and is
not entitled to a special salary rate in the new position and duty station.

Multiple Downgrades During 2-Year Grade Retention Period
As a result of reduction-in-force procedures, a GS−9 employee is placed in a lower-grade position as a
GS−7, which entitles the employee to grade retention for 2 years. A year later, during the 2-year
period of grade retention, the employee is placed in a lower-graded position as a GS−5. The employee
continues to retain the GS−9 position for the remainder of the original 2-year period of grade retention.

After the original 2-year period of grade retention has expired, the employee is eligible to retain the
GS−7 position for 1 year. However, the salary data in the employee’s database salary record (IRIS
Program IR101) reflects the data for the GS−9 position.

A personnel action (Nature of Action Code 866/VKJ) to terminate the employee’s grade retention at
GS−9 would be processed, and the data entered in the Retain: Info fields should be the data for the
GS−7 position. (The data in these fields should reflect data for the grade the employee will retain
during grade retention.)

GM Employee Placed In Grade Retention
A GM−13/00 employee with a scheduled rate of pay of $58,000 per annum is downgraded and otherwise
eligible for grade retention. The scheduled rate of pay for GS−13/03 is $57,379; for GS−13/04 is
$59,172. In establishing the employee’s grade retention, the pay plan is changed to GS, the step is
changed to 04, and the employee is entitled to retain the GS13/04 rate. The employee’s $1,172 increase
in pay ($59,172 − $58,000) is not considered an equivalent increase for within-grade purposes and no
change should be made to the SCD−WGI.

Federal Pay Increase And Locality Pay

Legislative Acts and Executive Orders mandate the Federal pay increases and locality-based
comparability payments (a.k.a. locality pay or locality payment) for Federal employees.

IRIS Program IR101 displays the adjusted salary amount, the scheduled salary amount, and
the locality payment amount, after the pay adjustment is processed.

Once the percentages for the increases are known, the following occur in the PPS:
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• TMGT tables are updated with the revised salary rates.

• Monetary appointment limitation balances are increased by 40% of GS 3 Step 1 salary
for employees on the database.

• Prior actions entered after the first pass of PINE are rolled off the database. This
occurs because personnel actions are sorted and processed by effective date. To avoid
the rollback, the prior action should be entered before the first pass of PINE.

For more information, see:

System-Generated Federal Pay Increase And Locality Pay

Agency-Entered Federal Pay Increase And Locality Pay

Processing Tips For Federal Pay Increase/Locality-Based Comparability Payment

Other Pay Changes During The Pay Period

System-Generated Federal Pay Increase And Locality Pay

The PPS automatically generates the Federal pay increase and locality payment personnel
action (NOAC 894, Pay Adjustment; Authority Code QWM/ZLM, Reg. 531.205), for most
employees. This single action is produced for both the Federal pay increase and the locality
payment. If only locality payment is authorized, the system generates a personnel action,
NOAC 895, Locality Payment; Authority Code VGR, 5 U.S.C. 5304. The system
automatically processes the Federal pay increase for the employees listed below.

• Employees in Pay Plans AL, CO, DN, ES, EX, FC, FE, FO, FP, FS, GG, GH, GM, GS,
GT, IR, IS, LE, MG, MS, NF, NX, PA, PE, TM, and TS

• Employees in Pay Plan ES who are at levels ES−1 through ES−4

• Employees who are paid at administratively determined rates (Pay Plan AD) as
requested by the agency

• Reemployed annuitants whose salaries are offset by annuities from CSRS or FERS.
Although the PPS will automatically generate the Federal pay increase pay adjustment
action for the existing scheduled salaries of these annuitants, the personnel office must
prepare a personnel action for the annuity cost-of-living adjustment. The increased
amount of the annuity must be recorded in the Salary Share Amount field.

If the Federal pay increase was not generated for an employee, informational message 100
Unable to generate pay raise−process personnel action or 117 LEO pay rate determinant
code not equal 0, 5, 6−process personnel action displays on the suspense listing. If the
employee is eligible for the pay increase, enter the personnel action for processing. In certain
situations the PPS is coded to bypass the Federal pay increase for an employee. Informational
message 111 Record entered to bypass pay raise for employee is displayed on the suspense
listing for these employees.

Agency-Entered Federal Pay Increase And Locality Pay

The agency personnel office must enter the Federal pay increase for the following employees;
the PPS does not automatically process these increases.

• Experts and consultants (Pay Plans CG, EC, ED, EE, EF, EG, EH, EI, IC).

• Employees in Pay Plans CP, FA, IJ, IL, LP, RE, SL, ST, TF, TR, and TW.
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• Do not abolish a position held by an employee on a detail or a temporary promotion
until the employee has returned to the permanent position.

• A temporary detail or promotion must be terminated before the POI can be changed.

• Employees paid at statutory rates (Pay Plan SR).

• Employees paid in Pay Plans IL, SL, ST, with the exception of employees in those
agencies that have notified NFC to automatically process the pay increase. The Federal
pay increase for these pay plans are made at the discretion of the department/agency.

• Employees in Pay Plans AD (except for those that agencies requested NFC to
automatically process), AE, DB, FN, HA, NB, PD, RA, and SB.

• Employees being paid under Pay Rate Determinant Code 2, 3, 4, M, or S.

• Employees in Pay Plan GS and GM who are being paid under cooperative agreements
and for whom the Federal government does not pay all the salary.

• Employees in Pay Plans GG and GH who are being paid under cooperative
agreements.

• Employees who are Americorps members (Special Employment Program Code V8)

Note: NFC mails lists to the agencies for employees in the above categories prior to the
effective pay period of the Federal pay increase. The lists are usually produced at the
end of Pay Period 25. Agencies should review the lists, verify eligibility for the
Federal pay increase, and enter the Federal pay increase action, if applicable.

• Employees hired or reappointed in the pay period prior to the Federal pay increase in
any of the above categories. The agency must determine eligibility for these
employees.

• Employees in any of the above categories whose status changes after the lists are
produced.

• Employees listed on the suspense listing under Document Type 999.

The PPS calculates and processes the locality payment for employees who receive the
Federal pay increase. The following GS employees do not receive locality pay:

• Special salary rate employees whose scheduled salary exceeds the locality pay for the
locality pay area

• Law enforcement officers receiving geographic special pay adjustments higher than the
locality pay in the locality pay area

The scheduled salary/basic pay is the OPM pay table base salary before addition of any
allowance, adjustment, or differential. The adjusted salary includes the scheduled salary plus
any allowance, adjustment, or differential. Locality pay is included in the adjusted salary
amount. The cooperative and/or annuitant share of salary amount is also included in the
adjusted salary amount.

Locality pay is based on the employee’s duty station. When the duty station changes to
another locality pay area, the locality pay rate changes to the new duty station rate on the
effective date of the duty station change. When the duty station changes to one that is not a
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locality pay area, the locality pay terminates. Most employees working in the 48 contiguous
states (including Washington, D.C.; excluding Alaska and Hawaii) receive locality pay.
Employees who are in retained pay status receive full locality pay.

Processing Tips For Federal Pay Increase/Locality-Based Comparability Payment

TMGT Table 029, Salary Table, displays the scheduled and adjusted salary by pay plan,
grade, and step for each OPM table. To display the scheduled salary, type 0000 in the OPM
Pay Table Number field; to display the adjusted salary, enter the occupational special pay area
code (e.g., 4RUS) in the OPM Pay Table Number field.

To acquire the locality pay rate and locality pay table code for a location, access
TMGT Table 016, Geographical Location Codes. This table lists all geographical locations
and the locality pay data, as applicable. You may execute a report with a range of locations
instead of scrolling through the table.

Other Pay Changes During The Pay Period

If a pay change (e.g., within-grade increase, promotion, etc.) or any action that results in an
entry in the Basic Pay field is processed in the pay period of the pay adjustment, enter the
new salary in the Basic Pay field. Do not include the locality payment.

Federal Wage System Area Increase

FWS employees receive a periodic wage area increase based on locality. TMGT Table 058,
Wage Area, is a report that contains the wage area codes with their production schedules in
selected pay areas used for current month processing of population reports on FWS
employees. TMGT Table 029, Pay Table, and Table 033, Wage Grade Pay Converter, include
information for the generation of FWS area increases.

Position Changes

Position changes are actions that affect the employee’s position and/or
salary (i.e., reassignment, promotion, etc.). When a position change action is entered, it is
likely that some type of action must be taken in PMSO. Several of the position change
actions listed on the Position Changes menu may be used for processing grade retention or
pay retention. For NOAC’s, pay rate determinant codes, and expiration dates for grade
retention, see the Grade And Pay Retention Tables.

For more information, see:

Entry Guidelines For Position Changes

Intergovernmental Personnel Act (IPA) Details

Entry Guidelines For Position Changes

Following are guidelines for processing position change actions.

• The previous agency code and current agency code cannot be the same when an
employee changes agencies within the department.
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• When entering a detail action, the individual position number must be different than
the position the employee currently occupies.

• A temporary detail or promotion must be terminated before another detail or temporary
promotion can be processed.

• The detail position must be established in PMSO to enter a detail, correction,
extension, cancellation, or termination to a detail. Verify in PMSO if the position is
permanent or a detail.

• Position occupied must be 2 for a promotion to excepted service.

• When entering a promotion, the grade must be greater than the grade on the database.

• The position occupied must be 1 for a reinstatement from excepted service to
competitive service.

• The position occupied must be 1 for a position change.

• The position occupied must be 1 or 2 for a position change due to a RIF, which entitles
the employee to grade retention.

• The position occupied must be 2 for a position change back to the retained grade in the
excepted service.

• The employee must have a saved grade record on the database for a position change
under the executive assignment system.

• When the action moves the employee back to a position at the retained grade, the
grade must be the same as the grade on the save grade record as shown on IRIS
Program IR128.

• When a promotion, reassignment, or change to lower grade is entered for an
employee in grade retention, the grade on the saved grade record must be greater
than the grade on the personnel action being entered.

Intergovernmental (IPA) Details

NOAC 730, Detail NTE; NOA 731, Ext Detail NTE; and NOA 732, Term of Detail NTE are
used to document an SF−50, Notification of Personnel Action, for employees on an IPA
detail.

Entry Guidelines For IPA Details

Following are guidelines for entering IPA Details.

• The expiration date is displayed on the Detail Detail Assignment Expires field on IRIS
Program IR127, Detail Assign/Temporary Promotion; IRIS Program IR227,
Detail/Temp Promotion; and IRIS Program IR527, Detail Assign/Temporary
Promotion.

Return To Duty

Return to duty actions are actions that place employees in pay status only when a personnel
action was processed to place the employee in a nonpay status.
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For more information, see Entry Guidelines For Return To Duty Actions.

Entry Guidelines For Return To Duty Actions

Following are guidelines for processing return to duty actions.

• Process the return to duty before the nonpay status not-to-exceed (NTE) date expires.

• The effective date of the return to duty should be the day after the NTE date of the
nonpay status NTE date.

• The return to duty personnel action must apply before the T&A will processed and
subsequently be paid.

Separations

Separation actions are actions that remove employees from the rolls by retirement,
resignation, termination, or death.

For more information on separations, see:

Processing Tips For Separations

Entry Guidelines For Separations

Retirement

Resignation

Removal

Death

Termination

Other Separations

Note: For separation incentive processing, see Bonuses And Incentives.

Processing Tips For Separations

Following are tips for processing separation actions.

Ensure that:

• The final time and attendance report (or the final code) is entered;

• Lump sum payments for leave have been made and there is no annual or compensatory
leave balance on the database;

• The separation action is processed;

• Bond refunds are disbursed;

• All payments due the Government are satisfied.

After these transactions are processed the record remains on the active database for 6 pay
periods following the processing of the last transaction then is transferred to the history
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database which stores up to 10 years of history data. To correct or cancel an action that has
transferred to history, use EPIC History Correction. For instructions, see Correcting History
Data.

Entry Guidelines For Separations

Following are guidelines for separation actions:

• Only an accession, a correction to the separation, a separation incentive, or a cash
award can be processed if a separation action is the last action on the database.

• Complete the FEHB Cov Code field for retirement, death, resignation in lieu of
involuntary action, or involuntary termination personnel actions.

• Be sure to complete the severance pay data when Remarks Code N22 is entered.

• If the processing action is a retirement or death action, and the FEHB code is 1, enter
one of the following remarks codes in the Remarks window (Figure 2:11):

Remarks
Code Definition

388 Terminate FEHB enrollment. (Employee ineligible to continue
FEHB coverage.)

389 Transfer FEHB enrollment to OPM. (Employee eligible to
continue FEHB coverage.)

390 Transfer FEHB enrollment to DC Retirement System. (Employee
under Retirement Coverage Code Y or Z and eligible to continue
FEHB coverage.)

564 Terminate FEHB − Not enrolled since first opportunity

565 Terminate FEHB − Not enrolled five years

566 Terminate FEHB − No survivor eligible to continue health
benefits

• Employees who are asked to resign involuntarily or are terminated involuntarily may
be eligible for discontinued service retirement. These employees may be eligible to
transfer their FEHB coverage to OPM if the conditions required for continuation of
FEHB enrollment have been met. Enter Remarks Code 388, 389, or 390 on the
resignation/termination action to indicate if FEHB coverage will be continued.

Retirement

A retirement action is processed when an employee has contributed to a retirement system
and is eligible to retire and collect an immediate annuity. For detailed instructions for
processing retirement transactions, see the Processing Retirement Documents procedure,
(Title I, Chapter 9). Use RETM to track the processing of applications for retirement benefits
in the event an employee retires, is deceased, or separates with a request for a refund of
retirement contributions.

Entry Guidelines For Retirement Actions

Following are guidelines for processing retirement actions.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 2

P
erso

n
n

el A
ctio

n
s

2:43Types Of Personnel ActionsUpdated 01/08

• If the employee is enrolled in FEHB and remark code 390 is entered on a retirement
action, the retirement plan code must be Y or Z.

• If the employee is enrolled in FEHB and remark code 391 is entered on a retirement
action, the retirement plan code must be 8 or 9.

Resignation

A resignation action is processed when an employee voluntarily elects to leave the
organization.

Entry Guidelines For Resignation Actions

Following are guidelines for processing resignation actions.

• FEHB remarks codes 388 and 389 must be entered for a resignation in lieu of
involuntary action.

• Remarks code 388,389,390,391,564,565, or 566 must be entered on
retirement, death, resignation in lieu of involuntary action, and involuntary termination
actions, if the employee was enrolled in FEHB.

Removal

A removal action is processed when an agency removes an employee from the rolls because
of misconduct, false statements at the time of appointment, unacceptable performance, etc.

Entry Guidelines For Removal Actions

Following are guidelines for processing removal actions.

• Adverse remarks codes are required for removal actions.

Death

A death action is processed to remove a deceased employee’s record from the database and
settle the deceased employee’s accounts as required by 5 USC 5581−5584. For detailed
information on processing death claims, see Title I, Chapter 8, Special Payroll Processing
System, and Title I, Chapter 11, Nonautomated Processing. All death cases must have an
SPPS record established to enable payments to beneficiaries.

Entry Guidelines For Death Actions

Following are guidelines for processing death actions.

• Remarks code 388,389,390,391,564,565, or 566 must be entered on
retirement, death, resignation in lieu of involuntary action, and involuntary termination
actions, if the employee was enrolled in FEHB.

• If the employee is enrolled in FEHB and remark code 390 is entered on a death
action, the retirement plan code must be Y or Z.
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• If the employee is enrolled in FEHB and remark code 391 is entered on a death
action, the retirement plan code must be 8 or 9.

Termination

A termination action is processed when an agency terminates the employee (through no fault
of the employee) because of a nondisciplinary action such as expiration of appointment, lack
of work, lack of funds, etc.

Entry Guidelines For Termination Actions

Following are guidelines for processing termination actions.

• FEHB remarks code 389 must be entered for an involuntary termination.

• Remarks code 388,389,390,391,564,565, or 566 must be entered on
retirement, death, resignation in lieu of involuntary action, and involuntary termination
actions, if the employee was enrolled in FEHB.

Other Separations

The List of Personnel Actions includes other separation actions not included in the above
categories (e.g., Separation Military, Separation RIF, etc.). For information pertaining to these
separations, see the OPM Guide To Processing Personnel Actions.

Within-Grade Increase

A WGI is an increase to the next step within a grade. The WGI is system-generated for most
employees. For more information on WGI’s, see:

System-Generated WGI

Agency-Entered WGI

Processing Tips For Within-Grade Increases

Entry Guidelines For Within-Grade Increases

WGI Denial

Quality Increases

System-Generated WGI

Based on the SCD−WGI, the number of days worked, and the performance rating, the PPS
generates Form AD−658, Within-Grade Increase Record, for GS and equivalent pay plans.

For more information on system-generated WGI, see:

Waiting Period

Creditable Service And Non-Creditable Service

System-Generated Form AD−658

Agency Notifications
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Waiting Period

The employee must meet the required time in step to advance to the next step. The PPS
counts calendar days in pay status for granting a WGI. A full day is counted if the employee
is in pay status any part of the day. The PPS projects the WGI due date based on the number
of weeks in the step of a grade as follows:

Step Calendar Weeks

1 − 3 52

4 − 6 104

7 − 10 156

The PPS credits actual intermittent days worked for intermittent employees. The WGI due
date is based on the number of days in pay status over a period of 52 calendar week intervals
in the step of the grade as follows:

Step
Calendar
Days

Calendar
Weeks

1 − 3 260 52

4 − 6 520 104

7 − 10 780 156

Creditable Service and Non-Creditable Service

Days worked are counted toward generation of the WGI. Excessive nonpay status or elapsed
calendar days during the year could prolong eligibility of the WGI. The PPS records
creditable service by the the number of days in pay status. This information is obtained from
hours, days, and paid leave recorded on the T&A.

The PPS records the number of days an intermittent employee works plus the equivalent
elapsed calendar days based on data recorded on the T&A. If a T&A is not processed for an
intermittent employee, 14 days will be recorded as elapsed calendar days for the pay period.
When the calendar time requirements for the waiting period are met, this period of time may
be extended by any noncreditable time on the rolls.

System-Generated Form AD−658

NFC generates Form AD−658 according to the following schedule:

• Full-time and part-time employees. 14 weeks prior to the actual due date of the
WGI.

• Intermittent employees. When the database indicates the employee has completed:

260 days in pay status in not less than 52 calendar weeks

520 days in pay status in not less than 104 calendar weeks

780 days in pay status in not less than 156 calendar weeks

The PPS automatically generates the AD−658 for Federal Wage System employees at the
beginning of the first applicable pay period following completion of the required waiting
period, provided the employee’s performance evaluation is fully successful and the employee
has not received an equivalent increase during the waiting period.
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If the agency agrees that the WGI is due, no action is necessary. The system automatically
processes the WGI in the effective pay period. If however, the WGI should not be processed
as indicated, the agency must take the necessary action to prevent the WGI from processing.

Agency Notifications

The PPS produces several reports for the agency personnel offices regarding WGI
processing. Each report and Form AD−658 display data contained in the database as of the
ending date of the pay period in which the report is prepared. Error conditions on the reports
must be corrected by processing personnel actions for all columns except Non Pay Status
Hours. Nonpay status hours must be corrected in TINQ. For detailed information on TINQ,
see the TINQ procedure. For report exhibits, see Title I, Chapter 20, Section 5,
Payroll/Personnel Output.

Classified Employee Within-Grade Increase Sixteen Week Listing. Lists employees
whose WGI’s will be generated based on their latest performance appraisal rating, which is
fully successful or higher. Produced 16 weeks prior to the projected date of the WGI,

Classified Employee Within-Grade Increase Four Week Notification. Lists employees
whose WGI will be generated in 4 weeks based on their latest performance appraisal rating,
which is fully successful or higher. Produced every pay period. This report updates the
16-week report previously issued (Report AECO36S1).

Classified Employee Control Listing of Within-Grade Increase Forms For F/T And P/T
Employees. Lists classified employees whose WGI’s are not automatically processed by the
PPS. Produced each pay period. Agencies must enter the WGI’s for these employees.

Classified Employee WGI Status Sixteen Week Listing. Lists employees whose WGI will
not be generated unless action is taken to change the performance appraisal rating to fully
successful or higher before the effective date of the WGI. Produced 16 weeks prior to the
projected date of the WGI.

Federal Wage System WGI Status Eight Week Notification. Lists Federal Wage System
employees whose WGI’s will not be processed because of unsatisfactory performance
evaluations. Produced eight weeks prior to the projected date of the WGI. The PPS will not
automatically process the WGI until a new performance evaluation is processed indicating
the employee has met the acceptable level of performance requirements.

In addition to the agency notifications, the following WGI-related reports are produced:

• Annual Report Of Within Grade Increase By Race And National Origin

• Annual Report Of Within Grade Increase By Series And Grade

• Certification For Within Grade Increase

• Notification Of WGI Overdue

• Quality Step Increase By PATCO & Pay Level

• Quality Step Increase By PATCO, Series, & Pay Level

• Semi-Annual (Or Annual) Report On Quality Increase

IRIS Program IR303, WGI Information, include data pertaining to WGI processing. The
following data elements apply to the generation of the WGI.
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*WGI Notification Given Code/Pay Period/Year. Indicates if an AD−658 has been
prepared for processing within 4 or 16 weeks as listed on the applicable notification reports
and the pay period and year of the notification.

Code Description

0 Notification Prepared

1 AD−658 Will Be Prepared In 6 Weeks

2 AD−658 Will Be Prepared In 4 Weeks

WGI Due Code. Indicates if a WGI is due or has been given. The WGI due code can be
changed by using the Master File Change document under the New Payroll Documents
option for processing a retroactive WGI.

Code Description

0 WGI Not Due

1 WGI Due

2 WGI Processed

3 Intermittent Projected Due

4 Process Intermittent WGI When Due

Agency-Entered WGI

The actions listed under Within-Grade Increase on the EPIC List of Personnel Actions menu
are used to process or deny step increases.

IRIS Program IR123 includes indicators regarding WGI processing. IRIS Program IR303
displays the counters since the last WGI. This program contains sensitive data and requires
special access.

Processing Tips For Within-Grade Increases

Following are tips for processing within-grade increase actions.

The SCD for the WGI is entered on the personnel action (e.g., accession action) or generated
by the PPS from the processing of a personnel action (e.g., promotion). Agencies should
correct or adjust this date when previous service and/or nonpay status was not considered at
the time this date was initially furnished for such service nonpay status. Output Forms
SF−50−B, issued while the employee is in a waiting period for a WGI, record the SCD−WGI
furnished by the agency, or the system-adjusted date based on creditable service and nonpay
status.

The WGI’s that are not automatically generated by the PPS must be entered by the agency. In
addition, there may be other conditions that the agency must enter the WGI.

To process a delayed WGI as a result of favorable reconsideration:

1. Change the performance appraisal rating to fully successful or higher.
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2. Access IRIS Program IR123 to view the WGI Due Code.

3. If necessary, change the WGI Due Code to 1 then enter the WGI (NOAC 893) for
processing in the PPS. For instructions on changing the WGI Due Code, see Master
File Change Document.

Entry Guidelines For Within-Grade Increases

Following are guidelines for processing WGI actions.

• The grade must be equal to the grade on the database.

• The step on the database cannot be 10.

• The pay plan cannot be FO, FP, or FS and the step cannot be 14.

• A denial cannot be processed if the WGI was processed.

• Must be effective on the first day of the processing pay period.

• Must be effective the pay period after the employee serves the designated waiting
period.

• The performance evaluation rating must be fully successful or greater for a WGI to be
processed.

• The WGI Due code must equal 1 (Due).

• The step for a WGI or quality step increase must be one step above the step on the
database.

• Employees in pay plans OC, PA, PE, ZP, ZS, and ZT are not eligible for a WGI.

• AE employees with Pay Plans SL and SP are not entitled to a quality step increase.

WGI Denial

The Payroll/Personnel System will not generate a denial of a WGI for an employee who has
failed to meet the acceptable level of competence requirements (i.e., unsatisfactory
performance). Agencies must enter the denial for processing prior to the effective pay period
the WGI is due. It is the agency’s responsibility to maintain the WGI due date for Federal
Wage System employees. The next AD−658 will not be produced until approximately one
year and fourteen weeks from the date the initial waiting period was completed.

Quality Increases

Following are guidelines for processing Quality Increase Actions.

• The performance evaluation rating must be outstanding for a QSI to be processed.

Reminder: Ensure the effective date is at least 52 weeks from the last QSI.
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Entering Personnel Actions

This section presents the following topics:

About Entering Personnel Actions

Selecting A Specific Personnel Action

Entering A Personnel Action

About Entering Personnel Actions

Personnel actions are entered to establish and update an employee record in the PPS database.
A personnel action consists of key data on the Personnel Action window (Figure 2:2) and the
other data (e.g., employee, position, salary, benefits, miscellaneous, award, and bonus
(includes retention and incentive data)) displayed on associated pop-ups.

Personnel actions also include Remarks data, which may be viewed and entered at the
Remarks window (Figure 2:11).

For instructions on selecting and entering personnel actions, see:

Selecting A Specific Personnel Action

Entering A Personnel Action

Employee Data Pop-up Field Instructions

Position Data Pop-up Field Instructions

Salary Data Pop-up Field Instructions

Benefits Pop-up Field Instructions

Miscellaneous Pop-up Field Instructions

Award Pop-up Field Instructions

Bonus Pop-up Field Instructions

At each window or pop-up, only fields applicable to the selected NOAC are accessible; those
not applicable are “grayed out” to prevent entry. Required field names are highlighted in
black to ensure completion; optional field names are highlighted in blue. The action is
released (or held) from the Personnel Action window (Figure 2:2) using the applicable status
code.

Selecting A Specific Personnel Action

To select a personnel action to be processed in EPIC:

1. Select a personnel action from the New Documents menu at the EPIC Navigation
window (Figure 1:4). A list of personnel actions by category appears (Figure 2:1 ).
This list includes all NOAC’s in the database for the type of action selected. The list is
updated as the NOAC tables in the Table Management System are updated.
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Figure 2:1. EPIC Navigation window [personnel action menu]

2. Click the appropriate action and select Edit > Add New Document at the menu bar. The
Personnel Action window (Figure 2:2) is displayed. For instructions on the entry
process, see Entering A Personnel Action.

Entering A Personnel Action

After you select a personnel action from the EPIC Navigation window (Figure 1:4), the
Personnel Action window (Figure 2:2) is displayed with an associated data set for the
selected NOAC. The type of action appears in the window title bar, and the NOAC is
generated in the 1st NOA field of the Personnel Action window (Figure 2:2).

Note: The cursor is positioned at the first field of the associated data pop-up. You may begin
entry at the pop-up, or you may move your cursor and begin entry in the key data area.

To enter the action:

1. Complete the key data and other fields as indicated under the following topics:

Personnel Action Window Key Data Field Instructions

Award Pop-up Field Instructions

Benefits Pop-up Field Instructions

Bonus Pop-up Field Instructions

Employee Data Pop-up Field Instructions

Miscellaneous Pop-up Field Instructions

Position Data Pop-up Field Instructions

Salary Data Pop-up Field Instructions

(For illustrations of these windows, see Figures 2:2 − 2:11.)
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Reminder: Field names in black must be completed; field names in blue are optional;
field names in gray are inaccessible.

2. After completing the fields, click ,  or the applicable data set tool button to

display and complete the next window.

3. After completing all applicable sets, click File > Close to save the entries and exit the
window. The Save Changes pop-up (Figure 1:4) appears.

4. At the Save Changes pop-up (Figure 1:4), choose one of the following responses:

• Click [Yes] to save the entries and edit the action.

• Click [No] to exit the window and not save the entries.

• Click [Cancel] to return to the Personnel Action window (Figure 2:2).

If you click [Yes] and front-end errors exist, an error list is displayed. Correct the
errors as indicated under Correcting EPIC Front-end Errors.

Illustrations Of Personnel Action Key Data Window And Data Set Pop-ups

Figure 2:2. Personnel Action (key data)

Figure 2:3. Benefits pop-up



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

2:52 Entering Personnel Actions Updated 01/08

Figure 2:4. Bonus pop-up

Figure 2:5. Employee Data pop-up

Figure 2:6. Position Data pop-up

Figure 2:7. Miscellaneous pop-up
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Figure 2:8. Salary Data pop-up

For instructions on entering award data and remarks, see:

Entering Award Data

Entering Foreign Language Bonus Data

Entering Remarks Data

Entering Award Data

The Awards pop-up (Figure 2:9) is used to enter cash awards and time off awards. For
processing information, see Awards.

Figure 2:9. Awards pop-up (Gainsharing Award)

To enter award data:

1. After the award NOAC is selected, the Personnel Action window(Figure 2:9) is
displayed. For entry instructions on the Personnel Action window (Figure 2:2), see
Entering A Personnel Action.

2. Complete the Personnel Action window (Figure 2:2) and click the awards tool button
to display the Awards pop-up (Figure 2:9).

3. Complete the fields as indicated under Awards Pop-up Field Instructions.

4. Click the envelope button to display the Specification Of Mailing Address
pop-up (Figure 2:10 ). 
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5. Complete the fields as indicated under Specification Of Mailing Address Pop-up Field
Instructions.

Figure 2:10. Specification Of Mailing Address pop-up

6. After completing the fields, click [Close] to exit.

Entering Foreign Language Bonus Data

The Awards pop-up (Figure 2:9) is used to enter cash awards and time off awards. For
processing information, see Awards.

Entering Remarks Data

The Remarks window (Figure 2:11) is used to enter and display remarks codes for personnel
actions. All remarks codes are listed in TMGT Table 052, Remarks Codes.

After you save and release an action at the Personnel Action window (Figure 2:2),
the [Remark] button is activated.

• If the action has a mandatory remark that needs more data to complete the remark
description (fill-in text), the message Document Successfully Saved (W=wait for
remark) is displayed and the status code changes from R to W.

• If the action has an optional remark that needs to be added, the status code remains R.

To enter remarks data:

1. At the Personnel Action window (Figure 2:2) menu bar, click [Remark]. The Remarks
window (Figure 2:11) is displayed.
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Figure 2:11. Remarks window

2. Complete the fields as indicated under Remarks Window Field Instructions.
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PART 3.

ROLLBACK APPLIED
DOCUMENTS AND
CORRECTING HISTORY DATA

This section presents the following topics:

Rollback Personnel Actions

Correcting History Data

Creating A History Correction Update Package
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Rollback Personnel Actions

This section presents the following topics:

About Rollback Actions

Rollback Action Types

Processing Rollback Documents

About Rollback Actions

A rollback can be initiated by the user (user-generated rollback), or by the system
(system-generated rollback) for actions that applied during the current processing pay period.

A user may rollback actions if the employee’s salary for that pay period has not been
computed by PAYE. If the employee has been paid the rollback feature is unavailable

A system-generated rollback occurs automatically when a personnel action has already
applied to the employee’s database and another personnel action with an earlier effective
date(s) is processed in a later PINE pass during the same processing pay period and prior to
the processing of PAYE. As a result, all personnel and payroll actions applied to the
employee’s database during that pay period are rolled off the database and placed in EPIC or
EPIC History Correction as new documents with the Status Code of (H) hold or (R) release.

Rollback Action Types

This section describes the three action types that are used to rollback documents. These
action types must be performed before PAYE has run (first Thursday and Friday, or Saturday
after the end of the processing pay period).

Rollback Database − Hold Documents

The primary purpose of this action type is to retrieve personnel data that has applied to
the employee’s database record during the current processing pay period. This
eliminates the need to process a cancellation or correction of a personnel action. The
timing of a rollback is very important. A personnel action can only be rolled back
during the same pay period it is processed and applied to the Payroll/Personnel
database. After PAYE is processed, a correction or cancellation to a personnel action
must be processed in the following pay period.

When a personnel action is rolled back, payroll and personnel actions processed and
applied to the employee’s database during the current processing pay period are rolled
back and placed on the EPIC Navigation window (Figure 1:4). A rollback of a
personnel action will result in the rollback of the payroll documents that applied after
the personnel action. The exception is the Master File Change document when it
applies the same pay period as the personnel action.
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A rollback for an award will remove the personnel action from the database, but not
the award payment that has processed through ADJP. A written request submitted
through DOTSE is required to delete the award payment from ADJP.

If the personnel action and all payroll documents must be reprocessed after the
rollback occurs, the status code on each document to be reprocessed must be changed
to R. These documents are identified on the EPIC Navigation window (Figure 1:4) or,
in the case of a History package, History Correction List window (Figure 3:5). If the
action must be deleted, the status codes on each document must be changed to 4.

Note: The rolled back document(s) remains on the applicable EPIC Navigation
window (Figure 1:4) until action is taken by the user. Therefore, FESI users must
delete the action if they plan to resend the actions via FESI.

Rollback Database − Release Documents

Used to roll off a personnel action that applied to the database in the current processing
pay period and to process another action with an earlier effective date in the same pay
period and the same pass of PINE.

Processing Rollback Documents

To search for a personnel action to perform a rollback option:

1. At the EPIC Navigation window (Figure 1:4), select Edit > Rollback Personnel Action.
The Rollback Search pop-up (Figure 3:1) appears.

Figure 3:1. Rollback Search pop-up

2. Complete the fields as indicated under Rollback Search Pop-up.

3. Click [OK]. The Rollback Personnel Action window (Figure 3:2) is displayed with a
list of all personnel actions for the SSN entered on the Rollback Search
pop-up (Figure 3:1) that were applied in the current processing pay period (including
documents released to the future file).
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Figure 3:2. Rollback Personnel Action window

Note: When using the rollback option from the History Correction Navigation
window (Figure 3:3), the complete package is rolled back.

4. Highlight the action to be retrieved. Choose the rollback action to be taken on the
document/package.

Hold. Rollback from the database and hold in EPIC until positive action is taken.

Release. Release from the database to EPIC.

5. The message Rollback Successful is displayed. Click [OK].

6. The document/package is then brought back to the EPIC Navigation
window (Figure 1:4).

7. Select and double-click the action to begin the editing process.

Note: Each document must be saved after the document is reviewed and the status code
is changed. The message Document Successfully Saved is displayed.
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Correcting History Data

This section presents the following topics:

About Correcting History Data

Employment With Different Agencies Within A Department

Employment With Different Departments

Retroactive Adjustments For 25 Pay Periods Or Less

Retroactive Adjustments Exceeding 25 Pay Periods

Exception Actions

Grade Retention

History Records That Are Not On The History Database

Cancellation Actions

Correction Actions

About Correcting History Data

The History Correction Update Processing System (History) is designed for correcting
personnel history data. History allows the correction and cancellation of personnel actions
which exist in the employee’s personnel history database. It also allows for the entry of late,
newly required, and replacement personnel actions in the employee’s personnel history
database. History actions are processed as a package. If one action in the History package is
suspended, all other actions in the History package will also be suspended until the erroneous
action is corrected.

Employment With Different Agencies Within A Department

The current agency has read access to all history data on the personnel history database for
their employees. The history data includes history for all previous employment (within a
department) with organizations serviced by NFC. The current agency is responsible for
assuring all corrections, cancellations, or any other type of modification to the employee’s
history record are processed.

Note: If an action must be added for the previous agency, the previous agency must process a
History package. The pay period after that package applies, the current agency enters
correction actions in EPIC, as necessary, based on the added action.

Employment With Different Departments

The Payroll/Personnel System uses four databases (5,6,7, 8) to process transactions for the
different departments serviced by NFC. Based on the user’s security access, the system
defaults to the appropriate department database.
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If an employee was previously employed by another department (serviced by NFC), and a
change to the previous department’s history record is required, cancellations for the current
department should be processed using the history correction process. Changes to the previous
department’s history must be processed through EPIC after the database is restored to the
previous department or processed manually. For more information on manual processing, see
Title I, Chapter 11, Nonautomated Processing.

Retroactive Adjustments For 25 Pay Periods Or Less

The system automatically adjusts an employee’s pay record for retroactive actions that are
effective within the last 25 pay periods. If a correction or cancellation action is processed that
affects the employee’s salary data, retirement coverage, cost of living allowance, post
differential, or quarters deductions rate, etc., the system will automatically disburse or collect
(in accordance with the Debt Collection Act), as appropriate. The system retroactively adjusts
an employee’s pay record, recomputes payments, collects and/or bills for overpayments, and
compensates for underpayments. The system uses the accounting data from the T&A.

Note: An SPPS request may be required for certain adjustments (e.g., back pay with interest,
Thrift Savings Plan Adjustments, back pay for service prior to migrating to NFC, etc.). See
Title I, Chapter 11, Nonautomated Processing, for more information. Also, an SPPS request
must be processed for adjustments to pay for employment with a previous agency regardless
of the adjustment period. The system will not automatically recompute these adjustments.

Retroactive Adjustments Exceeding 25 Pay Periods

If the adjustment period exceeds 25 pay periods, whether the employee was underpaid or
overpaid by the current or previous agency, each agency involved must enter or submit an
SPPS for processing. All parties involved should be in agreement with the changes made to
history.

Exception Actions

The following actions are not included in the History package and will not display on the
History Correction List window (Figure 3:5) unless corrected or canceled. Use IRIS to do the
necessary research if one of these actions needs to be corrected or canceled.
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NOAC Description

730−732 Detail

815 Recruitment Bonus

816 Relocation Bonus

825 Separation Incentive

840

841

Individual Cash Award

Group Cash Award

842 Individual Suggestion/Invention Award

843 Group Suggestion/Invention Award

844

845

Foreign Language Award

Travel Savings Incentive Award

846

847

Individual Time Off Award

Group Time Off Award

878 SES Rank Award

879 SES Performance Award

889 PRMS Performance Award

922−924 Detail

970 Foreign Language Bonus

982 Recruitment Allowance (USDA Only)

983 Retention Allowance (USDA Only)

Grade Retention

Employees in grade retention could possibly be downgraded a second time during the initial
two-year grade retention period due to downsizing, etc. If a subsequent downgrade is
processed in a History package, the employee is entitled to a new period of grade retention.
The Salary Data pop-up (Figure 2:8) is used to enter the information for the subsequent
change in grade.

History Records That Are Not On The History Database

If the document to be corrected is older than 10 years, process all changes prior to 10 years
manually. If the field(s) to be corrected impacts subsequent documents, process a correction
to the first impacted document, then follow OPM’s instructions on processing corrections that
affect Central Personnel Data Files (CPDF) files.
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Cancellation Actions

A cancellation action is an official action that rescinds an earlier action that was improper, or
was proper and contained references to an improper action or contained inappropriate or
erroneous remarks that should not have been recorded.

This section provides information relative to processing corrections and cancellations of
historical personnel actions which exist in the personnel history database. History correction
allows entry of late, newly required, and replacement personnel actions. Completion
instructions for each personnel data element are provided in Part 5, Field Instructions For
EPIC Windows.

Cancellation of personnel actions in the personnel history database are entered via the Create
New Package pop-up (Figure 3:4).

Reminder: When canceling an action, consider the status of the position. The permanent
position of the employee must be established in PMSO. For example, if a cancellation to a
separation is processed for an employee whose job was abolished, the position must be
re-established in PMSO.

For more information on cancellation actions, see:

Canceling Accession Actions

Canceling A Cash Award

Canceling A Time Off Award

Canceling A Separation Action

Canceling Accession Actions

There are three basic scenarios which require the cancellation of an accession action:

• The cancellation of an unpaid accession for reasons such as the employee not reporting
for duty;

• The cancellation of a current appointment (paid accession) in connection with a
correction to a previous appointment within the same executive department or
independent agency;, or

• The cancellation of a current appointment (paid accession) to your executive
Department or independent agency in connection with a correction to a previous
appointment with another executive Department or independent agency.

Note: Do not cancel accession actions for the purpose of correcting their NOA’s and/or
authority codes. For instructions on correcting NOAC’s and/or authority codes for accession
actions, see Correcting An Effective Date Or Authority Code or Correcting A Nature Of
Action (NOA).

Canceling An Unpaid Accession

If the agency has processed an accession for an employee, the employee has never
reported for duty, and processing has been completed for the pay period in which the
accession was processed, the accession action should be cancelled.
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Make the Starting Action an official cancellation of the accession action. If the History
Package contains any replacement actions, such as a subsequent 894 action, convert
that 004 action to an official cancellation (001) action.

To allow the employee’s database master to pass to history, use the Master File Change
Document to set the SEPARATION-FINAL-T&A-RECEIVED flag.

Cancelling A Current Appointment Back To A Previous One With The Same
Department Or Independent Agency

There will be times when an Agency must correct or cancel actions processed while an
employee was serving on a previous appointment within their executive department or
independent agency.

When choosing the Starting Action, an action which falls prior to the separation under
the previous appointment, History will generate (004) actions for the intervening
separation and accession actions. If on the basis of the correction, these actions are no
longer valid, the unofficial replacement (004) actions must be converted to official
cancellation actions.

Note: If the package is in suspense, because of an error in the system the 007
cancellation action(s) will appear on the Suspense Report and the History Correction
List window (Figure 3:5).

If the Starting Action is a cancellation of the separation from the previous
appointment, History will generate an unofficial cancellation (007) action for the
subsequent accession action. The unofficial (004) replacement of the subsequent
accession action must be converted to an official cancellation.

Cancelling A Current Appointment Back To A Previous One With Another
Executive Department Or Independent Agency

A History package cannot be established when the Starting Action would be one where
the employee belonged to another executive Department or independent agency. The
processing of such a case requires the establishment of two separate History packages.

The current employing office must establish a package with a cancellation of the
current appointment action as the Starting Action. All unofficial replacement (004)
actions must be converted to official cancellation actions. This will effectively delete
all PERHIS records for the current executive Department or independent agency at the
end of the processing pay period in which the package applies to the database.

The following pay period, History will allow the employing office in the former
executive Department or independent agency to establish a History package to correct
history for the period the employee belonged to that executive Department or
independent agency. Once this History package has applied to the database, the current
employing office can immediately process the new appointment and all subsequent
actions. They are to be processed as brand new actions.

Canceling A Cash Award

To process a cancellation of a cash award in History, enter the cancellation at the History
Create New Package pop-up (Figure 3:4). Once the package is regenerated, the cash award
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action is the only action that is displayed on the History Correction List window (Figure 3:5).
An SPPS request must also be processed to collect the amount of the award and reverse the
tax withholdings.

Canceling A Time Off Award

If a time off award was processed and the time off hours were not used and the agency wishes
to rescind the actions, process a cancellation action (NOAC 001/872) in History to cancel the
time off award. Enter zeros in the Basic Pay and Verify Basic Pay fields.

If a time off award was processed and time off hours were used, and the agency wishes to
rescind the action:

• Submit corrected T&A’s charging the used award hours to a paid leave category.

• Process a cancellation action to cancel the time off award and enter zeros in the Basic
Pay and Verify Basic Pay fields.

Canceling A Separation Action

Canceling a separation action in History does not require reprocessing payroll documents that
were in affect at the time of separation; the system automatically restores this data if the
employee’s information displays in the IRIS Current Data program (IR100 series). However,
circumstances may require personnel Offices to process the appropriate benefit documents to
assure the employee is properly enrolled.

If the employee’s information displays in the IRIS history program (IR500 series) only,
process the cancellation and reprocess all applicable payroll documents. Follow your agency
instructions for compensation as a result of the cancellation.

Note: Adding a retroactive separation action in a History package may require canceling all
subsequent actions in the History package.

Correction Actions

A correction action is an official action that changes information shown on an earlier action
which was in error, or adds information that was omitted from an earlier action.

To process a correction action in History, select the action to be corrected from the History
Correction List window (Figure 3:5). If more than one correction action is needed, select the
earliest action from the History Correction List window (Figure 3:5) then correct the other
subsequent action(s) in the History package.

For more information on Correction Actions, see:

Correcting A Cash Award

Correcting A Time Off Award

Correcting A Nature Of Action (NOA)

Correcting An Effective Date, Or Authority Code

Correcting An Unofficial (Updating) Action
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Correcting A Cash Award

To process a correction to a cash award in History, enter the correction at the History
Correction List window (Figure 3:5). The effective date and the authority are the only
elements that may be corrected. The cash award action is the only action that displays on the
History Correction List window (Figure 3:5).

Prepare an SPPS request for any cash award adjustment.

Correcting A Time Off Award

If a time off award was processed with an incorrect number of hours, process a correction to
the time off award. Enter the correct number of hours in the Base Salary and Verify Salary
fields.

If the hours reported were less than the number granted, enter the correct number of hours on
the correction action. A corrected T&A is not required if the hours used did not exceed the
amount granted or no hours were used.

If the hours reported were more than the number granted and the hours used exceeded the
amount granted:

• Process a correction to the time off award (NOAC 002/872).

• Process a corrected T&A.

• Change the erroneous hours charged to TC 66, prefix 61, to the appropriate leave on
the T&A.

Correcting A Nature Of Action (NOA)

To correct an NOA for separations and accessions only.

• Choose the action with the incorrect data.

• Make a selection from the History drop down menu.

• Choose the NOA from the list of Personnel Actions.

• Click [OK].

• The message Document Changed 2nd Nation of Action is displayed.

Note: If you need to correct the NOAC that is neither an accession or separation, you must
officially cancel the action and reprocess it.

Correcting An Effective Date Or Authority Code

To correct an effective date or Authority Code:

• Choose the action with the incorrect data.

• When the action is displayed, enter the correct data.

If the effective date is being changed to a later date and affects pay-related data, do not
process a 002 correction. Instead, process a cancellation, then process the action with the
correct effective date. For information on processing cancellation actions, see Cancellation
Actions.
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An adjustment may be required if the effective date is being changed to an earlier date and
pay is affected. The system will adjust if with the automatic adjustment timeframe, otherwise,
submit an SPPS request.

Correcting A Social Security Number And Employee Name

An employee’s ssn and name are corrected by entering corrections to the last non-exception
action.

To correct an ssn and employee name:

• On the Miscellaneous pop-up, type the correct ssn in the Correct SSN field.

• If the employee name is being corrected, select the Name Correction box. A check
mark will appear in this box if selected.

The employee’s name or ssn will be automatically changed in historical, as well as, current

records.

Correcting An Unofficial (Updating) Action

The non-CPDF elements processed as unofficial/updating actions are not reported to OPM,
nor are they included in History. Process another unofficial action through EPIC to change
these fields.
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Creating A History Correction Package

This section presents the following topics:

About The History Package

History Starting Action

Selecting “Insert” Action As A Starting Action

Changing/Deleting A History Package

About The History Package

When a History package is established, History adds the starting action and all subsequent
personnel actions in the EPIC database. All these personnel actions, along with any others
you might choose to add, make up the History package. Personnel actions generated by
History and new actions inserted into History go into the EPIC database. Once a History
package has been generated, the current servicing POI can alter information on any personnel
action within the History package.

History Starting Actions

The History Correction Navigation window (Figure 3:3) is the first entry window in the
History process and is used to establish a History package. The starting action is the
personnel action to be corrected, cancelled, or added to the employee’s history record.
History adds your starting action along with applicable cancellation and replacement
action(s) for all subsequent personnel actions to the EPIC database.

For more information on History Starting Actions, see Selecting The Starting Action.

Selecting The Starting Action

The starting action feature allows you to select from the history database the action to begin
the correction/cancellation process. If more than one action needs to be corrected or canceled,
select the action with the earliest effective date from the History Correction List
window (Figure 3:5) or, if adding more than one action, add the action(s) at the Create New
Package pop-up (Figure 3:4).

Note: If the starting action is a correction action or a cancellation of an exception action, it
cannot be earlier than the oldest history action or later than the most recent history action.

Reminder: The date on a starting action may be changed provided the sequence of the
document does not change, i.e., you can change the date higher or lower as long as the
starting action remains in sequence. If the change in effective date will result in a sequence
change, then the starting action must be dated prior to the action you are changing.

The Create New Package pop-up (Figure 3:4) is used to indicate the earliest personnel action
to be affected by the History Correction process. The starting action option selected is the
starting action to be inserted (new action), corrected (existing action), or canceled (removed
from history database).
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To select a starting action

1. At the EPIC Navigation window (Figure 1:4), select Go To > History Correction
Navigation. The History Correction Navigation window (Figure 3:3) is displayed.

Figure 3:3. History Correction Navigation window

2. From the History Navigation window (Figure 3:3), select Edit > Create New Package.
The Create New Package pop-up (Figure 3:4) appears.

Figure 3:4. Create New Package pop-up

3. Complete the fields according to the instructions under Create New Package Pop-up
Field Instructions.

Reminder: Choose Correct on the Create New Package pop-up (Figure 3:4).
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4. Click [OK]. The History Correction List window (Figure 3:5) is displayed with a list of
all personnel actions that have applied to the personnel history database (IR525).

Figure 3:5. History Correction List window

5. Select and double-click the applicable action to start the History package.

6. The message, History Package Successfully Generated, is displayed.

7. Click [OK]. The History Correction List window (Figure 3:5) is refreshed to remove all
actions prior to the starting action. The starting action and all subsequent personnel
actions remain in the package.

8. Select and double-click the action to begin editing the personnel action to be corrected.

9. After the personnel action to be corrected is completed, change the status code from
(I)incomplete to (R)elapse. Review each of the remaining documents in the package.
At a minimum, the status code on each must be changed to (R)elapse. For NOAC 001
and 002 documents, the Print SF-50b field must be completed.

Reminder: Each document must be saved after the document is reviewed and the status
code is changed. The message Document Successfully Saved is displayed.

10. The History Correction List window (Figure 3:5) is refreshed to indicate that the
package is ready to be released to EPIC.

11. Select Edit > Release Package for Processing

12. The message History Package Successfully Released is displayed.

Note: The package status is changed from Incomplete to Released.
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Selecting “Insert” As A Starting Action

When a retroactive, replacement, or newly required action is entered in History, all
subsequently processed actions (except for “exception” actions and unofficial actions) are
displayed on the History Correction List window (Figure 3:5) in descending order by
effective date. The inserted action and all subsequent actions must be reviewed and updated
from the History Correction List window (Figure 3:5).

Reminder: Process an SPPS request if an adjustment is required and the adjustment period
exceeds 25 pay periods.

Note: Do not add an action to History for a previous agency. See Special Processing for
more information.

Note: An 006 Update action can be processed through EPIC and not History. If an 006 action
is added to History, the message, Cannot Insert Unofficial Action To History Package, is
displayed.

To insert a starting action:

1. At the EPIC Navigation window (Figure 1:4), select Go To> History Correction
Navigation. The History Correction Navigation window (Figure 3:3) is displayed.

2. From the History Navigation window (Figure 3:3), select Edit > Create New Package.
The Create New Package pop-up (Figure 3:4) appears.

3. Complete the fields according to the instructions under Create New Package Pop-up
Field Instructions.

4. Choose Insert on the Create New Package pop-up (Figure 3:4).

5. Click [OK]. The Insert New Action pop-up (Figure 3:6) appears.

Figure 3:6. Insert New Action pop-up
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6. Complete the fields according to the instructions under Insert New Action Pop-up
Field Instructions.

Reminder: If the effective date of the retroactive, replacement, or newly required
action is equal to an action already in the personnel history database, and the new
action needs to apply before the action in the personnel history database, the
authentication date on the inserted starting action must be earlier than the
authentication date on the action in personnel history.

7. Select and double-click the action to begin editing the inserted personnel action.

8. The History Correction List window (Figure 3:5) displays the inserted action and all
subsequent actions.

9. After the inserted personnel action is completed, change the status code from
(I)incomplete to (R)elapse. Review each of the remaining documents in the package.
At a minimum, the status code on each document must be changed to (R)elapse. For
NOAC 001 and 002 documents, the Print SF-50b field must be completed.

Reminder: Each document must be saved after the document is reviewed and the status
code is changed. The message Document Successfully Saved is displayed.

10. The History Correction List window (Figure 3:5) is refreshed to indicate that the
package is ready to be released.

11. Select Edit > Release Package for Processing

12. The message History Package Successfully Released is displayed. The package status
is changed from Incomplete to Released.

To cancel a starting action:

1. At the EPIC Navigation window (Figure 1:4), select Go To > History Correction
Navigation. The History Correction Navigation window (Figure 3:3) is displayed.

2. From the History Navigation window (Figure 3:3), select Edit > Create New Package.
The Create New Package pop-up (Figure 3:4) appears.

3. Complete the fields according to the instructions under Create New Package Pop-up
Field Instructions.

Reminder: Choose [Cancel] on the Create New Package pop-up (Figure 3:4).

4. Click [OK]. The History Correction List window (Figure 3:5) is displayed with a list of
all personnel actions that have applied to the personnel history database.

5. Highlight and double-click the applicable action to start the History package.

6. The message History Package Successfully Generated is displayed.

7. Click [OK]. The History Correction List window (Figure 3:5) displays all actions prior
to the canceled action.

Note: An SPPS request may be required for certain adjustments (e.g., back pay with
interest, Thrift Savings Plan Adjustments, etc.). Also, an SPPS request must be
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processed for adjustments to pay for employment with a previous agency regardless of
the adjustment period. The system will not automatically recompute these adjustments.

8. Change the status code from (I)incomplete to (R)elapse. Review each of the remaining
documents in the package. At a minimum, the status code on each document must be
changed to (R)elapse. For NOAC 001 and 002 documents, the Print SF-50b field must
be completed.

Reminder: Each document must be saved after the document is reviewed and the status
code is changed. The message Document Successfully Saved is displayed.

9. The History Correction List window (Figure 3:5) is refreshed to indicate that the
package is ready to be released.

10. Select Edit > Release Package for Processing.

11. The message History Package Successfully Released is displayed. The package status
is changed from Incomplete to Released.

Changing/Deleting A History Package

To edit documents in a package or delete a package that has been released for processing, you
must change the status of the package from Released to Incomplete. If the package is in
suspense, it can be changed during the current processing pay period. If it has applied to the
database during the current processing pay period, it can be changed by using the Rollback
process. For more information on rollback documents, see Processing Rollback Documents.
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Garnishments Document

Federal employees’ salaries and wages are subject to garnishment for bankruptcy, educational
loans, tax levies, commercial garnishments and/or other debts. This type of garnishment occurs
when a governmental agency is directed, through legal process, to make a payment from monies
otherwise payable to an employee, to another party to satisfy the employee’s legal obligation.

NFC is authorized to collect commercial garnishments from employee(s) who are indebted to
commercial organizations and are having his/her wages garnished. Public Law 130−94 allows
NFC to collect these funds. The agency must first have the garnishment orders reviewed by
the legal department (or other authorizing office) in order to ensure that the orders conform to
current regulations. Commercial garnishment alimony data is displayed in IRIS Program
IR114, Receipt Accounts.

After the review is completed, the agency sends the employee a letter of notification with the
garnishment order attached. The letter must be mailed within 15 days after the order is
received. The letter must contain:

• the total amount owed

• the pay period in which the garnishment will begin

• the amount to be garnished each pay period

Note: The pay period that the garnishment is set to begin is the pay period designated by the
agency provided that the order is received at NFC one week prior to the end of the effective
pay period. Garnishments received after that date will be processed the following pay period.

Commercial garnishments may be no more than 25 percent of the employee’s total disposable
earnings for any pay period, unless it is for a state or local tax levy. There is no limit on these
garnishment orders. If the employee is also being garnished for child care and/or alimony
payments, the total disposable earnings are calculated prior to the child care and/or alimony
garnishment. If a garnishment for child care and/or alimony is equal to or greater than 25
percent of the employee’s total disposable earnings, no commercial garnishment is deducted.
The garnishment order is returned to the agency if this occurs.

In case of multiple commercial garnishments, if the first received commercial garnishment
received is 25 percent or greater of the employee’s total disposable income, only that
commercial garnishment is processed until that debt is paid. The second-received commercial
garnishment is returned to the agency. After the first received commercial garnishment is
paid, the second commercial garnishment can be processed. Personnel offices are responsible
for monitoring the balance of the garnishment in IRIS Program IR114, Receipt Accounts.

If the first received commercial garnishment is less than 25 percent of the employee’s total
disposable earnings, the first-received commercial garnishment should be recovered in one
pay period. The second-received commercial garnishment begins the same pay period (not to
exceed 25 percent less the first commercial garnishment).

If an overpayment is made to a third party, NFC cannot refund the overpayment to the
indebted employee. The employee must collect these funds directly from the third party.
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Steps for processing a commercial garnishment:

1. At the EPIC Navigation window (Figure 1:4) select, Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Deductions Due To Indebtedness.

3. At the menu bar select, Edit > Add New Document. The Deductions Due To
Indebtedness window (Figure 3:7) is displayed.

Figure 3:7. Deductions Due To Indebtedness window

4. Complete the indebtedness fields as indicated under Deductions Due To Indebtedness
Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.
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PART 4.

Payroll Documents

This section presents the following topics:

About Payroll Documents

Entering Payroll Documents

Entering Payroll Documents (A−E)

Entering Payroll Documents (F−O)

Entering Payroll Documents (P−Z)
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About Payroll Documents

This section presents the following topics:

Purpose For Processing Payroll Documents

Order Of Precedence For Payroll Deductions

Processing Tips For Payroll Documents

Payroll Document Transaction Field

Effective Date Of Payroll Documents

Purpose For Processing Payroll Documents

Payroll documents are processed to:

• Withhold mandatory and voluntary deductions such as health and life insurance, child
support and alimony payments, allotments, taxes, etc.

• Disburse payments such as annual leave and compensatory time payments

• Transfer data to the PPS from another payroll system (e.g., leave data transfer)

• Process performance appraisals

• Disburse payments through Direct Deposit/Electronic Funds Transfer (DD/EFT)

• Update the database with payroll-related miscellaneous elements (e.g., restored annual
leave, education and professional certification, etc.)

If an employee separates from one department to another department within the PPS, the
payroll documents in affect at separation must be reentered by the gaining department when
the accession action is entered.

Order Of Precedence For Payroll Deductions

The law mandates the order in which deductions are to be made from gross salary. The table
below lists the order in which voluntary and mandatory deductions are made in the PPS. If a
mandatory deduction on the list precedes another mandatory deduction, and the salary is not
sufficient to cover both/all mandatory deductions, the deduction(s) with the highest hierarchy
will take precedence.
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Order Of Precedence For Payroll Deductions

1. Uniform Service COLA
2. Retirement (Deferred)
3. Retirement (Non-deferred)
4. TSP (Deferred)
5. TSP (Non-deferred)
6. Health Benefits Deductions (Deferred)
7. Health Benefits Deductions

(Deferred−Receipt Account)
8. Long Term Disability (FDIC Only)
9. Social Security

10. Medicare
11. Federal Income Tax
12. Health Benefits Deductions

(Non-deferred)
13. Flexfund
14. FEGLI (excluding optional) /Non-Federal

Life Insurance
15. State/Panama Income Tax Federal

Income Tax
16. City Tax
17. City Tax (Extra)
18. Federal Income Tax (Extra)
19. State/Panama Income Tax (Extra)
20. Receipt Account (adjustments)
21. County Tax (Extra)County Tax
22. Travel Advances
23. Travel (Separated Employees)
24. Bankruptcy (Established Indebtedness)

25. Receipt Account Deductions
(Adjustments)

26. Meals
27. Quarters
28. Commissary
29. Imprest Fund
30. Occupational Privilege Tax
31. Other Deductions (Salary Overpayments

and Salary Offset)
32. Garnishment for Alimony and Child

Support Court Cost Amount
33. Garnishment for Alimony and Child

Support Deduction Amount
34. Garnishment for Alimony and Child

Support Arrears Deduction Amount
35. Garnishment for Commercial Debt
36. Optional Life Insurance Premium (1)
37. Optional Life Insurance Premium (2)
38. Optional Life Insurance Premium (3)
39. Membership Dues (Including Parking

Fees)
40. Charitable Contributions
41. Receipt Account (Separated Employees

or Less Than $10)
42. U. S. Savings Bonds
43. Discretionary Allotments
44. Financial Organization Allotments
45. TSP Loan Collections

Processing Tips For Payroll Documents

Because of the integrated PPS, certain payroll documents cannot process without the
interface of a personnel action or other type action (e.g., a final annual leave lump sum
payment cannot process until the separation personnel action is processed). The applicable
action and/or payroll document should be entered in the same pass of PINE to avoid rejection
in the PPS. Processing of payroll documents also generates data on certain output files
produced by NFC.

The following table provides hints for processing certain payroll documents and describes the
end result when a payroll document is processed.
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Payroll Document Affect/Result

Residence Address Voluntary local taxing entity on tax form must agree with residence
address. The Personal Benefits Statement and Earnings and
Leave Statement is mailed to the residence address.

State/local tax Mandatory deductions are based on the duty station of the
position in PMSO; voluntary deductions are based on the
residence. The state, city, or county on the tax form must agree
with duty station in PMSO for mandatory withholding. The
residence state, city, or county on the address form must agree
with the duty station in PMSO for voluntary withholding.

TSP Election Form TSP Eligibility Code on the personnel action identifies whether the
employee is eligible to participate in TSP. The TSP Election
indicates the employee selections.

Health Benefits Registration
Form

FEHB Coverage Code must be coded on personnel action.

Union Dues Bargaining Unit Status Code must be coded in PMSO.

Annual
Leave/Compensatory Time
Final Payments

Separation action must be processed.

Quarters Allowance (per
day)

T&A must be coded to disburse payment.

Uniform Allowance Entry allowed on the T&A or in EPIC but not both.

Separate Maintenance
Allowance

T&A must be coded for per day allowance.

Parking Entry allowed on the T&A or in EPIC but not both.

Severance Pay Remarks Code N22 must be shown on the personnel action for
severance payment disbursement.

Before entering data:

1. Read the information under Introduction (Part 1) to become familiar with using the
operating features and general processing functions in EPIC.

2. Use the EPIC tutorial to learn how to operate and navigate through EPIC using
command buttons, tool buttons, special function keys, etc. These instructions are not
included in this part of the documentation.

3. Consider the impact of processing the payroll document on another payroll document
(e.g., residence change and voluntary taxes); a personnel action (e.g., separation action
and final lump sum payment); or position data (e.g., duty station change and local
taxes).

You may enter the 4-digit year or the 2-digit year in a year field. If the 2-digit year is entered,
the system automatically generates the century.
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Payroll Document Transaction Field

Several payroll documents include a Transaction field. This field identifies the action being
taken relative to the PPS database. In most cases, the transactions are add/new, change, and
delete. For example, Transaction Add applies to a new document being added to the
database; C changes the document on the database; D deletes the document from the
database.

When entering a transaction, consider if the action being taken requires an adjustment. If an
adjustment is required, enter the data in DOTSE. Also review if the action affects the amount
being deducted and/or the balance.

Effective Date Of Payroll Documents

The payroll document includes an effective pay period field. Most payroll documents are
effective on the first day of the pay period entered in the Effective Pay Period field. If a prior
pay period is entered in the Effective Pay Period field, the document is effective in the
current processing pay period. If a future pay period is entered in the Effective Pay Period
field, the document is effective in the pay period of the effective date and is held in the future
file until the processing pay period.

Note: Certain payroll documents include an effective date field (e.g., FEHB, bonds, union
dues). The effective date on the document should be compatible with the effective pay period
in the Effective Pay Period field.

The system does not automatically adjust the employee’s pay record when a late payroll
document is processed. For more information, see New Transfer Enrollment. To collect for
the under-deduction, enter the adjustment data in DOTSE.
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Entering Payroll Documents

This section presents the following topics:

About Entering Payroll Documents

Steps For Entering Payroll Documents

About Entering Payroll Documents

Payroll documents are entered to establish and update payroll data in the database. These
documents are required to make disbursements or collections as well as provide other
pertinent information pertaining to the employee’s record.

Certain payroll documents are grouped according to a category (e.g., Federal and non-Federal
Benefits, Leave Payment, Performance Appraisal, Taxes, etc.). Other payroll documents are
grouped according to the action taken (e.g., savings bond new allotment, change in
inscription, etc.; union dues, new authorization, dues change between locals, etc.).

EPIC payroll document design facilitates multiple processes for a specific type of document
using a single window. For example, the union dues window is used to enter a new
authorization, a change between locals, a revocation, a cancellation, and a mass change.
Those fields that are not applicable to the transaction appear in grey and are not accessible.
The entry instructions for these types of documents include all fields in the window and
indicate the type of transaction that they may apply to.

EPIC lists the various payroll documents alphabetically on the EPIC Navigation
window (Figure 4:1). Certain payroll documents are grouped by category or action.

Figure 4:1. EPIC Navigation (payroll document menu)
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Note: The following documents are for NFC use only and will be documented in the internal
procedure:

• Deductions Due To Indebtedness

• TSP Collections

• Cancellation Of Employee Organizational Dues

• TSP loan allotment for Federal employees

Each payroll document window includes key fields that are common to all payroll
documents. Entry instructions and specifications for the key fields are not repeated for each
document. see Payroll Document Key Data Field Instructions.

For information and instructions on a specific payroll document, see:

Entering Payroll Documents (A−E)

Entering Payroll Documents (F−O)

Entering Payroll Documents (P−Z)

Steps For Entering Payroll Documents

To enter any payroll document:

1. At the EPIC Navigation window (Figure 4:1 ), select Payroll Document at the New
Document menu. An alphabetic list appears.

2. Select the document to be entered then select at the menu bar, Edit > Add New
Document. The applicable payroll document window is displayed.

3. At the payroll document window, complete the key fields as indicated under Payroll
Document Key Data Field Instructions.

4. After completing the key data fields, complete the remaining fields according to the
instructions for the specific document. For field instructions on specific documents, see
Field Instructions For Payroll Documents.
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Entering Payroll Documents (A−E)

This section presents the following topics:

Address Document

Allotment Documents

Allotment:: Discretionary

Allotment:: Financial

Allotment:: TSP Loan

Allowance Document

Charitable Contribution Document

Child Care Or Alimony Deduction Document

Deductions Due To Indebtedness Document

Education/Certification Document

Address Document

The Address document is used to add and update residence and check mailing addresses.
(Other address information may be specified on certain other payroll documents.) For entry
steps, guidelines, and field instructions, see:

About The Residence Address

About The Check Mailing Address Other Than Bank

Entry Guidelines For Address Documents

Steps For Entering Address Documents

Reminder: Following the entry guidelines helps prevent database errors during PINE
processing. Following the field instructions helps prevent front-end errors in EPIC.

About The Residence Address

This address is used for mailing the W−2, the personal benefits statement, and the earnings
and leave statement. It is also used for voluntary state or local tax processing in conjunction
with the applicable form. The city, county, or state code on the Employee Address
window (Figure 4:2) must agree with the city, county, or state code for the taxing entity on
the tax document to successfully process the voluntary tax withholding. An employee address
is required for all accessions.

About The Check Mailing Address Other Than Bank

All salary payments including annual leave lump sum, compensatory time, etc., are sent to
the salary address in the database. The check mailing address is used for employees who are
authorized by their agency to receive paper checks through the mail in lieu of DD/EFT. See
Net Pay Document for DD/EFT transmissions.
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A Government check must be cashed within 12 months after the date of issuance, or it will be
canceled. Effective January 2, 1999, the Department of the Treasury discontinued issuing
paper checks (excluding approved waivers); all Federal payments are disbursed electronically
in accordance with the Debt Collection Improvement Act of 1996. To initiate electronic funds
transfer (DD/EFT payments) through a financial organization, process a Direct Deposit
Sign-Up Form.

When the employee contacts the personnel office about nonreceipt of payment, a replacement
payment can be issued. For recertification procedures, see Title I, Chapter 18, DOTSE.

Warning: A salary payment address must be established in the database; otherwise, the
employee will not be paid.

Entry Guidelines For Address Documents

Following are guidelines for successfully processing address data.

Condition Action

If an address change is entered in the same
pay period as a personnel action to change the
employee’s SSN, name, or agency code

Enter the personnel action first.

To change from a paper check to DD/EFT Process a net pay allotment. It is not necessary
to process an address change with blanks in
the check mailing address fields.

To change any data previously processed Enter another Address document, as
applicable. This is particularly important if the
employee separates and changes addresses.
A change might be required for a final salary
payment or severance payments to prevent
delivery to an erroneous address.

Caution: If a check mailing address is entered inadvertently for an employee receiving DD/EFT
disbursements, the check mailing address entry overrides the DD/EFT disbursement. Hence, the
employee would receive a paper check in lieu of direct deposit to a financial organization.

Steps For Entering Address Documents

To enter an Address document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetic list appears.

2. Select Address.

3. At the menu bar select, Edit > Add New Document].The Employee Address
window (Figure 4:2) is displayed.
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Figure 4:2. Employee Address window

4. Complete the Employee Address fields as indicated under Employee Address Window
Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

After residence and check mailing address data is processed, it is displayed in IRIS
Program IR124, Address/Check Information. Residence addresses that were processed
in the pay period are listed in CULPRPT Report P0101, Mailing List of Residence
Addresses.

Allotment Documents

Allotments are recurring deductions from employees salaries for voluntary payments to a
financial organization. There are several types of allotments:

• Discretionary Allotment. Recurring deduction authorized by the employee and the
agency for any purpose deemed appropriate. The maximum allowed is 99. For more
information, see Allotment: Discretionary.
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• Financial Allotment. Recurring deduction authorized by the employee for direct
deposit in a checking or savings account. The maximum allowed is 2. For more
information, see Allotment: Financial.

• TSP Loan Allotment. Recurring deduction to repay a TSP loan borrowed from the
employee’s personal TSP account. For more information, see Allotment: TSP Loan.

For more information on allotments, see:

How Allotments Are Disbursed

Merger Or Takeover Of A Financial Organization

How Allotments Are Disbursed

Direct Deposit/Electronic Funds Transfer System transfers payments electronically from the
Department of the Treasury, through the Federal Reserve System, to the payee. Discretionary
allotment payments can be disbursed electronically in accordance with the Debt Collection
Improvement Act of 1996.

Check disbursement is not recommended due to fraud, loss, destruction, etc. For nonreceipt
of a check (or DD/EFT payment), follow the replacement procedures. See Title I, Chapter 8,
SPPS.

Merger Or Takeover Of A Financial Organization

When a merger or takeover of a financial organization occurs, the Department of the Treasury
notifies NFC of the change in the financial organization’s routing number. Treasury also
provides NFC with the account number(s) of those employees payrolled by NFC who have
accounts with the financial organization.

Treasury electronically transmits the changes to NFC on a daily basis. These changes are
edited and processed through PINE and then processed in PEPL to update or modify the
financial organization’s routing number and/or account number in the PPS database for those
employees who are affected by a merger or takeover. 

Note: When a routing number and/or account number is changed, PINE58 is displayed in the
User-ID field on IRIS Program IR126, Last Payroll Action.

If the routing number and/or account number received from the Department of the Treasury
does not agree with the routing number and/or account number currently on the database,
NFC mails Report PINE5801, Notification of Change (NOC) Suspense Report, to the
employee’s personnel office. The personnel office should take action to correct the report or
the database as appropriate.

If the employee elects to change to another financial organization, the employee must submit
a new direct deposit sign-up form.

Allotment: Discretionary

The discretionary allotment is used to enter and update a recurring deduction authorized by
the employee and the agency. The head of the agency may allow discretionary allotments for
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any purpose deemed appropriate. They are commonly used for paying employees’ monthly
bills to a designated payee, either an individual or company. Discretionary allotment data is
displayed in IRIS Program IR112, Discretionary Allotment.

The PPS divides the monthly payment into two deductions. Deductions are withheld twice a
month effective on the first payday of the month. If the allotment is established or changed in
the middle of the month, it will not take affect until the beginning of the following month.
For the months in which there are three pay periods, deductions are not withheld for the third
payday.

The Discretionary Allotment window (Figure 4:3) is used to enter and update residence
addresses and check mailing addresses (other than a bank). For step-by-step entry
instructions, entry guidelines, and field instructions for the Employee Address
window (Figure 4:2), see:

When There Are Insufficient Funds For A Discretionary Allotment

Changing Discretionary Allotments

Canceling Discretionary Allotments

Entry Guidelines For Discretionary Allotments

Steps For Entering Discretionary Allotment Documents

When There Are Insufficient Funds For A Discretionary Allotment

Discretionary allotment payments are made either as a full payment, half of the payment, or
nothing is paid. The order of precedence for paying monthly allotments is the same order in
which they were established.

If an employee is on extended nonpay status, deductions cannot be made. If an employee is in
nonpay status for a partial pay period, half of the monthly payment is deducted, if possible. If
half cannot be deducted, no deduction is made.

Changing Discretionary Allotments

Agency personnel offices should be notified of all changes regarding discretionary
allotments. Verify the correct allotment number before making a change to either the amount
or payee information if the employee has multiple allotments; otherwise, erroneous data
could affect another allotment.

Canceling Discretionary Allotments

Employees may request the cancellation of an allotment. Once an allotment is canceled, the
number can be used again for another allotment. Discretionary allotments are automatically
canceled once an employee separates. The PPS refunds any outstanding balances.

If an employee transfers to another department, all allotments are canceled. If the gaining
department allows for discretionary allotments, the allotment must be entered as a new
allotment.
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If an employee transfers to another agency serviced by NFC within the department, the
discretionary allotment deductions remain in effect. However, if the position is ineligible for
discretionary allotments, the gaining agency must process a cancellation for all discretionary
allotments.

Entry Guidelines For Discretionary Allotments

Following are guidelines for processing discretionary allotments.

• Number the allotments sequentially beginning with number 01, 02, 03 ... up to a
maximum of 99. Before entering an allotment, access IRIS Program IR112 to assure
the allotment is not already in effect.

• The total amount of discretionary allotments may not exceed 70 percent of the
employee’s gross salary. If an allotment exceeds 70 percent of gross salary, it will
reject. If the excess amount is valid, use Status Code L to release the document from
suspense.

Warning: Force releasing the document could result in no salary payment for the pay
period.

• The allotment cannot be processed if the effective pay period is for payments that will
be made on the second or third payday of the month. If the effective pay period is
correct, either delete the document from suspense or use Status Code G to send the
allotment to the future file.

• To cancel a discretionary allotment, complete the applicable fields and select Delete
at the Transaction drop-down menu.

Steps For Entering Discretionary Allotment Documents

To enter a discretionary allotment:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Allotment > Discretionary Allotment.

3. At the menu bar select, Edit > Add New Document. The Discretionary Allotment
window (Figure 4:3) is displayed.
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Figure 4:3. Discretionary Allotment window

4. Complete the Discretionary Allotment fields as indicated under Discretionary

Allotment Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Allotment: Financial

A financial allotment is the deposit into a checking or savings account at a financial
institution, a portion of an employee’s salary, deducted through recurring payroll deductions.
This allotment is deposited through DD/EFT. Financial allotment data is displayed in IRIS
Program IR110, Financial Allotment.

Note: Allotments for bill paying purposes are considered to be discretionary allotments. For
more information, see Allotment: Discretionary.

Report PINE5801, Notification of Change (NOC) Suspense Report lists, DD/EFT account
numbers and routing transit numbers of financial institutions that cannot be updated
automatically in the PPS and may need to be corrected by the agency. This report is mailed to
the agency personnel office.
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For more information, see:

When There Are Insufficient Funds For A Financial Allotment

Changing A Financial Allotment

Canceling A Financial Allotment

Entry Guidelines For Financial Allotments

Steps For Entering Financial Allotment Documents

When There Are Insufficient Funds For A Financial Allotment

The employee’s net pay must be sufficient to cover the amount of the financial allotment(s).
If the net pay due the employee after applying all required payroll deductions is less than the
amount of the allotment authorized, the allotment will automatically be nullified for that
particular pay period. If the employee has two allotments and the net pay is insufficient to
cover the aggregate of both authorizations, both allotments will be automatically nullified for
that pay period.

Changing A Financial Allotment

Changes are processed to:

• Decrease or increase the amount of the allotment

• Change the routing number, account number, and type of account

• Change financial organizations

Warning: If the routing number, account number, and type of account are not entered exactly
as they are in the database and the employee has only one allotment in effect, a second
allotment will be created with the new (incorrect) data. Deductions will be made for the
existing allotment and for the new allotment that was established in error.

Canceling A Financial Allotment

An allotment is canceled when the employee elects to permanently discontinue deductions for
the allotment or to replace the allotment with a new allotment.

Allotments are automatically canceled in cases of separation, retirement, death, or transfer to
another Department; therefore, it is not necessary to enter a financial allotment document.

Entry Guidelines For Financial Allotments

Following are guidelines for processing financial allotments.

• The savings/checking account must be in the name of the employee.

• The allotment must be a fixed, whole dollar amount which will be deducted from the
employee’s salary. No minimum amount is prescribed; however, the whole dollar
amount restriction automatically precludes any allotment for less than $1.00.

• The maximum financial allotments in effect at one time is 16. If the employee has
more than one allotment, each may be directed to a different financial organization. A
separate transaction must be entered for each financial allotment.
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• The allotment amount cannot exceed 70 percent of the biweekly gross salary. If the
excess is allowed, type L in the Status Code field to release the document from
suspense.

• When processing a change, the unchanged data must be exactly as that currently
established in the database.

• To change the financial organization or account number, process a cancellation and a
new allotment. First, process the cancellation of the financial allotment currently
established in the database. Enter zeroes in the Allotment Amount field. The remaining
allotment data must be exactly as that currently established in the database for the
allotment. Verify that the first allotment has been canceled by accessing IRIS
Program IR110 (usually the following day) before entering the new allotment. Process
the new allotment with the changed information.

Steps For Entering Financial Allotment Documents

These steps are also used for net pay documents. For more information about net pay
documents, see Net Pay Document.

To enter a financial allotment (or net pay) document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Allotment > Financial Allotment or Net Pay.

3. At the menu bar select, Edit > Add New Document. The Financial Allotment or Net
Pay window (Figure 4:4 ) is displayed. The fields for both types of documents are the
same, except the Allotment Amount field is not applicable for net pay.

Figure 4:4. Financial Allotment or Net Pay window

4. Complete the Financial Allotment window (Figure 4:4) fields as indicated under
Financial Allotment Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.
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6. Click [Yes] to save the entries and exit the action

OR

Click [No] to exit the window and not save the entries

OR

Click [Cancel] to reopen the window.

Allotment: TSP Loan

TSP loan allotment is the repayment through payroll deductions of a loan made by a TSP
participant against his/her TSP account. Refer to TSP BK04, TSP Loan Program, for
restrictions. These allotments are deposited electronically through DD/EFT. Eligible
employees may elect in-service withdrawals in lieu of a loan allotment. See Title I,
Chapter 11, Nonautomated Processing.

The TSP Loan Allotment window (Figure 4:5) is used to enter the TSP−22, Thrift Savings
Plan Loan Payment Allotment Form, for Federal and non-Federal employees. The TSP
Service Office enters the TSP−22 for Federal employees; agencies enter the TSP−22 for
non-Federal employees. TSP loan allotment data is displayed in IRIS Program IR120, Thrift
Savings Loans.

Loan amounts available are limited to the participant’s contributions to TSP and the earnings
attributable to such contributions.

For more information, see:

Types Of TSP Loans

Processing Tips For TSP Loan Allotment

Steps For Applying For A TSP Loan

Steps For Entering TSP Loan Allotment Documents

Types Of TSP Loans

By law, loan application requests are restricted to the following:

• General Purpose Loan. General purpose loans can be obtained for any purpose. The
repayment period for general purpose loans is from 1 to 4 years. Documentation to
support requests for general purpose loans is not required.

• Residential Loan. Residential loans can be obtained for the purpose of purchasing a
primary residence. The repayment period is from 1 to 15 years. Documentation to
support requests for residential loans is required.

Processing Tips For TSP Loan Allotment

Before a loan is approved, the participant must complete the required documentation to
request the loan.
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Steps For Applying For A TSP Loan

To apply for a loan:

1. The participant completes and submits Form TSP−20, Loan Application, or
TSP−20−H, Hardship Loan Application, to the TSP Service Office.

2. Upon receipt of the loan application, the TSP Service Office sends the participant a
loan package which includes:

• TSP−21, Thrift Savings Plan Loan Agreement/Promissory Note

• TSP−22, Thrift Savings Plan Loan Payment Allotment Form

• TSP−21−R, Residential Loan Documentation Form, for residential loans only. The
participant must provide copies of the purchase contract, settlement sheet, or other
documents to show the cost of the residence.

3. If the terms of the loan are not acceptable by the participant, the loan agreement may
be canceled by checking the appropriate block on the TSP−21 and returning it to the
TSP Service Office within 45 days.

4. If the terms of the loan are acceptable by the participant, the forms should be
completed and returned to the TSP Service Office within 45 days for approval.

5. A check is issued to the participant after the loan is approved, and NFC enters the
TSP−22 in the PPS for Federal employees only; agencies enter the TSP−22 for
non-Federal employees.

6. Once the TSP−22 is processed, it is forwarded to the appropriate personnel office. An
acknowledgement notice is also provided to the TSP Service Office verifying that
Form TSP−22 was processed.

Steps For Entering TSP Loan Allotment Documents

To enter a TSP loan allotment:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Allotment > TSP Loan.

3. At the menu bar select, Edit > Add New Document. The TSP Loan Allotment
window (Figure 4:5 ) is displayed.
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Figure 4:5. TSP Loan Allotment window

4. Complete the TSP Loan Allotment fields as indicated under TSP Loan Allotment
Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Allowance Document

Allowances are payments made to eligible employees in addition to the basic pay. These
allowances are paid in addition to the cost-of-living allowance (COLA) or a post differential
as provided for duty stations in certain nonforeign areas, a foreign post differential in certain
foreign areas, and TDY post differential. COLA and post differential are entered on a
personnel action; TDY is entered using the Multi Element Update option.

The allowances discussed in this section are paid as a one-time lump sum payment or paid
per day or per pay period. Allowance data is displayed in IRIS Program IR109,
Allowances/COLA/Post Differential.

For more information, see:

Types Of Allowances

Entry Guidelines For Allowances

Steps For Entering Allowance Documents
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Types of Allowances

There are several types of allowances. Each allowance is listed alphabetically under the field
Allowance Description and is discussed in detail with its entry guidelines. Certain allowances
are paid by entering the data in EPIC; others are paid by entering the data on the time and
attendance report. For information, see Title I, Chapter 7, Section 1, Time and Attendance
Instructions.

Warning: Duplicate payment could result if the allowance is reported on the T&A and in
EPIC.

Entry Guidelines For Allowances

Following are guidelines for processing allowances.

• The allowance total can only be changed for comparability and education allowances.
When changing or deleting these allowances, ensure the allowance total does not result
in a negative balance.

• If the uniform allowance is to be processed as a lump sum payment, the Allowance
Rate field and the Allowance Total field must be the same amount.

• If more than one allowance is being entered for an employee, complete the fields for
the first allowance then click File > Save then File > New. The window is refreshed for
the next entry. A document must be entered for each type of allowance.

Steps For Entering Allowance Documents

To enter an allowance:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Allowance.

3. At the menu bar select, Edit > Add New Document. The Allowance window (Figure
4:6 ) is displayed.
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Figure 4:6. Allowance window

4. Complete the Allowances window (Figure 4:6) fields as indicated under Allowance

Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Charitable Contribution Document

A charitable contribution is the authorization by an employee to withhold, through payroll
deductions, contributions for the CFC. Form CFC−804, Combined Federal Campaign, is
completed by the employee to authorize the deductions. Charitable contributions are
displayed in IRIS Program IR111, Charitable Contribution.

For more information, see:

About Charitable Contributions

Entry Guidelines For Charitable Contributions

Steps For Entering Charitable Contribution Documents
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About Charitable Contributions

Any employee whose duty station is located within an approved CFC area, and whose net pay
is sufficient to cover the allotment, may authorize payroll deductions for charitable
contributions. Employees may choose to have CFC contributions submitted to two different
campaign areas. Included are employees whose appointments are limited to 1 year or less,
provided an appropriate official of the employing agency determines the employee will
continue employment for a period sufficient to justify the allotment. The allotment will be an
equal amount deducted each pay period (minimum $1.00). The allotment will be for a term of
1 year beginning with the first pay period which begins in January and ending with the last
pay period that begins in December.

No deductions are made for any pay period in which the employee’s net pay is insufficient to
cover the deduction amount. When an employee has insufficient coverage of an allotment,
the agency may establish a standard order in which the deduction is made, or they may
request the employee to designate the order in which deductions are made. No adjustments
are made in subsequent pay periods to make up for deductions not made to cover the
authorized amount.

All CFC contributions are automatically discontinued only upon expiration of the 1-year
withholding period, in the event of death or retirement, or upon separation from Federal
service.

Entry Guidelines For Charitable Contributions

Following are guidelines for processing charitable contribution data.

• Since most of the CFC documents are processed for Pay Period 1, enter the CFC data
as soon as possible. It is not necessary to hold CFC cards with future effective dates;
these can be entered at anytime after receipt of the CFC card from the employee
(especially during the Combined Federal Campaign Drive).

• Do not enter one-time cash contributions in EPIC; send the contribution directly to the
designated charity or federated group.

• An employee may discontinue an allotment at any time by submitting a signed letter or
memorandum to the personnel office. The document must include the employee’s
name, the amount, and the organization from which the contribution is being revoked.
The cancellation is effective in the pay period it is entered into the system.

• The Office of Personnel Management regulations provide that allotment authorizations
be transferred when an employee moves to an organization serviced by a different
payroll office. Enter a new authorization form or enter the adjustment data in SPPS
only if an authorization was in effect with the losing department on the date of transfer.

• The maximum number of charitable contribution records allowed is two.

Steps For Entering Charitable Contribution Documents

To enter charitable contribution data:

1. At the EPIC Navigation window (Figure 1:4) select, Payroll Document at the New
Documents menu. An alphabetical list appears(Figure 4:7).
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2. Select Charitable Contribution.

3. At the menu bar select, Edit > Add New Document. The Charitable Contribution
window (Figure 4:7 ) is displayed.

Figure 4:7. Charitable Contribution window

4. Complete the Charitable Contribution fields as indicated under Charitable

Contribution Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.
OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Child Care Or Alimony Deduction Document

Child care or alimony deduction is the withholding of court ordered or voluntary child care or
alimony payments through payroll deductions. Child care and alimony data is displayed in
IRIS Program IR306, Child Support and Alimony.

Federal employees’ salaries and wages are subject to garnishment for child support and/or
alimony payments. This type of garnishment occurs when a governmental agency is directed,
through legal process, to make a payment from monies otherwise payable to an employee, to
another party to satisfy the employee’s legal obligation of providing child support and/or making
alimony payments. If garnishment has not been ordered, the employee may voluntarily request
payroll deductions for child support and/or alimony payments.

For more information, see:

Deductions From Disposable Income

Steps For Entering Child Care/Alimony Deduction Documents
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Deductions From Disposable Income

This section addresses the entry of child care and alimony payments based on a dollar amount
or a percentage of disposable income. If the payment is based on a percentage of gross
wages or if more than three child care/alimony deductions are to be made, the data should not
be entered in the PPS. For more information, see Chapter 11, Nonautomated Processing.

A maximum of three child care/alimony deductions may be entered in the system based on
the specific dollar amounts or percentages of disposable income. Enter a separate document
for each child care/alimony deduction. Maintain and use as required the AD−747 and all
copies for 3 years after the deductions have been completed. Maintain sufficient internal files
so that all inquiries concerning garnishment cases can be promptly answered.

Once established, cancellations of the garnishment must be ordered by the legal process.
Voluntary deductions may be canceled at any time.

Steps For Entering Child Care/Alimony Deduction Documents

To enter child care or alimony document:

1. At the EPIC Navigation window (Figure 1:4) select, Payroll Document at the New
Documents menu. An alphabetical list appears. 

2. Select Child Care or Alimony Deduction.

3. At the menu bar select, Edit > Add New Document. The Child Care or Alimony
Deductions window (Figure 4:8 ) is displayed.

Figure 4:8. Child Care Or Alimony Deductions window

4. Complete the Child Care or Alimony Deductions fields as indicated under Child Care
Or Alimony Deductions Window Field Instructions.
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5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.
OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Deductions Due To Indebtedness Document

Federal employees’ salaries and wages are subject to garnishment for bankruptcy, educational
loans, tax levies, commercial garnishments and/or other debts. This type of garnishment occurs
when a governmental agency is directed, through legal process, to make a payment from monies
otherwise payable to an employee, to another party to satisfy the employee’s legal obligation.

NFC is authorized to collect commercial garnishments from employee(s) who are indebted to
commercial organizations and are having his/her wages garnished. Public Law 130−94 allows
NFC to collect these funds. The agency must first have the garnishment orders reviewed by
the legal department (or other authorizing office) in order to ensure that the orders conform to
current regulations. Commercial garnishment alimony data is displayed in IRIS Program
IR114, Receipt Accounts.

After the review is completed, the agency sends the employee a letter of notification with the
garnishment order attached. The letter must be mailed within 15 days after the order is
received. The letter must contain:

• the total amount owed

• the pay period in which the garnishment will begin

• the amount to be garnished each pay period

Note: The pay period that the garnishment is set to begin is the pay period designated by the
agency provided that the order is received at NFC one week prior to the end of the effective
pay period. Garnishments received after that date will be processed the following pay period.

Commercial garnishments may be no more than 25 percent of the employee’s total disposable
earnings for any pay period, unless it is for a state or local tax levy. There is no limit on these
garnishment orders. If the employee is also being garnished for child care and/or alimony
payments, the total disposable earnings are calculated prior to the child care and/or alimony
garnishment. If a garnishment for child care and/or alimony is equal to or greater than 25
percent of the employee’s total disposable earnings, no commercial garnishment is deducted.
The garnishment order is returned to the agency if this occurs.

In case of multiple commercial garnishments, if the first received commercial garnishment
received is 25 percent or greater of the employee’s total disposable income, only that
commercial garnishment is processed until that debt is paid. The second-received commercial
garnishment is returned to the agency. After the first received commercial garnishment is
paid, the second commercial garnishment can be processed. Personnel offices are responsible
for monitoring the balance of the garnishment in IRIS Program IR114, Receipt Accounts.
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If the first received commercial garnishment is less than 25 percent of the employee’s total
disposable earnings, the first-received commercial garnishment should be recovered in one
pay period. The second-received commercial garnishment begins the same pay period (not to
exceed 25 percent less the first commercial garnishment).

If an overpayment is made to a third party, NFC cannot refund the overpayment to the
indebted employee. The employee must collect these funds directly from the third party.

Steps for entering a third party debt:

1. At the EPIC Navigation window (Figure 1:4) select, Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Deductions Due To Indebtedness.

3. At the menu bar select, Edit > Add New Document. The Deductions Due To
Indebtedness window (Figure 4:9) is displayed.

Figure 4:9. Deductions Due To Indebtedness window

4. Complete the indebtedness fields as indicated under Deductions Due To Indebtedness
Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.
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Education/Certification Document

Education and certification data records the highest education level attained based on years of
formal schooling and/or academic degrees or certificates conferred. The educational level
codes assigned to define the level of education and certification entered on the personnel
action in the Employee Data record is the official education record that is reported to CPDF.
The personnel action should be coded in addition to entering the education/professional
certification, as applicable. Education and certification data is displayed in IRIS
Program IR130, Education and Certificate.

For more information, see:

Entry Guidelines For Education/Certification Documents

Steps For Entering Education And Professional Certification Documents

Entry Guidelines For Education/Certification Documents

The institution where a degree was acquired, the type of professional certification attained,
and the year the degree or certification was received are entered in EPIC using the Education
and Certification windows.

Education data records the highest educational level attained. The first education record
entered is considered the official education record. The school code at which the degree or
certificate was received for the first education record is entered in the School Code field.
Secondary education records can also be entered separately.

An employee is allowed a maximum of five professional certificates in any of the following
areas:

• Lawyer (member of the bar)

• Certified Public Accountant (CPA)

• Certified Professional Manager (CPM)

• Certified Internal Auditor (CIA)

• Certified Information System Auditor (CISA)

Steps For Entering Education And Professional Certification Documents

To enter education or professional certification data:

1. At the EPIC Navigation window (Figure 1:4) select, Payroll Document. at the New
Documents menu. An alphabetical list appears.

2. Select Education/Certification > Education or Professional Certification.

3. At the menu bar select, Edit > Add New Document. The Education
window (Figure 4:10 ) is displayed.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 4

P
ayro

ll D
o

cu
m

en
ts

4:29Entering Payroll Documents (A−E)Updated 01/08

Figure 4:10. Education window (for Education or Professional Certification)

4. Complete the Education fields as indicated under Education Window Field

Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.
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Entering Payroll Documents (F−O)

This section presents the following topics:

Federal Benefit Documents

Federal Benefits Forms

Federal Benefit:: Health Document

Federal Benefit:: TSP Election Document

Leave Documents

Leave Payment Documents

Locator Document

Master File Change Document

Multi Element Update Document

Net Pay Document

Non-Federal Benefit Documents

Non-Federal: Flexible Spending Account Document

Non-Federal: Health Document

Non-Federal: Life Insurance Document

Non-Federal: Retirement Document

Non-Federal: Thrift Savings Document

Federal Benefit Documents

Federal employees benefits include health insurance, life insurance, TSP, etc. Health
insurance and TSP data are processed using payroll documents. Life insurance data is
processed using a personnel action. For information on life insurance, see Entering
Personnel Actions. The Federal Retirement Thrift Investment Board publishes TSP bulletins
about TSP processing by the TSP service office.

For more information, see:

Federal Benefit Forms

Federal Benefit:: Health Document

Federal Benefit:: TSP Election Document

Federal Benefit Forms

The SF−2809 and SF−2810 are used for processing health insurance coverage under FEHB
program.

The SF−2809 is used to enter a new enrollment, and to waive, change, or cancel enrollment.

• A new enrollment is entered when an employee is hired or an employee elects to enroll
during an open season.
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• A waiver is entered when an employee elects to waive coverage.

• A change is entered for qualified events.

The SF−2810 is used to enter enrollment changes (termination, reinstatement, and transfer of
health benefits coverage).

• A termination is entered due to 365 consecutive days in nonpay status or coverage is
terminated by the carrier due to nonpayment of dues.

• A reinstatement is entered when:

• An employee returns from military service

OR

• A correction is required to rescind an erroneous termination of enrollment

• A transfer is entered to transfer FEHB coverage:

• From one department to another department

• Back to the employing agency

OR

• To OWCP for employment compensation
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Federal Benefit: Health Document

Federal employees may enroll in FEHB to obtain health insurance coverage. IRIS Program
IR115, Health Benefits, displays health insurance data. The PPS generates the effective date
of the FEHB document in the Date Effective field of IRIS Program IR115.

For more information, see:

Health Benefits Processing

FEHB Children’s Equity Act

Public Law 106−394

Agency Personnel Office Responsibilities

Non-Federal Health Benefits

Employees In Non-Pay Status

Termination By Carrier

Restricted Enrollment Changes

Exceptions To Restricted Enrollment Changes

Nature Of Action Code/Authority Codes

Remarks Codes

Premium Conversion

FEHB Open Season

New/Transfer Enrollment

Nonpay Status For On-The-Job Injury

FEHB Premiums During Nonpay Status

System-Generated SF−2810

Direct Premium Remittance System (DPRS)

Before Entering The FEHB Data

FEHB Remarks Codes

Steps For Entering Federal Health Documents

Adding A Family Member

Entering FEHB Free-Form Remarks And Notes

Health Benefits Processing

Health benefits processing uses specific enrollment codes that are assigned by OPM. These
codes consist of three numbers: the first two identify the plan and the third identifies the
option and type of enrollment (e.g., Enrollment Code 102, 10 indicates the Service Benefit
Plan, and 2 indicates high option for self and family).

After a FEHB document has been successfully processed, the database is updated with the
appropriate FEHB coverage code and the carrier copies are sent to the carrier. The carrier
then issues the identification cards. Destroy the new carrier copy, old carrier copy, and the
payroll office copy of the SF−2809. Distribute the remaining copies in accordance with
agency instructions. Do not send to NFC. FEHB deductions begin during the pay period in
which the health benefits enrollment is processed and applied to the database. When FEHB is
cancelled, deductions stop at the end of the effective pay period.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

4:34 Entering Payroll Documents (F−O) Updated 01/08

The enrollment code is the only type of correction that can be made in the system. To correct
an enrollment code, enter a health benefits registration form. Select Change In Enroll
(SF−2809) at the Transaction drop-down menu and Correction at the Event Code drop-down
menu. All other corrections (e.g., correcting effective date) must be sent to NFC. The
correction should be indicated in the Remarks block of the SF−2809. To adjust for the
erroneous deductions, enter the information in SPPS.

FEHB Children’s Equity Act

The Federal Employees Children’s Equity Act requires FEHB-eligible employees who do not
comply with a court or administrative order to provide health benefits coverage for their
children. An employee subject to such an order must enroll in self and family coverage in a
plan that provides full benefits to his/her child(ren) in the area where they live or provide
documentation that he/she has other health coverage for the children.

Public Law 106−394

Public Law 106−394, the Federal Health Benefits Children Equity Act of 2000, enacted
October 30, 2000, requires mandatory self and family coverage for FEHB-eligible employees
who do not comply with a court or administrative order to provide health benefits for their
child/children.

Agency Personnel Office Responsibilities

When a court or administrative order is received for an individual, the agency personnel
office must review the employee’s records to determine whether he/she is eligible for FEHB
and, if so, whether he/she is enrolled in a self family plan that provides full benefits in the
location where the child/children live. Listed below are the specific actions that must be
taken by the agency personnel office to ensure compliance with the court or administrative
order.

If the employee has FEHB self and family coverage, notify the employee that when a court
order has been received requiring the employee to provide health benefits for his/her
children. If the child/children named on the court or administrative order is not identified as a
member of the employee’s self and family coverage, submit a copy of the individual’s
SF-2809 or SF-2810, along with a copy of the court or administrative order to NFC. NFC
will forward the appropriate documentation to the FEHB carrier to identify the additional
family member being covered under the self and family enrollment. Inform the appropriate
contact for the court or administrative order of the FEHB coverage and that action has been
taken to ensure the child/children is covered.

If the employee has FEHB self-only coverage, notify the individual that a court or
administrative order has been received requiring him/her to provide health benefits for his/her
children. The individual has until the end of the pay period following the one in which he/she
is given the notice to make a change from self only to self and family coverage. If the
individual does not make a change to self and family coverage, the agency personnel office
must enroll them in the basic Option of the Blue Cross/Blue Shield Service Benefit Plan
(Enrollment Code 112, Self and Family). The effective date of coverage is the first day of the
pay period following the one in which the SF-2809 is completed or the effective date as
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stated on the court or administrative order. Submit a copy of the individual’s SF-2809 or
SF-2810 along with a copy of the court or administrative order to NFC. NFC will forward all
the appropriate documentation to the FEHB carrier identifying the family members covered
under the self and family enrollment. Authorized enrollment changes must be processed
retroactively, if necessary, to comply with the effective date of the court or administrative
order. Enter in SPPS for processing of the retroactive FEHB personal action indicating:

• The enrollment is retroactive to the beginning of the pay period that includes the
effective date, but no further back than 2 years.

• The total adjustment amount due.

• The collection frequency for the amount due (e.g., one-time payment pr payment each
pay period).

Inform the appropriate contact for the court or administrative order of the FEHB self and
family coverage and that action has been taken to ensure the child/children is covered.

If the employee is not enrolled in an FEHB health plan that provides full benefits in the
location where the child/children live, notify the individual that a court or administrative
order has been received requiring him/her to provide health benefits for his/her children. The
individual has until the end of the pay period following the one in which he/she is given the
notice to enroll in a health plan or provide documentation that he/she has other health benefits
for the child/children. If the individual does not enroll in a plan or provide documentation of
coverage, enroll the child/children in the basic Option of the Blue Cross/Blue Shield Service
Benefit Plan (Enrollment Code 112, Self and Family). Complete an SF-2809 with remarks to
identify that the employee is being enrolled for FEHB self and family coverage under P.L.
106−394. The effective date of the coverage is the first day of the pay period following the
one in which the SF-2809 is completed or the effective date as stated on the court or
administrative order. Submit the SF-2809 along with a copy of the court or administrative
order to NFC. NFC will forward the appropriate documentation to the FEHB carrier to
identify each family member being under the self and family enrollment. Authorized
enrollment changes must be processed retroactively, if necessary, to comply with the effective
date of the court or administrative order. Inform the appropriate contact for the court or
administrative order of the FEHB self and family coverage once action has been taken to
ensure the child/children is covered.

Non-Federal Health Benefits

Agencies that employ non-Federal employees who are eligible for FEHB coverage, should
review P.L. 106−394 to determine the impact on their employees.

Employees In Nonpay Status

When an employee under a court or administrative order to provide FEHB coverage for
his/her child/children is in a nonpay status, he/she must either make direct premium payments
or incur a debt to the Federal Government to be repaid when he/she returns to pay status.
Note: This applies only during the first year in nonpay status. Coverage terminates after 365
days in nonpay status, even for employees with a court or administrative order. For additional
information, see 5 CFR 890.502(b).
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Termination By Carrier

When an individual under court or administrative order to provide FEHB coverage for his/her
child/children has FEHB coverage terminated by a FEHB carrier, it is the responsibility of the
employee’s personnel office to ensure that the individual continues to provide self and family
FEHB coverage under an alternative plan.

Restricted Enrollment Changes

During open season or when there is an event allowing an enrollment change, employees who
are under court or administrative order are restricted as to the type of enrollment changes they
may select while enrolled in FEHB. An employee who is under court or administrative order
can change to a different fee for service plan or an HMO that provides full benefits where the
child/children live. However, the employee cannot cancel enrollment, change to self only, or
change to an HMO that doesn’t provide coverage in the area where the child/children live, as
long as the court or administrative order is still in effect and the child/children are eligible
under FEHB. This applies whether the employee enrolled voluntary or involuntarily. If an
SF-2809 is received making such an enrollment change, do not process it. If the SF-2809 is
processed by mistake, a corrective action must be processed immediately, even retroactively,
if applicable. Notify the employee that he/she cannot make the change and that the existing
self and family will remain in effect.

Exceptions To Restricted Enrollment Changes

The following exceptions are allowed for enrollment changes when an employee is under a
court or administrative order.

• For employees who participate in the HB-Premium Conversion (HB−PC), if a court or
administrative order states that the FEHB coverage for the child/children must
continue until a specific age below 22, an employee may cancel coverage or change to
self-only(1) within 60 days after the date the last child turned 22, regardless of what
the court or administrative order says (FEHB provides coverage until age 22); or
(2) during the open season after the last child reaches the age stated in the court
or administrative order.

• For employees who waived HB-PC, the cancellation of coverage or change to self-only
may occur any time after the last child reaches the age specified in the court or
administrative order or age 22.

• When a court or administrative order states that health coverage for the child/children
must continue over age 22, the employee must provide proof of health benefits
coverage either Temporary Continuation of Coverage (TCC) or a private health plan. A
child/children cannot be covered by FEHB beyond age 22, regardless of what the court
or administrative order states unless the child/children meet the requirements for being
incapable of self-support.

Nature of Action Code/Authority Codes

NOAC 916, Court Ordered FEHB Change, must be processed to indicate a court-or
administrative order.
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The employee is required to enroll in FEHB due to following new authority codes have been
established for use with NOAC 916.

• BEG - The Beginning Effective Date authority should be used to reflect that an FEHB
court-ordered action is in effect for the employee.

• END - The Ending Effective Date authority should be used to reflect that an FEHB
court-ordered action is no longer in effect for an employee.

In addition, one of the following FEHB coverage codes must be included on the action.

• 6 − Court Order − Enrolled

• 7 − Court Order − Eligible-Pending Family Coverage

• 8 − Court− Order − Self-Only − Pending Family Coverage

Remarks Codes

The following remark codes will be generated automatically with NOAC 916 for processing
court-or administratively-ordered FEHB actions:

• FE1 − FEHB Family Coverage Required By P.L. 106-394

• FE2 − Employees FEHB Coverage is No Longer Subject To P.L. 105-394

The messages for remarks Codes FE1 and FE2 will be reflected on Form SF-50B,
Notification of Personnel Action, when a court-or administratively-ordered action is
processed.

Premium Conversion

Most employees whose agency has an Approved Adoption Agreement with OPM are eligible
to have their FEHB premiums paid under the premium conversion plan. Reemployed
annuitants enrolled in the FEHB will automatically participate in the premium conversion,
provided they are employed:

• in a position that conveys FEHB eligibility; and

• by an agency covered by premium conversion

Participation in the Health Benefits Premium Conversion Plan (HB-PC) is automatic unless
an employee chooses to waive coverage. The part of an employee’s salary that is deducted for
health insurance premiums is non-taxable. As a result, health benefits premiums are not
subject to Federal income, Medicare, or Social Security taxes. In most cases, state and local
taxes are also not applicable.

Agencies must deduct FEHB premiums on a pre-tax basis from the pay of these individuals
unless they waive participation in premium conversion. Health Benefits Premium Conversion
has no effect on the:

• Amount of an employee’s health insurance premiums.

• Amount of the Government’s share towards the FEHB premium on behalf of any
employee.
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• Base pay for retirement, life insurance and/or Thrift Saving Plan purposes.

Changes in participation in premium conversion may be affected during the annual FEHB
open enrollment period, or during the calendar year upon experiencing a qualifying life event.
Qualifying life events include:

• Change in Family Status (e.g., birth/death of child, foster, adoption, child ages up, etc.)

• Change in Legal Marital Status (e.g., married, divorce, annulled, legal separation,
death)

• Change in Employment Status(e.g., RTD from leave without pay (LWOP), Work
Schedule, Re-employment after three days break-in-service, transfer to/from overseas,
RTD from Military Service, Temp Appt becomes permanent, spouse’s eligibility
changes)

• Loss of Other Coverage (e.g., termination, cancellation, change to self only, FEHB
plan closes out, lost of coverage from spouse’s health insurance)

• Other (e.g., coverage under spouse’s health insurance and they have a different open
season that affects your coverage, employee in an HMO that moves to a non-covered
area, cost of health insurance under spouse’s non-federal health increase significantly,
(i.e., 20%) when you become eligible for medicare)

Error Corrections. If administrative errors occur in the precessing of employee elections to
participate or waive participation in health benefits, or errors occur in FEHB withholdings,
the IRS rules prohibit retroactive adjustments to taxable income even if it is clear that the
agency is at fault. In such cases, the agency is responsible for taking the appropriate actions
to correct the errors.

FEHB Open Season

FEHB open season occurs annually. New enrollments and changes for the open season are
effective the first pay period of the calendar year. All open season data should be entered as
early as possible. The data will be retained in the future file until the designated effective pay
period’s processing.

If an employee plans to retire and requests an open season change on or before the effective
date for an open season enrollment period, do not enter the health benefits data in the PPS;
include the SF−2809 with the employee’s retirement package. The employee should complete
the SF−2809 but the agency certifying office should only initial and date Part G to show
timely submission. The name of the agency and the signature of its certifying officer should
not appear on the SF−2809. OPM uses the SF−2809 to complete the processing of the
employee’s retirement request. Also include a memorandum with the retirement package to
verify the employee’s eligibility to transfer health benefits coverage from the PPS to OPM.

New/Transfer Enrollment

Certain temporary employees are eligible to participate in the FEHB program. Agencies must
verify the employee’s eligibility for FEHB coverage. The PPS produces Report AEC037U4,
Temporary Employees−−FEHB Coverage Eligibility, to identify eligible temporary
employees. Agencies should supply them with the Enrollment Information Guide And Plan
Comparison Chart, RI 70−5, and the SF−2809.
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To verify the FEHB−Temp−SCD recorded in the database, use IRIS Program IR115. If the
FEHB effective date requires an adjustment, complete the FEHB−TEMP−SCD field in the
Multi Element Update window (Figure 4:25). For additional information, see Multi Element
Update Document.

When a new employee enters on duty in the middle of a biweekly pay cycle from another
Federal department having a different biweekly pay cycle, the employee is not charged for
benefits from both departments. The PPS automatically adjusts the employee’s FEHB on a
prorated basis based on the effective date. The cost for part-time career employees is also
prorated depending on agency regulations. If an employee has a dual appointment, both
agencies contribute to the cost of FEHB. See Title I, Chapter 11, Nonautomated Processing
for information on setting up payment of premiums by the employee.

If the effective date of the SF−2809 is prior to the effective date of the processing pay period
and the employee is not currently enrolled, the uncollected premiums can be paid in a lump
sum in one pay period or prorated. The “Is This A Retroactive Adjustment For An Employee
Not Previously Enrolled In FEHB?” field is used to indicate the choice of payment. For more
information, see Health Benefits Window Field Instructions.

Nonpay Status For On-The-Job Injury

When an employee is in a nonpay status as a result of an on-the-job injury, follow the steps
below when health insurance premiums are paid by the Office of Workmen’s
Compensation (OWCP).

To process FEHB premiums paid by OWCP:

1. After OWCP notifies the agency to approve the claim, enter the LWOP personnel
action.

2. Enter the health benefits enrollment change. Select Transfer Out (SF−2810) at the
Transaction drop-down menu and Other at the Event Code drop−down menu to
indicate a transfer to OWCP.

3. After the employee returns to duty on a full-time basis, enter the health benefits
enrollment change. Select Transfer In (SF−2810) at the Transaction drop-down menu
for a transfer and Other at the Event Code drop-down menu to transfer enrollment back
to the employing agency.

FEHB Premiums During Nonpay Status

There are three cases when employees on LWOP should not be billed for health benefits
premiums.

• LWOP pending approval of the OWCP claim, and the application is approved.

When entering the personnel action for OWCP use NOAC 460, LWOP NTE,
Authority Code Q3K. A bill will not be generated to the employee. After the personnel
action is processed, verify that the Current Employment Status field is coded 7
(OWCP−LWOP) on IRIS Program IR102, Dates & Misc Salary/Personnel Data.
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• LWOP pending OPM approval of disability retirement and the application is approved.

When entering the personnel action for preliminary disability retirement, use NOAC
976, Preliminary Disability Retirement with Remark Code 211, LWOP Pending
Approval of Disability. A bill will not be generated to the employee. After the
personnel action is processed, verify that the Current Employment Status field is
coded 8 (LWOP Pending Approval Of Disability Retirement Application) on IRIS
Program IR102.

FEHB coverage cannot be continued if an employee reaches 26 consecutive pay periods of
LWOP or LWOP pending OWCP. For more information, see Federal Benefit Forms.

Note: When FEHB coverage is canceled due to 365 days of LWOP status, the FEHB
coverage code changes to 5 (canceled) after the personnel action is processed and the
employee is automatically billed.

If a personnel action was processed for LWOP in excess of 30 days, timekeepers should not
transmit a T&A after the 30 days. A bill is generated for the health benefits premiums if
T&A’s are transmitted.

If an employee in nonpay status chooses not to pay their share of the health benefits premium
before returning to work, the payroll office sends a letter to the employee indicating the
amount owed. When the employee returns to duty, either the entire amount may be paid or an
additional premium (in addition to the regular premium deduction) will be automatically
deducted each pay period, until the debt is repaid. For more information, see Title I,
Chapter 11, Nonautomated Processing, Employee Indebtedness.

If an employee separates from an agency owing FEHB premiums, the amount due will be
withheld from the employee’s final salary. If this amount is insufficient, it will be considered
an indebtedness due the United States. Recovery of the funds are made from any lump sum
payment due the employee, retirement deductions, annuities, or other monies owed to the
employee by the Federal Government. For more information, see Title I, Chapter 8, Special
Payroll Processing System.

System-Generated SF−2810

Information on the SF−2810 should not be entered in the PPS under certain conditions. The
PPS generates the SF−2810 when one of the following personnel actions is processed. The
carrier copy is sent to the carrier.

• Separation (except termination due to nonpay status for 365 consecutive days). The
personnel action separating the employee will cancel the FEHB coverage.

• Death

• Retirement

• Name Change (Enter NOAC 780, Name Change From, to change the employee’s name
in the database).

• Transfer Out (except to OWCP)
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Direct Premium Remittance System (DPRS)

DPRS is a centralized automated system for collecting premiums from eligible non-Federal
enrollees who elect to participate in the FEHB program (e.g., former spouses). DPRS is a
Federal plan used by non-Federal enrollees. These transactions are not entered in the PPS
by the agency. Agency personnel offices should refer to Title III, Billings And Collections
Manual, Chapter 5, DPRS, procedure for completing the SF−2809. Forward the SF−2809 and
related documents to:

USDA NFC 
DPRS Billing Unit 
P.O. Box 61760 
New Orleans, LA 70161−1760

Before Entering The FEHB Data

Employees have up to 31 days from their entry on duty date to either enroll in a plan or waive
enrollment. Code the personnel action as follows with the applicable FEHB code to begin
deductions, waive election, or cancel prior coverage.

Type 4 (Eligible Pending) in the FEHB Coverage field of the personnel action before the
FEHB enrollment document is entered. After the personnel action and the FEHB document
successfully process, withholdings from the employee’s salary begin and the system
generates 1 (Enrolled) in the FEHB Coverage Code field on IRIS Program IR115.
Enrollment Code 1 cannot be entered on a personnel action nor can it be changed to 4. If the
database reflects FEHB Coverage Code 1 and the Enrollment Code field is blank, contact
NFC, Fringe Benefits Unit, to change code 1 to code 4. Due to system configuration, this
could occur when a separation and accession are processed. After the code is changed the
SF−2809 can be entered in the PPS.

CULPRPT Report P0059, Employees With FEHB Eligibility Pending, lists employees with
FEHB Coverage Code 4. These employees have not yet registered to either enroll or waive
FEHB enrollment. Personnel offices should run this report each pay period and remind
employees to register before the end of the 31-day eligibility period. AEC037U4, Temporary
Employees FEHB Coverage Eligibility, lists employees who will become eligible to
participate in FEHB in two pay periods.

Type 3 (Waive) in the FEHB Coverage field of the personnel action if the employee elects
not to participate in the FEHB Program.

Type 5 (Change) in the FEHB Coverage field of the personnel action when the enrollment
changes because of (1) open season; (2) marital status changes from self to family or vice
versa within the same plan; (3) enrollment is rejected by the carrier.

Type 6 (Cancellation by employee) in the FEHB Coverage field of the personnel action if the
employee cancels after being enrolled. The losing carrier is notified and the cancellation
becomes effective on the last day of the pay period in which the SF−2809 is received in the
personnel office.
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FEHB Remarks Codes

Remarks codes applicable to FEHB coverage after separation are entered on the personnel
action. For a list of the FEHB remarks codes that are applicable to separation actions, see
Entry Guidelines For Separations.

Steps For Entering Federal Health Documents

To enter a health benefit registration or enrollment change document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll at the New Documents
menu. An alphabetical list appears.

2. Select Federal Benefit > Health Benefits Registration or Health Benefits Change
Enrollment.

3. At the menu bar select, Edit > Add New Document. The Health Benefits
window (Figure 4:11 ) is displayed. If Health Benefits Change Enrollment is chosen,
the Change in FEHB Enrollment window is displayed.

Figure 4:11. Health Benefits window (for Registration Form or Change Enrollment)

4. Complete the Health Benefits fields as indicated under Health Benefits Window Field
Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.
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Adding A Family Member

To add a family member:

1. After the document is successfully added, click View > Family Member. The List
Family Members pop-up (Figure 4:12 ) appears.

Figure 4:12. List Family Members pop-up

2. Click [Add]. The Family Member pop-up (Figure 4:13 ) appears.

Figure 4:13. Family Member window

3. Complete the fields as indicated under Family Member Window Field Instructions.

4. After completing the fields, click [Save] to close the Family Member
window (Figure 4:13) and return to the List Family Members pop-up (Figure 4:12).
The family member’s data appears in the box.

5. To add more family members click [Add].

6. To update a family member’s data:
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a. Select the family member’s name and click [Update]. The Family Member
window (Figure 4:12) is displayed.

b. Update the data and click [Save] to save the data and return to the List Family
Members pop-up (Figure 4:13).

7. To delete a family member, click the name and click [Delete]. The Confirm Deletion
pop-up appears with the message, Continue With Delete?.

8. Click [OK] to save the deletion and return to the List Family Members
pop-up (Figure 4:12). The family member’s data disappears from the box.

9. To view a family member’s detail record, select the name and click [Detail]. The
Family Member window (Figure 4:13) is displayed with the family member’s
information. No changes can be made in the View mode.

Entering FEHB Free-Form Remarks And Notes

A Remarks pop-up (Figure 4:14) is used to enter remarks that pertain to the FEHB
document (e.g., Erroneously enrolled in Enrollment Code 103; should be Enrollment
Code 104); a Notes pop-up (Figure 4:15) is used to enter notes that the agency deems
applicable to the transaction.

To enter remarks or notes from a Registration window or a Change Enrollment
window:

1. Click View > Remark or View > Notes. The Remark pop-up (Figure 4:14) or Notes
pop-up (Figure 4:15) appears.

Figure 4:14. Remark pop-up
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Figure 4:15. Notes pop-up

2. Enter the applicable remarks or notes and click [Save] to return to the previous
window. The remarks/notes can be printed and attached to the agency copy of the
FEHB form.

Note: Click [Save] > [Close] to close the Notes pop-up (Figure 4:15).

Federal Benefit: TSP Election Document

TSP is a retirement savings and investment plan for Federal employees. Employees covered
by FERS and CSRS can contribute to TSP. Employees hired on or after January 1, 1984, are
generally FERS employees. The Foreign Service Pension System (FSRS) and other
equivalent Government retirement plans are also included in FERS. CSRS includes the CSRS
Offset, the Foreign Service Retirement and Disability System, and other equivalent
Government retirement plans. For detailed information regarding TSP, refer to publications
and bulletins published by the Federal Retirement Thrift Investment Board.

Form TSP−1, Thrift Savings Plan Election Form, is completed by the employee to start,
change, waive, or terminate TSP contributions. Employees may elect to participate, change,
or stop contributions to the TSP during open season, as well as designate the 1−percent
automatic agency contribution (FERS employees only). An open season is held every six
months: May 15 − July 31 and November 15 − January 31.

Caution: Employee Express will not allow employees to reenroll prior to the second open
season; therefore, if the reenrollment is allowed, and must be overridden, enter the TSP data
in EPIC; do not allow the employee to attempt to enter the data in Employee Express.

For more information, see:

Processing Tips For TSP Election

Entry Guidelines For Coding The Personnel Action For TSP Elections

TSP Transfer

TSP Adjustments

TSP Catch-up Contributions

Steps For Entering TSP Election Documents
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Processing Tips For TSP Election

Below is a list of things-to-do before entering TSP data.

1. Verify in IRIS that the employee is eligible to participate or is participating in
TSP. To participate, the retirement plan code must be 1, 6, C, E, G, K, L, M, N, P, R,
T, or W (for code definitions, see the Retirement Plan Table) and the TSP status code
must be Y (yes) or E (eligible). If the status code is not Y or E but is correct, the TSP
document will reject. To release the document from suspense, type D in the Status
Code field. TSP Override Codes are for NFC Use Only.

2. Code the personnel action. The personnel action includes the TSP Eligibility Code
that identifies whether or not the employee is eligible to participate in FERS TSP for
FERS, CSRS, Offset, or FSRS employees.

The effective date of the status change is system generated and is the first day of the
pay period in which the TSP information is processed to begin employee contributions.
However, if the employee cancels the TSP contributions, the first day of the pay period
in which the cancellation is processed will be generated in the Eff Date Of Status
Change field in IRIS Program IR118, Thrift Savings Plan Funds. This field is also
changed when FERS employees start receiving the 1-percent agency contribution if
they are not participation in TSP.

The effective date of the status change will not change if the employee elects to change
the percentage rate or dollar amount of the contribution. For detailed information
regarding TSP, refer to the TSP bulletins published by the Federal Retirement Thrift
Investment Board. For a list of TSP Eligibility codes, see TSP Eligibility Code Table.

Entry Guidelines For Coding The Personnel Action For TSP Elections

Type the code that identifies whether or not a FERS, CSRS, Offset, or FSRS employee is
eligible to participate in FERS TSP. For a list of valid codes, see the TSP Eligibility Table. For
detailed information regarding TSP, refer to publications and bulletins published by the
Federal Thrift Investment Board.

• The TSP Eligibility Code is automatically changed to 9 when a TSP enrollment
document is processed or when a FERS employee begins receiving the 1-percent
Government basic contribution. Once code 9 has been established, it cannot be
changed. If an employee stops contributing, the employee’s eligibility to again
contribute is determined by the Change Status Code and Effective Date of Status
Change fields in IRIS Program IR119, Reserved For Future Use.

• The effective date of Status Change is generated and is the first day of the pay period
in which the Form TSP-1 is processed to begin employee contributions, the first day of
the pay period in which the cancellation is processed will be generated as the Effective
Date of Status Change.

• The Effective date of Status Change will not change if the employee elects to change
the percentage rate or dollar amount of the contribution or investment allocation.
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The following are guidelines for processing Status Changes:

• Must be completed for an accession action and a change to FERS retirement coverage
if the employee is not enrolled in TSP.

• Must be blank for a change to FERS retirement coverage if the employee is currently
enrolled in TSP.

• Retirement plan must be K, L, M, N, or P for TSP eligibility code 4 and 5.

• Retirement plan must be 2, 5, or Y for TSP eligibility code 6.

• Retirement plan must be 4 for TSP eligibility code 6. If the employee is a reemployed
annuitant, another valid code can be entered in this field.

The Change Status Codes are as follows:

Code Purpose

Y (Yes) Employee has elected to participate in TSP. A FERS employee
coded Y is eligible for matching funds as well as the 1−percent
Government basic contribution.

W Waiting to receive agency contributions. A FERS employee who is
contributing to TSP but who is not yet eligible to receive agency
contributions.

S Stopped employee contributions. A FERS employee who terminate
their own contributions before they become eligible to receive
agency contributions.

T Employee has elected to terminate participation in TSP outside an
election period. A FERS employee coded T is eligible for the
1-percent Government basic contribution.

E Employee is eligible to participate in TSP but has not submitted a
TSP−1 to contribute or waive. A FERS employee coded E is eligible
for the 1-percent Government basic contribution.

I Employee is ineligible to contribute to TSP. A FERS employee
coded I is not eligible for the 1-percent Government basic
contribution.

Code the TSP Eligibility field as follows:

• Code 1 applies to FERS employees only. These employees are eligible to participate
immediately in employee contributions; however, the agency 1-percent basic
Government contribution and the Agency matching funds will not be applied until the
first open season. (This applied to new hires; transfers or rehires not yet eligibility for
1-percent basic contribution.

• Code 2 applies to FERS employees only. These employees are eligible to participate
immediately in employee contribution, however the agency 1-percent basic
Government contribution and the agency matching funds will not be applied until the
second open season. (This applies to new hires, transfers or rehires not yet eligible for
the 1-percent basic Government contributions.)

• Code 3 applies to:

• all CSRS and CSRS-Offset transfers (except if they terminated their TSP
contributions);
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• CSRS and CSRS-Offset rehires;

• FERS employees who transfer from another Federal agency/payroll system
without a break in service who were making TSP contributions and receiving the
1-percent basic Government contribution and matching funds;

• FERS employees who are rehired with a break in service of less than 31 days who
were making TSP contributions, receiving the 1-percent basic Government
contributions and receiving the 1-percent matching funds immediately prior to
their separation; and,

• FERS employees who transfer from another Federal agency/payroll system
without a break in service who are not making employee contributions but are
receiving the 1-percent basic Government contribution (except if they terminated
their TSP contribution),

• FERS employees who are rehired after a break in service of 31 days or more, who
were previously eligible to receive agency contributions, agency contributions
will be begin immediately.

Employees are eligible to participate immediately in employee contributions.

Note: FERS, CSRS, and CSRS-Offset employees with a break in service of less than
31 days are considered transfers and TSP contributions must be based on their last
TSP-1.

• Code 4 applies to:

• FERS employees who had terminated TSP contributions during the last TSP open
season before transferring to a new Federal agency/payroll system, and are
eligible immediately for the agency 1-percent basic Government contribution and
eligible to contribute to TSP during the first TSP Open Season, or,

• CSRS or CSRS-Offset employees who terminated TSP contributions during the
last TSP Open Season before transferring to a new Federal agency/payroll system,
and are eligible to contribute to TSP during the first TSP Open Season.

• Code 5 applies to

• FERS employees who transferred from another agency/payroll system and had
terminated TSP contributions after the last TSP Open Season and are eligible
immediately for the agency 1-percent basic Government contribution and eligible
to contribute to TSP during the second TSP Open Season, or,

• CSRS or CSRS-Offset employees who terminated TSP contributions after the last
TSP Open Season before transferring to a new Federal agency/payroll system, and
are eligible to contribute to TSP during the second TSP Open Season.

• Code 6 applies to employees that are not eligible. Employees with retirement coverage
codes of 2 (FICA); 4 (none, except for re-employed annuitants who have an annuity
code of 1, 4, or 5); 5 (other retirement system); J (FICA and other Retirement −
Partial Rate); or X (FICA and Other Retirement − Full Rate).

Note: FERS employees include FSPS employees, and FSRS and CSRS-Offset
employees include Foreign Service Retirement and Disability Service (FS) employees.
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SCD-TSP

Type the beginning date of the vesting period for the 1-percent Government contribution to
TSP. Must be completed for FERS and FSPS employees participating in TSP; do not
complete for CSRS-Offset (Congressional)(FICA) retirement plan; cannot be prior to January
1, 1984; and cannot be later than effective date of action.

TSP Transfer

When a TSP contributing employee (1) transfers into the PPS or (2) transfers from one
department to another and both departments are serviced by NFC, abstract and enter as a new
enrollment, the data from SF−75, Request For Preliminary Employment Data. Timely entry is
important to prevent interruption of participation in TSP.

A TSP election form should be processed when a TSP participant separates and is rehired
with a break in service of less than 31 full calendar days to continue coverage and
contributions. Enter the TSP data that was in effect at separation.

If a new enrollment is not entered, TSP contributions will not resume.

TSP Adjustments

When TSP data is not processed timely or an error is discovered after contributions begin,
TSP deductions must be adjusted using Form AD−343, Payroll Action Request. Enter the
AD−343 data in SPPS. For detailed information, see Title I, Chapter 8, SPPS.

TSP Catch-up Contributions

Public Law 107−304 permits eligible TSP participants age 50 or older to make tax-deferred
“catch-up” contributions from basic pay to their TSP accounts. The catch-up contributions
are a supplement to the participant’s regular TSP contributions and do not count against
either the statutory contribution percentage limitations or the IRS deferral limit.

Participants must meet the following criteria in order to make catch-up contributions:

• Be in pay status.

• Be at least 50 years or older in the year the catch-up contributions are made.

• Not be in the 6-month non-contribution period following a financial hardship
in-service withdrawal.

• Be contributing the maximum amount allowed according to TSP/IRS regulations and
not exceeding the TSP catchup contribution limit.

There are no matching government contributions when making catch-up contributions.
Allocations for the catch-up contributions will be made in accordance with the employee’s
current allocations.

Steps For Entering TSP Election Documents

To enter a TSP election document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.
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2. Select Federal Benefits > TSP Election .

3. At then menu bar select, Edit > Add New Document. The Thrift Savings Plan Election
Form window (Figure 4:16) is displayed.

Figure 4:16. Thrift Savings Plan Election Form window

4. Complete the fields as indicated under Thrift Savings Plan Election Form Window
Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Leave Documents

Leave documents are used to enter transferred leave, restored annual leave, interim and final
compensatory leave, and annual leave lump sum payments. This leave data is displayed in the
following IRIS Programs:

• IR133, Separated Leave

• IR136, Annual/Sick Leave

• IR138, Other Leave

• IR139, Compensatory Leave And Rates

• IR140, Nonpay Leave

Leave discrepancies are resolved by the agency by submitting corrected time and attendance
records or entering the correction in TINQ. CULPRPT includes reports that pertain to annual
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leave, compensatory leave, etc., processing and discrepancies. For exhibits of all CULPRPT
reports, see Title I, Chapter 20, Section 1. Several reports that pertain to leave processing are
mailed to agency locations upon agency request. For exhibits of all payroll/personnel reports,
see Title I, Chapter 20, Section 5.

For more information, see:

Leave: Leave Data Transfer Document

Leave: Restored Annual Leave Document

Leave: Leave Data Transfer Document

Leave data is transferred in accordance with Federal regulations to record an employee’s
leave record when the employee separates and is rehired. The SF−1150, Record Of Leave
Data, is used to credit the employee’s leave account for annual and/or sick leave, and nonpay
status. The SF−1150 is processed (in conjunction with the accession action) to enter leave
data when an employee transfers into the PPS from a department not serviced by NFC or
from one department to another department in the PPS. The gaining department enters the
data to transfer the leave data into the PPS when an employee is rehired and has leave that is
creditable.

The system generates the SF−1150 to transfer the leave data to another department when:

• A separation transfer personnel action is processed

• The final code is recorded in the database via T&A or master file change document

• The lump sum leave payments have been disbursed, when applicable

The SF−1150 is forwarded to the losing department via dispatch or through RFQS. That
department reviews the SF-1150 for accuracy and then forwards it to the gaining department.

For more information, see:

Adjustments To Transferred Leave Data

Steps For Entering Transferred Leave Documents

Adjustments To Transferred Leave Data

If the original SF−1150 contained an error, send a leave audit and enter the data in SPPS.
NFC enters the correct data and produce a corrected SF−1150.

If the SF−1150 has processed to transfer leave data into the PPS and it should not have been
processed, adjust the leave data in the applicable fields in TINQ based on leave accruals and
usage since employment.

If the SF−1150 was generated for a separated employee and the leave balances should be
deleted, TINQ cannot be used. Send a leave audit to NFC.

Steps For Entering Transferred Leave Documents

To enter a leave data transferred document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document. at the New
Documents menu. An alphabetical list appears.
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2. Select Leave Data Transfer.

3. At the menu bar select, Edit > Add New Document. The Leave Data Transferred
window (Figure 4:17) is displayed.

Figure 4:17. Leave Data Transferred window

4. Complete the Leave Data Transferred fields as indicated under Leave Data Transferred
Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action.
OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Leave: Restored Annual Leave Document

Restored annual leave is annual leave that has been returned to the employee instead of
forfeited due to administrative error, exigencies of the public business, or sickness. Restored
annual leave displays on IRIS Program IR136, Annual Leave.

For more information, see:

Timekeepers Recordkeeping Of Restored Annual Leave

Correcting And Canceling Restored Annual Leave

Steps For Entering Restored Annual Leave Documents

Timekeepers Recordkeeping Of Restored Annual Leave

The PPS calculates restored annual leave used and balances. Timekeepers should maintain
the restored annual leave record in a separate leave account from regular annual leave.
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Restored annual leave used is recorded on the T&A report under TC63. The amount of the
restored annual leave does not increase or change an employee’s normal maximum carryover
of annual leave into a new leave year.

Timekeepers should establish adequate record keeping and administrative procedures to
properly identify in a separate leave account:

• The date the annual leave was restored for use

• The amount credited

• The specific schedule established for use

• The amount of usage and balance

Correcting And Canceling Restored Annual Leave

If the correction or cancellation of restored annual leave documents is for the current year,
enter the data in EPIC. If the correction is for a prior year, enter the data in TINQ Program
TI07, Annual Leave Restored. Changes in restored annual leave usage are handled via
corrected T&A’s.

Steps For Entering Restored Annual Leave Documents

To enter a restored annual leave document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Restored Annual Leave.

3. At the menu bar select, Edit > Add New Document. The Restored Annual Leave
window (Figure 4:18) is displayed.

Figure 4:18. Restored Annual Leave window

4. Complete the Restored Annual Leave fields as indicated under Restored Annual Leave
Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action.

OR
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Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Leave Payment Documents

Leave payment documents include two basic types: compensatory leave and annual
leave (or other lump sum leave payments). An interim compensatory leave or annual leave
payment is made when an employee converts to a work schedule that terminates leave
earning eligibility (i.e., from full-time or part-time to intermittent) or other cases where the
compensatory leave expires, depending on agency policy. A final compensatory leave or
annual leave payment is made when an employee separates from the rolls.

Processing Tips For All Lump Sum Leave Payments

Below is a list of things-to-do before entering lump sum payments.

1. Before entering the leave transaction, access TINQ Program 05 and/or IRIS
Programs IR136 and IR139 to assure the leave balance on the payment document
agrees with the leave balance on the database. If a discrepancy exists, correct the
discrepancy before entering the payment document. Agencies without TINQ access
must send NFC Form AD−717, to correct the leave discrepancy.

2. Determine if the lump sum payment should be processed manually. For more
information, see Title I, Chapter 11, Nonautomated Processing. Also, for information
regarding repayment of lump sum leave, see Chapter 11. The following lump sum
transactions should not be entered in the PPS for processing:

• The lump sum payment amount is over $99,999.99.

• A terminated employee is rehired with a break in service.

• The employee has dual rates (except for pp26 separations).

• Credit hours.

For more information, see:

Leave Payment: Compensatory Leave Payment Document

Leave Payment: Annual Leave Payment Document

Leave Payment: Compensatory Leave Payment Document

Compensatory time is hours of irregular or occasional overtime work for which the employee
is required or has elected to take time off in lieu of receiving overtime pay. Compensatory
time earned is recorded on the time and attendance report using Transaction Code 32,
Compensatory Time Worked. Compensatory leave may be liquidated by the end of the leave
year, carried to the following year, or paid in full, etc., in accordance with agency policy.

Compensatory leave payments are paid at the rate of overtime pay applicable at the time the
work was performed. Payments must be charged to the current fiscal year appropriation
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regardless of the fiscal year in which the overtime work was performed. The system currently
store only the Title V rate. If employees need to be paid at the FLSA rate a request for
manual payment must be processed via SPPS.

Compensatory leave data (including rates at which compensatory time was earned) can be
viewed in IRIS Program IR139, Compensatory Leave and Rates and TINQ Program 05,
Compensatory Leave & Compensatory Other Rate. TINQ is also used to correct any
compensatory time discrepancies. For TINQ instructions, see Title I, Chapter 7, Section 4.

For more information, see:

Entry Guidelines For Compensatory Leave

Steps For Entering Compensatory Leave Payment Documents

Steps For Entering Accounting Data

Entry Guidelines For Compensatory Leave

If the employee’s Fair Labor Standards Act (FLSA) overtime rate is higher than the Title V
overtime rate, enter the compensatory payment in SPPS.

Steps For Entering Compensatory Leave Payment Documents

To enter a compensatory leave lump sum payment document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Leave Payment > Compensatory Time Payments.

3. At the menu bar select, Edit > Add New Document. The Compensatory Time Payment
window (Figure 4:19) is displayed.

Figure 4:19. Compensatory Time Payments window

4. Complete the Compensatory Time Payments fields as indicated under Compensatory
Time Payments Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action.
OR
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Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Steps For Entering Accounting Data

The Use Database Accounting Data field must be coded No to enter accounting data.

To enter accounting data:

1. Select File > Save at the menu bar. The List Accounting Data pop-up (Figure 4:20)
appears.

Figure 4:20. List Accounting Data pop-up

2. Click [Add]. The Accounting Data pop-up (Figure 4:21 ) appears.

Figure 4:21. Accounting Data pop-up

3. Complete the Accounting Data fields as indicated under Accounting Data Pop-up
Field Instructions.

4. After completing the fields, click [Save] to save the entries and close the window. The
entries appear on the List Accounting Data pop-up (Figure 4:20).

5. To update, delete, or display the accounting data, select the applicable command button
at the List Accounting Data pop-up (Figure 4:20).

6. To close the window, click [Close].
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Leave Payment: Annual Leave Payment Document

Full-time and part-time employees earn annual leave based on their appointment. The Annual
Leave Category on the personnel action determines the biweekly accruals. Annual leave
accruals are recorded on the T&A each pay period. Annual leave used is recorded using
Transaction Code 61, Annual Leave. Based on this data, the PPS maintains employees leave
records in the database. IRIS Program IR136 displays annual leave data.

For more information, see:

About Lump Sum Annual Leave Payments

Steps For Entering Lump Sum Leave Payment Documents

About Lump Sum Annual Leave Payments

A final lump sum payment is normally processed when an employee separates from Federal
service. Under certain conditions a lump sum payment can be made when NOAC 352,
Termination Appointment-In, is processed. If the lump sum payment is appropriate for
NOAC 352, enter Status Code C to release the action from suspense.

In addition, lump sum payments are also payable to:

• Employees who enter the Armed Forces or who transfer to public international
organizations and who do not elect to retain their annual leave to their credit

• Employees who transfer to positions not under a leave system to which annual leave
may be transferred

• PT/FT employees who change to an intermittent work schedule

• Intermittent employees for whom there have not been established regular tours of duty
during each administrative workweek

• Temporary employees engaged in construction work at hourly rates

• Employees of the Senate or House of Representatives

• Employees of any corporation under the supervision of the Farm Credit
Administration (FCA) if any member of the corporation’s board of directors is elected
or appointed by private interests

A lump sum is not payable to an employee who transfers to a position to which his/her annual
leave is transferable, or to a student trainee employed continuously with intermittent duty
status between full-time tours of duty.

The lump sum payment to which an employee is entitled is equal to the pay that would have
been received had the employee remained in service until the expiration of the period of
annual leave. The lump sum payment is to be computed on the basis of an employee’s rights
at the time of separation under all applicable laws and regulations existing at that time which
would have affected pay had the employee remained in service for the period covered by the
leave. In some cases this may result in the lump sum being paid at a dual rate.

If the employee is indebted to the Government at the time of separation and the final salary is
insufficient to recover the debt, the annual or compensatory leave payment (or other payable
leave) will be offset to collect for the indebtedness. For more information, see the SPPS
(Title I, Chapter 8) procedure.
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Steps For Entering Lump Sum Leave Payment Documents

To enter a lump sum leave payment:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Leave Payment > Lump Sum Leave Payment .

3. At the menu bar select, Edit > Add New Document. The Lump Sum Leave Payment
window (Figure 4:22) is displayed.

Figure 4:22. Lump Sum Leave Payment window

4. Complete the Lump Sum Leave Payment fields as indicated under Lump Sum Leave
Payment Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action.

OR

6. Click [No] to exit the window and not save the entries.

OR

7. Click [Cancel] to reopen the window.

Locator Document

Locator data includes the location of employees. Based on the information entered in the
Work Building Location field in EPIC, the PPS generates the building abbreviation, name,
and address in the database. IRIS Program IR146, Building Locator Information, displays
locator information. CULPRPT Report P0055, GAO Employee Locator Listing is a report of
the data entered for each employee.
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For more information, see:

Steps For Entering Locator Documents

Steps For Entering Locator Documents

To enter a locator document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Locator.

3. At the menu bar, select Edit > Add New Document. The Locator window (Figure 4:23)
is displayed.

Figure 4:23. Locator window

4. Complete the Locator fields as indicated under Locator Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Master File Change Document

Master File Change data are miscellaneous database elements that are not entered on a
personnel action or payroll document but may affect pay and personnel eligibilities of the
employee. The IRIS programs that display these elements are listed with the entry
instructions.

For more information, see:

Steps For Entering Master File Change Documents
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Steps For Entering Master File Change Documents

To enter a master file change document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Master File Change.

3. At the menu bar select, Edit > Add New Document. The Master File Change
window (Figure 4:24) is displayed with a selection list of fields that you can update.

Figure 4:24. Master File Change window

4. From the selection list, click the field (data element) to be updated. The field name
appears in Field Selected.

5. At Field Value, type the value for the selected field as indicated under Master File
Change Window Field Instructions.

6. After completing the fields, click [Yes] to save the entries and exit the action.
OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Multi Element Update Document

Multi element update data includes miscellaneous database elements that are not entered on a
personnel action or payroll document but used for reporting requirements as well as to denote
expertise in various fields. The IRIS programs that display these elements are listed with the
entry instructions.
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For more information, see:

Steps For Entering Multi Element Update Documents

Steps For Entering Multi Element Update Documents

To enter a multi element update document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Multi Element Update.

3. At the menu bar select, Edit > Add New Document. The Multi Element Update
window (Figure 4:25) is displayed with a selection list of fields that you can update.

Figure 4:25. Multi Element Update window

4. From the selection list, click the field (data element) to be updated. The field name
appears in  Field Selected.

5. At Field Value, type the value for the field selected as indicated under Multi Element
Update Window Field Instructions.

6. After completing the fields, click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.
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Net Pay Document

Net pay is the employee’s pay after deductions, which is transmitted through DD/EFT to a
financial organization. A net pay allotment is the direct deposit of net pay into a checking or
savings account at a financial organization through DD/EFT. Net pay is displayed in PINQ
Program 32, Payroll Listing.

If the routing number and/or account number that is received from the Department of the
Treasury does not agree with the routing number and/or account number currently on the
database, NFC will mail Report PINE5801, Notification of Change (NOC) Suspense Report,
to the employee’s personnel office. The personnel office should take action to correct this
report or the database record as appropriate.

For more information, see:

Changing Net Pay

Canceling Net Pay

Steps For Entering Net Pay Documents

Changing Net Pay

Once the employee is participating in direct deposit, an SF−1199A must be processed to:

• Change the employee’s depositor account number

• Change from a checking to a savings account or vice versa

• Change from one financial organization to another

• Change the routing number of a financial organization

Canceling Net Pay

To cancel a direct deposit authorization, enter the new check mailing address data or
designated agent code in the Employee Address window (Figure 4:2). You must enter the
new check mailing address or designated agent number, otherwise the salary will continue to
be disbursed to the financial organization through DD/EFT.

Steps For Entering Net Pay Documents

For instructions on entering Net Pay Documents, see Steps For Entering Financial Allotment
Documents.

Non-Federal Benefit Documents

Non-Federal benefits include non-Federal life insurance, flexible spending account,
retirement, thrift savings, and health benefits for eligible employees. For more information
about non-Federal benefits plans, see your agency’s instructions.
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For information about specific non−Federal benefit documents, see:

Non-Federal Benefit: Flexible Spending Account Document

Non-Federal Benefit: Health Document

Non-Federal Benefit: Life Insurance Document

Non-Federal Benefit: Retirement Document

Non-Federal Benefit: Thrift Savings Document

Non−Federal Benefit: Flexible Spending Account Document

Sections 125 and 129 of the Internal Revenue Code have authorized the Flexfund Flexible
Spending Account Program (a.k.a. Flexfund). The Flexfund Flexible Spending Account
Program allows employees to arrange for payment of qualifying expenses through biweekly
payroll deductions. This arrangement results in the deferral of the following taxes on these
payments: Federal income tax, Social Security (formerly OASDI), Medicare (formerly HIT),
and all state income taxes except New Jersey and Pennsylvania.

Flexible spending applies to the following agencies only. Refer to your agency instructions
for eligibility requirements.

• Office of the Comptroller of the Currency (OCC)

• Appalachian Regional Commission (ARC)

• Federal Deposit Insurance Corporation/Resolution Trust Corporation (FDIC/RTC)

• Farm Credit Administration/Farm Credit System Insurance Corporation (FCA/FCSIC)

• Office of Thrift Supervision (OTS)

For more information, see:

Flexfund Deductions

Insufficient Funds

Dependent Care And Health Care Expenses

Dependent Care Flexible Spending Account (DCFSA) And Health Care Flexible Spending
Account (HCFSA)

Steps For Entering Flexible Spending Account Documents

Flexfund Deductions

Eligible employees may elect to participate in Flexfund at the time of accession or during the
open season enrollment period. A separate document must be processed for each Flexfund
account. Flexfund deductions are for a term of 1 year beginning with the first pay period in
the tax year and ending with the last pay period of the tax year (usually Pay Period 25
through Pay Period 24). A new document must be processed at the beginning of each plan
year (tax year) indicating the plan code and the total annual amount to be deducted.

Biweekly deductions are the total annual amount divided by the number of pay periods in the
plan year. If an employee enrolls after the beginning of the plan year, biweekly deductions are
the total annual amount divided by the number of pay periods remaining in the plan year. If
the annual amount is not evenly divisible by the number of pay periods in the plan year, the
balance is deducted in the last pay period of the plan year.
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Flexfund deductions may be canceled at any time. The cancellation becomes effective the
first day of the pay period in which the cancellation is processed, and no Flexfund deduction
is made for that pay period. All Flexfund deductions are terminated automatically only upon
expiration of the one-year withholding period.

Insufficient Funds

If an employee is in nonpay status, deductions continue when the employee returns to duty.
One missed payment is deducted in the last pay period of the plan year along with the final
payment. If two or more payments are missed, the employee must contact the contractor to
make arrangements for the payments missed.

Flexfund deductions are considered voluntary allotments for the purpose of establishing
priority of deductions in accordance with OPM rules and the Treasury Fiscal Requirements
Manual. If an employee has both health care and dependent care deductions and pay is
insufficient to take both deductions, the health care deductions are taken first.

Dependent Care And Health Care Expenses

The Flexfund Flexible Spending Account (FSA) Program consists of two accounts:
dependent care expenses and health care expenses.

Dependent Care Flexible Spending Account (DCFSA) And Health Care Flexible
Spending Account (HCFSA)

All employees that are eligible for FEHB participation are eligible to participate in the FSA
Program. The FSA Program allows participants to have tax-free money for out-of-pocket
health care and dependant care expenses (i.e., deductibles, co-payments, dental care,
orthodontics, etc.) deducted from their pay. This money is put into an account and upon
receipt of the proper documentation, is reimbursed to the participant after the services are
rendered. There are two parts to the FSA Program, DCFSA and HCFSA.

DCFSA is money used for the care of dependant children under age 13 while the employee is
working. DCFSA also covers the care of an adult dependent who is physically or mentally
incapable of caring for himself/herself. In the case of adult care, the adult being cared for
must be claimed as a dependent on the participant’s income tax return. A minimum of $250
and a maximum of $5000 per year ($2500 per year if the employee is married and filing a
separate income tax return) may be contributed to a DCFSA account.

HCFSA is money used to cover health care expenses not paid by the employee’s FEHB or
other health insurance carrier. A minimum of $250 and a maximum of $4000 per year may be
contributed to an HCFSA account.

Participants must first determine the total annual amount to be deducted. The amount is then
divided by the number of pay periods for that year to determine the deduction(s) to be taken
each pay period. The total amount to be deducted must be carefully considered because any
unused money is forfeited at the end of each year. Employees have 90 days after the end of
the plan year to claim reimbursements for DCFSA transactions and 120 days after the end of
the plan year to claim reimbursements for HCFSA transactions.
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Note: Insurance premiums of any kind (i.e., FEHB, Medicare Part B, Tricare, etc.) do not
qualify for the FSA Program. Furthermore, any reimbursements received do not qualify for
deductions on an employee’s Federal income tax return.

OPM has contracted with Sykes Health Plan Services (SHPS) who will serve as the
administrator of the FSA Program. SHPS will handle all FSA transactions. Agency personnel
offices will not handle FSA transactions. Transactions should be directed to www.fsafeds.com
(24 hours per day, seven days per week) or 1−877FSAFEDS (1−877−372−3337) (between
9:00 a.m. and 9:00 p.m. Eastern Standard Time). All submitted claims must be accompanied
by proper documentation.

* * Elections made during an open seasons will be effective January 1 of the year following
the election. Participants will not be allowed to make an election outside of the open season
unless a qualifying life event occurs. Employees must re-enroll each year. If the employee
fails to re-enroll, the employee will not be allowed to participate in the FSA Program the
following year.

Other than reducing participating employees’ taxable income, there is no other impact on pay
or benefits as a result of Flexfund. Health care and dependent care amounts are not included
in the employee’s taxable income on the employee’s W−2, Wage and Tax Statement. Health
care expenses are included in the NT Health Ins (Not in Wages). Dependent care expenses are
listed separately on the W−2.

Steps For Entering Flexible Spending Account Documents

To enter a flexible spending account document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Non-Federal Benefit > Flexible Spending Account.

3. At the menu bar select, Edit > Add New Document. The Flexible Spending Account
window (Figure 4:26 ) is displayed.

Figure 4:26. Flexible Spending Account window
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4. Complete the Flexible Spending Account fields as indicated under Flexible Spending
Account Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Non−Federal Benefit: Health Document

Non-Federal health includes health insurance plans for certain eligible employees. DPRS is a
centralized automated system for collecting premiums from eligible non-Federal enrollees
who elect to participate in the FEHB program (e.g., former spouses). DPRS is a Federal plan
used by non-Federal enrollees. These transactions are not entered in the PPS by the agency.
For more information, see Federal Benefit: Health.

For more information, see:

Entry Guidelines For Non-Federal Health

Steps For Entering Non-Federal Health Documents

Entry Guidelines For Non-Federal Health

• To change from a Federal plan to a non-Federal plan or vice versa, enter a cancellation
for the current plan and a new enrollment. Process the cancellation before the new
enrollment.

• Do not enter a new enrollment, reinstatement, or transfer-in if the employee is on
military furlough.

• The plan code must be a non-Federal health plan code. TMGT Table 085 displays
non-Federal health benefit codes.

• The plan code must be compatible with the enrollment code.

• The plan code, type of appointment, and work schedule must be compatible.

• If the first 2 positions of the enrollment code is 47, 50, or 51, the type of
appointment code must be 01, 02, 06, or 07, and the work schedule must be
full-time or part-time.

• The Effective Date field must be:

• Equal to or later than the accession effective date

• Equal to or later than the last day of the processing pay period

• 90 days earlier than the first day of the effective pay period. If approved, Status
Code C or L will release the document from suspense.

• Do not enter a document for Trust intermittent employees (agencies 71, 73, and 77).

• Agencies 66, 68, 71, 73, and 77 must enter Y in the Tax Deferred Code field.
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• If the first two positions of the enrollment code is 19, and the last digit is 2 or 5, the
employee must be full-time.

• If the first 2 positions of the enrollment code is 19, 43, 68, or 70, the work schedule
must be full-time or part-time.

• If the first 2 positions of the enrollment code is 43, the appointment must be greater
than 180 days.

• If the first 2 positions of the enrollment code is 68 or 70, the appointment must be
greater than 364 days.

• Do not enter a waiver after a new enrollment has been processed.

Steps For Entering Non-Federal Health Benefit Documents

To enter a non-Federal health document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Non-Federal Benefit > Health Benefits. 

3. At the menu bar select, Edit > Add New Document. The Non-Federal Health Benefits
window (Figure 4:27) is displayed.

Figure 4:27. Non-Federal Health Benefits window

4. Complete the Non-Federal Health Benefits fields as indicated under Non-Federal
Health Benefits Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action

OR

Click [No] to exit the window and not save the entries.

OR
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Click [Cancel] to reopen the window.

Non-Federal Benefit: Life Insurance Document

The Non-Federal Life Insurance Program is a savings and investment plan for certain eligible
employees. Life insurance data is displayed in IRIS Program IR116, Life Insurance.

For more information, see:

Entry Guidelines For Non-Federal Life Insurance

Steps For Entering Non-Federal Life Insurance Documents

Entry Guidelines For Non-Federal Life Insurance

Use the following guidelines to enter non-Federal life insurance documents.

• Certain plan codes require the completion of the Option 1, Option 2, or Option 3 field,
while others require the field to be blank. Review your agency instructions.

• The plan code must be compatible with the agency.

• Certain plans require part-time employees to work at least 40 hours per pay period.

• The employee cannot participate in both Federal and non-Federal life insurance plans.

• The work schedule code must be F, P, or I and the type of appointment code must be
01, 02, 06, or 07 for plan code 45. All other type of appointment codes must have a
work schedule code of F.

• The appointment must be career or career conditional and the type of appointment
code must be 01, 02, 06, or 07 for plan code 46.

• The employee must be younger than 70 years of age for plan code 46.

Steps For Entering Non-Federal Life Insurance Documents

To enter a non-Federal life insurance document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Non-Federal Benefit > Life Insurance.

3. At the menu bar select, Edit > Add New Document. The Non-Federal Life Insurance
window (Figure 4:28) is displayed.
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Figure 4:28. Non-Federal Life Insurance window

4. Complete the Non-Federal Life Insurance fields as indicated under Non-Federal Life
Insurance Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Non-Federal Benefit: Retirement Document

Non-Federal retirement is a retirement savings and investment plan for certain eligible
employees.

For more information, see:

Entry Guidelines For Non-Federal Retirement

Steps For Entering Non-Federal Retirement Documents

Entry Guidelines For Non-Federal Retirement

• The maximum number of retirement plan enrollments is two.

• The appointment must exceed 90 days for plan code 23.

Steps For Entering Non-Federal Retirement Documents

To enter a non-Federal retirement document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.
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2. Select Non-Federal Benefit > Retirement.

3. At the menu bar select, Edit > Add New Document. The Non-Federal Retirement
window (Figure 4:29) is displayed.

Figure 4:29. Non-Federal Retirement window

4. Complete the Non-Federal Retirement fields as indicated under Field Instructions For
Payroll Documents, Non-Federal Retirement Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Non-Federal Benefit:Thrift Savings Document

Non-Federal thrift savings is a savings and investment plan for certain eligible employees.
The employee must be employed at least 180 days to participate.

For more information, see:

Steps For Entering Non-Federal Thrift Saving Documents

Steps For Entering Non-Federal Thrift Saving Documents

To enter a non-Federal thrift savings document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Non-Federal Benefit > Thrift Savings.
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3. At the menu bar select, Edit > Add New Document. The Non-Federal Thrift Savings
window (Figure 4:30) is displayed.

Figure 4:30. Non-Federal Thrift Savings window

4. Complete the Non-Federal Thrift Savings fields as indicated under Non-Federal Thrift
Savings Window Field Instructions.

5. After completing the fields, click [Yes] to save the entries and exit the action

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.
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Entering Payroll Documents (P−Z)

This section presents the following topics:

Performance Appraisal Documents

Savings Bond Documents

Savings Bond: Overview

Savings Bond: Document Processing

Severance Pay Document

Tax Documents

Tax: City

Tax: County

Tax: State

Tax: Territorial

Tax: Foreign Country (Republic Of Panama)

Tax: Earned Income Credit

Tax: Federal Income Tax

Union Dues Documents

Union Dues: Overview

Union Dues: Authorization Of Labor Organization Dues

Union Dues: Change Between Locals

Union Dues: Cancellation/Revocation Of Membership

Performance Appraisal Documents

Performance appraisals act as a guide to (1) recognize and reward quality work performance,
and (2) develop those employees that are not performing proficiently by providing training
and counseling. These transactions are processed for all employees.

The following IRIS Programs display performance appraisal data for users with access to
sensitive data:

IR304, Performance Evaluation Data

IR305, History Performance Evaluation Data

IR313, SES Performance Data

IR314, History Senior Executive Performance Data

A maximum of five performance appraisal records (IRIS Program IR313, SES Performance
Data) are stored in the database for SES employees. Four performance appraisals records are
stored for all other employees. BEAR must process for the current pay period before another
change to the same performance appraisal rating period can be entered.
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For more information, see:

Processing Tips For Performance Appraisals

Performance Appraisal: Non SES

Performance Appraisal: SES

Processing Tips For Performance Appraisals

CULPRPT includes several reports that pertain to performance appraisal processing. For
exhibits of all CULPRPT reports, see Title I, Chapter 20, Section 1. Several reports and
correspondence that pertain to performance appraisal processing are sent to agency locations.
See Title I, Chapter 20, Section 5, for exhibits of all payroll/personnel reports.

RFQS provides the Control Listing of Performance Evaluation Forms Prepared For Full Time
and Part Time Employees. This report should be verified by the agency personnel office for
accuracy. If the report is not accurate, an employee may be reported in error or not reported at
the proper time.

Performance Appraisal: Non SES

Performance appraisals are used to evaluate an employee’s performance. Form AD−435,
Performance Appraisal, is generated in advance of the rating period for all employees except
Senior Executive Service employees and those employees for whom their agencies have
made other arrangements. This advanced notification is sent to the agency personnel office
for evaluation of employees who are nearing completion of the agency established rating
period.

For more information, see Steps For Entering Non-SES Performance Appraisal Documents.

Steps For Entering Non-SES Performance Appraisal Documents

To enter a performance appraisal document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetical list appears.

2. Select Performance Appraisal > Performance Appraisal.

3. At the menu bar select, Edit > Add New Document. The Performance Appraisal
window (Figure 4:31) is displayed.
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Figure 4:31. Performance Appraisal window

4. Complete the fields as indicated under Field Instructions For Payroll Documents,
Performance Appraisal Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Performance Appraisal: SES

SES Performance Appraisal is used to enter SES performance appraisals and bonuses.
Review the RFQS control listing to confirm the employee’s evaluation is due before entering
the SES performance appraisal. An SF−50−B, NOAC 879, SES Performance Award, is
generated after the data is processed.

For more information, see Steps For Entering SES Performance Appraisal/Bonus
Documents.

Steps For Entering SES Performance Appraisal/Bonus Documents

To enter a performance appraisal and bonus:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents window. An alphabetical list appears.

2. Select Performance Appraisal > SES Performance Appraisal

3. At the menu bar select, Edit > Add New Document. The SES Performance Appraisal
window (Figure 4:32) is displayed.
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Figure 4:32. SES Performance Appraisal window

4. Complete the fields as indicated under SES Performance Appraisal Window Field
Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Savings Bond Documents

Savings bonds documents are used to enter U.S. Series EE and Series I Savings Bonds data
for deductions through the Payroll Savings Plan. Bond data is displayed in IRIS
Program IR108, Bonds. PAYE4704, Data For Preparation Of Semi-Annual Bond Report,
provides statistics pertaining to bond deductions. The bond account is reflected on the
employee’s AD−334, Statement of Earnings and Leave, and in the EARN system.

Savings Bond: Overview

Employees may purchase a maximum of 9 allotments for U.S. Series EE and Series I Savings
Bonds combined through voluntary participation in the Payroll Savings Plan. The Payroll
Savings Plan is an automatic system for installment purchases of Series EE and Series I
Savings Bonds through regular allotments (authorizations) set aside each pay period.
Employees may elect to enroll in the Payroll Savings Plan at any time.
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NFC electronically transmits savings bond information to the Federal Reserve Bank (FRB)
on the official Thursday payday. FRB prints and distributes savings bonds the following
week. Bond owners should receive their bonds within 10 working days after the official
payday in which the savings bond was purchased.

For more information on savings bonds, see:

Bond Account

Bond Purchase Price

Bond Inscriptions

Bond Authorization Number

Bond Transfer And Cancellation

Bond Nonreceipt

Destroyed, Lost, Stolen, Mutilated, Or Defaced Savings Bonds

Undeliverable/Returned Savings Bonds

Bond Address Change

Bond Account

The allotment amount specified by the employee is established when the initial bond is
entered. This amount is deducted from the employee’s salary each pay period. The allotments
are accrued in the employee’s bond account established in the PPS database until the full
purchase price of the bond has been accumulated. At that time, the bond is issued and mailed
to the designated bond owner. This cycle continues until the employee cancels the allotment
or terminates employment. Upon cancellation of the allotment or termination of employment,
the employee’s savings bond account is closed in the database.

If the accumulated amount exceeds the purchase price of the bond, the balance is carried
forward in the employee’s bond account and applied toward the next bond purchase. If any
portion of the amount cannot be equally applied toward the purchase of another bond, it is
refunded.

Bond Purchase Price

The purchase price of the Series EE bond is one-half of its face value as shown on the bond
card. Series EE Savings bonds may be purchased in the following denominations for the
respective purchase price as indicated.

Bond 
Denomination Purchase Price

$100.00 $50.00

$200.00 $100.00

$500.00 $250.00

$1000.00 $500.00

The purchase price of Series I is 100 percent of the face value. The denominations are $50,
$75, $100, $200, $500, and $1000.
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Bond Inscriptions

The savings bond inscription is the owner and/or coowner/beneficiary information printed on
the savings bond. This information is dictated by the employee. For each savings bond
allotment, the savings bond may be issued to a single owner inscription or with a rotating
inscription.

Single Owner Inscription Option

The single owner inscription option permits the employee to designate one savings bond
owner and zero or one coowner/beneficiary for a savings bond allotment. Each savings bond
purchased from one allotment will be issued to the designated bond owner. The owner and
coowner or beneficiary inscription will remain constant until the employee changes the
inscription, cancels that savings bond allotment, or terminates employment. The employee
may:

• Designate an adult or minor as the owner and/or coowner/beneficiary.

• Designate a fiduciary or an organization, private or public, as the owner. If the
institution is an employer, the employer identification number assigned to the Internal
Revenue Service must be entered on the bond card in lieu of the owner’s social
security number (SSNO).

Rotating Inscription Option

The rotating inscription option allows the employee to have the savings bond resulting from
one allotment issued to different designated owners and/or different coowners or beneficiaries
on a recurring, sequential cycle. The employee may designate one to nine owners and zero to
nine coowners and/or beneficiaries. The coowners or beneficiaries designations may be: zero
to nine coowners, zero to nine beneficiaries, or a combination of coowners and beneficiaries
totaling a maximum of nine (i.e., five coowners and four beneficiaries, three coowners and
six beneficiaries, etc.). Many issuing combinations are possible through the rotating
inscription option.

Each employee may have a maximum of nine separate savings bond accounts for Series EE
and Series I combined. Each savings bond account has two subdivisions (a savings bond
owner section and a coowner/beneficiary section).

For a new savings bond allotment under the rotating inscription option, as many as nine bond
cards may be required. Even though multiple bond cards are required to transact the rotating
inscription option, it is only assigned one authorization number.

The bond owner section may designate a total of nine separate savings bond owners. Savings
bonds are issued to a designated owner in a rotating sequential order. The owner rotation is
accomplished independently with the savings bond account.

The coowner/beneficiary section may have a total of nine coowners or nine beneficiaries, or a
combination of coowners and beneficiaries totalling a maximum of nine. The
coowner/beneficiary inscription is rotated with each savings bond issued and is also
accomplished independently with the bond account.

Naming multiple savings bond owners and/or multiple coowners/beneficiaries causes both
the savings bond owners and coowner/beneficiary inscriptions to change with each savings
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bond issued. Because the savings bond owner and coowner/beneficiary designation both
rotate independently with the employee’s savings bond account, the employee can determine
the issuing order and sequence by the procedure illustrated below.

1. List the savings bond owners in order of designation (savings bond owner Number 1,
2, etc.).

2. List the coowners/beneficiaries in a second column in order of designation, if
applicable.

3. List the savings bond to be issued and the inscription to be reflected on that savings
bond as the owner and coowner/beneficiary designation are rotated. Remember the
savings bond owner designation rotates independently as does the coowner/beneficiary
designation. (The table below depicts an example of a rotating inscription with six
bond owners and four coowners/beneficiaries.)

Savings Bond Owner Coowner/Beneficiary

1−John Snow 1−Karen Rain (coowner)

2−Susan Snow 2−Betty Rain (beneficiary)

3−Billy Snow 3−Sharon Rain (beneficiary)

4−Sally Snow 4−Randy Rain (coowner)

5−Mary Snow

6−Bob Snow

Inscription Reflected On Savings Bond When Issued

Savings Bond Issued Savings Bond Owner Coowner/Beneficiary

1 1−John Snow 1−Karen Rain

2 2−Susan Snow 2−Betty Rain

3 3−Bill Snow 3−Sharon Rain

4 4−Sally Snow 4−Randy Rain

5 5−Mary Snow 1−Karen Rain

6 6−Bob Snow 2−Betty Rain

7 1−John Snow 3−Sharon Rain

8 2−Susan Snow 4−Randy Rain

9 3−Bill Snow 1−Karen Rain

10 4−Sally Snow 2−Betty Rain

11 5−Mary Snow 3−Sharon Rain

12 6−Bob Snow 4−Randy Rain

Bond Authorization Number

An authorization number is assigned to each savings bond allotment. The authorization
number identifies the employee’s savings bond account in the database. The assigned
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authorization number will remain with that particular savings bond allotment until the savings
bond allotment is canceled. All future transactions affecting a specific savings bond allotment
must show the original assigned authorization number.

Each employee may establish a maximum of nine separate savings bond authorizations for
Series EE and Series I in the database. Individually, the savings bond allotment may be for
any amount equal to or greater than $3.75. For each authorization, the resultant savings bond
may be issued to a single owner or issued with a rotating inscription.

The authorization number assigned to each savings bond allotment plays an important role
when the employee wishes to enroll in the Payroll Savings Plan for savings bonds, change
any information for the savings bond allotment, or wishes to cancel the savings bond
allotment. Verify the authorization number in IRIS Program IR108 when processing a savings
bond allotment for an employee.

This includes new allotments to ensure that the employee has no savings bond allotments
established in the database and that Authorization Number 1 can be used. If the new savings
bond allotment is for an employee who has established savings bond allotments in the
database, the next sequential number should be used for the authorization number.

Bond Transfer And Cancellation

An employee who transfers from one department to another department is treated as an
accession (this includes departments serviced by the USDA PPS). If the new employee
wishes to continue and/or start savings bond allotment(s), enter the bond data from the bond
card.

Once established, a savings bond authorization continues until the employee cancels the
allotment or terminates employment with the department. Intradepartmental movement
(changes in personnel office, agency, duty, station, etc.) does not effect the savings bond
allotment(s). The employee’s savings bond record in the database is automatically updated
when the payroll/personnel changes are processed. No action is required at the time of the
intradepartmental reassignment unless the reassignment results in a change of address of a
designated bond owner. In such cases, enter the data to change the bond inscription(s).

If an employee is transferring to an agency outside the department, retiring, or resigning, the
savings bond allotment(s) are automatically canceled. Any balance remaining in the
employee’s bond account will be included in the final salary payment. If the employee
transfers and wishes to continue voluntary participation in the Payroll Savings Plan, a bond
card must be completed and submitted to the gaining organization (this includes departments
serviced by the USDA PPS).

In the event of death, the balance remaining in the savings bond account is included in the
balance paid to the survivors or an estate.

Bond Nonreceipt

If a savings bond has not been received within 30 days after the expected delivery date, the
employee should contact the agency personnel office. If the bond has not been returned to the
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agency personnel office, the agency personnel office should request the savings bond serial
number from NFC through SPPS. The serial numbers are needed to complete the Department
of the Treasury’s claim form.

If the savings bond has not been received between 31 and 120 days after the expected
delivery date, Form PDF 3062, Claim for Relief on Account of Loss, Theft, or Destruction of
United States Savings Bonds After Valid Issue but Prior to Receipt by Owner, Coowner, or
Beneficiary, must be completed. This form can be obtained from the local servicing Federal
Reserve Bank. The completed form should be sent to:

Federal Reserve Bank
Pittsburgh Branch
P.O. Box 299
Pittsburgh, PA 15219

OR

Federal Express Form PDF 3062 to the following address:

Federal Reserve Bank
Pittsburgh Branch
717 Grant Street
Pittsburgh, PA 15230

Claims routed to the Federal Reserve Bank, Pittsburgh Branch with issue dates of more than
120 days old are returned to the agency since these claims are handled by the Bureau of the
Public Debt. The agency should assist the employee in completing Form PDF 3062−4,
Claims for Relief on Account of the Nonreceipt of United States Savings Bonds. This form
can be obtained from the local servicing Federal Reserve Bank. The completed form should
be sent to:

Bureau of the Public Debt
Parkersburg, WV 26106−1328

If the original savings bond is received in the interim before relief is granted, the claimant
should promptly notify Treasury in writing at the address mentioned above. If the application
can be canceled in time, no replacement savings bond will be issued.

If the original savings bond is received after the replacement savings bond, the original
savings bond should be forwarded promptly to the Department of the Treasury with a letter
explaining the reason for the return.

Destroyed, Lost, Stolen, Mutilated, Or Defaced Savings Bonds

A request for a replacement savings bond must be prepared only if the savings bond was
received by the owner or representative and was subsequently destroyed, lost, stolen,
mutilated, or defaced.

To initiate the replacement of a savings bond, the owner must prepare Form PDF 1048,
Application for Relief on Account of Loss, Theft, or Destruction of United States Savings
and Retirement Securities. This form can be obtained from the local servicing Federal



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 4

P
ayro

ll D
o

cu
m

en
ts

4:81Entering Payroll Documents (P−Z)Updated 01/08

Reserve Bank. The employee should follow the instructions attached to the form and submit
the form and the defaced savings bond and all available fragments of a mutilated savings
bond, in any form whatsoever, to the following address:

Bureau of the Public Debt
Parkersburg, WV 26106−1328

A replacement bond request because of loss or theft ordinarily is not issued by the
Department of the Treasury until 6 months after the date of receipt of the notice of loss or
theft.

If a savings bond reported lost, stolen, or destroyed is subsequently recovered before the
replacement savings bond is received, the claimant should promptly notify the Department of
the Treasury in writing. If the application can be canceled in time, no replacement is issued.

If the original savings bond is received after the replacement savings bond, the original
savings bond should be forwarded promptly to the Department of the Treasury with a letter
explaining the reason for the return. In all cases, if a replacement savings bond has been
issued for an original savings bond, the replacement savings bond is the only one honored by
the Department of the Treasury for redemption purposes.

Undeliverable/Returned Savings Bonds

All undeliverable savings bonds are returned to the Department of the Treasury. The
Department of the Treasury returns the original savings bond to NFC for handling.

Upon receipt of undeliverable savings bond, NFC will determine which agency personnel
office services the employee. The original savings bond is then forwarded to the employee’s
agency personnel office with a memorandum that provides instructions for sending the
savings bond to the employee and asking that the employee’s savings bond address be
corrected. A bond card must be completed to change an address for savings bond allotments.
An employee address document will not change an address for a savings bond allotment.

The agency personnel office should give the original savings bond to the employee, if
possible. If the savings bond cannot be given to the employee (e.g., the employee is at
another location, separated, etc.) the agency should make every effort to notify the employee
of the undeliverable/returned bond so that arrangements can be made to deliver the bond to
the employee.

Have the employee complete a bond card to correct the address and enter the address in the
system. If a subsequent savings bond is issued before the inscription is changed, it is also
returned to the Department of the Treasury and then to NFC. This procedure continues until
the address is corrected; therefore, it is important to correct the employee’s address in the
PPS as soon as possible.

If the agency personnel office is unable to contact the employee within 90 days after the
savings bond issue date, forward the savings bond to the Bureau of the Public Debt,
Parkersburg, WV 26106−1328, using Form PD 4581 ABC, Forwarding Item Transmittal −
U.S. Savings Bonds/Notes − Retirement Plan Bonds − Individual Retirement Bonds. The
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Remarks block should be annotated with a description of the efforts made to deliver the bond
(e.g., “Attempted to contact employee at last known address.”). This form can be obtained
from the local servicing Federal Reserve Bank.

Forward a deceased employee’s bond to the coowner or beneficiary, if any, and obtain a
receipt. If the savings bond cannot be delivered within 30 days to a coowner or beneficiary, or
it is in a single ownership form, it should be returned to NFC with a statement indicating why
the bond cannot be delivered. NFC will then forward this information to the Bureau of the
Public Debt. A 90-day waiting period is not necessary in this case.

Bond Address Change

Enter a change in inscription to change an address for a savings bond allotment.

Note: Processing an employee address document does not change an address for a savings
bond allotment.

Savings Bond: Document Processing

Savings bonds documents are used to add new bonds, update bond data, and cancel existing
bonds. For more information, see:

Adding A New Bond

Changing An Inscription/Denomination/Allotment

Canceling A Bond

Canceling An Owner/Coowner

Adding A New Bond

The initial bond establishes the bond record and account. After the record is established,
subsequent bonds update the bond account as applicable.

Entry Guidelines For A New Bond

• The initial bond authorization number should be 1 indicating the first bond to be
processed. Multiple bond authorizations are numbered sequentially (i.e., 2, 3, etc.).

• Verify the authorization number in IRIS before entering the bond data to ensure the
correct bond is being entered or updated.

Changing An Inscription/Denomination/Allotment

Bond changes in inscription, denomination, and allotment are the result of a change to the
(1) coowner/owner information, and/or (2) bond denomination, or (3) bond allotment.
Employees may change their inscriptions for a savings bond at any time.

Changing An Authorization Number

The authorization number of the savings bond on which the owner and/or
coowner/beneficiary is being changed must be identical to the original savings bond
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allotment established in the database. The owner number and/or coowner/beneficiary number
to be changed must also be identical to the original savings bond established in the database.
Verify the authorization, owner, and coowner/beneficiary number(s) on IRIS Program IR108.

Correcting An Inscription

Upon receipt of a U.S. Savings Bond, the owner should examine the savings bond to ensure
the social security number and the names of the owner and coowner/beneficiary are correct.

If any portion of the inscription is incorrect, the owner should immediately report the error(s)
to the agency personnel office for proper handling with NFC. Upon being notified that an
error has occurred in the savings bond inscription(s), agency personnel offices should take
one of the following actions:

• If the savings bond is not received due to an erroneous savings bond inscription,
contact the Payroll Personnel Operations Section at NFC for the following
information: the inclusive number series in which the savings bond was issued, the
issue date, the SF−1166, Voucher and Schedule of Payments, schedule number, the pay
period in which issued, and the correct inscription. Forward the signed letter with the
additional data to the Department of the Treasury.

OR

• If the bond is received with an erroneous inscription, submit the original savings bond
under cover of Form AD−354, Request For Information, to the Payroll/Personnel
Operations Section at NFC. Annotate on the Form AD−354 the correct savings bond
inscription(s) and request a replacement bond be issued. Make a copy of the original
bond for your files.

Have the employee complete a bond card to correct the inscription for any future savings
bonds and enter the inscription change to update the database.

Upon being notified by the agency personnel office on receipt of the original savings bond,
NFC will begin replacement procedures by preparing Treasury Form RO−258, Request For
Issuance or Cancellation of U.S. Savings Bond, to accomplish bond corrections. The RO−258
will be certified and submitted to the Federal Reserve Bank, Pittsburgh Branch, with the
original savings bond. The RO−258 is to be completed by NFC only.

For denomination and allotment changes, see Changing An
Inscription/Denomination/Allotment.

Canceling A Bond

A bond is canceled when an employee elects to discontinue deductions for a specific bond.
Employees may cancel their savings bond allotment(s) at any time. Savings bond deductions
will normally discontinue in the pay period selected. However, if the deduction amount for
the pay period will complete the purchase price of the savings bond, the allotment amount for
that pay period will be withheld and a savings bond will be issued. The cancellation will take
effect at the beginning of the next pay period. If the savings bond allotment for each pay
period amounts to the full purchase price of the bond, no deduction will be withheld and the
cancellation will be effective as of the beginning of the pay period selected.
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Entry Guidelines For Canceling A Bond

• The authorization number for the savings bond being canceled must be identical to the
original savings bond allotment established in the database. Verify the authorization
number on IRIS Program IR108.

• If the employee has authorized two or more savings bond allotments, do not attempt to
change the authorization numbers if one of them should be canceled. For example, if
an employee has three savings bond allotments and cancels Authorization Number 2,
the remaining authorization numbers would be 1 and 3.

Canceling An Owner/Coowner

The employee may elect to cancel an owner, coowner, or beneficiary for a bond
authorization. Access IRIS Program IR108 to ensure the correct bond is being updated.

Entry Guidelines For Canceling An Owner/Coowner

The authorization number of the savings bond for which the owner, coowner, or beneficiary
is being canceled must be identical to the original savings bond authorization.

Savings Bond: Document Entry

The Savings Bond Authorization window (Figure 4:33) is used for all savings bond document
entry. Owner, coowner, and beneficiary data is entered on related pop-ups. For entry
instructions on savings bond documents, see:

Steps For Entering Savings Bond Documents

Adding Owner, Coowner, And Beneficiary Information

Viewing Owner Or Coowner/Beneficiary Detail Data

Updating Owner Or Coowner/Beneficiary Data

Deleting An Owner Or Coowner/Beneficiary

Steps For Entering Savings Bond Documents

To enter a savings bond document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetic list appears.

2. Select Savings Bond > [applicable authorization].

3. At the menu bar, select Edit > Add New Document . The Savings Bond Authorization
window for the selected authorization (Figure 4:33) is displayed.
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Figure 4:33. Savings Bond Authorization window (for new, change, and cancellation)

4. Complete the fields as indicated under Savings Bond Authorization Window Field
Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.
OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Adding Owner, Coowner, And Beneficiary Information

To add owner or coowner/beneficiary information after saving bond data is
entered:

1. At the Savings Bond Authorization window (Figure 4:33), click View > Owners or
View > Coowners/Beneficiaries. The applicable List pop-up (Owner or
Coowners/Beneficiaries appears. (See the example in Figure 4:34).

Figure 4:34. List pop-up (for Coowners/Beneficiaries)
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2. Click [Add].

• If you selected View > Owners at the Savings Bond Authorization
window (Figure 4:33), the Owner Information pop-up (Figure 4:35) appears.

Figure 4:35. Owner Information pop-up

• If you selected View > Coowners/Beneficiaries at the Savings Bond Authorization
window (Figure 4:33), the Coowner/Beneficiary Information pop-up (Figure
4:36 ) appears.

Figure 4:36. Coowner/Beneficiary Information pop-up

3. Complete the fields according to the applicable instructions. (See Owner Information
Pop-up Field Instructions or Coowner/Beneficiary Information Pop-up Field
Instructions).

4. After completing the fields, click [Save] to save the entries and return to the List
pop-up (Figure 4:34). The bond owner or coowner/beneficiary name and SSN are now
displayed.

Note: The Total Number Of Owners and the Total Number Of Coowners/Beneficiaries
fields on the Savings Bond Authorization window (Figure 4:33) are system generated
based on the number of owners and/or coowners/beneficiaries entered.
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5. To add another record, click [Add] at the List pop-up (Figure 4:34) to display the
applicable entry pop-up.

OR

To return to the Savings Bond Authorization window (Figure 4:33), click [Close].

Viewing Owner Or Coowner/Beneficiary Detail Data

To view detail data for an owner or coowner/beneficiary:

1. At the Savings Bond Authorization window (Figure 4:33), click View > Owners or
View > Coowners/Beneficiaries. The applicable List pop-up (Owner or
Coowners/Beneficiaries) appears. (See Figure 4:34).

2. Click [Detail] to view owner or coowner/beneficiary bond detail data.

3. After viewing the data, click [Cancel] to return to the List pop-up (Figure 4:34).

4. To view another record, click [Detail] at the List pop-up (Figure 4:34) to display the
applicable entry pop-up.

OR

To return to the Savings Bond Authorization window (Figure 4:33), click [Close].

Updating Owner Or Coowner/Beneficiary Data

To update data after saving a bond and exiting the bond record, select View > Update
Document at the EPIC Navigation window (Figure 1:4). To update after PINE processes,
display the Search pop-up (Figure 1:7) and select All Documents at the EPIC Status field.
Select the bond to be updated from the document list. If the bond has not applied, the data
can be updated using the following instructions.

To update owner and coowner names and SSNs:

1. At the Savings Bond Authorization window (Figure 4:33), click View > Owners or
View > Coowners/Beneficiaries. The applicable List pop-up (Owner or
Coowners/Beneficiaries) appears. (See Figure 4:34).

2. Select the name and click [Update].

• If you selected View > Owners at the Savings Bond Authorization
window (Figure 4:33), the Owner Information pop-up (Figure 4:35) appears.

• If you selected View > Coowners/Beneficiaries at the Savings Bond Authorization
window (Figure 4:33), the Coowner/Beneficiary Information pop-up (Figure
4:36 ) appears.

3. Update the fields according to the applicable instructions. (See Owner Information
Pop-up Field Instructions or Coowner/Beneficiary Information Pop-up Field
Instructions).

4. After updating the fields, click [Save] to save the entries and return to the List
pop-up (Figure 4:34).
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5. To update another record, click [Update] at the List pop-up (Figure 4:34) to display the
applicable entry pop-up.

OR

To return to the Savings Bond Authorization window (Figure 4:33), click [Close].

Deleting An Owner Or Coowner/Beneficiary

To delete an owner or coowner/beneficiary:

1. At the Savings Bond Authorization window (Figure 4:33), click View > Owners or
View > Coowners/Beneficiaries. The applicable List pop-up (Owner or
Coowners/Beneficiaries) appears. (See Figure 4:34).

2. Select the record to be deleted and click [Delete]. The Confirm Deletion pop-up
appears with the message Continue With Delete?.

3. Click [OK] to delete the record. The name and SSN disappear from the list.

Severance Pay Document

Severance pay applies to employees who are involuntarily separated from service other than
removal for cause on charges of misconduct, delinquency, or inefficiency. IRIS
Program IR134, Severance Payment, displays severance payments made in the PPS; IRIS
Program IR135, Severance Pay Computation, displays a computation of severance pay based
on the salary data in the database.

For more information, see:

Entry Guidelines For Severance Pay

Steps For Entering Severance Pay Documents

Entry Guidelines For Severance Pay

Following are guidelines for processing severance pay data.

• Once it has been determined that the employee is entitled to severance pay, process the
personnel action and enter Remarks Code N22, Entitled to $ (amount) severance pay
fund to be paid at the rate of $ (amount) per week over (number) weeks beginning
(date). The Severance Pay window (Figure 4:37) is displayed when remark code N22
is entered on the personnel action. To update severance pay data after the action has
been entered, use the payroll document option.

• Calculate the severance payment and/or access IRIS Program IR135 to obtain and/or
verify the calculation.

Steps For Entering Severance Pay Documents

To enter a severance pay document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetic list appears.
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2. Select Severance Pay.

3. At the menu bar, select Edit > Add New Document. The Severance Pay
window (Figure 4:37) is displayed.

Figure 4:37. Severance Pay window

4. Complete the fields as indicated under Severance Pay Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Tax Documents

Tax documents are processed for local, Federal, and foreign taxes. Taxes are withheld each
pay period through payroll deduction based on a formula or a percentage of earnings.

The Department of the Treasury has entered into an agreement with local taxing entities (city,
county, state, territorial, and the Republic of Panama) for mandatory tax withholding based
on place of employment (i.e., duty station). The employee should complete the applicable tax
form to authorize withholding and claim exemptions, as applicable. In most cases, taxes are
withheld each pay period based on the processing of a tax document. If a document is not
processed, the PPS withholds taxes at the highest rate applicable. Withholding formulas are
located on the NFC home page at www.nfc.usda.gov under NFC Pubs and Forms.
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A tax record is established at the time the accession personnel action and/or tax form are
processed. Some local taxes are computed based on a percentage of gross wages or on a
specific dollar amount designated by the taxing entity and do not require the declaration of
exemption information. In these cases, the entry of a tax certificate is not required.

For more information, see:

Processing Tips For Taxes

Steps For Entering Tax Documents

Processing Tips For Taxes

For processing purposes, the tax year usually begins in Pay Period 25 and ends in Pay
Period 24 because payments made during this timeframe are payments made within one year.
All taxes withheld for those inclusive pay periods are reported on the W−2, Wage and Tax
Statement.

A new tax certificate may be processed at any time to change an employee’s tax information.
If the employee’s duty station or residence changes and the new local tax location has an
agreement with Treasury for mandatory withholding, a new tax certificate should be
processed. All previously processed exemptions, additional withholdings, etc., will be
removed and must be reprocessed, if applicable. If a new tax certificate is not processed, the
PPS will begin withholdings at the highest taxable rate if the duty station has a mandatory tax
withholding agreement.

Voluntary Withholding

Several taxing entities that do not have agreements with the Secretary of the Treasury have
been established in the database for voluntary tax withholding. Tax data must be processed
for these entities for taxes to be withheld. Voluntary withholding is based on residence. An
employee may voluntarily elect to pay tax based on residence if:

• The residence city, county, or state is established in TMGT

• The mandatory duty station tax is waived (if allowed)

• The residence tax locality on the tax form agrees with the residence tax locality of the
duty station

Additional Withholding

Employees may authorize an amount to be withheld from their salary each pay period in
addition to the amount automatically withheld in accordance with the income tax formula.
Most exemption certificates allow for additional withholding. This dollar amount is entered
in the Additional Amount field of the applicable income tax certificate window.

Note: Exemptions must be claimed when indicating additional withholding.

Viewing Processed Data For Taxes

To view biweekly tax withholdings, access PINQ Program PQ032, Payroll Listing. To view
year-to-date tax withholding data for the tax year, access EARN. To view tax data after the
document is processed, access the following IRIS programs:
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• IR104, Earned Income Credit and Federal Tax

• IR105, State and territorial taxes

• IR106, City Tax

• IR107, County Tax

TMGT Tax Tables

The following TMGT tables validate tax data for processing tax documents in the PPS:

• Table 007, City Tax, City Name and Address

• Table 008, County Tax, County Name And Address

• Table 009, State Tax Name And Address

Steps For Entering Tax Documents

One window is used to process all types of taxes (Federal, state, local); however, the window
heading changes and fields become inactive, based on the type of tax being processed.

Reminder: Inactive fields are gray and protected from entry.

To enter a local, state, or Federal income tax certificate, or an earned income
credit:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetic list appears.

2. Select Tax > [City Tax, County Tax, Earned Income, Federal Tax, or State Tax].

3. At the menu bar, select Edit > Add New Document. The applicable window (Figure
4:38) is displayed.
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Figure 4:38. Tax Certificate window (for local, state, and Federal taxes and earned
income credit)

4. Complete the fields as indicated under Tax Certificate Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Tax: City

City tax is withheld for the city in which an employee works or resides. City tax data is
required if:

• Exemption status (marital status and/or number of exemptions) is required in the
computation of the tax

• The employee is exempt from withholding

• The employee authorizes additional withholding

• The employee reduces the tax withholding by estimating a percentage of work
performed outside the duty station city

• The employee is voluntarily electing city tax
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For more information, see Processing Tips For City Tax.

Processing Tips For City Tax

If an employee is transferring into the PPS or transferring from one Department to another
within the PPS, the city taxes deducted YTD should be carried forward to the PPS to prevent
overpayment of city tax for cities that have maximum annual tax amounts. For information
about entry of YTD data, see Master File Change Document.

Mandatory Withholding Of City Tax

Withholding of city tax may be based on (1) duty station only, (2) residence only, or (3) both
duty station and residence. This is determined by the city taxing authority. If an employee’s
duty station and residence have mandatory city taxes, the duty station city tax will take
precedence.

Exemption Status For City Tax

If the city ordinance contains provisions which allow an employee to waive or claim
exemption from the tax, an exemption certificate or FMS−7311 must be processed indicating
the employee is not liable for the tax. Enter the duty station city tax document to waive
liability before entering the city tax document for the residence city. Type XT in the Total
Number of Allowances Claimed field.

Reduced City Tax For Work Performed Outside The Duty Station

A city tax reduction is allowed if the employee performs 25 percent or more of their work
outside the duty station city and wishes to have the withholding amount reduced to the
appropriate tax liability. Enter the percentage of time the employee works outside the duty
station city in the percent of annual compensation for services performed outside the city?
field. If this data is not entered, taxes will be withheld on the total wage amount.

Tax: County

County tax is withheld for the county in which an employee works or resides. County tax
data must be entered if:

• The employee is exempt from withholding

• The employee wants to authorize additional withholding

• The employee wants to reduce the amount of tax withholding by estimating a
percentage of work performed outside the duty station county

• The employee resides or works in Clay or Greene county in Indiana

• The employee is voluntarily electing county tax withholding

For more information, see Processing Tips For County Tax.
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Processing Tips For County Tax

If an employee is transferring into the PPS or transferring from one Department to another
within the PPS, the county taxes deducted YTD should be carried forward to the PPS to
prevent overpayment of county tax for counties that have maximum annual tax amounts. For
information regarding entry of YTD data, see Master File Change Document.

Mandatory Withholding For County Tax

Mandatory withholding is based on the county code in the database. If a county tax document
is not entered, withholding will be based on the highest rate applicable for the county. Most
mandatory county taxes are computed based on a percentage of gross wages and do not allow
for the declaration of exemptions (except Clay and Greene Counties in Indiana); therefore,
the processing of county tax data is not required. If a tax certificate is not processed,
withholding is based on zero exemptions.

Voluntary County Taxes

Employees whose duty station or residence is located in certain counties may voluntarily
elect county tax withholding. A county income tax certificate must be processed to declare
the dollar amount or a number of exemptions.

If an employee is subject to mandatory withholding in another county, a waiver must be
processed for the mandatory county before election can be made for the voluntary county.

Refer to the tax formulas on the NFC home page for a list of voluntary counties.

Waiver/Exemption From Withholding For County Tax

If the county ordinance contains provisions which allow an employee to waive or claim
exemption from the tax, an exemption certificate or FMS−7311 must be processed indicating
the employee is not liable for the tax. Enter the duty station county tax document to waive
liability before entering the county tax document for the voluntary residence county. Type
XT in the Total Number Of Allowances Claimed field.

Reduced County Tax For Work Performed Outside The Duty Station

A county tax reduction is allowed if the employee performs 25 percent or more of their work
outside the duty station county and wishes to have the withholding amount reduced to the
appropriate tax liability. Enter the percentage of time the employee works outside the duty
station city in the “Percent Of Annual Compensation For Services Performed Outside The
County/City” field. If this data is not entered, taxes will be withheld on the total wage
amount.

Tax: State

State income tax is withheld on a mandatory basis when the duty station state is one that has
entered into a withholding agreement with the Secretary of the Treasury. A state tax
certificate should be entered to begin withholding; otherwise, the system will automatically
withhold based on the duty station at the highest rate applicable for the state. For state tax
formulas go to the NFC home page at www.nfc.usda.gov under Pubs and Forms.
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The basis for state tax withholding are as follows as shown on the state withholding formulas,
as applicable:

• Marital status and number of exemptions/ allowances/dependents

• Wage bracket

• Percentage of Federal tax

• Percentage of annual wages

For more information, see:

Processing Tips For State Tax

Entry Guidelines For State Tax

Processing Tips For State Tax

An employee may be exempt from withholding of state tax on the basis of limited earnings or
other reasons determined by the state. If exemption is allowed by the state, type ONL in the
Total Number Of Allowances field, to indicate the employee is exempt from withholding.

Some states do not provide state withholding exemption certificates for establishing an
exemption status; others do not require the processing of state tax withholding data since the
income tax formulas are based on a percentage of Federal income tax, Federal exemption
status, or a percentage of annual wages. If the state tax withholding is based on the Federal
withholding and a IRS Form W−4 , Withholding Certificate, is not processed, Federal and
state income taxes will be automatically withheld at the rate of single with zero exemption
until a W−4 is entered for processing.

If an employee is reassigned or changes duty stations to a new state, city, etc., tax documents
must be processed.

Unless otherwise indicated, state tax deductions for lump sum payments and cash awards are
withheld based on the employee’s state tax exemptions recorded in the database.

Note: State income tax is grossed up at the rate of 2% on all individual and group spot cash
awards and bonuses.

Certificate Of Nonresidence For State Tax

States with reciprocal agreements have agreed that if taxes are withheld for the residence
state, taxes will not be withheld for the duty station state. A certificate of nonresidence allows
an employee to declare nonresidency for the duty station state to have taxes withheld for the
residence state.

State laws and regulations should be checked to determine if reciprocal agreements are in
place before processing a certificate of nonresidence for an employee. In most cases, the
employee must reside in one of several designated states to be exempt from the mandatory
withholding provisions of their duty station state.

If an employee’s duty station changes, the certificate of nonresidence in effect at that time
will become void, and a new certificate is required for the new duty station state (if
applicable).
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Each certificate of nonresidence is to be completed following the instructions on the
individual form. Enter the duty station state tax document to waive liability before entering
the state tax document for the residence state. Type WAV (waiver) in the Total Number of
Allowances Claimed field.

Dual State Tax Voluntary Withholding

Dual state tax withholding allows employees to voluntarily elect to pay state tax in both their
duty station and residence states. If state income tax is currently being withheld based on the
duty station and a state tax form is entered to begin withholding for the residence state, the
document will appear in suspense with an informational message indicating the document
entered will result in dual state tax deductions. To release the document, type C in the Status
Code field.

The AD−304, Request and Authorization for Allotments of Compensation for State Income
Tax Purposes, serves as a certification that the employee is authorizing voluntary withholding
from his/her pay and must accompany the appropriate state withholding exemption
certificate. The AD−304 can also be used to record the voluntary state tax withholding data in
cases where the state does not provide a form for the declaration of withholding.

If the AD−304 is used to record voluntary state tax data in lieu of a state tax certificate, the
State Tax Withholding State Code, the Total Number of Allowances, and the Additional
Amount (if applicable) must be indicated on the form when signed by the employee.

Cancellation Of Voluntary Withholding

Voluntary state tax withholding will terminate if:

• An employee’s duty station state changes (the certificate of nonresidence is now void).

• The state revokes its tax withholding law.

• An exemption from withholding certificate is processed (ONL in the Total Number Of
Allowances field).

• A cancellation of voluntary withholding is processed (CAN in the Total Number Of
Allowances field).

Coding State Tax Forms

Data from individual state tax certificates is entered in the system. Since each state has its
own form, special coding instructions may be required for entry of the data. Individual state
tax formulas and coding instructions can be found on the NFC home page at
www.nfc.usda.gov under NFC Pubs and Forms.

Those states that use form W−4 as the state tax form should annotate the state name and code
on the W−4 to not confuse it with the actual Federal form W−4. Follow the instructions on
the W−4 to determine the employee’s Total Number of Allowances (marital status and total
number of allowances), Additional Amount (additional amount to be deducted each pay
period), and other data needed for entry.
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Entry Guidelines For State Tax

Following are guidelines for entering state tax data.

• State code on tax document and duty station must agree to begin tax deductions.

• The state code on a waiver or a cancellation to voluntary state tax must be the same as
the duty station state code on the database.

• The state code on a voluntary withholding state tax document must be the same as the
residence state code on the database. A waiver must be processed for the duty station if
the duty station state is a taxable state and not the same as the residence state.

• Verify in IRIS Program IR105 that the Status Duty State field reflects 1 or 3 which
indicates the state has an agreement with Treasury. If the code is other than 1 or 3, a
state tax document cannot be processed to begin or update tax data except for
presidential appointees, NOAA field employees, DoC wage marine employees, and
overseas employees payrolled by NFC.

• Cannot enter an additional amount for certain states (e.g., Mississippi).

• Type C in the Status Code field to release an approved dual state tax document from
suspense. If not approved, type 4 in the Status Code field to delete the erroneous
document. If the state tax record on the database is to be deleted, enter a waiver for this
record.

Tax: Territorial

Territorial income tax is withheld on a mandatory basis for the following duty stations:

• Virgin Islands

• Guam

• Northern Mariana Islands

The Federal income tax formula is used to compute the territorial income tax for the Virgin
Islands, Guam, and Commonwealth of Puerto Rico Northern Mariana Islands. The proceeds
are remitted to the respective governments.

For more information, see:

Entry Guidelines For Territorial Tax

Entry Guidelines For Puerto Rico Tax

Entry Guidelines For Territorial Tax

• To begin tax withholdings for these entities, use form W−4 coded as a territorial
income tax document and enter the data in the State Income Tax Certificate window. If
a tax document is not processed at the time of accession, withholding will be made on
the basis of single with zero exemptions until the territorial income tax data is entered.

• A new W−4 can be processed at any time to change an employee’s exemption status. If
the employee’s duty station changes, process a new tax document for the appropriate
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territory. If an employee’s duty station changes from the Virgin Islands, Guam, or the
Northern Mariana Islands, to a state within the United States, enter a W−4 Federal
income tax document to begin withholding.

• Employees having income tax withheld for the Virgin Islands, Guam, and the Northern
Mariana Islands may be exempt from Federal income tax withholding. Contact the
appropriate territorial taxing authority to determine if the employee is exempt from
Federal income tax.

• If the employee is qualified to be exempt, enter a W−4 coding the Total Number Of
Allowances Claimed field with XT. A new W−4 must be processed before February 15
each tax year to prevent Federal income tax withholding in the first pay period of the
new tax year.

Entry Guidelines For Puerto Rico Tax

The Commonwealth of Puerto Rico and the Secretary of the Treasury have an agreement for
mandatory tax withholding for employees whose duty station is Puerto Rico. Puerto Rico tax
is withheld in accordance with the withholding formula. The withholding formula is located
on the NFC home page at www.nfc.usda.gov under NFC Pubs and Forms.

Special coding is required to identify public employees who contribute to a government
retirement system and private employees who do not contribute to a government retirement
system. For more information, see Tax Certificate Window Field Instructions.

Federal tax can be withheld in addition to Puerto Rico taxes. If an employee is exempt from
Federal tax, a Federal tax exemption certificate must be filed prior to February 14 each year
to retain the exemption status; otherwise, withholdings will be based on the maximum
withholding rate.

Tax: Foreign Country (Republic Of Panama)

The Republic of Panama and the Secretary of the Treasury have entered into an agreement for
the mandatory withholding of foreign country tax withholding Currently, the Republic of
Panama is the only foreign country income tax being withheld by NFC. In order for the
Republic of Panama income tax to be withheld, the employee’s duty station in the database
must be Panama. For the Republic of Panama tax formula, go to the NFC home page at
www.nfc.usda.gov under NFC Pubs and Forms.

For more information, see Processing Tips For Foreign Country Tax.

Processing Tips For Foreign Country Tax

Foreign country tax data should be established at the time of the accession personnel action
or at the time an employee changes duty stations. If at the time these actions are processed the
employee has not filed the appropriate foreign country tax certificate, withholding will
automatically begin at the rate of single with no exemptions.
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Employees whose duty station is in the Republic of Panama may be exempt from Federal
income tax withholding. If so, a Form W−4 must be processed coding the Total Number Of
Allowances Claimed field with XT. A new certificate must be processed prior to February 15
of each year to ensure the employee’s exempt status for Federal income tax.

Tax: Earned Income Credit

Earned income credit (EIC) is a special tax credit for certain employees with a qualifying
child and is based on the processing of Form W−5, Earned Income Credit. The credit reduces
the amount of Federal tax an employee owes and is intended to offset increases in living
expenses and social security taxes.

The EIC consists of the basic credit for qualifying children, the health insurance credit, and
the extra credit for a child born in the tax year. Only the basic credit for one qualifying child
is payable in advance.

For more information, see Processing Tips For Earned Income Credit.

Processing Tips For Earned Income Credit

Eligible employees have the option of receiving a refund after filing their individual tax
returns (Forms 1040 or 1040−A, U.S. Individual Income Tax Return) or in advance
payments. Those who choose the EIC advance payments must file a Form W−5, Earned
Income Advance Payment Certificate each year. The W−5 expires December 31 of each
calendar year with payments through Pay Period 24 (or the last pay period of the tax year).
The advance payment amount is computed using an IRS formula. The formula is located on
the NFC home page at www.nfc.usda.gov under NFC Pubs and Forms.

Tax: Federal Income Tax

Federal tax is withheld through payroll deductions based on the processing of form W−4.
Federal income tax withholding is based on an IRS formula that includes a calculation of TSP
contributions, the number of allowances claimed, and a tax withholding table for marital
status. From this calculation the tax amount is determined based on the taxable income
amount and the tax percentage. The formula is located on the NFC home page at
www.nfc.usda.gov under NFC Pubs and Forms.

For more information, see Processing Tips For Federal Income Tax.

Processing Tips For Federal Income Tax

Federal income tax is withheld based on the processing of form W−4. If a W−4 is not
processed, Federal income tax will be automatically be withheld at the rate of single with
zero exemption until a W−4 is processed.

A Federal income tax certificate does not need to be processed for employees reassigning,
etc., to another agency serviced by NFC within the same department. However, employees
transferring from one department to another department serviced by NFC must submit a new
W−4 at the time the accession action is processed.
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Employees claiming 10 or more allowances and employees claiming total exemption from
withholding (with wages exceeding $200 a week) will be reported to the Internal Revenue
Service (IRS). Once under IRS control, the number of allowances cannot increase without the
approval of IRS and a W−4 cannot be processed in the PPS. The original W−4 must be
submitted to:

USDA, National Finance Center
Government Employees Services Division
P.O. Box 29310
New Orleans, LA 70129

If the number of allowances decreases while under IRS control, the change can be processed
in the PPS. The IRS control is only released upon notification from the IRS.

An employee may choose to claim exempt if no Federal tax was owed the prior year and the
employee does not expect to owe any tax in the current year. The employee must file a W−4
before February 15 of each year if total exemption is claimed. Otherwise, tax withholding
will automatically be withheld based on single with zero exemptions.

Note: Employees whose duty station is the Republic of Panama, Virgin Islands, Guam or the
Northern Mariana Islands, may be exempt from Federal income tax. If exempt, the employee
must file a W−4 indicating Exempt status.

Federal income tax is withheld at the rate of 25% on all cash awards and bonuses. For annual
leave and compensatory time lump sum payments, an employee can choose to have Federal
income tax withheld based on the Federal income tax withholding exemption code in the PPS
or at the 25% rate.

Note: Spot awards are grossed up 25%.

Union Dues Documents

Union (i.e., organization or association) dues are deducted based on the processing of a union
dues document in the PPS. Authorization of parking fees for Smithsonian Institution
employees who are obligated to pay parking fees to the Harvard Parking Office, Harvard
University in Cambridge, Massachusetts are also processed based on the entry of a union
dues document.

The following IRIS Programs display union/association data:

• IR308, Union/Association Dues

• IR309, Union/Association Dues Transactions

• IR311, History Union/Association Dues

• IR122, SF−50−B, Data Elements (Bus Code)

For more information, see Steps For Entering Union (Organization) Dues.
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Union Dues: Overview

Eligible employees may authorize payments of dues to labor organizations, professional
associations, or other organizations through payroll deductions. A maximum of two
union/associations dues in effect at the same time is allowed. If the employee has two
union/association dues withheld, each may be for different unions/associations.

The amount of dues a member pays is a matter for determination by the labor organization,
professional association, or other organization. However, the authorized withholding must be
compatible with the established pay periods and procedures of NFC.

For more information on union dues, see:

TMGT Table 010, Union And Association Code Address

Bargaining Unit Status (BUS) Code

Cancellation Of Employee Organization Dues

Incorrect Union Dues Membership

TMGT Table 010, Union And Association Code Address

TMGT Table 010 lists all the valid union, association, and organization codes and addresses
for dues deductions. Also included on the table is the dues withholding amount or percentage
for calculating dues, to avoid over/under payment to a local or chapter.

Bargaining Unit Status (BUS) Code

A BUS Code is a 4-digit code that is entered in the position data record when the position is
established and identifies the bargaining unit status for each position. The employee’s
bargaining unit status code is the last four digits of the Office of Labor Management
Relations (OLMR) number. An employee with BUS Code 7777 or 8888 is not entitled to
dues withholding for labor organization dues but is entitled to dues withholding for a
professional association and other organizations.

Cancellation Of Employee Organization Dues

The PPS automatically cancels employee organization dues for:

Movement To A Nonbargaining Position. A bargaining unit employee who is moved
to a nonbargaining unit position is ineligible for inclusion in a bargaining unit. When a
promotion, reassignment, position change, conversion, or change to lower grade
personnel action is processed, the dues deductions will discontinue.

Temporary Promotion To A Nonbargaining Position. A temporary promotion to a
position in a nonbargaining unit will temporarily stop dues deductions and store the
membership authorization. To restore deductions and membership authorization,
process a change to lower grade.

If an employee in a bargaining unit position is temporarily promoted to a
nonbargaining unit position, and a change to lower grade is processed moving the
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employee to another nonbargaining unit position, membership is canceled and no
longer stored in the database.

If a permanent promotion is processed for the nonbargaining unit position, the PPS
cancels membership.

The above automatic cancellations and reinstatements are effective no earlier than the end of
the processing effective pay period (deductions start or stop the following pay period). If any
of these actions are processed late, the PPS only stops or starts the membership dues; it does
not automatically adjust for over/under deductions. Enter the adjustment in SPPS.

Incorrect Union Dues Membership

If you enter the wrong organization code, contributions will be made to the wrong
organization. In this case, cancel the incorrect union/association using the instructions under,
Union Dues Window Field Instructions. Enter the correct data in EPIC and PMSO, and enter
the adjustment in SPPS.

Union Dues: Authorization Of Labor Organization Dues

The employee authorizes the deduction of labor Organization dues by completing the
appropriate form to begin dues deduction.

For more information, see:

Processing Tips For Authorization Of Labor Organization Dues

Entry Guidelines For Authorization Of Labor Organization Dues

Steps For Entering Union (Organization) Dues

Processing Tips For Authorization Of Labor Organization Dues

Following are tips for processing labor organization dues authorizations.

The SF−1187, Request for Payroll Deductions for Labor Organization Dues, or other
appropriate form must be completed by the employee and the union/association to authorize
dues deduction when:

• The employee is a member of a labor organization which holds exclusive recognition
(Memorandum of Understanding established with the agency) for employees in the
unit in which employed.

• The employee is a supervisor or management official and is a member of a supervisory
or managerial association, and the agency has agreed in writing with the association to
deduct for payment of fees to maintain membership.

• The employee is a member of a professional association or organization, and the
agency has agreed in writing with the association or organization to deduct for
payment of dues.

Enter the BUS code before processing the payroll document. The BUS code is entered in
PMSO or a FESI.
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Access TMGT Table 010 to verify the organization and applicable rates exist in the PPS.
Access the applicable IRIS programs to ensure the dues allotment data being entered is
accurate and to ensure the allotment to be entered is not currently on the database.

Entry Guidelines For Authorization Of Labor Organization Dues

• Do not enter more than two union/local or association records for an employee.

• Prior Pay Period Adjustment field must be blank except if dues have been deducted in
error or if the cancellation was entered prior to the first full pay period following
March 1st or September 1st and not processed.

• Process a new authorization after a cancellation; do not process a change.

• The Effective Pay Period and Pay Period Year fields must be at least 1 year later than
the effective pay period/pay period year of the authorization.

• Enter either a dues dollar amount or percent based on the union deduction indicator in
TMGT Table 010.

• Do not enter a deduction amount for union dues that require special handling for
processing. Special calculations are performed based on certain criteria.

• The national amount for USDA, Foreign Agricultural Services and Office Of
Operations, is based on a percentage of basic pay; the chapter amount is based on a flat
dollar amount.

Steps For Entering Union (Organization) Dues

To enter a union/organization dues or parking fee document:

1. At the EPIC Navigation window (Figure 1:4), select Payroll Document at the New
Documents menu. An alphabetic list appears.

2. Select Union Dues > [applicable dues transaction] .

3. At the menu bar, select Edit > Add New Document. The applicable window (Figure
4:38) is displayed.
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Figure 4:39. Union Dues window (authorization, change, cancellation, revocation, or
mass change)

4. Complete the fields as indicated under Union Dues Window Field Instructions.

5. After completing the fields, select File > Save. The Save Changes pop-up (Figure 1:6)
appears.

6. Click [Yes] to save the entries and exit the action.

OR

Click [No] to exit the window and not save the entries.

OR

Click [Cancel] to reopen the window.

Union Dues: Change Between Locals

Dues change between locals window is a transfer of dues deduction when an employee
transfers to another agency within the same Department or a different labor
organization/association within the same agency. If an employee is reassigned or transferred
to a location represented by a different local or chapter of the same labor organization and the
employee continues to hold a bargaining unit position, the membership dues record may be
changed to show the new local/chapter and the amount of the membership dues.

For more information, see Steps For Entering Union (Organization) Dues.

Union Dues: Cancellation/Revocation Of Union Dues

The cancellation/revocation of union dues is the discontinuance of dues deduction when the
employee is no longer eligible or voluntarily elects to cancel membership. The SF−1188,
Cancellation of Payroll Deduction for Labor Organization Dues, or other appropriate form is
used to enter the data.
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For more information, see:

Union Dues Cancellation

Union Dues Revocation

Union Dues Cancellation

Cancellation of employee union/organization dues applies when:

• A reassignment to a location not represented by the labor organization or professional
association for which dues were withheld prior to the reassignment occurs

• The employee is no longer a member in good standing

• The employee is reassigned or transferred to a bargaining unit represented by a
different local of the same labor organization and does not wish to continue dues
withholding

A cancellation is effective immediately or in the pay period in which it is entered. For
example, if the cancellation was entered in Pay Period 19, deductions will stop in Pay
Period 19.

Union Dues Revocation

Certain labor organizations designate when an employee may revoke labor organization
withholding; other organizations permit revocations at any time. TMGT Table 010 includes
the Revocation Eff Date field which indicates when revocation of membership is allowed.
Revocation Eff Date code 0 indicates that membership can be canceled at any time. If the
organization permits revocation at any time, enter the revocation at any time prior to the
effective pay period.

Note: The revocation code does not change until BEAR processes which is after the
processing of PAYE. Therefore, deductions will be withheld in the pay period the revocation
was entered and will stop in the following pay period (or the established revocation pay
period).

Example:

The revocation request is for dues to discontinue in Pay Period 18. Enter the document in Pay
Period 17. Dues will be withheld (one last time) in Pay Period 17 and discontinued in Pay
Period 18.

If the labor organization designates when to revoke and the revocation date falls on the first
day of the pay period, the revocation can be entered in any pay period prior to the revocation
date.
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Example:

The revocation date is September 1, the first day of Pay Period 18. The revocation will be
effective Pay Period 18. Enter the revocation prior to or for the processing of Pay Period 17.
Dues will be deducted in Pay Period 17 and discontinue in Pay Period 18.

If the revocation date is not specified by the organization and the date falls on any day of a
given pay period, the revocation may be entered at any time before or during the pay period
of the revocation date. However, the revocation will not be effective until the designated pay
period.

Example:

The revocation date is September 1, the middle of Pay Period 18. The revocation will be
effective in Pay Period 19. Enter the revocation prior to or for the processing of Pay Period
18. Dues will be deducted in Pay Period 18 and discontinue in Pay Period 19.

Caution: When entering a revocation of employee union dues, use the current pay period as
the effective pay period. The PPS will stop dues deductions based on the first approved
revocation date following the end of the current pay period. The pay period the revocation is
to be effective should never be used as the effective pay period. If it is, the document will
apply to the database too late to stop deductions for the pay period intended. Instead the PPS
will stop deductions based on the approved revocation date.

Union Dues: Mass Change

A union dues mass change is used to enter multiple union dues transactions that are alike. If
more than 100 employees are affected, NFC can provide special assistance with entering
these documents. Submit these requests in writing to NFC, Applications Systems Division.

Steps For Entering Union Dues Mass Change Documents

1. Follow the entry instructions under Steps For Entering Union (Organization) Dues.

2. For field instructions, see Union Dues Window Field Instructions.

3. After completing the fields, click File > Save. The applicable fields are refreshed.

4. Complete the fields for the next social security.

5. Click File > Save.

6. Repeat this process for each social security number.

7. After the last social security number is entered, click File > Close.
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PART 5.

Requesting EPIC
Reports And Correcting
Data

This section presents the following topics:

Requesting EPIC Reports

Correcting Suspense
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Requesting EPIC Reports

This section presents the following topics:

About EPIC Reports

Steps For Requesting A Report

About EPIC Reports

EPIC includes a Report option for viewing and requesting status and suspense reports for
transactions entered for processing. These reports are available for printing at agency
locations.

Note: EPIC reports are not available to FESI users.

Steps For Requesting An EPIC Report

To request an EPIC report:

1. At the EPIC Navigation window (Figure 1:4), select File > Report. The PINE Status
pop-up (Figure 5:1) appears.

Figure 5:1. PINE Status pop-up

This pop-up provides information about the latest PINE pass processed. For
information about the PINE process, see Correction Process Overview.
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2. Click [OK] The Reports window (Figure 5:2) is displayed.

Figure 5:2. Reports window

3. Click Report at the Reports window menu bar. A drop-down menu is displayed with
the following options.

• Processing Status List

• Processing Status Totals

• Suspense Error Counts

4. Click the applicable report option. A selection criteria pop-up for that report appears.
To enter selection criteria, see the instructions under the applicable topics, as follows:

• If you selected the Processing Status List report, see Processing Status Report
Request Criteria.

• If you selected the Processing Status Totals report, see Processing Status Totals
Report Request Criteria.

• If you selected the Suspense Error Counts report, go to Step 6 below to complete
the JCL Requirements pop-up (Figure 5:3).

5. After completing the applicable pop-up, click [OK]. The JCL Requirements
pop-up (Figure 5:3) appears.
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Figure 5:3. JCL Requirements

6. Complete the fields as indicated under JCL Requirements Pop-up Field Instructions.

7. Click [OK] to execute the report. You are returned to the Reports window (Figure 5:2).

8. To request another report, repeat the above process.

Processing Status Report Request Criteria

The Processing Status Report pop-up (Figure 5:4) appears from the Reports window (Figure
5:2) and is used to enter selection criteria when requesting a Processing Status report.

Figure 5:4. Processing Status Report



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

5:6 Requesting EPIC Reports Updated 01/08

To enter selection criteria for a Processing Status report:

1. Select the applicable report criteria.

2. Click [OK].

3. To cancel a selection, click the box to remove the checkmark. The JCL Requirements
pop-up (Figure 5:3) appears. For completion instructions on the JCL Requirements
pop-up (Figure 5:3), go to Step 6 under Steps For Requesting An EPIC Report.

Processing Status Totals Report Request Criteria

The Processing Status Totals pop-up (Figure 5:5) appears from the Reports window (Figure
5:2) and is used to enter selection criteria when requesting the Processing Status Totals report.

Figure 5:5. Processing Status Totals

To complete the Processing Status Totals pop-up:

1. At the Reports field, click the applicable box(es) to select the type of documents to be
included in the report. To cancel a selection before exiting the pop-up, click the box
again to remove the checkmark. A report is produced based on the selection criteria.

Note: For documents in hold, incomplete, or waiting remarks status, select Pending.

2. After selecting the document(s), click [OK]. The JCL Requirements
pop-up (Figure 5:3) appears. For completion instructions on the JCL Requirements
pop-up (Figure 5:3), go to Step 6 under Steps For Requesting An EPIC Report.
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Correcting Suspense

This section presents the following topics:

About Correcting Suspense

Document Type

Status Codes

Correcting EPIC Front-end Errors

Correcting Database (PINE) Errors

About Correcting Suspense

This section describes how to correct payroll and personnel transactions that rejected because
they failed the EPIC front-end edits or PINE database edits. Every effort should be made to
correct all suspense transactions to ensure accurate and timely salary payments to your
employees.

This part describes the front-end and database edits that are performed in EPIC and PINE. A
FESI should include the EPIC front-end edits also to avoid rejecting database (PINE) errors.

Document Type

Each personnel action or payroll document is identified in the PPS by a system-generated
document code known as document type. This code identifies the type of document or type of
activity for a document and is carried throughout the system from the beginning to the end of
the processing cycle. The document type displays on the List EPIC Document window in the
Type column. For a list of document types, see Document Type Codes Table (Appendix C).

Document Type 998 (FESI Position Data)

Document Type 998 identifies position discrepancies for position data that was entered
through FESI and processed in PMSO. Position data entered through a FESI that failed the
edits is placed in suspense for one pass and coded for deletion. FESI users must either correct
the position data in the FESI and transmit a new record or use PMSO to update or establish
the position data. PMSO errors cannot be corrected using the View > Suspense Documents
option.

Document Type 999 (Informational Messages)

Document Type 999 includes informational messages that pertain to (1) the need to process a
personnel action or other document; (2) actions rolled off the database that must be
re-entered; and (3) transactions deleted from the future file.

The processing of certain personnel actions require an update to the position data and vice
versa.
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Example:

The pay plan on the master record is changed in PMSO. A personnel action must be
processed with the new pay plan to update the employee’s personnel record. If a personnel
action is not processed, the message PMSO Pay Plan Changing − Submit Personnel Action
will appear on the suspense error listing.

The agency deletion of a document from the future file causes informational message,
Document Deleted From Future File, to display on the suspense error listing.

A system-generated rollback displays the message In SINQ Due To Rollback − Take
Appropriate Action to display on the suspense error listing. The PPS sorts and processes
personnel actions by effective date. A system-generated rollback occurs automatically when a
personnel action(s) has applied to the database in the current processing pay period and
another personnel action(s) with an earlier effective date is processed in a later PINE pass
during the same processing pay period and prior to the processing of PAYE. As a result, all
actions are rolled back and deleted from the database and placed in suspense.

Example:

In PINE Pass 02, a reassignment effective 4/17 is processed and applies to the database. In
PINE Pass 03, a name change effective 4/11 is entered. Since the name change has an earlier
effective date, it must be applied before the reassignment. The PPS rolls back both actions off
the database, sorts according to effective date, and places them in suspense. To release from
suspense, type 9 in the Status Code field.

Status Codes

Status codes are used to release, hold, delete, override certain error messages, and send
personnel actions and payroll documents to the future file. Most codes are entered by the
user; others are system generated. See Status Code Table.

Correcting EPIC Front-end Errors

EPIC performs front-end edits that validate data entered in each field before releasing the
transaction for PINE editing. The fields are edited for size, characters, and validity of data.
Certain fields are edited against TMGT tables and PPS relational databases for validation. For
example, the employee name and social security number are validated against the Employee
Name database; the department and agency codes are edited against TMGT tables. EPIC edits
a personnel action or payroll document after all data is entered and the transaction is coded
hold or release. All front-end edits must be corrected before the transaction can be released to
PINE.

After completing all applicable fields of the personnel action or payroll document,
type H (hold) or R (release) in the Status Code field for EPIC to edit and validate data.
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Caution: If the transaction is coded I (incomplete), no edits are performed.

If errors are detected, the Edit Error Listing pop-up (Figure 5:6) appears.

Figure 5:6. Edit Error Listing

To correct EPIC front-end errors:

1. Review the errors and click [Close] to return to the Personnel Action
window (Figure 2:2). All fields in error on the Personnel Action window (Figure 2:2)
are highlighted in red.

2. Correct the data as indicated under Field Instructions For Personnel Actions or Field
Instructions For Payroll Documents.

3. After correcting the errors, click File > Close. The Save Changes pop-up (Figure 1:4)
appears.

4. Click [Yes] to release the action for PINE processing.

Note: All EPIC documents are picked up by PINE and edited during each PINE run
except those coded with EPIC status code I.

Correcting Database (PINE) Errors

PINE is a subsystem that edits personnel actions and payroll documents before they apply to
the PPS database, comparing the employee’s database record to the data being entered. PINE
edits all transactions regardless of the entry system. For an overview of the entry, correction,
and processing of payroll and personnel transactions, see Payroll/Personnel Processing
Cycle.

This section presents the following topics:

Correction Process Overview

Viewing And Correcting Suspense Transactions

Clear Error Codes

Confirming Corrections Applied

Correction Process Overview

The first PINE pass begins on the first Monday (week 1) of the processing pay period and
executes daily (except Saturdays and Sundays) through the second Friday (week 2). This
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allows agencies ample time for correcting transactions so they can apply to the database.
Transactions must be corrected before the last pass of PAYE to be applied in the processing
pay period.

Transactions can be corrected with each PINE process and must be corrected before the first
pass of PAYE which is the first Thursday of the following pay period (week 2), otherwise the
error will rollover to the next pay period(s) until corrected or deleted.

Payroll and personnel transactions that fail PINE edits are placed in suspense and must be
corrected by the agency. Every attempt should be made to correct all errors with each PINE
pass to ensure the employee receives the correct salary timely. The PINE Edit Messages
procedure, Title I, Chapter 10, Section 2, is documentation that should be used when
correcting suspense. The PINE procedure includes all PINE edit messages and an explanation
of each message to assist in resolving PINE discrepancies. The PINE procedure lists all the
PINE edits by document type.

PINE consists of many edits that pertain to correcting all types of personnel actions. Edits are
performed on (1) individual field specifications (e.g., field requirement, size, and validity);
(2) field-to-field compatibility (e.g., service computation date for leave must be compatible
with annual leave category); (3) validity of action being processed (e.g., promotion grade is
the same as the grade on the database; and (4) many other miscellaneous edits pertaining to
processing personnel actions. Also, PINE associates personnel actions and payroll documents
by editing the validity or need to process a transaction (e.g., processing an accession requires
a residence/salary address).

Suspense reports are available that provide the actual errors that are preventing the document
from applying to the database as well as other suspense-related information.

After all errors have been corrected, personnel and payroll transactions are reedited and based
on the effective pay period, either apply to the database or the future file.

Transactions that pass the PINE edits with a current or prior effective pay period are sent to
PEPL to update the PPS database. Actions that are effective in a future pay period are sent to
the future file, edited through PINE each pay period and applied in the appropriate pay
period.

Viewing And Correcting Suspense Transactions

The PPS performs hundreds of PINE edit checks when a transaction processes. To view
and/or correct a suspense document:

1. Locate the document using the Search pop-up (Figure 1:7). For instructions,
see Searching For/Viewing EPIC Transactions. 

Note: After entering search criteria in the Search pop-up (Figure 1:7), the EPIC
Navigation window (Figure 1:4) is displayed with a list of suspense documents based
on the selection criteria. The EPIC Status column displays S, and the Status Code
column displays 9 indicating the transaction is in suspense because it failed the PINE
edits.
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2. At the EPIC Navigation window (Figure 1:4), double-click the applicable document
line to display the suspense document and the Suspense Error Listing pop-up (Figure
5:7).

Figure 5:7. Suspense Error Listing pop-up

3. At the applicable personnel action or payroll document window, correct the data
according to the applicable instructions under Field Instructions For Personnel
Actions or Field Instructions For Payroll Documents. For help in correcting errors,
use the PINE procedure.

4. After correcting the errors, click File > Save to save the corrections.

• To display the next suspense transaction, at the document window click File >
Next.

• To display the previous suspense transaction, at the document window click File >
Previous.

Correct as many errors as possible for all transactions in document list of the EPIC
Navigation window (Figure 1:4). Those not corrected will be repeated in the next
PINE process and remain until corrected or deleted.

Note: If the error requires entering a new personnel action, select File > New Personnel
Action > [applicable action] to enter the action.

5. After resolving all corrections, click File > Close to save the corrections and exit the
window. The Save Changes pop-up (Figure 1:4) appears.

6. At the Save Changes pop-up (Figure 1:4), choose one of the following responses:

• Click [Yes] to save the entries and edit the action.

• Click [No] to exit the window and not save the entries.

• Click [Cancel] to return to the personnel action or payroll document window.

Note: Do not change the status code from 9 unless and override code is necessary.

Clear Error Codes

Clear error codes are used to release certain PINE messages for specific data elements. Clear
error codes apply to personnel actions only.
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To release the action from suspense:

1. Review the data element in error.

2. Do one of the following:

a. Enter the correct data at the applicable Personnel Action data pop-up.

OR

b. Do not change the data and enter the appropriate clear error code. For a list of
PINE edit messages and applicable clear error codes, see the Clear Error Codes
Table.

3. After correcting the errors or entering the clear error code, save the action and close
the window.

Note: Do not change the status code from 9 unless and override code is necessary.

For complete instructions on correcting suspense transactions, see Viewing And Correcting
Suspense Transactions.

Confirming Corrections Applied

To confirm a transaction successfully processed and applied to the database:

1. Select View > Search. The Search pop-up (Figure 1:7) appears.

2. Complete the fields as indicated under Search Pop-up Field Instructions.

3. Select Applied Documents or All Documents at the EPIC Status field.

4. Click [OK]. The EPIC Navigation window (Figure 1:4) is displayed. All successfully
processed transactions listed reflect A in the EPIC Status column and X in the Status
Code column.

To view deleted transactions select:

1. Select View > Search . The Search pop-up (Figure 1:7) appears. 

2. Complete the fields as indicated under Search Pop-up Field Instructions. 

3. Select Deleted Documents or View > All Documents at the EPIC Status field.

4. Click [OK]. The EPIC Navigation window (Figure 1:4) is displayed. The deleted
transactions reflect an EPIC Status column and 4 (delete) in the Status Code on the
EPIC Navigation window (Figure 1:4).
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PART 6.

FIELD INSTRUCTIONS FOR
EPIC WINDOWS

This part presents the following topics:

Field Instructions For Getting Started In EPIC

Field Instructions For Personnel Actions

Field Instructions For Rollback Actions And Correcting History Data

Field Instructions For Payroll Documents

Field Instructions For Requesting Reports
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Field Instructions For Getting Started In EPIC

This section presents field instructions for getting started in EPIC under the following topics:

Change Password Pop-up Field Instructions

NFC Logon Banner Field Instructions

Search Pop-up Field Instructions

Change Password Pop-up Field Instructions

The Change Password pop-up (Figure 1:3 ) is used to change your password.

User Id Required, alphanumic, 6 − 8 positions

Type your user identification number.

Old Password Required, alphanumeric, 6 − 8 positions

Type your current password.

New Password Required, alphanumeric, 6 − 8 positions

Type your new password.

Confirm New Password Required, alphanumeric, 6 − 8 positions

Type the new password again to confirm it was entered as intended.

NFC Logon Banner Field Instructions

The NFC logon banner (Figure 1:1) is used to logon to EPIC.

User Id Required, alphanumeric, 8 positions max.

Type your user identification number.

Password Required, alpha, 6 − 8 positions

Type your unique password.
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Server Required, alphanumeric

Click the down arrow to display the drop down menu and select
Payroll/Personnel.

Search Pop-up Field Instructions

The Search pop-up (Figure 1:7) is used to search for transactions.

Search Criteria

SSN Optional, numeric, 9 positions

To search for one or all transactions for a specific employee, type the social
security number.

Document Type Optional, numeric, 3 positions

Complete this field as follows:

To search for: Type:

A specific personnel action for an
employee

063

A specific payroll document for an
employee

The applicable document type code

All transactions for a specific
employee or personnel office

No entry. Leave blank

For a list of document type codes, see Document Type Code Table.

1st NOA Optional, numeric, 3 positions

To search for transactions by NOA, type the nature of action code, or type only
hte first digit. If you type only hte first digit, all NOA’s beginnign with that
number are dsiplayed.

User Id Optional, alphanumeric, 8 positions max.

To search for transactions entered or last updated by a specific user, type the
user’s identification number.
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If you enter: Then:
The full user ID All transactions entered by that user ID are

displayed.
Only the first 2 positions of
the user ID (agency
identifier)

All SSN’s (based on the user’s security access)
that were entered for the agency personnel office
are displayed (e.g., NF would list all SSN’s
entered for NFC).

The first 2 digits and the
next digit(s)

All SSN’s for the user ID’s within the number
series are displayed (e.g., NF5 would list all
SSN’s for user-ID’s that begin with NF5).

The first digit All SSN’s (based on security access) entered by
a user Id beginning with N (e.g., NF, NC, NP)

Servicing Agency Optional, alphanumeric, 2 positions

To search for transactions for an agency serviced by another agency, type the
agency code of the serviced agency.

POI Conditional, numeric, 4 positions

To search for transactions for a specific personnel office, type the POI.

Agency Conditional, alphanumeric, 2 positions

To search for transactions for a specific agency, type the agency code.

Pay Period Optional, numeric, 2 positions

Type the processing pay period number. Valid values are 01 through 27.

Status Code Alpha, 1 position

Type the code that indicates the disposition of a document. The valid values are
H (hold); I (incomplete); R (release); S (severance); W (waiting). For a
complete list and explanation of status codes, see Status Code Tables.

EPIC Status Optional, system default

The EPIC status indicates the status of a personnel action or payroll document
after it has been entered for processing. See EPIC Status Codes for a list of
codes and definitions. The EPIC Status field default is All Documents,
which allows you to view all transactions entered. To view other EPIC status
transactions, click the down arrow.
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Field Instructions For Personnel Actions

This section presents field instructions for personnel action windows under the following
topics:

Awards Pop-up Field Instructions

Benefits Pop-up Field Instructions

Bonus Pop-up Field Instructions

Employee Data Pop-up Field Instructions

Miscellaneous Pop-up Field Instructions

Personnel Action Window Key Data Field Instructions

Position Data Pop-up Field Instructions

Remarks Window Field Instructions

Salary Data Pop-up Field Instructions

Specification Of Mailing Address Pop-up Field Instructions

Awards Pop-up Field Instructions

The Awards window (Figure 2:9) is used to enter cash awards and time off awards. For
instructions on the entry process, see Entering A Personnel Action.

Case Number Alphanumeric, 8 positions

Type the cash award case number assigned by the agency.

• Enter the same case number on each action for a group award.

Award Code Alphanumeric, 4 positions

Type the code that identifies the type of award.

Award Amount Numeric, 7 positions

Type the monetary amount of the award.

Hours Conditional, numeric, 5 positions max.

Type the number of hours granted for a time off award.

• Cannot exceed the maximum allowed per leave year for a time off award.

Tangible Benefits Numeric, 1 position

Type 1 if the value of the award is based on tangible benefits; otherwise, go to
the next field.
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Intangible Benefits Numeric, 1 position

Type 1 if the value of a cash award is based on intangible benefits.

Verify Amt Conditional, numeric, 7 positions max.

Type the monetary amount of the award for verification.

Verify Hrs Conditional, numeric, 5 positions max.

Type the number of hours granted for a time off award for verification.

First Year Savings Numeric, 10 positions max.

Type the monetary amount of the first year savings as a result of implementing
the suggestion. Required field for tangible benefits only.

Number Of Persons Awards window: Numeric, 2 positions max.

Type the number of persons included in the award.

Amount Paid External
Source Numeric, 7 positions

Type the amount paid by a non-government external source.

Pay Code Alphanumeric, 1 position

Click the down arrow to display the drop-down menu to select the action being
taken. Valid Values are:

Process
Award

Issue payment if applicable, update W-2, update Earnings & Leave
Statement, Updates IRIS/PINQ/Reporting Center, updates SF-50b.
(NOAC840/841 auth V3F will not generate payment)

Document
Award

Updates IRIS/PINQ/Reporting Center and SF-50b. Use this option if
payment has already been issued by NFC Manual Pay/SPPS. This
option will not update an employee’s W-2 or Earnings & Leave
Statement.

Accounting To Generate
Payment

Complete the following accounting-related fields if payment is to be generated.

Code Alphanumeric, 27 positions max.

Type the accounting data that will be charged for payment of an award.

Station Numeric, 4 positions

Type the accounting station that will be charged for payment when the
employing agency is not charged.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 6

F
ield

 In
stru

ctio
n

s F
o

r
E

P
IC

 W
in

d
o

w
s

6:9Field Instructions For Personnel ActionsUpdated 01/08

Agency Alphanumeric, 2 positions

Type the agency code of the agency granting the award.

• For USDA agencies, complete the code field only to generate payment.

• For USDA agencies, if another agency is granting the award, process the
personnel action pay code as Document Award and submit through SPPS
with agency and accounting code of granting agency to NFC for payment.

Dates

The inclusive dates of the period covered by the award.

From Numeric, 8 positions

Type the beginning date of the period covered by the award.

To Numeric, 8 positions

Type the ending date of the period covered by the award.

Address Indicator Numeric, 1 position

Type the award address indicator.

Code Description

1 Send payment to POI address

2 Use database address

3 Enter specific address

4 Enter designated agent code

Note: If you enter 1, 3, or 4, the envelope icon is highlighted for completion of
the Specification Of Mailing Address window.

Benefits Pop-up Field Instructions

The Benefits pop-up (Figure 2:3) displays data elements that relate to employee benefits (e.g.,
health, life, retirement, etc.). For instructions on the entry process, see Entering A Personnel
Action.
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FEHB Cov Code Numeric, 1 position

Type the code that identifies the employee’s eligibility for participation in
FEHB, and if eligible, whether they are participating.

Employees who resign or terminate under NOAC 312, Resignation In Lieu of
Involuntary Action, or NOAC 356, Termination − Involuntary, may be eligible
for discontinued service retirement. These employees may be eligible to transfer
their FEHB coverage to OPM if the conditions required for continuation of
FEHB enrollment have been met. For a list of valid codes, see the FEHB
Coverage Code Table.

• FEHB Coverage code 1 is system-generated after the FEHB document is
processed and cannot be entered on a personnel action. Do not attempt to
enter Code 1 even if the option is known at the time of the accession.

• Type 2 if the employee is excluded from coverage by FEHB law or
regulations. Type 2 if the employee is eligible for non-Federal health
insurance. Enter the appropriate non-Federal plan code by
selecting File > New > Payroll Documents > Non-Federal Benefits > Health.

• Type 3 or 5 only if the employee is (1) transferring into the Department or
(2) being reemployed without a break in service of more than 3 days, and has
canceled or waived coverage under prior Federal employment.

• Type 4 if the employee elects to enroll and in all other cases. If the FEHB
document is processed during the same pay period as the accession personnel
action, the output SF−50−B is displayed code 1 even though 4 was entered.
FEHB deductions will begin during the pay period in which the SF−2809 or
SF−2810 is processed and applied to the database.

• Must be completed for retirement, death, resignation in lieu of involuntary
action, and involuntary termination actions. Conversely, must be blank for
other separation actions.

• Enter the required remarks codes. See Remarks Window Field Instructions.

FEGLI Cov Amount Numeric, 4 positions

Type the amount of basic insurance coverage for an employee who is covered
under FEGLI. The amount recorded in this field does not include additional
optional insurance coverage amount.

• The FEGLI coverage amount is required for employees who have not waived
and:

Are paid at different rates of pay during the year and the PPS cannot
calculate the FEGLI amount

Are paid on a piecework basis

Are FWS employees paid at different rates

• Must be in multiples of $1,000 (e.g., $10,000 is entered as 0010; $100,000
is entered as 0100,, etc.).
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6:11Field Instructions For Personnel ActionsUpdated 01/08

• If the annual salary is less than $8,000, the amount is $10,000.

FEGLI Coverage Alphanumeric, 1 position

Type the code that identifies if the employee is eligible for participation in
FEGLI as authorized on the SF−2817, Life Insurance Election. If eligible, the
code indicates whether:

• The employee waived coverage

• Is covered by basic life only

OR

• Has elected coverage under one of the optional insurance plans as well as the
basic life. For a list of valid codes, see the FEGLI Coverage Table.

Enrollment in FEGLI is automatic unless:

• The employee is appointed to a position or is under a type of appointment or
employment which is excluded from coverage by law or regulation

• The employee voluntarily waives coverage by completing an SF−2817

• The employee previously waived coverage under a prior Federal
appointment, and such waiver is still in effect

Note: A previous waiver of coverage is automatically canceled if the
employee is reinstated following a break in service of at least 180 days.

• Must be completed and different than the code on the database for a FEGLI
Change action.

• Type A0 only if the employee (including reemployed annuitants) is ineligible
for insurance coverage (no deductions for life insurance will be made).

• Type A0 if the employee is eligible for non-Federal life insurance. Enter the
appropriate plan code by selecting at the EPIC Navigation window, New
Document menu Payroll Document > Non-Federal Benefits > Life Insurance.
At the menu bar, select Edit > Add New Document.

• If both FEGLI and non-Federal life insurance are elected, enter the
appropriate code in this field and enter the non-Federal life insurance data
using the payroll document option. To enter the data, select at the EPIC
Navigation window under New Documents Payroll Document > Non Federal
Benefit > Insurance. At the menu bar, select Edit >Add New Document.

• Type B0 only if the employee (including reemployed annuitants) elects to
waive all insurance coverage or has previously waived all insurance coverage
during prior employment and the waiver is still in effect.

• Type C0 when the employee (including reemployed annuitants) has elected
Basic coverage only.

• If the employee has not submitted the SF−2817 to the agency when the
accession action is ready for processing, type C0 on the accession personnel
action, because the employee must be considered as being covered by basic
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life insurance. Process a personnel action when the SF−2817 is received in
the personnel office and the employee has either waived coverage or has
indicated that he/she wants the optional insurance coverage as well as the
regular coverage.

• Type 90 or D0 through Z5 if:

The employee is not excluded from coverage by law or regulation

Has not waived coverage

Has elected to be covered by one of the optional insurance plans in addition
to the basic coverage

• Do not complete for employees with alternating tours of duty who are in an
intermittent status at the time of hire. These employees are not eligible for
FEGLI coverage.

Coverage At
Appointment Alpha, 1 position

Type the code that identifies whether an employee has, at the time of the most
recent appointment to Federal service, previously been covered by CSRS or
FERS. Valid values are:

Code Definition

N Never covered by CSRS or FERS

P Previously covered by CSRS or FERS regardless of whether or not the
employee withdrew previous contributed funds

R Previously covered by CSRS and eligible for a refund

Retirement Plan Alphanumeric, 1 position

Type the code for the civilian retirement system(s), to which deductions from an
employee’s pay are credited, based on civilian employment by the U.S.
Government or the District of Columbia. For a list of valid codes, see
the Retirement Plan Table.

• A split T&A may be required if the effective date of the personnel action is
other than the first Sunday of the pay period.

• Must be 1, 3, 6, 8, or 9 when type appointment is 01 or 02.

• Agency code must be 10, 34, 51, 55, 58, or 67 for retirement plan 3, G, P, or
W.

• Must be 4 (none) when the employee is not eligible for coverage under any
retirement system.

• SCD−Leave and SCD−Retirement must be completed for retirement plan 4.

• Must be 5 only when the employee is to be covered by a retirement plan
other than CSRS, FERS, FICA, or Foreign Service.

• Department code must be AQ or AR for retirement plan 7, D, or I.
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6:13Field Instructions For Personnel ActionsUpdated 01/08

• Must be 7, D, or I for agency codes AQ and AR.

• Must be 8 or 9 only for CVA judges who are eligible to convert, or have
converted to the CVA Judges Retirement Plan.

• Agency code must be 74 for retirement plan 8 or 9.

• Must be C, E, G, or K if type appointment is 01 or 02.

• Must be M, P, R, T, W, Y, or Z when type appointment is 01 or 02.

• Must be P or 6 when Agency is USAID and Special Employment Program
Code is AM.

• Pay plan must be EX, ES, FE, or IE with retirement plan R, T, W, or X; SR
with retirement plan 8 or 9; DB with retirement plan 2.

• Department code must be AC for retirement plan Y or Z.

• Must be Z only for CSRS employees who are eligible to convert, or have
converted to, the DC Retirement Plan.

• The retirement plan cannot be changed to Z if the current retirement plan is
not 1 (CSRS).

• Process a change in retirement plan code (NOAC 803) to change retirement
plans; process an official correction action to correct the retirement coverage
code.

• Must be 2 if the employee is eligible for non-Federal retirement coverage.

• For codes 6, E, M, and T, enter a Multielement Update [payroll] Document
to establish the 6C Retirement Date in the database. If not processed, the
personnel action will remain in suspense for three processes of PINE or until
the payroll document is processed.

SCD−Retirement Numeric, 8 positions

Type the date which reflects all service creditable for retirement purposes.

• Must be blank for retirement plans other than CSRS or FERS (coverage
codes 2, 4, 5, J, X).

• Must be completed for all retirement coverage codes except 2, 4, 5, J, N, and
X.

• Must be completed if different than SCD−Leave.

• Cannot be later than effective date of action.

• System-generated for NOAC’s 100, 101, 140, 141, and 170.

SCD Leave Numeric, 8 positions

Type the date which reflects all service creditable for earning annual leave.

This date is used by the PPS to generate various external reports such as:
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• The projected number of annual leave hours an employee has in excess of the
maximum carryover to either use, lose, or have restored by the end of the
leave year.

• Notification when the employee’s leave category changes.

The PPS automatically adjusts the SCD Retirement and SCD Leave dates at the
end of the leave year for:

• All excess nonpay status (exclusive of military furlough or compensable
injury leave) which occurred during the calendar year provided the employee
is on the rolls of the Department at that time. An SF−50−B, Notification of
Personnel Action, is produced with Remarks Code B32, Changes SCD from
(date) to reflect excess time in nonpay status during calendar year XX.

• All intermittent employees to record the days worked under the intermittent
appointment during the calendar year. An SF−50−B is produced with
Remarks Code B31, Changes SCD from (date) to reflect number of days
worked under intermittent appointments.

The Payroll/Personnel System automatically adjusts this date for:

• Days of creditable intermittent service whenever an action is processed
which changes an employee from intermittent to full-time or part-time. An
SF−50−B is produced with Remarks Code G29 or G30 to document the most
current period of intermittent service.

• Any excess nonpay status whenever a return to duty personnel action is
processed.

If a personnel action is processed only to adjust this date, all related counters
(e.g., intermittent time recorded on the database intermittent record
(IRIS Program IR129) or nonpay status recorded on the database nonpay leave
record (IRIS Program IR140) are zeroed out by the PPS. However, when a return
to duty is processed, or a corrected T&A is processed to change or correct hours
previously charged as leave without pay, the related counters are not adjusted or
zeroed out by the PPS.

• Complete this field for official change actions only if the date must be
corrected because:

The agency has determined that the date originally furnished included prior
noncreditable service.

The agency has determined that the date originally furnished must be
adjusted to include prior creditable service and/or nonpay status from a
previous calendar year(s).

• Complete when the annual leave category is other than 0.

• Must be compatible with the annual leave category.

• Cannot be later than effective date of personnel action.

• Must be completed and different than SCD−Leave on database for a Change
in SCD action.
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6:15Field Instructions For Personnel ActionsUpdated 01/08

• Enter the date of the accession action if the date is unknown.

• System generated for NOAC’s 100, 101, 140, 141, and 170.

TSP Eligibility Code Numeric, 1 position

Type the code that identifies whether or not a FERS, CSRS, Offset, or FSRS
employee is eligible to participate in FERS TSP. For a list of valid codes, see
the TSP Eligibility Table. For detailed information regarding TSP, refer to
publications and bulletins published by the Federal Retirement Thrift Investment
Board.

The TSP Eligibility Code is automatically changed to 9 when a TSP enrollment
document is processed or when a FERS employee begins receiving the 1-percent
Government basic contribution. Once Code 9 has been established, it cannot be
changed. If an employee stops contributing, the employee’s eligibility to again
contribute is determined by the Change Status Code and Effective Date of Status
Change fields in IRIS Program IR118.

The Effective Date of Status Change is generated and is the first day of the pay
period in which the Form TSP−1 is processed to begin employee contributions.
However, if the employee cancels the TSP contributions, the first day of the pay
period in which the cancellation is processed will be generated as the Effective
Date of Status Change.

Note: The Effective Date of Status Change will not change if the employee
elects to change the percentage rate or dollar amount of the contribution.

SCD−TSP Numeric, 8 positions

Type the beginning date of the vesting period for the 1 percent Government
contribution to TSP.

• Complete for FERS

• and FSPS employees participating in TSP.

• Do not complete for CSRS Offset (Congressional) (FICA) retirement plan.

• Cannot be prior to January 1, 1984.

• Cannot be later than effective date of action.

Date Retired Military Numeric, 8 positions

Type the date an employee retired from military service.

• Must be completed if annuitant indicator is 4, 5, or C through F.

• Must be completed if uniform service status is 4 or 5.

Frozen Service Numeric, 4 positions

Type the total years and months of civilian and military service, creditable for
calculation of the SCD for leave, at the time the employee first becomes covered
by FICA and CSRS (retirement coverage codes C and E) or by FERS and FICA
(retirement coverage codes K, L, M, or N).
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• First two positions must be 00 through 99(number of years); last two
positions must be 01 through 12 (number of months).

• Must be completed for veterans only.

• Retirement Plan code cannot be 4 or 5.

Creditable Military
Service Numeric, 4 positions

Type the total number of years and months of military service.

• The first two positions must be 00 through 99 (number of years); last two
positions must be 01 through 12(number of months).

Last Day In Pay Status Numeric, 8 positions

Type the projected final date in pay status for a retiring or deceased employee.

• Complete for retirement and death actions. Conversely, must be blank for
other actions.

• Enter the date the annual leave extends if the employee is on annual leave.

• Complete when sick leave expiration date is completed.

• If the employee is on annual leave and has sick leave available, confer with
the employee to determine if annual leave will be continued to be used or if
sick leave will be used.

Sick Leave Expiration
Date

Numeric, 8 positions

Type the projected expiration date of sick leave for a retirement or death action
for a part-time employee with an uncommon tour of duty. This date applies if
the employee meets the criteria and the tour has not changed 180 days prior to
retirement or death.

• Must be completed for death and retirement actions.

• Must be completed when last date in pay status is completed.

Agency Use Alphanumeric, 12 positions max.

For accessions/official changes, complete in accordance with agency
instructions. Check with agency for specific instructions. For separations, type
the individual agency requirements for processing retirement cases as described
below.

• Position 1, Refund of retirement deductions received
(SF−2801/SF−3107). Valid values are Y (yes), N (no), and U (unknown).
Type the applicable code to indicate if the employee previously received a
retirement refund.

• Position 2, Military retired pay recipient (SF−2801/SF−3107). Valid
values are Y (yes), N (no), and U (unknown). Type the applicable code to
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6:17Field Instructions For Personnel ActionsUpdated 01/08

indicate if the employee is receiving retirement payments based on military
service.

• Position 3, Military waiver received (SF−2801/SF−3107). Valid values
are Y (yes), N (no), and U (unknown). Type the applicable code to indicate a
military waiver was received declining military pay. If the employee is not a
retired military recipient, type N.

• Position 4, Survivor election (SF−2801/SF−3107).Valid values are Y (yes)
and N (no). Type the applicable code to indicate if the employee elected the
survivor option.

• Position 5, Post−1956 military deposit paid (SF−2801/SF−3107), Survivor
election (SF−2801/SF−3107). Valid values are Y (yes/not applicable) and N
(no). Type the applicable code to indicate if the employee paid Post−1956
military deposit. Type Y if the employee does not have military service.

• Position 6, Part-time after April 7, 1986 (SF−2801−1/SF−3107−1). Valid
values are Y (yes) and N (no). Type the applicable code to indicate if the
employee has any part-time service after April 7, 1986.

• Position 7, Administrative Fee. Valid values are Y (yes) and N (no). Type
the applicable code to indicate if the agency has to pay OPM a 9-percent or
15-percent administrative fee.

• Position 8, Life insurance reduction (SF−2818). Valid values are 0 (no life
insurance), 1 (75 percent reduction), 2 (50 percent reduction), and 3 (no
reduction). Type the applicable code to indicate if the employee is selecting a
reduction in life insurance.

• Position 9, FERS disability applicant−applied for SSA benefits. Valid
values are Y (yes) and N (no). Type the applicable code to indicate if a FERS
employee applying for disability retirement has also applied for social
security benefits.

Note: If the NOAC applies to one of the codes listed above and data is not entered
in this field, the pay plan must be FE, FO, or FP. NOAC 312 has been removed
from PINE Edit 478. If you are processing a 312 for discontinued service
retirement, you must complete these data elements in the Agency Use field. If you
are processing a 312 for Resignation-ILIA, this block must remain blank.

Bonus Pop-up Field Instructions

The Bonus pop-up (Figure 2:4) is used to enter bonus and incentive amounts and percentages.
For instructions on the entry process, see Entering A Personnel Action.

Relocation Bonus Numeric, 8 positions max.

Type the amount of the relocation bonus.
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Recruitment Bonus Numeric, 8 positions max.

Type the amount of the recruitment bonus.

Supervisory Percent Numeric, 2 positions

Type the percentage rate for the supervisory allowance.

Retention Percent Numeric, 2 positions

Type the percentage rate for the retention allowance.

Employee Data Pop-up Field Instructions

The Employee Data pop-up (Figure 2:5) includes data elements that relate to the employee
(e.g., gender, date of birth, race and national origin, etc.). For instructions on the entry
process, see Entering A Personnel Action.

Gender Alpha, 1 position

Type the employee’s sex identity. Valid values are F (female) and M (male).

RNO Code Alpha, 1 position

Type the employee’s race and national origin. For valid codes, see the RNO
Code Table.

• Duty station cannot be Puerto Rico for RNO codes A, C,or E.

• Duty station must be Puerto Rico for RNO code D or Y.

• Duty station cannot be Puerto Rico or Hawaii for RNO code B.

• Duty station must be Hawaii for RNO codes F, G, H, J, K, L, M, N, P, or Q.

• RNO code 0 (zero) is valid for: citizenship code O; special employee code
45 or 46; duty station Panama.

Date Of Birth Numeric, 8 positions

Type the employee’s date of birth.

• The date of birth must be at least 16 years but no more than 90 years prior to
the effective date of the action.

Handicap Code Numeric, 2 positions

Type the code that identifies physical or mental disabilities, or history of such
disabilities. For a list of valid codes, see the Handicap Code Table.
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6:19Field Instructions For Personnel ActionsUpdated 01/08

• Must be 05 through 94 for authority codes WTM, YKM, or WUM.

Veterans Preference RIF Numeric, 1 position

Type the code that identifies employees who are entitled to veterans preference
for RIF purposes. For a list of valid codes, see the Veterans Preference RIF
Table.

• Veterans preference must be 6 if veterans preference RIF is 1.

• Veterans preference must be 2 through 5 if veterans preference RIF is 2.

• Veterans preference must be 1 or 7 if veterans preference RIF is 3.

• Veterans preference cannot be 1, 5, or 7 if veterans preference RIF is 4.

• Veterans preference cannot be 1 if veterans preference RIF is 5.

Veterans Status Alpha, 1 position

Type the code that identifies veterans who served during the Vietnam Era
(August 6, 1964 through May 7, 1975). For a list of valid codes, see
the Veterans Status Table.

• Veterans preference must be 2, 3, 4, or 6 for veterans status code V.

Veterans Preference Numeric, 1 position

Type the employee’s category of entitlement to preference in the Federal service
based on military service that terminated honorably. For a list of valid codes, see
the Veterans Preference Table.

• Must be completed for a change in veterans preference action.

• Must be 6 for special employment programs code 60.

• Must be 2, 3, 4, or 6 for Veterans Status V.

• Complete the Agency Use field as follows for NOAC’s 300 through 304,
312, 350, 356, and 976.

If military retired pay
recipient is:

The military retired
waiver is:

Y Y, N, U

N N

U U

• If the NOAC applies to one of the codes listed above and data is not entered
in the Agency Use field, the pay plan must be FE, FO, or FP.

Uniform Service Status Numeric, 1 position

Type the employee’s current military status. For a list of valid codes, see the
Uniform Service Status Table.
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• A date must be entered in the Date Retired Military field when uniform
service status is 4 or 5.

Citizenship Numeric, 1 position

 Type the code that identifies whether the employee is a U.S. Citizen. Valid
values are 1 (citizen by birth or naturalization) or 8 (other).

Annuitant Indicator Alphanumeric, 1 position

Type the code that identifies whether the employee is receiving retired or
retainer pay from previous civilian or military service. For a list of valid codes,
see the Annuitant Indicator Table.

• A date must be entered in the Date Retired Military field when the annuitant
indicator is 4, 5, or C through F.

• Must be 1, 4, 5, or A through F if salary share code is 3, 4, or 5.

• Must be 1, 4, 5, or A through F if retirement plan is 4 or the work schedule
is I.

• Salary share amount must be completed for annuitant codes 1, 4, 5, A, C, E,
G, H, or J.

Education Level Numeric, 2 positions

Type the code that identifies the highest level of the employee’s educational
attainment based on years of formal schooling and/or academic degrees or
certificates conferred. For a list of valid codes, see the Education Level Table.
To enter the school code for the degree or certificate, select at the New
Documents menu of the EPIC Navigation window Payroll Document >
Education/Certification > Education. At the menu bar, select Edit > Add New
Document. TMGT Table 032, School Identification, lists the instructional
program codes.

• Complete Year Degree Attained field when education level is 06, 10, or 13
and above.

• Complete the Instructional Program field when the education level is 06,
10, or 13 and above.

Year Degree Attained Numeric, 4 positions

Type the calendar year during which the employee received the academic degree
or certificate for the education level.

• Must be 17 years later than date of birth.

• Complete when the educational level is 06, 10, or 13 and above.

Instructional Program Numeric, 6 positions

Type the employee’s official education record which includes the major field of
study beyond high school. Refer to OPM instructions for valid codes.
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6:21Field Instructions For Personnel ActionsUpdated 01/08

• Complete when education level is 06, 10, or 13 and above.

• To enter the school code for the primary and secondary education records
select at the EPIC Navigation window, New Document menu Payroll
Document > Education/Certification > Education.

Miscellaneous Pop-up Field Instructions

The Miscellaneous pop-up (Figure 2:7) displays miscellaneous data elements (e.g., tenure,
special employee code, SCD leave, etc.). For instructions on the entry process, see Entering A
Personnel Action.

Tenure Numeric, 1 position

Type the retention group (for RIF purposes) in which the employee is placed,
based on the type of appointment. For a list of valid codes, see the Tenure Table.

• Cannot be 0 for an excepted appointment or a conversion to a permanent
appointment.

• Must be 0 for pay plan ES.

• Career tenure date must be blank for tenure 0.

• Type appointment must be 04 or 09 for tenure 0.

• Authority code ZNM requires the tenure to be 0 with type appointment 08.

• Must be 0 or 3 if authority code is WXM, W5M, or W7M or begins with M
or N (except NUM).

• Must be 1 for pay plans VM, VN, and VP.

• Must be 1 for NOAC 502/JMM.

• Type appointment must be 01 or 06 for tenure 1.

• Probationary period and career tenure start dates must be blank for tenure 1.

• Must be 1 or 3 if authority code begins with K (except KLM).

• Must be 2 if authority code is J8M, YAM, Y1M, Y2M, Y3M, or Y4M.

• Career tenure date must be present for tenure 2.

• Type appointment must be 01, 02, 06, or 07 for tenure 2.

• Type appointment must be 03, 08, 09 for tenure 3.

• Type appointment 08 with tenure 3 requires the career tenure to be blank.

SCD−RIF Numeric, 8 positions

Type the SCD for RIF purposes.
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• Cannot be later than effective date of action.

• Complete if the type appointment is changing from temporary to permanent.

• Complete if the tenure is changing to 3 and the type appointment is changing
to 9.

• Must be at least 16 years but not more than 90 years from the date of birth.

• Must be blank for type appointment codes 04 and 09.

• Do not complete if same as SCD−Leave; the system will generate the date
from the SCD−Leave field. Conversely, complete the SCD−RIF if different
than SCD−Leave.

Sup/Managerial
Probationary Period
Required Numeric, 1 position

Type the code that indicates whether a supervisory/managerial probationary
period is required, served, or waived. For a list of valid codes, see the
Supervisory/Managerial Probationary Period Required Table.

Sup/Managerial Start
Date Numeric, 8 positions

Type the starting date for the supervisory/managerial probationary period, or for
an SES probationary period.

• If previous service is unknown, enter the effective date of the action. An
additional probationary period may not be required if previous service is
creditable. A manual record should be recorded in these cases.

• Must not be later than the effective date of the personnel action.

• Supervisory code must be 1 or 3 if this field contains a date.
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6:23Field Instructions For Personnel ActionsUpdated 01/08

Probationary Period
Start Date Numeric, 8 positions

Type the beginning date of a one year probationary (or trial) period. The system
automatically removes the date after one year of creditable service.

When this date is initially furnished, the PPS begins maintaining two records,
creditable service and nonpay status, as shown on the T&A and as recorded on
personnel actions. Creditable service is recorded on the employee’s database
intermittent record (IRIS Program IR129) and nonpay status is recorded on the
employee’s nonpay leave record (IRIS Program IR140).

If a personnel action changes or corrects the date previously furnished, the
creditable service is disregarded, and beginning with the processing pay period
in which the personnel action was processed, a new record of creditable service
is started. However, the nonpay status record maintained since the date was
originally furnished remains unchanged.

The PPS credits full calendar time for periods of full-time and part-time service,
and 7 days calendar time for every 5 days of intermittent service. Creditable
service is reduced for each workday in nonpay status (other than for military
furlough or compensable injury) which exceeds 22 workdays (e.g., up to 22
days of nonpay is considered creditable service since it is forgiven).

Report Number AECO36T2, Notification of Expiration of Probationary or Trial
Period, is produced each pay period and distributed to agency personnel offices
to identify those employees approaching expiration of probationary or trial
periods. This report is produced four months prior to the expiration date.

Employees who have previous service which is creditable toward this date may
not be required to serve the complete probationary period. Agency personnel
offices must maintain manual records for these employees.

• Complete when tenure is 2 and type appointment is 01.

• Complete for type appointments 01, 02, 03, and 06 through 09.

• Complete when the type appointment 01 or 06 and the tenure is 2.

• Must be blank for tenure 0 or 1.

• Must be blank for tenure 3 with type appointment 08.

• Do not process a personnel action to remove the date.

• Enter the effective date of the accession if previous service is unknown.

• Cannot be later than effective date of action.

• The PPS generates the effective date of the action as the probationary period
start date if a date is not entered for the following NOAC’s.

Code Description

100 Career Appointment

101 Career Conditional Appointment

140 Reinstatement−Career Appointment

141 Reinstatement−Career Conditional Appointment

170 Excepted Appointment
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• If this date is prior to the effective date of the accession, adjust the date to
include any previous service which is creditable toward the probationary or
trial waiting period. Do not adjust this date to include prior periods of nonpay
status; this data must be entered as an SF−1150, Record of Leave Data
Transferred, payroll document. To enter the SF−1150, select at the EPIC
Navigation window, New Document menu Payroll Document > Leave Data
Transferred. At the menu bar, select Edit > Add New Document.

Career Tenure Start Date Numeric, 8 positions

Type the beginning date for counting service toward career or permanent tenure.

When initially entered, the PPS begins maintaining two records; creditable
service and nonpay status as shown on the time and attendance report and as
recorded on personnel actions. If a date is not entered on the accession action,
the PPS will not establish any record of creditable service and/or nonpay status.

• Cannot be more than three years from the effective date of the accession
action.

• Enter effective date of accession action if previous service is unknown.

• Cannot be later than the effective date of the personnel action.

• Do not complete for career appointment/conversion actions.

• Do not complete if service is not creditable (e.g., Schedule B student and
VRA appointments). The PPS automatically removes this date once a
minimum of three years of creditable service has been completed.

• For Taper and indefinite appointments in the competitive service, enter the
beginning date of creditable service toward career status under P. L. 90−105.

• When adjusting the date, include previous service that is creditable toward
the career tenure waiting period. Do not include prior periods of nonpay
status; this data is entered on the leave data transferred payroll document.

• Must be blank for tenure 0 and 2.

• Must be blank for type appointment 08 with tenure 3.

• Complete when the tenure is 2 and the type appointment is 02.

Date Entered Present
Grade Numeric, 8 positions

Type the date when the employee was most recently assigned to the current
grade.

• Must be completed when grade changes.

• Cannot be later than the effective date of the personnel action.

• Must be completed for grade retention actions.
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Losing/Gaining
Department Alphanumeric, 2 positions

Type the Federal department or place of employment for an employee moving
into or out of a Federal department. See TMGT Table 014 for a list of
department codes. For a list of valid codes, see the Losing/Gaining Department
Table.

• Complete for a transfer in accession or transfer out separation NOAC.

• If the transfer is for departments serviced by NFC, enter the losing
department code on the accession action and the gaining department code on
the separation action.

Special Employment
Program Alphanumeric, 2 positions

Type the code that identifies employees in special employment programs. For a
list of valid codes, see the Special Employment Program Table.

• Special Employment Programs codes 42 through 46 are for USDA only.

• Veterans preference must be 6 for special employment programs code 60.

• Pay plan must be EX or SR for special employment programs code 91.

• Grade must be 05 through 09 for special employee codes IP and HT.

• Grade must be 05 through 15 for special employee code PP.

• Must be PZ for agency code JA.

• Special Employment Programs Code EH is for Department of Labor only.

• Below is a table of the special employment programs code with the
appropriate work schedule and type appointment code.

Special
Employment
Program Work Schedule

Type of
Appointment

Employee
Type

00, G1, G2 F, G 06, 07 A

G7 F, G 08

00, 12, 59, 69, 97, G4,
G5 F, G 08, 09 B

G6 F, G 08, 09

00, G1, G2, G6 P, Q, S, T 06, 07 C

00, G3  I, J D

67 or 77 F, G, I, J, P, Q, S, T F or G

00 F, G, P, Q, S, T 09 H

67 or 77 I , L

GR F, G 08 R

GS F, G 08 S

00 F, G, I, J, P, Q, S, T 09 V
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Note: Employee type applies to agencies 85 (CSCE) and 97 (GAO) only.

Special Employee Numeric, 2 positions

Type the code that identifies employees belonging to special categories of pay
processing not accommodated in any other portion of the PPS. Data in this block
also assists agency personnel offices in the preparation of certain output listings
and reports. For a list of valid codes, see the Special Employee Table.

• A split T&A may be required if the action is effective other than the first
Sunday of the pay period.

• Special employee codes 01, 02, 03, and 08 are invalid for Senior
Executive Service.

• The following applies to special employee code 04:

Agency code must be 07

Pay plan must be AD

Grade and step must be 00

Pay basis must be PD or WC (PD salary must be in TMGT Table 055)

Pay rate determinant code must be 0

Remarks code 273 must be shown for pay plan WC

• The following applies to special employee code 05:

Agency code must be FA

Pay plan must be AD

Occupational series must be 0301

Pay basis must be PH

Agency code must be 07

Pay plan must be AD

Occupational series must be 0301

Grade and step must be 00

Pay basis must be PD or WC (PD salary must be in TMGT Table 055)

Remark code 273 must be shown for WC pay plan

• Agency code must be 74, retirement plan must be 8 or 9 for special employee
code 05.

• Pay plan must be AD, EH, EI, EX, FE, FO, GS (grade 16 − 18), or SR for
special employee code 05.

• Pay plan must be EC, ED, EE, EF, EG, EH, or EI for special employee
code 07.
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• Special employee codes 09, 23, 25, 41 through 44, 47, and 48 apply to
agency 11 only.

• For agency 57, the supervisory code must be 2 for special employee
codes 12, 16, 18, and 19.

• Special employee code 13 applies to Agency 03 only.

• Occupational series code must be 1811 or 1812 for special employee
code 26.

• Pay plan must be ES for special employee code 26.

• Cannot change special employee code 26 to special employee code 01,
02, 03, or 08.

• Occupational series code must be 1811 or 1812 for special employee
code 26.

• The FLSA code in PMSO must be E or N for special employee code 26.

• The pay plan cannot be ES for special employee code 26.

• Special employee code 30 applies to agencies 03, 10, 34, and 37 only.

• Special employee code 31 applies to agency 02 only.

• Special employee code 33 applies to agency 34 and 37 only.

• To record the mileage in the pay period that the travel is performed, the
timekeeper must code the T&A with Transaction Code (TC) 17 Prefix 50
(Travel Reimbursement).

• Special employee code 45 requires a YCC enrollee NOAC and agency
code 11 (Forest Service).

• Accession NOAC for special employee code 45 is 911.

• Accession NOAC for special employee code 46 is 906.

• Cannot process a conversion action for special employee codes 45 and 46.

• The following apply to special employee codes 45 and 46:

Agency code must be 11

Pay plan must be AD

Grade and step must be 00

Occupational series must be 0000

FEGLI code must be A

FEHB code must be 2

FLSA code must be E

• Special employee code 60 applies to agency 83, occupational series codes
0510 and 0511.
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• Special employee code 81 applies to agencies 02 and 11 only.

Type Appointment Numeric, 2 positions

Type the type appointment code for which the employee has accepted the
position. This code is used in reporting employment statistics to the Office of
Management and Budget (OMB) and OPM, particularly for the SF−113 series
on work force statistics. For a list of valid codes, see the Type Appointment
Table.

• A split T&A may be required if the effective date of the action is other than
the first Sunday of the pay period.

• Must be 01 for career actions.

• Must be 01 or 06 for tenure 1.

• Must be 01, 02, 06, or 07 for tenure 2.

• Probationary period start date must be completed for type appointment 01,
02, 03, and 06 through 09.

• Must be 02 for career-conditional actions.

• Must be 03, 08, 09 for tenure 3.

• Must be 04 or 09 for tenure 0.

• Type appointment 08 with tenure 3 requires the career tenure to be blank.

• Must be 09 for Smithsonian Institution intermittent employees.

• Complete the SCD RIF if the tenure is changing to 3 and the type
appointment is changing to 09.

• If change is from temporary to permanent type appointment, complete the
SCD RIF.

Annual Leave

A type of leave earned based on time in service composed of a category, 45-day
code, and earning status during the pay period.

Category Numeric, 7 positions

Type the employee’s annual leave earning status. For a list of valid codes, see
the Annual Leave Category Table.

• Must be completed for full-time and part-time employees who are eligible to
earn annual leave.

• Must be compatible with the service computation date for leave.

• SCD for leave must be completed when annual leave category is other than
0.

• Must be completed when SCD for leave is changed, as applicable.
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6:29Field Instructions For Personnel ActionsUpdated 01/08

45 Day Alpha, 1 position

Type the code that identifies employees who are stationed at an overseas foreign
post of duty that are entitled to carry over from one leave year to another for a
maximum of 45 days annual leave accumulation.

• Applicable when an employee is in a foreign duty station.

• Must be Y for foreign duty stations.

• Adjust the annual leave ceiling at the end of the leave year, if applicable,
when the employee returns from a foreign post.

Earning Status Alpha, 1 position

The code that identifies if an employee is entitled to leave accruals for the first
pay period of leave eligibility or for the last pay period of employment. Valid
values are N (not entitled to earn leave) and Y (entitled to earn leave).

• Must be completed on accession and separation actions for alternating tour of
duty and part-time employees.

• Must be blank if Annual Leave Category is 0.

Previous/Correction

The following fields are used to correct/update documents when processing
history correction packages.

Agency Alphanumeric, 2 positions

Type the previous agency code in this field.

NOA Numeric, 3 positions

Type the previous nature of action code.

1A Cd Alphanumeric, 3 positions

Type the first authority code for the previous NOA.

2A Cd Alphanumeric, 3 positions

Type the second authority code for the previous NOA.

Date Numeric, 8 positions

Type the effective date of the previous NOA.

Correct SSN Numeric, 9 positions

If correcting the SSN, type the correct SSN in this field.
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Name Correction

Check this box if correcting the name.

Clear Error Codes Conditional, Alpha, 1 position each

For instructions on Clear Error Codes, see Requesting EPIC Reports And
Correcting Data.

Personnel Action Window Key Data Field Instructions

The Personnel Action window (Figure 2:2) is displayed after you select the NOAC at the List
Of Personnel Actions window. This window includes key data that identifies the employee
(SSN, name, etc.) and the action (NOAC, authentication date, etc.). For instructions on the
entry process, see Entering A Personnel Action.

Dept/Agcy Alphanumeric, 4 positions

Type the department and agency codes.

POI (Personnel Office
Identifier Numeric, 4 positions

Type the assigned code that identifies an agency personnel office. The POI
identifies the personnel office to which the employee is assigned.

• Must be completed for change in POI.

SSN Numeric, 9 positions

Type the employee’s social security number.

Pay Period Numeric, 2 positions

Type the number of the pay period in which the personnel action is entered.

Eff Date Numeric, 8 positions

Type the effective date of the personnel action.

Note: When more than one personnel action is processed during the same
processing pay period, and the actions are not entered in sequence according to
the effective dates, the system will automatically rollback any actions not in
sequential order.

• May require a split T&A if the effective date is not the first day of the pay
period:

The employee’s rate of pay is changing.
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The employee is being moved either within an agency or between agencies in
a department, except where it is an inter-agency move which does not change
the employee’s grade or salary, T&A contact point, organizational structure
code, position number, or duty station.

The employee is being terminated and rehired within the same pay period.

The employee’s type of retirement coverage is being changed from FICA to
Civil Service Retirement, or vice versa.

The employee’s work schedule is being changed and the change will affect
the employee’s leave accrual.

The employee’s service year beginning date is being changed and
employment is subject to an hourly, daily, and/or monetary limitation.

Any change not listed in the above situations that would impact the
employee’s leave accrual.

• Required for all personnel actions.

• Should be the first day of the effective pay period for certain actions.

• Must be the same or later than the last action.

• Must be equal to or earlier than the effective date of the processing pay
period when the retirement code is changed.

• Must be earlier or equal to SCD−Retirement, RIF, WGI.

Auth Date Numeric, 8 positions

Type the authentication date for the personnel action. If two actions with
identical effective dates are entered in the same pay period, the system sorts
based on the authentication date.

• Must be earlier than effective date.

• For the Federal pay increase, type the date the Executive Order the Federal
pay increase was signed.

Date NTE Numeric, 8 positions

Type the not-to-exceed (NTE) date for an appointment, nonpay status, extension
or other action for which the action will expire unless extended, renewed, or
removed.

For payroll and timekeeping purposes, this date is considered to be effective at
the close of business on the date entered in this field.

• Must be completed for temporary-type actions (temporary promotion,
temporary appointments, extensions, LWOP, etc.). Conversely do not
complete this field for permanent-type action (permanent promotion, career
appointment, etc.)

• Must be completed for type of appointment codes:
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Code Definition
03 Competitive−taper
04 Competitive−temporary
08 Excepted−indefinite
09 Excepted−temporary

• Must be 10 or more days later than the effective date of the action.

• Must be one year later than the effective date for competitive−indefinite (03)
term appointments/conversions.

• Must be completed only for those NOAC’s that require a NTE date.

• Must be completed for a promotion when the pay plan is PA or PE and the
grade is 00.

• Must be more than 1 year and less than 5 years from the effective date of a
senior foreign service non-career appointment−NTE.

• Must be completed for Special Employee Code 81 (temporary employee−FS
pilot units).

1st NOA Numeric, 3 positions

The first NOAC is system generated from the personnel action selected at the
List Of Personnel Actions window.

1A Auth Code Alphanumeric, 3 positions

Type the first authority code for the first NOAC.

• For the Federal pay increase, type QWM.

• Enter the authority code for all official actions, as applicable.

• Enter one or both authority codes based on the NOAC.

1B Auth Code Alphanumeric, 3 positions

Type the second authority for the first NOAC.

• For Federal pay increase, type ZLM.

• The occupational series code must be 0099, if the authority code is YAM or
Y1M.

• The occupational series code must be 3506, if the authority code is WVM or
ZVM.

• The occupational series code must be 3506, if the authority code is WVM or
ZVM.

• Appointing authority must be valid.

• The pay plan must be compatible with the appointing authority.
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6:33Field Instructions For Personnel ActionsUpdated 01/08

Legal Auth [1A] Alphanumeric, 20 positions max.

Type the description of the law, executive order, regulation, rule, or other basis
that authorizes the personnel action.

• For Federal pay increase, type the regulation (e.g., Reg.531.205) and the
Executive Order Number (EON). Note: Agencies with special authorities
must use the agency-cited authority. For SES employees, Levels ES−1
through ES−5, the authority code is ZLM and the EON; Pay Plans SL and
ST, the authority is ZLM, Reg. 534.504 and the EON.

2nd NOA Numeric, 3 positions

The data in this field is system generated from the original personnel action that
is corrected or cancelled.

2A Auth Code Alphanumeric, 3 positions

The data in this field is system generated from the original personnel action that
is corrected or cancelled.

2B Auth Code Alphanumeric, 3 positions

The data in this field is system generated from the original personnel action that
is being corrected or cancelled.

Legal Auth [1B] Alphanumeric, 20 positions max.

Type the description of the law, executive order, regulation, rule, or other basis
that authorizes the personnel action.

Name Last, First, Middle Alphanumeric, last 17 positions max., first 12 positions max., middle 12 positions max.

Type the name by which an employee is known or designated on all official
transactions.

A total of 25 characters are actually printed on the salary payment. If the name
exceeds 25 characters, the first name will be reduced and printed as an initial.

When the SF−50-B is printed, the entire name is limited to 35 characters; the
name will be adjusted as described above.

Once the employee is established in the database, the name will be generated on
all actions entered. If the name is not generated, either the Employee Name
database is unavailable, the incorrect social security number was entered, or the
employee is not established in the Payroll/Personnel database. Always verify the
generated name agrees with the social security number that is entered.

• Complete for accession actions and name change/correction actions.

• Last name must contain at least two alpha characters; first and middle names
at least one alpha character each.

• Enter items such as Jr, Sr, III, etc. one space after the last name. If more than
one space, the additional item will not print on the SF−50−B.
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• If the employee has a two-part last name (e.g., Smith Martin), use a space to
separate the two parts.

• If the employee has two or more first names or initials (e.g., John Paul or J P)
and each is to be shown, use a space to separate the two names.

• If the employee has two or more middle names or initials (e.g., Ann Marie or
A M) and each is to be shown, use a space to separate the two names or
initials. Leave the middle name blank if the employee has no middle name or
initial.

• Do not use any type of punctuation (e.g., hyphen, period, etc.) in any part of
the name.

• A space counts as one character. For long names, ask the employee to decide
on an abbreviation.

• Do not include titles, such as Mr., Mrs., Ms., Dr., Prof., etc., as part of the
name.

• To change the name, at the EPIC Navigation window, New Documents
menu, select Personnel Action > Change > 780 Name Change. At the menu
bar, select Edit > Add New Document.

Print SF50 Optional

This field is used to print SF−50’s when working with history correction
packages.

Status Code Alpha, 1 position

Type the code that indicates the disposition of a document. Certain status codes
are entered by the user; others are system generated. The status code also
appears on the List EPIC Document window and on each payroll document
window. The valid status codes for a personnel action are H (hold);
I (incomplete); R (release); S (severance); W (waiting). For a complete list and
explanation of status codes, see Status Code Tables.

Note: The transactions in hold, waiting remarks, or incomplete status are
accessible in EPIC for modification and release. Applied actions can only be
viewed.

Position Data Pop-up Field Instructions

The Position Data pop-up (Figure 2:6) includes data elements that relate to the position (e.g.,
master record number, individual position number, etc.). For instructions on the entry
process, see Entering A Personnel Action.
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Position Classification
Code Numeric, 1 position

Type the code that defines the disposition of the individual position in PMSO.
For a list of valid codes, see the Position Classification Code Table.

The entry of the position classification code sets the status of the position in
PMSO after the employee is removed from the position. All other changes to the
individual position must be performed in PMSO or a FESI.

• When an employee is reassigned (1) from one agency to another or (2) to
another personnel office within the same agency, the losing office should
advise the gaining office of the action to be taken with the employee’s former
position (i.e., abolish, inactivate, etc.)

• If a cancellation of a previous position change is processed, a vacant and
active individual position number must exist in PMSO. It may be necessary
to establish a temporary individual position if the employee’s former position
is no longer vacant or was abolished.

• If a temporary position is established to process a cancellation, enter the
position classification code as follows:

On the cancellation, type 0 to leave that position vacant and active.

On the restored action, type 1 to abolish the temporary position.

• Must be 0, 1, or 2 (inactivate former position) if the position is being
vacated.

Position Occupied Numeric, 1 position

Type the code that indicates if the position is in the competitive service,
excepted service, or senior executive service. For valid values, see the Position
Occupied Table.

• Codes 1 and 2 are system generated for all accession personnel actions
based on the NOAC.

• Must be 3 or 4 for SES employees.

• Verify the type appointment and tenure codes are compatible with the
position occupied code when changing this code.

PMSO Key

The PMSO key consists of the department, agency, POI, position classification
code, grade, master record number, and individual position number for a
position.

• All data elements in the PMSO key must be identical to the PMSO key data
elements in PMSO except for the position classification code, which is
entered on the personnel action only.
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(Dept) Department Alpha, 2 positions

Type the unique identification of the Department to which the employee is
assigned.

Agency Alphanumeric, 2 positions

Type the agency to which the employee is assigned. The agency code may be
different than the OPM assigned agency code. If different, the OPM assigned
code is reported in CPDF and printed on the SD−50B; the NFC assigned code is
shown on all other output.

• A split T&A may be required if the effective date of the change action is
other than the first Sunday of the pay period.

• Must match first level of organizational structure code.

POI (Personnel Office
Identifier) Numeric, 4 positions

Type the assigned code that identifies an agency personnel office. The POI
identifies the personnel office to which the posiiton is assigned.

Grade Numeric, 2 positions

Type the grade of the position.

Master Record Number Alphanumeric, 6 positions max.

Type the master record number for the position the employee is occupying.

Individual Position
Number Alphanumeric, 8 positions max.

Type the individual position number for the position the employee is occupying.

• The detail individual position number must be different than the incumbent
position individual number in PMSO.

• The position must be active and vacant in PMSO when an employee is being
placed in the position.

History Position Data

Occ Series Required, numeric, 4 positions

Type in the applicable occupational series code. For a list of valid values, see
TMGT Table 018, Occupational Series Alpha Description.

Occ Ser Func Required, numeric, 2 positions

Type in the applicable function code if the occupational series code requires a
occupational function code.
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Official Title PF/CD/SF
(Prefix/Code/Suffix) Required, alphanumeric, 8 positions: PF=2, CD=4, SF=2

Type the prefix, position code, and suffix code for the official title.

Supv Cd Required, numeric, 1 position

Type in the applicable supervisory code. Valid values are:

Code Definition

2 Supervisor or manager

4 Supervisory (CSRA)

5 Management Official (CSRA)

6 Leader under work leader grade evaluation guide

8 All other positions

Prof Category Optional, alphanumeric, 1 position

Type the applicable professional category code. Valid values are:

Code Definition

1 SES or equivalent

2 Professional − audit related

3 Professional − other

4 Clerical support staff

5 Wage

6 Expert/consultant

MR−Agy−Use Optional, alphanumeric, 10 positions

This is a multipurpose field which agencies may enter agency specific data.

Official Title Required

Type the official title in this position.

FLSA CD Required, alphanumeric, 1 position

This field indicates if the position is exempt or nonexempt from the overtime
provisions of the Fair Labor Standards Act. Valid values are E−Exempt,
position is exempt from the minimum wage and overtime provisions of FLSA;
or N−Nonexempt, position is subject to the minimum wage and overtime
provision of FLSA.

Pay Tbl Optional, alphanumeric, 6 positions

Type the code assigned by OPM.
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Note: The Pay Table code is required for position whose official title suffix is B
(data-transcriber), C (official automation, E (stenographer/office automation),
T (typing), or Y stenography, and the duty station state is 11 District of
Columbia).

Pos Sens Required, alphanumeric, 2 positions

Type the code that indicates whether or not the position is sensitive and the
extent of the sensitivity. 

Valid values are:

1st
Position

Code

Definition 2nd
Position

Code

Definition

1 Nonsensitive/low risk C Computer − ADP

2 Noncritical sensitive N Noncomputer − ADP

3 Critical sensitive

4 Special sensitive

5 Moderate risk

6 High risk

PATCO Cd Optional, alphanumeric, 1 position

The professional category code is system generated to this field. Valid values
are: P Professional, A. Administrative, T Technical, C Clerical, O Other, B Blue
Collar, amd M Mixed Collar.

Comp Lev Required, alphanumeric, 4 positions max

Type the code that identifies positions so alike as to be interchangeable during a
reduction-in-force.

Work Title Code Optional, numeric, 4 positions

Type the 4-digit code working title code and the system will generate the
description of the working title.

Work Title Optional, alphanumeric, 38 positions

Type the working title of the position in this field if working title code is not
listed in TMGT Table 076, Working Position Title.

Accounting Station Code Required, numeric, 4 positions

Type the agency-assigned accounting station code in this field.

Org Structure Code Required, numeric, 18 positions max.

Type the organizational structure code that identifies the location of an
employee’s position by each level of organizational structure.
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6:39Field Instructions For Personnel ActionsUpdated 01/08

Duty Station Code (state,
city, county) Required, alphanumeric 9 positions: state=2, city=4, county=3

Type in the state, city and country codes in which the position is located. See the
OPM Web site or Table Management Table 016, Geographical Location Codes
with Names, for valid location codes.

IP−Agy−Use Optional, alphanumeric 12 positions max

This is a multipurpose field into which agencies may enter agency specific data.

Bargaining Unit Status Required, numeric, 4 positions

Type the bargaining unit status code applicable for the position. Valid values are:

Code Definition

7777 Person is eligible but not in a bargaining unit status.

8888 Person is ineligible for inclusion in a bargaining unit.

Last 4 digits
of OLMR
number

Position is represented by a bargaining unit. The Office of Labor
Management Relations (OLMR) number is established by OPM and
contained in the Union Representation in the Federal Government
publication.

COPR ST Optional, alpha, 1 position

Click to select this field if the employee is eligible to be covered and paid by the
provisions of the Customs Officer Pay Reform Act.

LEO Indicator Optional, alpha, 1 position

Type in the applicable law enforcement officer (LEO) indicator to indicate that
the position is classified as law enforcement under the Federal Employees Pay
Comparability Act of 1990 (FEPCA).

Note: This field must be completed on all law enforcement positions to ensure
correct pay entitlement.

Position Status Budget Required, alphanumeric, 1 position

Type in the code that indicates whether the position is permanent.

Remarks Window Field Instructions

The Remarks window (Figure 2:11) is used to enter, update, view, and delete remarks data
after a personnel action has been entered and saved. For instructions on the entry process, see
Entering A Personnel Action.

1st NOA No entry

The nature of action code is system generated from the Personnel Action
window.
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2nd NOA No entry

The nature of action code is system generated from the Personnel Action
window.

Remark Code No entry

The required remarks codes are system generated based on the NOAC;
agency-entered optional remarks codes are system generated from the remark
code entered in the Detail area.

Note: Remark code 499+ can only be used once per document.

Status Code No entry

The status codes are system generated to indicate if the remark description is
complete or requires a literal fill-in.

• If the status code is W (waiting remarks literal fill-in description), click the code to
display the remark code and description in the Detail area of the window. Then go
to the detail area and add the fill-in text in the Remark Description field. Repeat
this process for each code with Status Code W.

• If the status code is R (remark is ready for release), no action is needed.

Detail

This area is used to add, update, or delete remarks data.

Remark Code Conditional, alphanumeric, 3 positions

Complete this field as described below:

• To add or update a required remark, select a code from the code list in the
above area. The code appears in this field and the description is generated in
the Remark Description field below. Exception: Remark Code 499 is free
form and does not generate a description. Go to the Remark Description field
to add/update the description. 

• To add an optional remark code, click in this field and type the code. (If the
field is not blank, select Edit > Clear at the menu bar to clear the field before
typing the code.) After typing the code, select Edit > Add. The message
Remark successfully added is generated. If applicable, go to the Remark
Description field to add the remark description or fill-in text. 

• To delete a remark code, select a code from the code list in the above area.
The code appears in this field and the description is generated in the Remark
Description field. Click Edit > Delete. The message Remark successfully
deleted is displayed. Required remark codes cannot be deleted.
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6:41Field Instructions For Personnel ActionsUpdated 01/08

Remark Description Required, alphanumeric, 74 positions max.

Add or edit the description, then select Edit > Update at the menu bar. The
message Remark successfully changed is displayed and the status code changes
to R.

Caution: A personnel action remains in EPIC until the remarks status code
changes to R.

Salary Data Pop-up Field Instructions

The Salary Data pop-up (Figure 2:8) displays data elements that relate to the salary record
(e.g., grade, step, basic pay, etc.). For instructions on the entry process, see Entering A
Personnel Action.

Pay Plan Alpha, 2 positions

Type the plan prescribed by law or other authoritative source that governs the
compensation paid an employee. Each plan provides for a separate wage/pay
scale that determines the scheduled rate(s) of pay which the employee is to
receive, according to the grade and step. For a list of valid codes, see TMGT,
Table 025, AD−350, Personnel Block and Description.

• The grade and step must be 00 for pay plan AD.

• For agency code 63, the grade can be 60, 70, or 80 and the step must be
00 through 10.

• For agency code JA the step must be 00.

• Complete the Grade field for Pay Plan DB. Type 00 in the Step field.

• Base salary must be within the range of TMGT Table 098 for applicable pay
plan.

• Pay Plan EC not valid for an accession action.

• The following apply to Pay Plan ZZ:

Salary rate code must be WC

Scheduled salary must be blank

Grade and step must be 00

Pay rate determinant code must be 0

Retained rate expired date must be blank

• Tenure must be 0 for pay plan ES.

• Must be EX, ES, FE, or IE with retirement plan code R, T, W, or X; SR with
retirement plan code 8 or 9; DB with retirement plan code 2.
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• Must be EX or SR for special employment programs code 91.

• Pay Plans FO, FP, or FS with step 14 are not entitled to a within-grade
increase.

• For Pay Plans GG, GS, GT, IS, LG, NF, or VG, the grade must be greater
than 08.

• The basic pay for pay plan GM must be equal to or greater than the amount of
step 01 of TMGT Table 029.

• Pay plan must be GS to receive supervisory differential.

• FLSA code for pay plan GS must be N for grades 01 through 04.

• FLSA code for pay plan GS must be E for grade 12 and above for
occupational series codes 1980 and 2181.

• Pay plan must be GS or an FWS pay plan for PRD 4.

• Pay plans GS, GM, and VH, basic pay must be within the range of step 01
through 10 for the grade unless the pay rate determinant code is 2, 3, 4, J, K,
R, U, or V.

• FLSA code can be either E or N for pay plans GS, GT, IS, LG, and NF.

• Pay plan PA grade must be 11, 12, or 20.

• Pay plan PE grade must be 11, 12, 20, or 30.

• Pay plans PG, PL, PS, XD, XL, XN, XP, and XS occupational series code
must be in the range of 4400 through 4499.

• Pay plan PA for GAO pay for performance effective date must be
June 17, 1989 or later and the occupational series code must be 0904 or
0905.

• Pay plan PE for GAO pay for performance effective date must be 
June 17, 1989 or later and the professional category code must be 2.

• Pay plan cannot be PA, PE, or ZP for PRD 6, E, or F.

• Pay plan RG grade and step must be 01 through 05.

• Pay plan RW grade must be 01 through 15 and step 01 through 15.

• Pay plan TG Special Employee Code must be 85 for OTS employees who
exceed the pay cap.

• For agency 17 WB pay plan, the grade must be 00 and the step must be 01
through 09 for Occupational Series Code 2601. The step may be 00 if the
employee is being paid at a higher prevailing rate.

• Step must be 01 through 05 for FWS wage grade (WG) pay plan.

• The grade and step may be zeros for pay plan WM.

• Step must be 01 through 08 for FWS wage grade (WT) pay plan.
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• Pay plans ZA, ZP, ZS, ZT grade must be between 00 and 06.

• Must be compatible with the appointing authority.

• Pay plan must be compatible with quality step increase.

• FWS pay plan must be compatible with occupational series code in PMSO.

• Must be same as saved grade pay plan for grade retention termination.

Grade Numeric, 2 positions

Type the grade of the position.

• A split T&A may be required if the effective date is other than the first
Sunday of the pay period for a change action.

• Must be 00 if step is 00 for FWS pay plan; if position has no grade level for
ES pay plan

• Must be between 00 and 05 for pay plans ZA, ZP, ZS, and ZT.

• Must be between 00 and 25 for pay plan OC.

• Must be between 01 and 32 for FWS employees.

• Must be between 01 and 05 for pay plan RG.

• Must be between 01 and 15 for pay plan RW.

• Must be between 01 through 32 for FWS pay plans.

• Must be greater than 04 for pay plans GG, GS, GT, IS, LG, NF, and VG if
supervisory code is 1.

• Must be 05 through 09 for special employment programs codes IP and HT.

• Must be greater than 08 for pay plans GG, GS, GT, IS, LG, NF, and VG if
supervisory code is 3.

• Must be 11, 12,or 20 for pay plan PA.

• Must be 11, 12, 20, or 30 for pay plan PE.

• Must be between 01 and 30 for pay plan TG.

• Must be 60, 70, or 80 with step 00 through 10 for agency code 63.

• Must be at least one grade higher than current grade for promotion action
except promotion from a temporary promotion.

• Must be same as grade on database for system-generated pay raise.

• Do not complete for a QSI.

• For executive level employees (Pay Plan EX), enter the level as the grade
(e.g., Executive Level IV, type 04).

• Grade retention under 5 U.S.C. 5362, enter the retained grade as shown on
IRIS Program IR128; do not enter the grade for pay and benefit purposes.
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• For termination of grade retention, enter the grade shown on IRIS
Program IR128.

Step Numeric, 2 positions

Type the specific step within a grade, level, class, rank, or pay band.

• A split T&A may be required if the effective date is other than the first
Sunday of the pay period.

• Must be greater than step on database for a quality step increase.

• Must be one step greater than step on database for a WGI.

• Must be 00 for PRD codes J, K, U,V, 2, 3, and 4.

• Must be 00 for pay plan DB.

• Must be 00 if grade is 00 for FWS pay plan.

• Must be 00 for grade retention action.

• Must be 00 through 20 for agency code JA.

• Must be between 01 and 05 for pay plan RG.

• Must be between 01 and 04 for pay plan TG.

• Must be between 01 and 05 for FWS wage grade pay plan.

• Must be between 01 and 08 for WT pay plan.

• Must be between 01 and 15 for pay plan RW.

• Must be two steps higher than step on database for FWS wage step increase.

• Must be same as step on database for system-generated pay raise.

Basic Pay Numeric, 8 positions

Type the scheduled salary amount the employee is receiving for the position
held and which is fixed by law, regulation, or administrative action exclusive of
any allowance, adjustment, or differential.

The following TMGT tables include salary data:

• TMGT Table 029, Pay Table Rates

• TMGT Table 031, Special Pay Converters With Occupational Series and
Duty Stations

• TMGT Table 033, Special Pay Converters For Wage Board Employees

• For the Federal pay increase, enter the new scheduled salary amount which
includes the current Federal pay increase. Do not include the locality
payment. The PPS automatically increases the basic pay amount for
employees who are entitled to the locality payment based on the duty station.

• A split T&A may be required if the action is effective other than the first
Sunday of the pay period.
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6:45Field Instructions For Personnel ActionsUpdated 01/08

• Must be annual salary for General Schedule employees regardless of the
work schedule.

• Must be 6 percent more than database salary for promotion for agency JA,
pay plan AD.

• Does not include premium pay, allowances, or differentials (e.g., locality pay
adjustment or interim geographic adjustment (IGA), etc.)

• Must be scheduled salary shown on the database when processing a locality
pay adjustment or interim geographic adjustment.

Locality-based comparability payments are computed automatically based on
the pay plan and official duty stations for areas authorized to receive locality
payments. Employees in Pay Plan AD do not receive locality pay unless the
system is specifically programmed to allow it based on an agency request.
The amount of locality pay is recorded in the Geographic−Adj Rate field on
IRIS Program IR101. The amount of the scheduled salary and locality pay is
recorded in the Adjusted−Salary field of IRIS Program IR101.

The IGA is computed automatically based on the the occupational series
code and duty station. The IGA is recorded on IRIS Program IR101 in the
Geographic−Adj−Rate field; the total amount of the scheduled salary and
IGA is recorded in the Adjusted−Salary field.

• Cannot exceed or be less than the high or low salary range recorded in
TMGT Table 055, Minimum and Maximum Salaries.

• Must be greater than database salary on a promotion.

• Must be blank for pay plan WC.

• Must be prior salary when processing a cancellation to a pay change type
action.

• Must be more than current salary for a promotion.

• Must be compatible with grade and step.

• Must be blank on grade retention action.

• Must be more than current salary for saved pay (PRD 2, 3, 4, J, K, R).

• Must be first shift per hour salary for Federal Wage System employees.

• Must be basic salary for cooperative-type employees and reemployed
annuitants. Do not subtract the salary share amount from this amount; the
PPS automatically does this when both the basic pay and salary share amount
are entered.

• For agency code JA, pay plan AD, the scheduled salary must be 6 percent
greater than database salary when entering a promotion.

• The following apply to agency code 57:

If the special employee code is 12, the supervisory code must be 2.

If the special employee code is 16, the supervisory code must be 2, working
title code 2110, and pay plan ZP.
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If the special employee code is 19, the supervisory code must be 2 and pay
plan ZP.

If the special employee code is 20 the supervisory code must be 2, working
title code 2110, and pay plan ZA.

If the special employee code is 10, 12, or 16 through 20, the pay plan must
be ZA, ZP, ZS, or ZT and the step 04, 05, or 06.

If the special employee code is 17 or 19, the pay plan must be ZA or ZP and
the step 05. The scheduled salary must not exceed step 3 for pay plan ZA and
step 4 for pay plan ZP.

If the special employee code is 10 or 12, the pay plan must be ZA or ZP and
the step 05. The scheduled salary must not exceed step 3 for pay plan ZA and
step 4 for pay plan ZP.

Cannot change from special employee code 26 to special employee code 01,
02, 03, or 08 and vice versa.

• Must be the same or more than step 01 of the grade for medical officers
(occupational series code 0602). Cannot be more than step 10 of the grade.

Note: Under certain circumstances, the amount can be less than step 01.

• Enter the appropriate salary based on the effective date of the personnel
action; do not enter the current salary if the action is for a prior year.

Pay Basis Alpha, 2 positions

Type the pay basis for the salary the employee is receiving for the position being
held, which is fixed by law, regulation, or administrative action. For a list of
valid codes, see the Pay Basis Table.

• Must be blank for grade retention action.

• Must be BW for special employee code 36.

• Must be BW, FB, PM, or PW for biweekly, monthly, piece work, and fee basis
work schedules (except FWS, alternating tour of duty, and FmHA county
committee persons).

• Salary share code must be 0 for salary rate codes BW, FB, PM,or PW.

• Must be PA for General Schedule (and equivalent) pay plan, regardless of
work schedule.

• Must be WC for employees serving without compensation.

• Must be compatible with Basic Pay field (e.g., per annum salary must have
PA pay basis, etc.)

Pay Rate Determinant Alphanumeric, 1 position

Type the code that identifies whether the employee is receiving a rate of pay
other than the regular rate for the position, and, if so, identifies the legal and/or
regulatory basis. For a list of valid codes, see the Pay Rate Determinant Table.
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• The Rate Expired field must be blank for PRD codes 0, 2 through 8, J, K,
R, or S.

• PMSO Pay Table field cannot be zeroes for PRD codes 5, 6, E, F, or M.

• Enter PRD Codes 5 and 7 on accession actions only. When a change action
is processed, change PRD 7 to another PRD code.

• Pay plan cannot be PA, PE, or ZP for PRD 6, E, or F.

• The occupational series code and duty station in PMSO must indicate special
rate of pay for PRD codes E and F.

• Must be A, B, E, F, U, or V for grade retention action.

• The rate expired date must be blank for PRD codes J and K.

• Step must be 00 for PRD codes J, K, U, and V.

• PRD M requires entry of the adjusted salary for a salary change action.

• PRD M cannot be entered when the pay table code on the database is blank.

Verify Basic Pay Numeric, 8 positions

Type the basic salary amount when the salary cannot be verified in TMGT. The
basic salary amount for certain pay plans (e.g., AD, SR, etc.) cannot be verified
in TMGT and must be reentered in the Verify Basic Pay field.

• Complete this field if the basic pay field is not table driven.

Adjusted Basic Pay Numeric, 8 positions

Type the basic pay (scheduled salary) plus any allowance, adjustment, or
differential. Locality pay is included in the adjusted basic pay. The cooperative
and/or annuitant share of salary amount is also included in the adjusted basic
pay.
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COLA/Post Differential Numeric, 1 position

Type the code that identifies whether the employee is entitled to receive COLA
and/or a post differential, in addition to the scheduled salary. For a list of valid
codes, see the COLA/Post Differential Table.

COLA is a special pay entitlement for an employee in a high cost of living area.
Non-foreign post differential is a special pay entitlement for an employee whose
duty station is in a non-foreign area. Foreign post differential is a special pay
entitlement for an employee whose duty station is in a foreign area.

Non-foreign COLA or post differential and foreign post differential are
considered pay which an employee receives in addition to the basic pay. It is not
included in the basic pay. Payments for both non-foreign and foreign differential
are included in gross income for Federal income tax purposes. Payment for
COLA is not included in gross income for Federal income tax purposes.

Note: FWS employees are not entitled to COLA or post differential in
non-foreign areas. For foreign areas, the Department of State’s Standardized
Regulations (Government civilians, foreign areas) establishes regulations and
post classifications for the payment of foreign post differential. Actual payment
of COLA or foreign differential for FWS employees is based upon information
recorded on the employee’s T&A.

• TC 45 (start cost of living allowance) and TC 46 (start post differential) must
both be recorded on the employee’s T&A to begin actual payment of both
non-foreign COLA and post differential. TC 47 (stop cost of living
allowance) and TC 48 (stop post differential) must both be recorded on the
employee’s T&A to discontinue payment of non-foreign COLA and post
differential. For information on TC 45 through48, see the T&A Procedure,
Title I, Chapter 7.

• Type 0 if the employee’s duty station:

Is not within one of the designated non-foreign or foreign areas for which a
post differential has been established, thus automatically excluding the
employee from these payments.

Is within one of the designated non-foreign or foreign areas for which a post
differential has been established, but the employee will not be eligible to
receive payments because of a disqualifying factor.

• Type 2 if the employee’s duty station is in one of the following non-foreign
areas for which a post differential has been established, and the employee is
eligible to receive non-foreign post differential:

Code Definition
AQ American Samoa

CQ Northern Mariana Islands

GQ Guam

JQ Johnston Atoll

MQ Midway Islands

WQ Wake Island
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• Type 3 if the employee’s duty station is in a non-foreign area for which both
COLA and a post differential rate have been established, and the employee is
eligible to receive both non-foreign COLA and post differential.

• Type 4 if the employee’s duty station is in a foreign area classified for
payment of a foreign post differential and the employee is entitled to receive
foreign post differential only.

• Type 5 or if the duty station is one of the following non-foreign areas and the
employee is eligible to receive non-foreign COLA only:

Code Definition
02 Alaska

15 Hawaii

CQ Northern Mariana Islands

GQ Guam

RQ Puerto Rico

VQ Virgin Islands (St. Croix, St. Thomas, and St. John only)

• Do not complete for Federal Wage System employees.

Salary Share Amount Numeric, 7 positions

Type the portion of the employee’s annual salary which is being paid by a
non-Federal organization, the Civil Service Retirement fund, or the Federal
Employee Retirement System fund.

The PPS automatically reduces the amount of the annual basic pay by the
amount entered in this field and computes the amount to be paid. An employee
whose salary is paid entirely by a source other than the agency or whose salary
is insufficient to meet the deductions for personal benefits is paid manually.

• Must be less than annual scheduled salary amount.

• Must be 1, 2, 4, or 5 for cooperative type employees.

• Must be entered as an hourly amount for the 22 days of military offset leave.
(999.99 maximum). The salary share amount is calculated by subtracting
the Department of Defense (DOD) hourly salary rate from the hourly salary
rate paid by the NFC Payroll/Personnel System. The agency personnel office
can obtain the DOD hourly salary rate from the employee’s military orders in
the employee’s Official Personnel File. The NFC hourly salary rate is
displayed on PINQ Program PQ32, Payroll Inquiry, in the Hourly Rate field
for each pay period affected by the calculation. This calculation is made by
the agency personnel office. The employee’s timekeeper should use TC68,
Emergency Military Leave, in order for the employee to be paid for the 22
days of military leave offset.

Salary Share Code Numeric, 1 position

Type the source which shares with the agency in paying the employee’s salary.
For a list of valid codes, see the Salary Share Code Table.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

6:50 Field Instructions For Personnel Actions Updated 01/08

• Complete the Salary Share Amount field if the salary share code is other
than 0. Conversely, the Salary Share Amount field must be blank if the
salary share code is 0.

• Must be 0 for salary rate codes BW, FB, PM, or PW.

• Pay plans GG and GH require salary share code 1, 2, 3, or 4.

• The salary share amount and cooperative overtime rate must be completed
for salary share code 3.

• Must be 3, 4, or 5 if annuitant indicator is 1, 4, 5, or A through F.

• Must be 9 for the 22 days of military offset leave.

Coop

A cooperative entity that shares the salary of an employee with the government.

Overtime Rate Numeric, 4 positions

Type the hourly overtime rate for a cooperative type employee when the
overtime rate is not based on the basic pay because the cooperator pays part of
the overtime.

Holiday Rate Numeric, 4 positions

Type the hourly holiday rate for a cooperative type employee when the holiday
rate is not based on basic pay because the cooperator pays part of this rate.

• Do not complete either field if the agency has agreed to pay all overtime or
holiday pay.

• Do not complete for reemployed annuitants.

Quarter Deduction

An amount deducted for quarters, utilities (in-kind allowances). For a list of
valid codes, see the Quarter Deduction Table.

Rate Numeric, 1 position

Type the code that identifies whether the quarters deduction amount is to be
taxable or tax exempt. For a list of valid codes, see the Quarter Deduction Table.

• Complete if Amount field is completed.

• Quarters deductions are applicable to the following agency codes only: 03,
11, 16, 17, 34, 54, 70, and 71.

• Complete the quarters deduction amount and rate for a change in quarters
personnel action.

Amount Numeric, 5 positions

Type the amount to be deducted per day or per pay period.
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6:51Field Instructions For Personnel ActionsUpdated 01/08

• Must be completed if Rate field is completed.

Work Schedule Alpha, 1 position

Type the code that identifies the basis for which an employee is scheduled to
work. For a list of valid codes, see the Work Schedule Table.

•  A split T&A may be required if the effective date is other than the first
Sunday of the pay period.

• Intermittent work schedule applies to temporary accessions and conversions
or extensions of temporary appointments.

• Complete the tour of duty hours for part-time employees.

• If the employee is intermittent, the FEGLI and FEHB Coverage Code fields
must both denote ineligible, unless the employee is eligible to continue this
coverage due to continuity of service.

• Enter I if the employee is hired without compensation.

• Must be different than the Work Schedule in the database for a change in
work schedule personnel action.

• Must be F or P when the SCD leave and annual leave category are entered.
May be I for an alternating tour of duty.

• For Smithsonian Institution employees, the type appointment must be 09 if
the work schedule is intermittent.

Tour Of Duty Hours Numeric, 4 positions

Type the scheduled number of hours an employee is to work per pay period.

• A split T&A may be required if the effective date is other than the first
Sunday of the pay period.

• Type the whole hours in the first 2 positions and zeroes (or fractions) in the
last 2 positions.

• Complete for part-time work schedules.

• Must be greater than 1 and less than 79.

• Must be blank for full-time and intermittent work schedules.

• Must be different than database duty hours when processing a change in duty
hours action.

Date Service Year Starts
(Mo/Da/Yr) Numeric, 8 positions

Type the date on which the employee’s service year begins. A service year is a
12 to 24 month period beginning with the date of the first appointment under an
authority that establishes a dollar, hour, or day limitation which cannot be
exceeded within the service year.
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• A split T&A may be required if the service year date is other than the first
Sunday of the pay period.

• Cannot be later than effective date of action.

• Do not complete if Appointment Limit fields are blank.

SCD−WGI Numeric, 8 positions

Type the date from which service is to be credited toward the employee’s next
within-grade salary increase.

• Must be at least 16 years but not more than 90 years from the date of birth.

• Cannot be later than effective date of personnel action.

• Must be blank for pay plans AL, CA, EC, ED, EE, EF, EH, EI, GG, GS, ST,
IS, LE, LG, NF, SP, TR, and VG when the type appointment is 04 or 09.

Note: Exception: This does not apply for accessions with authority code
XAM.

• Must be blank for FWS employees in pay plans HG, HL, or HS and the type
of appointment code is 04 or 09.

• Complete when the employee is not in the top of the step.

• If previous service is unknown, enter the effective date of the action.

• Must be zeros for grade retention if the employee is ineligible for a WGI.

• System generated for NOAC’s 100, 101, 102, 103, 104, 140, 141, and 170.

Appointment Limit

The limitation of the appointment. The PPS updates the balance each pay period
when the T&A processes. The appointment limitation data is displayed in IRIS
Program IR102.

• A split T&A may be required if the action is effective other than the first
Sunday of the pay period.

• When correcting a balance field, enter the balance as of the end of the pay
period prior to the one in which the correction is being processed.

• See TMGT Table 030, Payroll Constants, for the minimum and maximum
amounts for each limitation.

Dollar Total Numeric, 7 positions max.

Type the appointment limitation full dollar amount.

Dollar Balance Numeric, 7 positions max.

Type the appointment limitation remaining balance dollar amount.

Hours Total Numeric, 7 positions max.

Type the appointment limitation total hour amount.
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Hours Balance Numeric, 3 positions max.

Type the appointment limitation remaining hour balance.

Days Total Numeric, 7 positions max.

Type the appointment limitation total day amount.

Days Balance Numeric, 3 positions max.

Type the appointment limitation remaining day balance.

• Enter only one limitation type.

• Balance must be equal to or less than full limitation.

• Total limitations are as follows:

Limitation
Type

Value

Day 130, 180

Hour 700, 1039, 1040, 1280, 1300, 2000

Monetary Changes based on Federal pay increase

• If the full limitation is entered, the balance must be entered and vice versa.

• Senior Community Service Program full limitation must be 1300 hours.

• Applies to the following type of appointment codes:

Code Description

03 Competitive−indefinite or taper

04 Competitive−temporary or special need

07 Excepted−conditional

08 Excepted−indefinite

09 Excepted−temporary

Retained Information

Information pertaining to the position being retained when the employee is
eligible for grade retention.

• Complete these fields when the salary record (IRIS Program IR101) does not
reflect the retained information.

Pay Plan Alpha, 2 positions

Type the pay plan the employee will retain during the period of grade retention.

Grade Numeric, 2 positions

Type the grade the employee will retain during the period of grade retention.
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• Must be equal to or less than the grade currently on the database.

Occ Series Numeric, 4 positions

Type the occupational series code the employee will retain during the period of
grade retention.

Occ Ser Func Numeric, 4 positions

Type the function code (if applicable) for the occupational series code the
employee will retain during the period of grade retention.

Rate Expd Numeric, 8 positions

Type the expiration date of an employee’s entitlement to grade retention.

• Must be blank for pay rate determinant codes 0, 2, through 8, J, K, R, or S.

• Must be later than effective date of action.

• Must be blank for pay rate determinant codes J and K.

Specification Of Mailing Address Pop-up Field Instructions

The Specification Of Mailing Address pop-up (Figure 2:10 ) is used to enter the award
mailing address data. For instructions on the entry process, see Entering A Personnel Action.

Address Alphanumeric, 35 positions max. for each line

Type the first and/or second line address.

City Numeric, 20 positions max.

Type the city code for the address. For a complete list of codes, see TMGT
Table 016, Geographical Location Codes With Names. For APO and FPO
addresses, type:

Code Description

0001 APO address

0002 FPO address

Designated Agent Numeric, 4 positions

Type the code assigned for check pick up.

State Alphanumeric, 2 positions

Type the state code for the address. For a complete list of codes, see TMGT
Table 015, State Code And Zip Range. For APO and FPO addresses, type:
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Code Description

91 America

92 Europe

93 Pacific

98 Other foreign areas

Zip Code Alphanumeric, 9 positions max.

Type the 5-digit required ZIP code plus optional ZIP+4 code (TMGT
Table 015).
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Field Instructions For Rollback Documents and Correcting
History Data

Rollback Search Pop-up

Rollback Personnel Action Window

History Correction Navigation Window Field Instructions

History Correction List Window Field Instructions

Insert New Action Pop-up Field Instructions

Create New Package Pop-up Field Instructions

Rollback Search Pop-up

The Rollback Search pop-up (Figure 3:1) is used to search for personnel actions
and history correction packages.

Rollback Search Criteria

Agency Required, alphanumeric, 2 positions

Type the agency to which the employee is assigned.

SSN Required, numeric, 9 positions

Type the employee’s ssn.

Rollback Personnel Action Window

The Rollback Personnel Action window (Figure 3:2)is used to display and identify
documents and history packages that were applied to the database in the current processing
pay period (including documents to the future file).

Rollback

Click the applicable radio button to select the type of rollback to perform on the
action selected. Each type of rollback is described below. For more detailed
instructions on rollback types, see Rollback Action Types.

Hold. Rollback from the database and hold in EPIC until positive action is taken.

Release. Release from the database to EPIC.

Personnel Office
Identifier (POI) No entry

The Personnel Office Identifier is displayed in this field.
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NOA1 No entry

The first nature of action code is displayed in this field.

Description No entry

The description of the first nature of action code is displayed in this field.

NOA2 No entry

The second nature of action code is displayed in this field.

Description No entry

The description of the second nature of action code is displayed in this field.

EPIC Status No entry

The EPIC status indicates the status of a personnel action or payroll document
after it has been entered for processing. See EPIC Status Codes for a list of
codes and definitions.

Status Code No entry

The status of the action is displayed in this field. See Personnel Action Input Status
Codes for a list of codes and definitions.

History Correction Navigation Window Field Instructions

The History Correction Navigation window (Figure 3:3) is used to display a list of history
correction packages that have been entered into the History Correction System. This window
can also be used to navigate to history correction packages, create new packages, or insert
documents into existing packages.

SSN No entry

The employee’s social security number is displayed in this field.

Name No entry

The employee’s name is displayed in this field.

Package Status No entry

This field displays the status of the history correction package. Valid values are
I−Incomplete, R−Released, A−Applied, S−Suspense, and
P−Pending.
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1st NOA (Nature of
Action) No entry

The first nature of action code for each personnel action on the History
Correction Navigation window is displayed in this field.

2nd NOA (Nature of
Action) No entry

The OPM or agency specific NOAC for each personnel action on the History
Correction Navigation window is displayed in this field.

Eff Date (Effective Date) No entry

The effective date of the personnel action displayed on the History Correction
Navigation window is displayed in this field.

Current Agency No entry

The code for the agency processing the action is displayed in this field.

Agcy (Agency) No entry

The agency code, as of the effective date of the action, is displayed in this field.

POI (Personnel Office
Identifier) No entry

The personnel office identifier code for the employee is displayed in this field.

User ID No entry

Identifies the user who entered or last updated a specific transaction.

DOC No entry

The document type number is displayed in this field.

Orig System No entry

The system the document was originally entered is displayed in this field (e.g.,
EPIC, HIST).

Strt Actn No entry

This field indicates if the document displayed is the starting action of the
correction package.

Date Document Entered No entry

The date the document was entered into the History Correction System is
displayed in this field.
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Date Last Changed No entry

The date the document was last changed in the History Correction System is
displayed in this field.

Last Changed User ID No entry

The User ID of the person who last updated the action shown on the History
Correction navigation window is displayed in this field.

History Correction List Window Field Instructions

The History Correction List window (Figure 3:5)is used to view all personnel actions in a
package, insert new actions into the package, change a package to incomplete, delete a
package, and release a package for processing.

The following fields are system generated for data entered on the Starting
Action window.

SSN No entry

The employee’s social security number is displayed in this field.

Agcy (Agency) No entry

The agency code is displayed in this field.

POI (Personnel Office
Identifier) No entry

The personnel office identifier code of the employee is displayed in this field.

Name No entry

The employee’s name is displayed in this field.

The following fields display information generated from the personnel history
database or from data entered on the Starting Action window.

Agcy (Agency) No entry

The agency code of the agency that processed the action is displayed in this
field.

POI (Personnel Office
Identifier) No entry

The personnel office identifier code of the employee is displayed in this field.
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1st NOA (Nature of
Action) No entry

The first nature of action code for each personnel action in the History package.

Note: 000 is displayed if a newly added action (i.e., newly required, late, and
replacement) and for a history action before the action is released to the EPIC
database. 001 is displayed for a cancellation action. 002 is displayed for a
correction action. 004 is the system generated action waiting to be changed to
002 or 001 and is displayed after the starting action is selected.

1A Auth Code (Authority
Code) No entry

The first authority code for the first NOAC for each personnel action in the
History package is displayed in this field.

1B Auth Code (Authority
Code) No entry

The second authority code for the first NOAC for each personnel action in the
History package is displayed in this field. 

2nd NOA (Nature of
Action) No entry

The OPM or agency specific NOAC for each personnel action in the History
package is displayed in this field.

2A Auth Code (Authority
Code) No entry

The first authority code for the second NOAC for each personnel action in the
History package is displayed in this field.

2B Auth Code (Authority
Code) No entry

The second authority code for the second NOAC for each personnel action in
the History package is displayed in this field.

Eff Date (Effective Date) No entry

The effective date of each personnel action in the History package is displayed
in this field.

Auth Date
(Authentication Date) No entry

The authentication date of each personnel action in the History package is
displayed in this field.

Status Code No entry

The status of the action is displayed in this field. See Personnel Action Input
Status Codes for a list of codes and definitions.
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SRC/STRT No entry

This field indicates the source of the documents displayed on the History
Correction List window. If the package has not been generated, the source will
be HIST (history data base), if the package has been generated the source will
be EPIC (EPIC data base).

EPIC Status No entry

The EPIC status indicates the status of a personnel action or payroll document
after it has been entered for processing. See EPIC Status Codes for a list of
codes and definitions.

Rollback Ind No entry

This field indicates if the document has been rolled back.

Suspense Ind No entry

This field indicates if the document is in suspense. Y indicates that the document
is in suspense. The field is blank if the document is not in suspense. 

User ID No entry

Identifies the user who entered or last updated a specific transaction.

Date Document Entered No entry

Date document entered into package.

Date Last Changed No entry

Date document last changed/modified in package.

Insert New Action Pop-up Field Instructions

The Insert New Action pop-up (Figure 3:6) is used to insert a newly required action in the
History package. For more information on inserting new actions, see Inserting A Retroactive,
Replacement, Or Newly Required Action in History.

1st NOA Code No entry

The nature of action code for the action to be inserted in the History package.

Note: Click the Literal button to display the description of the nature of action
code.

Effective Date Required, numeric, 8 positions

Type the effective date of the action to be inserted in the History package.

Note: If the effective date is being corrected, enter the original (incorrect)
effective date.
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Authentication Date Required, numeric, 8 positions

Type the effective date of the starting personnel action in month, day, and year
order. 

Insert Agency Required, alphanumeric, 2 positions

Type the agency code for the agency inserting the action.

Insert POI Required, numeric, 4 positions

Type the personnel office identifier for the agency inserting the action.

Create New Package Pop-Up Field Instructions

The Create New Package pop-up (Figure 3:4) is used to indicate the earliest personnel action
to be affected by the History Correction process. The action entered is the starting action to
be corrected, canceled, or added to the employee’s history record.

SSN Required

The employee’s social security number is displayed in this field.

Current Agency Conditional

The code for the agency processing the action is displayed in this field.

Starting Action

Choose one of the following radio buttons to select the action to be taken to
create a new package.

Insert An original action with an effective date that is earlier than
the last action in EPIC History.

Correct An official action that changes information shown on an
action.

Cancel An official action that rescinds an earlier action that was
improper, or was proper and contained references to an
improper action or contained inappropriate or erroneous
remarks that should have not been recorded.
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Field Instructions For Payroll Documents

This section presents field instructions for payroll document windows under the following
topics:

Accounting Data Pop-up Field Instructions

Allowance Window Field Instructions

Charitable Contribution Window Field Instructions

Child Care Or Alimony Deductions Window Field Instructions

Compensatory Time Payments Window Field Instructions

Coowner/Beneficiary Information Pop-up Field Instructions

Deductions Due To Indebtedness Window Field Instructions

Discretionary Allotment Window Field Instructions

Education Window Field Instructions

Employee Address Window Field Instructions

Family Member Window Field Instructions

Financial Allotment Window Field Instructions

Flexible Spending Account Window Field Instructions

Health Benefits Window Field Instructions

Leave Data Transferred Window Field Instructions

Locator Window Field Instructions

Lump Sum Leave Payment Window Field Instructions

Master File Change Window Field Instructions

Multi Element Update Window Field Instructions

Non-Federal Health Benefits Window Field Instructions

Non-Federal Life Insurance Window Field Instructions

Non-Federal Retirement Window Field Instructions

Non-Federal Thrift Savings Window Field Instructions

Owners Information Pop-up Field Instructions

Payroll Document Key Data Field Instructions

Performance Appraisal Window Field Instructions

Restored Annual Leave Window Field Instructions

Savings Bond Authorization Window Field Instructions

SES Performance Appraisal Window Field Instructions

Severance Pay Window Field Instructions

Tax Certificate Window Field Instructions

Thrift Savings Plan Catchup Form Window Field Instructions

Thrift Savings Plan Election Form Window Field Instructions

TSP Loan Allotment Window Field Instructions

Union Dues Window Field Instructions
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Accounting Data Pop-up Field Instructions

The Accounting Data pop-up (Figure 4:21 ) is used to enter accounting data for leave lump
sum payments. For instructions on the entry process, see Steps For Entering Accounting
Data.

Accounting Data Required, numeric, 27 positions max. each line

Type the accounting code to which the payment is to be charged. The accounting
code must be valid for the agency.

Hours To Be Charged Required, numeric, 5 positions max.

Type the number of hours to be paid for the accounting code entered. The hours
must agree with the number of hours on the database.

Allowance Window Field Instructions

The Allowance window (Figure 4:6 ) is used to enter allowance data. For instructions on the
entry process, see Steps For Entering Allowance Documents.

Taxable Required

Click the applicable radio button that indicates if the allowance is taxable or tax
exempt. Click [Yes] if the allowance is taxable; click [No] if the allowance is tax
exempt.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are Add, Change, and Delete.

Allowance Required, numeric 1 position

Click the down arrow to display the allowance code that identifies the basis of
deductions. Valid values are Per Day, Per Pay Period, Per Year,
and Percent Of Base Pay. The code for each allowance is as follows: 
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Allowance Frequency

Comparability Per pay period or annual

Choice Credits (Taxable) Per pay period

Education Per pay period or full amount

Foreign Language Blank

Hazardous Duty Per pay period

Horse Per pay period (one time only)

Parking Per pay period

Parking Fringe Per pay period

Post Per pay period

Professional Liability Per pay period (one time only)

Quarters Per day or per pay period

Reassignment Per pay period (one time only)

Recruitment Per pay period (one time only)

Separate Maintenance Per day or per pay period

Transit Per Pay Period

Uniform Per pay period or full amount

Allowance Type No entry

This field is generated from the Allowance Description field.

Allowance Rate Required, numeric, 7 positions max.

Type the per day, per pay period, annual, percentage of base pay, or full amount
rate to be paid in dollars and cents.

Note: If entering a 2-year agreement, the amount shown should reflect the
annual amount for the first year of the 2-year agreement.

Allowance Description Required

Select the applicable allowance description. Each type is described in the
alphabetic list below.

Comparability. The per pay period or annual amount for employees officially
stationed in the continental United States or in a foreign area, whose rates of
basic pay are fixed by statute or, without taking into consideration the
allowances and differentials for work of comparable level of difficulty and
responsibility. The payment is taxable.

• To obtain the pay period deduction, the system divides the amount
entered in the Allowance Rate field by 80 to determine the hourly rate.
The hourly rate is then multiplied by the regular hours in pay status each
pay period.
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• To obtain the annual amount, the system divides the amount entered in
the Allowance Rate field by 2087 to determine the hourly rate. The
hourly rate is then multiplied by the regular hours in pay status each pay
period.

Choice Credits. For FDIC use only. An FDIC employee may choose various
benefit options in FDIC Choice, including electing a low option or waiving
dental, vision, or life benefits. If an employee chooses a low option or waives
benefits, the employee will receive a predefined amount of taxable cash (Choice
Credits) paid through NFC’s Payroll/Personnel System. Once the employee has
elected the Waiver Option, the Third Party Administrator (TPA) will determine
the full amount to be applied to the Choice Credits allowance. These taxable
payments are processed on a calendar year basis in 25 equal installments.

Education. The per pay period or lump sum payment amount for assistance in
meeting extraordinary and necessary expenses in providing adequate elementary
and secondary education for an employee’s children while serving in a foreign
area. The payment is tax exempt.

• Enter the full amount in the Allowance Rate and Allowance Total fields
for a lump sum payment. This amount will be paid in a single pay
period.

• For per pay period payments, enter the amount in the Allowance Rate
field to be paid each pay period. This amount will be paid until the IRIS
Program IR109 Total field indicates full payment has been made.

Foreign Language. The percentage of basic pay that is paid each pay period for
employees in foreign service positions to acquire and/or maintain proficiency in
foreign languages used at overseas posts. The payment is taxable. The percentage
entered in the Allowance Rate field will be paid each pay period until Delete is
used to stop the allowance.

Hazardous Duty. The per pay period amount for hazardous duty for U. S. Capitol
Police only. For detailed information, refer to your agency’s publications. The
amount entered in the Allowance Rate field will be paid each pay period until
Delete is used to stop the allowance. The payment is taxable.

Horse. The lump sum payment amount for furnishing a horse and the necessary
equipment for use on the job. The payment is taxable.

Parking. The per pay period amount for parking on or near the business premises
of the employer, or on or near a location from which the employee commutes to
work by mass transit. The payment is tax exempt.

• Cannot exceed $80.76 per pay period.

• Cannot exceed $2100 per year.

Parking Fringe. The per pay period amount for employee parking. The employee
is taxed on the cash value for parking in excess of $185 per month. The amount
entered in the Allowance Rate field will be paid each pay period until Delete is
used to stop the allowance.

Post. The per pay period amount for assignment to a foreign post where the
foreign cost of living is significantly higher than in Washington, D.C. The amount
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is tax exempt. The amount entered in the Allowance Rate field will be paid each
pay period until Delete is used to stop the allowance.

Professional Liability Insurance. The lump sum payment amount paid to
eligible management officials, supervisors, and law enforcement officers for up to
one-half the cost of their Professional Liability Insurance. The amount is tax
exempt.

• Enter the data each time the policy is renewed so that the Allowance
Total field can be adjusted for the necessary pay period.

• Enter the full amount in the Allowance Rate and Allowance Total fields.

Quarters. The per day or per pay period amount for the cost of rent, heat, light,
and water for American citizen civilian employees while living in a foreign area
by reason of employment by the U. S. Government. The amount may be taxable
or tax exempt.

• If the payment is based on per day, the timekeeper must record on the
T&A (TC 49 Suffix 3 or Suffix 4) the number of days for which
quarters allowance is to be paid. If the payment is based on per pay
period, no entry on the T&A is required.

Reassignment. The lump sum payment amount for extraordinary, necessary, and
reasonable expenses, not otherwise compensated for, incurred by an employee
incident to establishment at a post or assignment in a foreign area (including costs
incurred in the United States prior to departure for a post assignment in a foreign
area) or the United States between assignment to post in a foreign area. The
amount is taxable.

Reminder: Timekeepers may record parking on the T&A report in lieu of entering
the payment in EPIC. Do not enter parking fringe in EPIC and on the T&A; the
T&A will reject.

Recruitment Incentive. The lump sum payment amount for recording cash
payments offered to selectees of the USDA Demonstration Project. The amount is
taxable.

•  Do not complete the Allowance Total field.

Separate Maintenance. The per day or per pay period amount for additional
expenses of maintaining family members at a place other than the employee’s post
for the convenience of the Government or due to adverse living conditions at the
employee’s post. The amount may be taxable or tax exempt.

• If payment is based on per day, the timekeeper must record on the T&A
(TC 51 Suffix 2, Separate Maintenance Allowance−Tax Exempt, or TC
51, Suffix 3, Separate Maintenance Allowance−Taxable), the number of
days for which the allowance is to be paid.

• If payment is based on per pay period, no entry is required on the T&A.
The amount entered in the Allowance Rate field will be paid each pay
period until TC D (delete) is entered in EPIC to stop the allowance.

Transit Benefits. The per pay period amount of transit or eligible vanpools. The
payment is tax exempt.
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• Cannot exceed $50 per pay period.

• Cannot exceed $1200 per year.

Uniform. The per pay period or lump sum payment amount for the additional
expense of wearing a uniform required by regulation or statute in the performance
of official duty. The amount entered in the Allowance Rate field will be paid each
pay period until TC D (delete) is entered to stop the allowance.

• Enter the full amount in the Allowance Rate and Allowance Total fields
for a lump sum payment.

Reminder: Do not enter uniform allowance in EPIC and on the T&A; the
T&A will reject.

Allowance Total Required, numeric, 7 positions max.

Type the maximum amount of the allowance in dollars and cents. The system
will reduce the allowance total each pay period by the allowance rate until the
allowance total reaches zero.

Note: If entering a 2-year agreement, the amount shown should reflect the
2-year agreement amount.

Percentage Of Base Pay Required, numeric, 2 positions max.

The percentage of base pay to be paid for foreign language allowance. Type 05,
10, or 15.

•  Leave blank for all other allowances.

Charitable Contribution Window Field Instructions

The Charitable Contribution window (Figure 4:7) is used to enter charitable contribution
data. For instructions on the entry process, see Steps For Entering Charitable Contribution
Documents.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are New, Change, and Delete.

Location Codes

The campaign area state and city codes.

State Required, numeric, 2 positions

Type the state code.
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City Required, numeric, 4 positions

Type the city code.

Amount Per Pay Period Required, numeric, 5 positions

Type the amount to be deducted each pay period in dollars and cents.

• Do not enter the total amount of the contribution.

Child Care Or Alimony Deductions Window Field Instructions

The Child Care Or Alimony Deductions window (Figure 4:8) is used to enter child care and
alimony data. For instructions on the entry process, see Steps For Entering Child Care Or
Alimony Deduction Documents.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are Add, Change, and Cancel.

• If the garnishment payment changes from an address to a financial
organization, select Change and complete the financial organization
information in the recipient address information fields.

Case Number Required, numeric, 4 positions

Type the assigned sequential case number. This case number is assigned by the
agency and should appear on all documents prepared for the same garnishment
case. A recommended numbering system is to have the first 2 digits represent
the year (i.e., 1999 would be “99”) and the last 2 digits represent the sequential
numbering of the cases processed in the calendar year. For example, the first
child care deduction for 1999 would be typed as 9901.

Year Required, numeric, 4 positions

Type the year of the effective pay period for which the deductions are to begin.

Maximum Percentage Required, numeric, 2 positions

Type the maximum percentage of disposable earnings allowed by law for child
care and alimony biweekly deductions. Valid values are 50, 55, 60, and 65
(see 5 CFR Chapter 1,Subpart D, Paragraph 581.402, Maximum Garnishment
Limitations, for additional information). For voluntary child care and alimony
deductions, type 99.

Court Case Number Required, alphanumeric, 35 positions max.

Type the court-ordered assigned case number.
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• If the allotment is on a voluntary basis, type voluntary.

Court Ordered PP
Deduction

The payment rate established for deductions.

Total Amount Required, numeric, 6 positions

Type the amount to be deducted each pay period in dollars and cents if the
deduction is based solely on a dollar amount.

• Complete only if a dollar amount is specified either voluntarily or in the legal
process. If monthly payments are ordered, multiply the monthly amount by
12 and divide the results by 26 to obtain the amount to be deducted each pay
period.

• If weekly payments are specified, multiply the weekly amount by two to
determine the pay period amount. If the deduction is a dollar amount that
includes a not to exceed percentage, complete the Percentage Of Earnings
and the Amount NTE fields. Do not complete this field.

Percentage Of Earnings Required, numeric, 2 positions max.

Type the percentage of disposable income to be deducted each pay period.

• If a dollar amount is specified instead of a percent, leave this field blank.
Deductions based on percentages of gross earnings must be processed
manually. Submit these cases to the Administrative Billings and Collections
Section at NFC.

Amount NTE Required, numeric, 6 positions max.

Type the maximum dollar amount that may be deducted each pay period.

Complete this field only if the legal process stipulates the payment is not to
exceed a certain dollar amount.

Court Cost PP Deduction

The court costs as stipulated by the court.

Total Amount Required, numeric, 6 positions max.

Type the total amount of the court cost in dollars and cents. Type zeros if no
court costs were specified.

Amount Collectable Required, numeric, 5 positions max.

Type the dollar amount of the court costs to be deducted each pay period.

• Complete this field if the legal process stipulates a specific amount is to be
collected until total court costs are paid. If a monthly amount has been
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specified, convert to 26 pay periods. To make this conversion, follow the
procedures in the Dollar Amount field under Court Ordered PP Deduction. If
this field is left blank, the amount in the Total Amount field is deducted in
full in one pay period.

Arrears PP Deduction

The arrears deductions as stipulated by the court.

Total Amount Required, numeric, 7 positions max.

Type the total arrears amount as specified in the court order.

• Complete this field if there is an entry in the Court Ordered PP Deduction
group fields.

Amount Collectable Required, numeric, 6 positions max.

Type the dollar amount to be collected each pay period if the deduction is based
solely on a dollar amount.

• If the deduction is a dollar amount that includes a not to exceed percentage,
complete the Percentage of Earnings and Amount NTE fields. Do not
complete this field.

Percentage Of Earnings Required, numeric, 2 positions max.

Type the percentage of disposable income to be deducted each pay period.

Amount NTE Required, numeric, 6 positions max.

Type the amount if the percentage cannot exceed a certain dollar amount each
pay period.

Recipient Information

The name and mailing address information of the recipient.

Name Optional, alpha, 35 positions max.

Type the name of the court official or recipient of the deduction.

Address Optional, alphanumeric, 35 positions max.

Type the street address of the court official or recipient of the deduction.

City Optional, alpha, 20 positions max.

Type the city for the street address.

• Do not include punctuation, such as periods, commas, or parentheses in the
name, address, and city.
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State Optional, alpha, 2 positions

Type the state abbreviation.

Zip Code Optional, numeric, 9 positions max.

Type the 5-digit required ZIP Code plus the optional ZIP+4 Code.

DD/EFT

Type Account Optional, alpha, 1 position

Identifies the type of account in which the monies are to be deposited. Valid
values are checking and savings. Click the down arrow to display the drop-down
menu and select Checking or Savings.

Account Number Optional, alphanumeric, 17 positions max.

Type the account number of the checking or savings account.

Note: Scroll to view the entire number if it exceeds 13 positions.

Routing Number Optional, numeric, 9 positions

Type the routing number of the financial organization. The first 2 positions of
the routing number must be 01 − 12, 21 − 32, or 90 and 91.

Compensatory Time Payment Window Field Instructions

The Compensatory Time Payment window (Figure 4:19) is used to enter compensatory time
payments. For instructions on the entry process, see Steps For Entering Compensatory
Leave Payment Documents.

Type Payment No entry

Click the appropriate radio button to select the type payment being made. The
system defaults to Final for a final compensatory time payment for an
employee separating from Federal service. The separation action must be
entered to pay a final payment. Click the Interim radio button if an interim
payment is being entered for an employee who is not separating but must be
paid the compensatory time lump sum payment due to regulation and/or policy.
A separation action should not be processed for an interim payment.

Use Database
Accounting Data No entry

Select Yes in the Use Database Accounting Data box if the database accounting
is used for the payment. The accounting data must be stored on the database if
Yes is selected. Select No if the accounting data is being entered on the
document. The accounting data must be valid for the agency and located in
MASC.
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Total Hours To Be Paid Required, numeric, 5 positions max.

Type the total amount of compensatory leave hours to be paid.

Total Lines Of
Accounting Data No entry

The system-generated number of lines of accounting data listed on the
Accounting Data window. If the Use Database Accounting Data field is
coded Yes (use database accounting), 00 appears in this field.

Coowner/Beneficiary Information Pop-up Field Instructions

The Coowner/Beneficiary Information pop-up (Figure 4:36) is used to update
coowner/beneficiary data. For instructions on the entry process, see Steps For Entering
Savings Bond Documents.

Coowner Beneficiary
Code Required

Click the applicable radio button to indicate if the transaction refers to the bond
coowner or the beneficiary.

Coowner/ Beneficiary
Name Required, alphanumeric, 28 positions max.

Type the coowner or beneficiary name.

• The name must be entered even if the employee is the coowner or
beneficiary. See the Owner Name field Entry Guidelines above for entering
the name.

Coowner/ Beneficiary
SSN Required, numeric, 9 positions

Type the coowner/beneficiary social security number.

Discretionary Allotment Window Field Instructions

The Discretionary Allotment window (Figure 4:3) is used to enter discretionary allotment
data. For instructions on the entry process, see Steps For Entering Discretionary Allotment
Documents.

Transaction Required

Click the down arrow to display the drop-down menu and select the TC that
identifies the action being taken. Valid values are Add, Change, Delete,
and Cancel All.
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Allotment Number Required, numeric, 2 positions

Type the number that identifies the individual allotments. Maximum number of
allotments allowed is 99.

Allotment Amount Required, numeric, 6 positions max.

Type the monthly amount of the allotment in dollars and cents. The PPS divides
this monthly amount by two to determine the bimonthly deduction.

Account Number Required, alphanumeric, 17 positions

Type the account number for the savings or checking account to which the
allotment amount is sent.

DD/EFT

The type of account and routing number for direct deposit/electronic funds
transfer.

Type Account Required, alpha, 1 position

Click the down arrow to display the drop-down menu and select the type of
account in which the allotment amount is being deposited. Valid values are
Checking and Savings.

Routing Number Required, alphanumeric, 9 positions

The financial organization’s routing number. The first 2 positions must be 01
through 12, 21 through 32, or 90 through 91.

Check Mailing

The name and address identifying to whom which the payment is to be
disbursed.

Name Required, alphanumeric, 35 positions max.

Type the name of the payee receiving the discretionary allotment.

Address Required, alphanumeric, 35 positions max.

Type the payee’s address.

• Do not include punctuation, such as periods, commas, or parentheses when
entering the name or address.

City Required, alpha, 16 positions max.

Type the city name.
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State Required, alpha, 2 positions

Type the standardized abbreviation for the state.

Zip Code Required, alphanumeric, 9 positions max.

Type the 5-digit required ZIP Code plus the optional ZIP+4 Code (TMGT
Table 015).

Optional Line for Check
Mailing or DD/EFT Info Optional, alphanumeric, 25 positions max.

Type any remark applicable to the allotment. This data is transmitted to the
financial organization or printed on the check along with the payee’s name and
address, and the employee’s name at the bottom of the check indicating an
allotment check.

Deductions Due To Indebtedness Window Field Instructions

The Deductions Due To Indebtedness window (Figure 3:7) is used to enter third party
indebtedness. For instructions on the entry process, see Steps For Entering A Third Party
Debt.

Depy/Agcy Required, alpahnumeric, 4 positions

Type the applicable department/agency code. The first two positions are the
department code, and the second two positions are the agency code. For a list of
department and/or agency codes, go to www.nfc.usda.gov and click the Pubs &
Forms icon.

POI Required, numeric, 4 positions

Type the employee’s 4-position POI.

SSN Required, numeric, 9 positions

Type the indebted employee’s 9-digit ssn.

Effective Pay Period Requried, numeric, 2 positions

Type the pay period number of the pay period in which to begin the deductions.

Pay Period Year Conditional, numeric, 4 positions

Type the 4-digit year that corresponds to the pay period in which to begin the
deductions.

Name: Last Required, alphanumeric, 17 positions max.

Type the last name of the employee or press [Enter] in order for the application
to generates the name.
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First Required, alphanumeric, 12 positions max.

Type the first name of the employee or press [Enter] in order for the application
to generate the name.

Middle Optional, alphanumeric, 12 positions max.

Type the middle name of the employee or press [Enter] in order for the
application to generate the name.

Transaction Code Required, alpha, 2 positions

Click the down arrow to select the applicable type of transaction. Valid values
are New, Change, and Delete.

Type Deduction Code Required, numeric, 2 positions

Type the applicable code to indicate the deduction type. Valid values are:

• 30−Bankruptcy

• 33−Education Loan

• 40−IRS 2159 Payroll Deduction

• 50−Commercial Garnishment (which includes state or local tax
levies)

• 57−Travel Credit Cards−Other Than Agriculture
Agencies

• 90−Other Departmental Debt

• 94−Military Service for CSRS

• 96−Military Service for FERS

Receipt Account Number Conditional, numeric, 12 positions

Type the receipt account number for the garnishment in the following format:
Position Data
1−3 000 (3 zeroes)
4−5 Type Deduction Code
6−12 Agency assigned sequential number.
NOTE: If the garnishment is for state or local tax levy, type ST or LO in
positions 11−12.

Balance Required, numeric, 9 positions max.

Type the balance of the money owed in dollars and cents. If 30 is entered in the
Type Deduction Code field, type 999,999.000 in this field.

Deduction Per Pay
Period Conditional, numeric, 6 positions max.

The type of deduction (amount or percent) to be made each pay period.
NOTE: You must complete either the Deduction Amount field or the Percent
field. You cannot complete both fields.
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Deduction Amount Conditional, numeric, 6 positions max.

If the garnishment is based on an amount per pay period, type the amount in
dollars and cents.
NOTE: If data is entered in the Percent field, this field is left blank.

OR

Percent Conditional, numeric, 2 positons max.

If the garnishment is based on a percent each pay period, type the applicable
percentage.
NOTE: If data is entered in the Deduction Amount field, this field is blank.

Payee Information

If a check is issued for the debt payment, complete the Name, Address, City,
State, and Zip Code fields.

NOTE: If the debt payment is sent to a financial institution through DD/EFT, do
not complete the Name, Address, City, State, and Zip Code fields.

 Name Optional, alphanumeric, 35 positions max.

Type the name of the entity to whom the debt is to be paid. This field is only
completed if a check is mailed.

Address Optional, alphanumeric, 35 positions max.

Type the street address of the entity to whom the debt is paid. This field is only
completed if a check is mailed.

City Optional, alphanumeric, 16 positions max.

Type the city of the entity to whom the debt is paid. This field is only completed
if a check is mailed.

State Optional, alpha, 2 positions

Type the 2-position alpha state abbreviation of the entity to whom the debt is
paid. This field is only completed if a check is mailed.

Zip Code Optional, numeric, 9 positions max.

Type the zip code of the entity to whom the debt is paid. The first five positions
of the field are the zip code, and the last four positions are the zip+4 code. This
field is only completed if a check is mailed.

DD/EFT

If the debt payment is to be sent to a financial institution through DD/EFT,
complete the Type Account, Account Number, and Routing Number fields.

NOTE: If a check is being issued for the debt payment, do not complete the
Type Account, Account Number, and Routing Number fields.
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Type Account Optional, alpha, 1 position

Type the applicable code for the type of account for the entity receiving payment
if the payment is made through DD/EFT. Valid values are C (checking) and S
(savings). This field is only completed if the payment is made by DD/EFT.

Account Number Optional, alphanumeric, 17 positions max.

Type the account number for the entity receiving payment if the payment is
made through DD/EFT. This field is only completed if the payment is made by
DD/EFT.

Routing Number Optional, numeric, 9 positions max.

Type the routing number for the financial institution of the entity receiving
payment if the payment is made through DD/EFT. This field is only completed
if the payment is made by DD/EFT.

Payment Identification Optional, alphanumeric, 25 positions max.

Type any applicable payment information in this field.

Status Code Required, alpha, 1 position

 Type the code that indicates the disposition of a document. The valid values are
H (hold); I (incomplete); R (release); S (severance); W (waiting).

Education Window Field Instructions

The Education window (Figure 4:10) is used to enter the highest education level attained
based on years of formal schooling and/or academic degrees or certificates conferred. For
instructions on the entry process, see Steps For Entering Education/Professional
Certification Documents.

Transaction Required

Click the down arrow to display the drop−down menu and select the action
being taken. Valid values are Add, Change, and Delete.

Year Received Required, numeric, 4 positions

Type the year the employee received the degree or certificate.

• The Year Received must be entered for professional certification codes 01
and 02.

• The Year Received must be blank for professional certification codes 03,
04, and 05.
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• If the education level is 04, 07, 08, 09, 11, or 12, this field must be blank
or zeros.

Education

Information pertaining to the employee’s education attainment.

• The maximum records allowed is five.

Education Level Required

Click the down arrow to select the academic level code for education attained
for the degree or certificate being recorded. For a list of code definitions, see the
Education Level Table.

• Must be 06, 10, and 13 through 22 for GAO.

School Code Required, numeric, 5 positions

Type the code for the school from which the employee received the degree or
certificate being recorded.

Instructional Program Required, numeric, 6 positions

Type the employee’s instructional program code.

Note: For a list of the education level codes, see TMGT Table 036; for a list of
school codes, see TMGT, Table 025, field AD−350−Blk−Number 097
through 101 and 390.

Professional
Certification

The type of professional certification.

Code Required, numeric, 2 positions

Type the professional certification code. For a complete list of codes,
see (Appendix E).

State Required, numeric, 2 positions

Type the state code where the employee received the professional certification.

• The state code must be entered for professional certification codes 01
and 02.

• The state code must be blank for professional certification codes 01, 03,
04, and 05.
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Employee Address Window Field Instructions

The Employee Address window (Figure 4:2) is used to enter residence and check mailing
addresses. For instructions on the entry process, see Steps For Entering Address Documents.

Effective Date Required, numeric, 8 positions

Type the date the current address became effective.

Current Residence

Type the employee’s current residence address. Do not include punctuation,
such as periods, commas, or parentheses in the street address.

First Line Street Address Required, alphanumeric, 25 positions max.

Type the first line street address.

Second Line Street
Address Optional, alphanumeric, 25 positions max.

Type the second line street address, if applicable.

Third Line Street
Address Optional, alphanumeric, 25 positions max.

Type the third line street address, if applicable.

City Code Required, numeric, 4 positions

Type the city code (TMGT Table 016). For APO addresses, type 0001; for
FPO addresses, type 0002.

County Code Required, numeric, 3 positions

Type the county code (TMGT Table 016). For APO and FPO addresses,
type 000.

State Code Required, alphanumeric, 2 positions

Type the state code (TMGT Table 015). For APO and FPO addresses, type 91
for America; 92 for Europe; 93 for Pacific; 98 for other foreign areas.

Zip Code Required, alphanumeric, 9 positions max.

Type the 5-digit required ZIP Code plus the optional ZIP+4 Code
(TMGT Table 015).
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Check Mailing Address
Other Than Bank

The employee’s current check mailing address. This field does not apply to
financial organizations.

Do not include punctuations, such as periods, commas, or parentheses in the street
address.

First Line Street Address Required, alphanumeric, 35 positions max.

Type the first line street address.

Second Line Street
Address Optional, alphanumeric, 35 positions max.

Type the second line street address, if applicable.

City Code Required, numeric, 4 positions

Type the city code (TMGT Table 016). For APO addresses, type 0001; for
FPO addresses, type 0002.

State Code Required, alphanumeric, 2 positions

Type the state code (TMGT Table 015). For APO and FPO addresses, type 91
for America; 92 for Europe; 93 for Pacific; 98 for other foreign areas.

Zip Code Required, alphanumeric, 9 positions max.

Type the 5-digit required ZIP Code plus the optional ZIP+4 Code (TMGT
Table 015).

Designated Agent Code Optional , numeric, 4 positions

Type the 4-digit designated agent code (TMGT Table 004), if the salary check is
to be delivered to a designated agent. Do not enter a designated agent code and
a check mailing address.

Family Member Window Field Instructions

The Family Member window (Figure 4:13 ) is used to enter family member data for health
benefits documents. For instructions on the health benefits entry process, see Steps For
Entering Federal Health Benefits Documents. For information on adding a family member,
see Adding A Family Member.

Member
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Last Name Required, alpha, 20 positions max.

Type the last name of the family member.

First Name Required, alpha, 14 positions max.

Type the first name of the family member.

Middle Initial Optional, alpha, 1 position

Type the middle initial of the family member, if applicable.

SSN Optional, numeric, 9 positions

Type the family member’s SSN.

Date of Birth Required, numeric, 8 positions

Type the family member’s date of birth.

Gender Required, alpha, 1 position

Click the applicable radio button. Valid values are Male and Female.

Relationship Required, alpha

Click the down arrow to display the drop-down menu and select the relationship
of the family member to the employee.

Other Insurance
Information

Other Private Insurance
Ind Optional, 1 position

Click this field if the family member has another private insurance. The default
is blank.

Other Insurance Name Conditional, alpha, 35 positions max.

Type the name of the family member’s other insurance carrier, if applicable.
This field must be completed if the Other Private Insurance Ind field is selected.

TRICARE Required, 1 position

Click this field if the family member is covered by TRICARE. The default for
this field is blank.

Other Insurance Policy
Number Optional, alphanumberic 30 positions max.

Type the policy number of the insurance carrier listed in the Other Insurance
Name field, if applicable.
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Medicare Part A Indicator Required, 1 position

Click this field if the family member is covered by Medicare Part A. The default
for this field is blank.

Medicare Part B Indicator Required, 1 position

Click this field if the family member is covered by Medicare Part B. The default
for this field is blank.

Medicare Part D Indicator Required, 1 position

Click this field if the family member is covered by Medicare Part D. The default
for this field is blank.

Address

Street Required, alphanumeric, 35 positions max.

Type the first line of the FEHB member’s (employee’s) address.

Street Required, alphanumeric, 35 positions max.

Type the second line of the FEHB member’s (employee’s) address, if applicable.

Street Required, alphanumeric, 35 positions max.

Type the third line of the FEHB member’s (employee’s) address, if applicable.

City Required, alpha, 23 positions max.

Type the city name.

State Required, alpha, 2 positions

The 2-character state abbreviation.

Zip Code Optional, numeric, 9 positions max.

Type the zip code of the family member’s address.

Financial Allotment Window Field Instructions

The Financial Allotment window (Figure 4:4) is used to enter data for financial allotment and
net pay documents. For instructions on the entry process for financial allotment documents
and net pay documents, see Steps For Entering Financial Allotment Documents.
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Type Account Required

Click the down arrow to display the drop-down menu and select the type of
account to which the money is being deposited. Valid values are Checking,
Savings, and Health Savings.

Allotment Amount Conditional, numeric, 4 positions max.

Type the amount allotted each pay period in whole dollars for a financial
allotment.

• To increase or decrease an allotment, enter the new amount of the allotment.

• To cancel an allotment, type 0000.

Routing Number Required, alphanumeric, 9 positions

Type the financial organization’s routing number. The first 2 positions must be
01−12, 21−32, or 90−91.

Account Number Required, alphanumeric, 17 positions max.

Type the account number of the savings or checking account.

Flexible Spending Account Window Field Instructions

The Flexible Spending Account window (Figure 4:26 ) is used to enter flexfund data. For
instructions on the entry process, see Steps For Entering Flexible Spending Account
Documents.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are Enroll, Change, and Cancel.

Plan Code Required, alphanumeric, 2 positions

The plan code for the flexible spending account. A document must be entered
for each account. For a list of valid codes, see Plan Code Table.

Option Code No entry

The system generates 1 in this field.

Tax Deferred Required

Click the applicable radio button to indicate if the deductions are taxable or tax
deferred. Valid values are Yes and No.
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Total Amount Required, numeric, 6 positions max.

Type the total yearly flexfund amount in dollars and cents, designated by the
employee.

• If the amount is a whole dollar amount, type 00 in the last two positions of
the field. Biweekly deductions will be the total amount divided by the
number of pay periods remaining in the plan year.

The table below lists the minimum and maximum annual amounts for each
dependent care account:

Agency
Code

Dependent
Care

Minimum

Dependent
Care

Maximum

ARC $ 1 $ 5,000

FCA 130 5,000

FCSIC 130 5,000

FDIC 100 5,000

OCC 100 5,000

* *

The table below lists the minimum and maximum annual amounts for each health
care account:

Agency
Code

Health Care
Minimum

Health Care
Maximum

ARC $ 1 $ 5,000

FCA 130 5,000

FCSIC 130 5,000

FDIC 100 2,500

OCC 100 2,500

RTC 100 2,500

NOTE: The above amounts (in both tables) apply to non-Federal benefits. The
minimum amount for an account for most Federal agencies is $250, and the
maximum is $5000.

Effective Date Required, numeric, 8 positions

Type the effective date of the Flexfund account.
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Health Benefits Window Field Instructions

The Health Benefits window (Figure 4:11 ) is used to enter health benefits data. For
instructions on the entry process, see Steps For Entering Federal Health Benefit Documents.

• After processing the return to duty personnel action when enrollment is
reinstated, enter the health benefits enrollment change in the Health Benefits
Enrollment window. Select Reinstatement at the Transaction drop-down
menu and Reinstatement at the Event Code drop-down menu.

• Event Code must be present with all TC’s.

• If Event Code is Correction or Other then a Remark is required.

• Effective Date is required for all transaction Codes.

• No Enrollment Code if the TC is Waived or Cancel.

• If Event Code that Permits Change is blank then date of Event is also blank.

• New Payroll Office or Retirement System is required when TC is Transfer
Out.

Event code that permits
change Required

Type the appropriate event code as listed on the instructions for the SF−2809.
For a list of valid values, see the Event Code Table.

Transaction Required

Click the down arrow. to display the drop-down menu to select the action being
taken. Only the codes applicable to the document (Health Benefits Registration
or Change in FEHB Enrollment) being entered will appear in the drop down
box. Valid values are:

Description Reason For Processing

Administrative (SF−2809) Corrections to pre-tax coverage only

New Enrollment (SF−2809) New hire or open season

Term Due To LWOP (SF−2810) 365 consecutive days in nonpay status

Waived (SF−2809) New hire

Cancel (by carrier) (SF−2810) Nonpayment of dues

Change in Enroll (SF−2809) Open season/marital status/carrier rejection

Cancel (by employee) (SF−2809) Employee cancels

Reinstatement (SF−2810) Return from military status or correction of erroneous
termination

Transfer In (SF−2810) Transfer from department to department and coverage
continues

Transfer Out (SF−2810) Transfer enrollment to OWCP
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Married Required

Indicates married or not married. Click the down arrow to display the
drop-down menu. Valid values are Yes and No.

Enrollmt Code Required, alphanumeric, 3 positions

Type the OPM-assigned enrollment code. For a list of valid codes, see TMGT
Table 012.

Event Code Required

The code that identifies the reason for the event. Click the down arrow to select
the reason.

Date of Event Required, numeric, 8 positions

Type the date of the event.

Personnel Contact

Information pertaining to the person to be contacted for questions.

Last Required, alphanumeric, 20 positions max.

Type the last name of the personnel office contact person.

First Required, alphanumeric, 15 positions max.

Type the first name of the personnel office contact person.

Phone Required, numeric, 10 positions

Type the area code and phone number of the personnel office contact person.

Other Insurance
Information

Information pertaining to other/supplementary insurance coverage.

Medicare A Optional, alpha, 1 position

Click the box if the employee is enrolled in medicare hospital insurance.

Medicare B Optional, alpha, 1 position

Click the box if the employee is enrolled in a supplementary medicare hospital
insurance.

Policy Number Required, alpha, 30 positions max.

Type the policy number of the other insurance policy.
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Medicare Part D Indicator Optional, 1 position

Click this field if the person is covered by Medicare Part D. The default for this
field is blank.

TRICARE Optional, alpha, 1 position

Click the box if the employee is enrolled in TRICARE.

NOTE: To cancel a selection, click the checkmark.

Date Signed Required, numeric, 8 positions

Type the date the employee signed the form.

Date Received In
Personnel Office Required, numeric, 8 positions

Type the date the personnel office received the form from the employee.

Effective Date Required, numeric, 6 positions

Type the date the transaction is effective.

Agency Official Phone
Number Required, numeric, 10 positions

Type the area code and phone number of the authorized agency official.

Is this a retroactive
adjustment for an
employee not previously
enrolled in FEHB? Optional

Click the down arrow to display the drop-down menu. Select Yes if the
effective date of the registration or change is prior to the processing pay period
and the employee is not enrolled in FEHB. Yes indicates an automatic
deduction for a lump sum payment in one pay period for the total FEHB debt
owed. 

Caution: The PPS only adjusts back to the effective date of the last action. If a
personnel action with a date after the effective date of the FEHB enrollment has
been processed, the system will only adjust back to the date of the personnel
action. Automatic adjustments are not made back to the date of enrollment.
Hence, enter the AD−343 in DOTSE for the period prior to the last personnel
action.

Select No if the employee was ever enrolled in FEHB and requires a retroactive
adjustment. No indicates the past due FEHB costs will be prorated. Enter the
adjustment and indicate the amount to be deducted each pay period until the
debt is repaid.
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Temporary
Employee−Pay Full
Premium Conditional, alpha, 1 position

Indicates a temporary employee is required to pay both the Government share
and employee share of FEHB premiums. Leave blank if the employee is not in a
temporary position.

Click the down arrow to select Yes or No. Select Yes if the employee is in a
temporary position and must pay both the employee share and Government
share of the health benefits premium.

Select No if the employee is in a temporary position and previously held a
permanent position which makes the employee eligible to pay only their share of
the health benefit premium. If No is selected, the document rejects in PINE for
verification of full premium payments. When the document rejects, enter I in
the Status Code field if the employee is eligible to pay only the employee share
of the health benefit premium. If the field was entered incorrectly, contact the
Payroll/Personnel Operations Section to change the pay full premium indicator.

Traditional Choice Since
11/01/96 Conditional, alpha, 1 position

Indicates if an FDIC employee was enrolled prior to November 1, 1996. This
field applies to FDIC only.

Click the down arrow to select Yes or No. Select Yes if the employee was
enrolled continuously in the plan since November 1, 1996.

Select No if the employee was not enrolled in the plan, or was not enrolled
continuously in the plan since November 1, 1996.

Pre-Tax Premium Conditional, alpha, 1 position

Indicates if premium is deducted before or after tax deductions.

Click the down arrow to select Yes or No. The default is Yes.

Once an employee elects Yes for PC−HB, the employee can only change this
option (from Yes to No) during the annual Open Season or via a Qualified Life
Event (QLE). For more information on Qualified Life Events see Premium
Conversion.

Open season usually runs from mid-November to mid-December with an
effective date in early January of each year.

Daytime Phone Required, numeric, 10 positions

Type the area code and phone number where the employee can be reached
during the daytime.

Other Private Optional, alphanumeric, 35 positions max.

Type the name of the insurance company in which enrolled.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 6

F
ield

 In
stru

ctio
n

s F
o

r
E

P
IC

 W
in

d
o

w
s

6:91Field Instructions For Payroll DocumentsUpdated 01/08

New Payroll Office Or
Retirement System Optional, alphanumeric, 35 positions max.

Type the new payroll office or retirement system when FEHB is transferred to
OWCP.

Note: This field does not apply to system-generated SF−2810’s.

Leave Data Transferred Window Field Instructions

The Leave Data Transferred window (Figure 4:17) is used to enter transferred leave data. For
instructions on the entry process, see Steps For Entering Transferred Leave Documents.

Anual Leave Hours

The annual leave record.

Prior Year Leave Balance Required, numeric, 6 positions max.

Type the prior year annual leave balance(s).

Credit Conditional

If the prior leave balance is negative, check the Credit box. To cancel the credit,
check the box again.

Current Year Leave
Earned Required, numeric, 3 positions max.

Type the number of annual leave hours earned during the current leave year.

Reduction In Credits Required, numeric, 3 positions max.

Type the number of hours the annual leave is to be reduced.

Current Year Leave
Taken Required, numeric, 6 positions max.

Type the total number of annual leave hours used during the current leave year.

Leave Transferred No entry

The system generates this data from the agency-entered data. If the leave
transferred amount is a negative balance, the Credit box contains a checkmark.

Credit No entry

If the leave transferred is a negative balance, the system generates a checkmark.
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Sick Leave Hours

The sick leave record.

Prior Year Leave Balance Required, numeric, 6 positions max.

Type the prior year sick leave balance(s). If the prior leave balance is negative,
check the Credit box. To cancel the credit, check the box again.

Credit Conditional

If the prior leave balance is negative, check the Credit box. To cancel the credit,
check the box again.

Current Year Leave
Earned Required, numeric, 3 positions max.

Type the number of sick leave hours earned during the current leave year.

Reduction In Credits Required, numeric, 3 positions max.

Type the number of hours the sick leave is to be reduced.

Current Year Leave
Taken Required, numeric, 6 positions max.

Type the total number of sick leave hours used during the current leave year.

Leave Transferred No entry

The system generates this data from the agency-entered data. If the leave
transferred amount is a negative balance, the Credit box contains a checkmark.

Credit No entry

If the leave transferred is a negative balance, the system generates a checkmark.

Current Year

The current year nonpay status record.

LWOP Or Furlough Optional, numeric, 6 positions max.

Type the number of LWOP or furlough hours during the leave year.

AWOL Or Suspension Optional, numeric, 6 positions max.

Type the number of absence without leave (AWOL) or suspension hours during
the leave year.
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6:93Field Instructions For Payroll DocumentsUpdated 01/08

Since Last WGI

Nonpay status record since the last WGI.

LWOP Or Furlough Optional, numeric, 6 positions max.

Type the number of LWOP or furlough hours since the last WGI.

AWOL Or Suspension Optional, numeric, 6 positions max.

Type the number of AWOL or suspension hours since the last WGI.

Date Of WGI Waiting
Period Optional, numeric, 8 positions

Type the beginning date of the WGI waiting period.

Date Of Lump Sum
Leave Optional, numeric, 8 positions

Type the date the lump sum payment carried through.

Current Year Military
Leave Taken Optional, numeric, 2 positions max.

Type the number of days of military leave used during the current leave year.

Locator Window Field Instructions

The Locator window (Figure 4:23) is used to enter employee location data. For instructions
on the entry process, see Steps For Entering Locator Documents.

Building Locator Required, numeric, 3 positions max.

Type the employee’s work building location code. For a list of work building
location codes (building codes), see TMGT, Table 096.

Mail Room Required, numeric, 6 positions max.

Type the employee’s work mail room location code.

Physical Room Required, numeric, 6 positions max.

Type the employee’s work physical room location code.

Phone Number Required, numeric, 10 positions

Type the employee’s work telephone number starting with the area code.
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Lump Sum Leave Payment Window Field Instructions

The Lump Sum Payments window (Figure 4:22) is used to enter lump sum leave payments.
For instructions on the entry process, see Steps For Entering Lump Sum Leave Payment
Documents.

Type Payment Required

Select the type payment being entered in the Type Payment box. The system
defaults to Final for a final lump sum payment for an employee separating
from Federal service. The separation action must be entered to pay a final
payment. Click the Interim radio button if an interim lump sum payment is
being entered for an employee who is not separating but must be paid the lump
sum payment due to regulation and/or policy. A separation action should not be
processed for an interim payment.

Use Database
Accounting Data Required

Select Yes in the Use Database Accounting Data box if the database accounting
is to be used for the payment. The accounting data must be stored on the
database if Yes is selected. Select No if the accounting data is being entered on
the document. For instructions on the entry process, see Steps For Entering
Accounting Data. The accounting data must be valid for the agency and located
in MASC.

Flat Tax Rate Required

This field is defaulted to No, do not pay flat tax rate, pay at the database
withholding rate. If Federal income tax is based on the 27 percent withholding
rate, click the Yes radio button. If Federal tax is based on the database
withholding rate click the No radio button.

Caution: If the No radio button is selected, the Federal tax formula will be used
to calculate Federal tax withholding for the lump sum payment based on the
current W−4.

Minus Sick Leave Conditional

If the employee is indebted for sick leave that is forgiven, click the Yes radio
button; if the employee is indebted and the sick leave is not forgiven and the
debt must be paid, click No. The sick leave balance on the database must be
negative hours. If a sick leave indebtedness does not exist, do not make a
selection.

Pay AUO Required

Click the [Yes] radio button if the employee is eligible for administratively
uncontrollable overtime (AUO); click the [No] radio button if the employee is
ineligible for AUO.
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Pay COLA/Post Diff Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are:

• No − Do not pay COLA or Post Differential

• COLA − Pay COLA only

• Non-Foreign Post Differential − Pay Non-Foreign Post
Differential Only

• Non-Foreign Post Differential COLA − Pay both
Non-Foreign Post Differential and COLA

Note: Foreign Post Differential is not authorized in Lump Sum Payments. Foreign
Post Allowance is authorized but the system cannot pay it automatically. Must
submit an SPPS request for payment.

Wage Emp Shift Rate
Hours

The shift rates for FWS employees. Complete at least one field for a FWS
employee.

1st Required for wage grade employees, numeric, 5 positions max.

Type the first shift rate hours for an FWS employee.

2nd Conditional, numeric, 5 positions max.

Type the second shift rate hours for an FWS employee.

3rd Conditional, numeric, 5 positions max.

Type the third shift rate hours for an FWS employee.

Variable Conditional, numeric, 5 positions max.

Type the varied shift rate hours for an FWS employee.

Dates LSP Carries
Through

The projected dates all payable annual leave would have carried through had it
not been paid.

• When the A/L Within Ceiling field is blank, the A/L Restored and A/L
Above Ceiling must also be blank.

• Do not complete for an interim lump sum payment.

• The annual leave balance must be greater than the annual leave ceiling and
the annual leave carryover on the database if the A/L Above Ceiling is
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completed. Conversely, the A/L Above Ceiling must be blank if the annual
leave balance is less than the annual leave carryover on the database.

• The dates must be later than the separation action effective date.

• When projecting the dates, project the A/L Restored first, the A/L Above
second, and the A/L Within Ceiling third.

• The A/L Above Ceiling date must be later than the A/L Restored date and the
A/L Within Ceiling date must be later than the A/L Above Ceiling date.

• Holidays are included as regular work days in the projected dates.

A/L Restored Optional, numeric, 8 positions

Type the date the restored annual leave carries through. A restored annual leave
balance must exist on the database.

A/L Within Ceiling Optional, numeric, 8 positions

Type the date the annual leave within ceiling carries through.

A/L Above Ceiling Optional, numeric, 8 positions

Type the date the annual leave above ceiling carries through.

If the employee is indebted for sick leave that is forgiven, click Yes in the Minus
Sick Leave box; if the employee is indebted and the sick leave is not forgiven and
the employee is expected to pay for the indebtedness, click No. The sick leave
balance on the database must be negative hours. If a sick leave indebtedness does
not exist, do not make a selection. An SPPS indetbedness record must be
estimated before hte lump sum action is processed.

If the employee is eligible for COLA, click Yes under Pay COLA; if the employee
is ineligible for COLA, click the No radio button.

If the employee is eligible for authorized unscheduled overtime (AUO), click the
Yes radio button under Pay AUO; if the employee is ineligible for AUO, click No.

Total Hours To Be Paid Required, numeric, 5 positions max.

Type the total number of hours to be paid. The hours must agree with the hours
on the database.

Date Of Separation Required, numeric, 8 positions

Type the date the employee separated. This field applies to final payments only
and must be the same as the effective date of the personnel action.

Total Lines Of
Accounting Data No entry

The number of lines of accounting data listed on the Accounting Data window.
If the Use Database Accounting Data field is coded Yes (use database
accounting), 00 appears in this field.
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Hours Applicable To Last
Day Of LSP Required, numeric, 4 positions max.

Type the number of hours that are applicable to the last day of the lump sum
payment.

Master File Change Window Field Instructions

The Master File Change window (Figure 4:24) is used to enter miscellaneous database
elements that are not entered on a personnel action or payroll document. For instructions on
the entry process, see Steps For Entering Master File Change Documents.

Field Selected No entry

This field is system generated. After you select a data element from the field
selection list, the field name appears in this field.

Field Value Required, alphanumeric, 35 positions max

Type the value for the selected field according to the instructions for the data
elements listed below.

Action Code Required, alpha, 1 position

Click the down arrow to select the code that identifies the type of action to be
taken. Valid values are 0 (Replace), 1 (Add), and 2 (Subtract).

Following are field instructions for the data elements that can be selected from the
field selection list.

Appointment Nature Of
Action/1st Auth/2nd Auth Alphanumeric, 9 positions max.

The appointment NOAC and authority codes, if applicable. This field is only
used to correct the current appointing authority on the original personnel action.
This data displays in IRIS Program IR123.

• For those appointments without authority codes(s), enter the NOAC only.
The new data will supersede what is currently in the PPS database.
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Position Data

1 − 3 Appointment NOAC

4 − 6 Appointment authority (first) code

7 − 9 Appointment authority (second) code

City Tax YTD Numeric, 12 positions max.

The monetary amount of year-to-date city tax deductions for the current taxing
authority. A city tax record must exist. This data displays in IRIS Program
IR106.

• Must be completed by new customers converting to the USDA PPS and when an
employee transfers from one department to another within the PPS.

Position Data

1 − 2 State code

3 − 6 City code

7 − 12 YTD city tax deducted

County Tax YTD Required, alphanumeric, 11 positions

The monetary amount of year-to-date county tax deductions for the current
taxing authority. A county tax record must exist. This data displays in IRIS
Program IR107.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

Position Data

1 − 2 State code

3 − 5 County code

6 − 11 YTD county tax deducted

Critical Element Indicator Numeric, 1 position

The code that indicates the performance appraisal is used to control the granting
of a WGI. This data displays in IRIS Program IR303. Valid values are:
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Position Data

1 Eligible for WGI

2 Composite rating less than 3.0

3 Critical element less than 3.0

4 Composite rating and critical element less than 3.0

Cumulative Retirement
Deductions Conversion Numeric, 7 positions max.

The monetary amount of retirement deductions an employee had prior to being
payrolled by the USDA PPS. This field only updates the Retirement Deductions
This Appointment field on the AD−334, Statement of Earnings and Leave; it
does not update the SF2806/SF3100A, Individual Retirement Record. This data
displays in IRIS Program IR117, Retirement Data.

Date Appointment
Effective Numeric, 8 positions

The appointment date. This data displays in IRIS Program IR102.

• Date must be entered as YYYYMMDD.

Earnings Limitation YTD Numeric, 8 positions max.

The monetary amount of compensation a non-executive level or SES employee
has received to date up to the FEPCA imposed limit. This amount includes the
employee’s base salary, awards, allowances, differentials, bonuses, or other
similar payments. This data displays in IRIS Program IR102.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

FEHB Part Time
Coverage Code Numeric, 1 position

Type the FEHB Part Time Coverage Code. Valid values are:

Code Description

0 Not applicable

1 Prorated based on tour of duty

2 Part time employee paying as a full time employee

3 Temporary employee paying both the employee and agency contribution

Hospital Insurance Tax
Deduction YTD Numeric, 6 positions max.

The monetary amount of year-to-date medicare deductions. This data displays in
IRIS Program IR103, Salary Data YTD.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.
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Hospital Insurance Tax
Wages YTD Numeric, 7 positions max.

The monetary amount of year-to-date medicare wages. This data displays in
IRIS Program IR103.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

Intermittent Days Worked
Calendar Year SCD Numeric, 4 positions max.

The number of days worked while serving an intermittent work schedule during
the calendar year appointment. This data displays in IRIS Program IR129.

Intermittent Days Worked
Last WGI Numeric, 3 positions max.

The number of intermittent days worked since the last WGI. This data displays
in IRIS Program IR303.

Intermittent Days Worked
Probation Period Numeric, 3 positions max.

The number of intermittent days worked while serving an intermittent work
schedule for an appointment that was subject to a one year probationary or trial
period. This data displays in IRIS Program IR129.

Intermittent Days Worked
This Appointment Numeric, 4 positions max.

The number of intermittent days worked during the current appointment. This
data displays in IRIS Program IR129.

Intermittent Days Worked
While On Rolls Numeric, 4 positions max.

The number of days worked while employed by the department. This data
displays in IRIS Program IR129.

Intermittent Elapse
Calendar Days Career
Tenure Numeric, 4 positions max

The number of intermittent elapsed calendar days towards conversion to career
tenure. This data displays in IRIS Program IR129.

Intermittent Elapse
Calendar Days Probation Numeric, 4 positions max

The number of calendar days that have elapsed during an intermittent work
schedule for an appointment that is subject to a 1-year probationary or trial
period. This data displays in IRIS Program IR129.
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Intermittent Elapse
Calendar Days SCD Numeric, 6 positions max

The number of intermittent elapsed calendar days toward the service
computation date for leave, retirement, RIF, and TSP. This data displays in IRIS
Program IR129.

Intermittent Elapse
Calendar Days WGI Numeric, 4 positions max

The number of calendar days that have elapsed while serving in an intermittent
work schedule and in a waiting period for a WGI. This data displays in IRIS
Program IR303.

Intermittent Hours
Worked Leave
Retirement RIF Numeric, 4 positions max

The number of hours an intermittent worked for the leave year. The PPS
automatically adjusts the SCD for leave, retirement, RIF, and TSP at the end of
the leave year for all intermittent employees to reflect the number of hours
worked. This data displays in IRIS Program IR129.

Intermittent Paid Days To
Career Tenure Numeric, 3 positions max

The number of paid intermittent days of creditable service towards career
tenure. This data displays in IRIS Program IR129.

No Pay Due Indicator Alpha, 1 position

Type a Y in the No Pay Due Indicator field.

OASDI Deductions YTD Numeric, 6 positions max

The monetary amount of year-to-date social security deductions. This data
displays in IRIS Program IR103.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

OASDI Wages YTD Numeric, 7 positions max

The monetary amount of year-to-date social security wages. This data displays
in IRIS Program IR103.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

Overpayment Carryover
YTD Numeric, 8 positions max

The monetary amount an employee earned that is not payable in the current
calendar year because it exceeds the annual earnings limitations. This amount is
carried to the next year so payment can be made to the employee in the first pay
period in the calendar year. This data displays in IRIS Program IR103.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

6:102 Field Instructions For Payroll Documents Updated 01/08

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

Pay Adjustment Pay
Period Elapsed Counter Numeric, 3 positions max

The number of pay periods that have elapsed since the first pay period the
employee was paid. It is used to generate automatic pay adjustments for Census
decennial employees. For use by the Department of Commerce, Bureau of the
Census (decennial employees) only. This data displays in IRIS Program IR123.

Performance Evaluation
Pay Period Numeric, 2 positions max

The pay period for which the performance evaluation is prepared. This data
displays in IRIS Program IR304, Performance Evaluation Data.

Performance Evaluation
Rating Code Numeric, 2 positions max

The employee’s performance evaluation rating for the current rating period.

Performance Evaluation
Year Numeric, 4 positions

The year for which the performance evaluation is prepared. This data displays in
IRIS Program IR304.

Performance Penalty
Status Alpha, 1 position

Indicates whether an employee has been placed in a warning status. Type Y
(yes) or N (no). This data displays in IRIS Program IR123.

• For use by the Department of Commerce, Bureau of the Census (decennial
employees) only. The pay plan must be AD and the grade must be 60, 70, or
80.

Premium Pay YTD Numeric, 8 positions max

The monetary amount of premium pay the employee has received year to date.
This data displays in PINQ Program PQ22, Pay History.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

Retirement YTD
Retirement Earnings Numeric, 7 positions max

The monetary amount of year-to-date retirement earnings. This data displays in
IRIS Program IR117.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.
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Separation Final T&A
Received Alpha, 1 position

Indicates separated status. Type Y (yes) or N (no). This code indicates if the final
T&A has been processed for an employee in separated status. This data displays
in IRIS Program IR132, Separation Information.

• If the timekeeper fails to code the Final field on the T&A to indicate that an
employee is in separated status, type Y.

• If the timekeeper erroneously coded this field for an employee who is not
separating, type N to indicate that the employee is not separating.

TSP Deduction YTD Def
Catchup Numeric, 8 positions

Type the year to date amount of the TSP catchup contributions.

TSP Deduction YTD Def
Plan Specific Numeric, 10 positions

Type the year to date amount of the TSP plan specific contributions.

Thrift Saving Deduction
YTD Deferred Numeric, 7 positions max

The monetary amount of year-to-date Thrift Savings Plan deductions. This data
displays in IRIS Program IR118, Thrift Savings Data.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

Thrift Saving YTD Thrift
Earnings Numeric, 7 positions max

The monetary amount of year-to-date Thrift Savings Plan earnings. This data
displays in PINQ Program PQ56, PACS Thrift Savings.

• Must be completed by new customers converting to the USDA PPS and
when an employee transfers from one department to another within the PPS.

W−4 Controlled By IRS
Alpha, 1 position

Type Y to indicate yes if the W−4 is controlled by the IRS, or type N to indicate
if the W−4 is not controlled by the W−4.

WGI Due Code Numeric, 1 position

Indicates if a WGI is due. Type 0 (no) or 1 (yes). The system tracks when the
next WGI is due based on the time in step and generates the WGI personnel
action accordingly. This field is used to update the database so that the WGI can
or cannot be processed. This data displays in IRIS Program IR303.
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Multi Element Update Window Field Instructions

The Multi Element Update window (Figure 4:25) is used to enter miscellaneous database
elements that are not entered on a personnel action or payroll document but are used for
reporting requirements as well as to denote expertise in various fields. For instructions on the
entry process, see Steps For Entering Multi-Element Update Documents.

Field Selected No entry

After you select a data element from the selection list, the name appears in this
field.

Field Value Required, alphanumeric, 20 positions max.

Type the value for the selected field according to the instructions for the data
elements listed below.

Following are field instructions for the data elements that can be selected from the
field selection list.

6C Retirement Date Numeric, 8 positions

The retirement service computation date for employees appointed to law
enforcement or firefighter positions entailing a special retirement deductions
rate (Retirement Coverage Code 6, E, M, and T). This data displays in IRIS
Program IR102.

• Must be completed for employees to receive a Benefits Statement for Law
Enforcement Officers and Firefighters.

Note: When an entry is made in this field, the data will be recorded in IRIS
Program IR102. Even though completing this field will update IRIS, include
Remarks Code B05, Employee became subject to 7 1/2 percent CSR deduction
effective (date), on the personnel action appointing the employee to a law
enforcement or firefighter position. When the retirement date is entered for
Remarks Code B05, the date is recorded in RETM to update the employee’s
SF−2806/SF−3100, Individual Retirement Record. The date entered for Remarks
Code B05 is not recorded in IRIS; therefore, complete this field in order to
establish this date in IRIS.

• If an incorrect date was entered when Remarks Code B05 was completed,
enter a correction to the personnel action using Remarks Code B05 with the
correct date. If an incorrect date appears on IR102, enter the correct date in
this field.

• If the employee moves from a law enforcement or firefighter position, enter
Remarks Code 619, 7 1/2 percent retirement discontinued (date) under PL
93−350.
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6:105Field Instructions For Payroll DocumentsUpdated 01/08

Agency EOD Date Numeric, 8 positions

The date the employee entered on duty with the agency. For new appointments,
the system uses the effective date of the accession action to generate the agency
EOD Date; no entry is required. This data displays in IRIS Program IR102.

Agency Information 1 Alphanumeric, 20 positions max

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Information 2 Alphanumeric, 20 positions max

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Information 3 Alphanumeric, 20 positions max

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Information 4 Alphanumeric, 20 positions max

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Information 5 Alphanumeric, 20 positions max

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Use 1 Alphanumeric, 1 position

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Use 2 Alphanumeric, 2 positions

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Use 3 Alphanumeric, 4 positions

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Agency Use 4 Alphanumeric, 5 positions

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.
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Agency Use 5 Alphanumeric, 6 positions

Free-form agency specific information used in accordance with agency
instructions. This data displays in IRIS Program IR123.

Approved Leave
Recipient Alpha, 1 position

Identifies employees who are approved by their personnel office to receive
annual leave from other Federal employees through the Leave Transfer Program
for a medical or family emergency or other hardship situation. Type Y (yes) or
N (no). This data displays in IRIS Program IR136.

Computer Equipment
Ability Code 1 Alpha, 1 position

The code that identifies the employee’s experience with a specific type of
computer equipment. This data displays in IRIS Program IR123. Valid values
are:

Code Description

B Burroughs

H Honeywell

I IBM

R Fosdic

U Univac

O Other

Computer Equipment
Ability Code 2 Alpha, 1 position

The code that identifies the employee’s experience with a specific type of
computer equipment. For valid values, see the Computer Equipment Ability
Code 1 field. This data displays in IRIS Program IR123.

Computer Equipment
Ability Code 3 Alpha, 1 position

The code that identifies the employee’s experience with a specific type of
computer equipment. For valid values, see the Computer Equipment Ability
Code 1 field. This data displays in IRIS Program IR123.

Computer Equipment
Ability Code 4 Alpha, 1 position

The code that identifies the employee’s experience with a specific type of
computer equipment. For valid values, see the Computer Equipment Ability
Code 1 field. This data displays in IRIS Program IR123.
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Date EOD Foreign
Service Numeric, 8 positions

The date the employee converted to or entered foreign service. This date is used
to generate a correction to the Your Personal Statement of Benefits output to
determine eligibility for foreign service retirement. This data displays in IRIS
Program IR117.

Note: Employees who entered foreign service after January 1988 are not eligible
to retire from foreign service unless they complete a minimum of 5 years in the
foreign service.

• Pay plan must be FC, FE, FO, FP, or FS.

Date Entered POI Numeric, 8 positions

The date the employee began to be serviced by the personnel office. For new
appointment personnel actions or personnel actions that transfer the jurisdiction
of an employee’s personnel record from one servicing personnel office to
another, the system uses the effective date of the personnel action to generate the
Date Entered POI. No entry is required. Refer to agency instructions in
completing this field. This data displays in IRIS Program IR102.

Date Of Investigation Numeric, 8 positions

The initial date the security investigation was completed. This data displays in
IRIS Program IR312.

Date Of Reinvestigation Numeric, 8 positions

The date the reinvestigation needs to be initiated to assure security clearance is
updated. This data displays in IRIS Program IR312.

FEHB Temp SCD Numeric, 8 positions

The date a temporary employee becomes eligible for the FEHB program. This
data displays in IRIS Program IR115.

•  This field must be completed for:

Temporary employees who have a break in service of 5 days or less. The
PPS will generate the effective date of the new appointment as the FEHB
Temp SCD. Since a break in service of 5 days or less does not interrupt a
temporary employee’s length of service for FEHB eligibility, adjust the
FEHB Temp SCD field to reflect the correct SCD.

Newly hired employees. The PPS will generate the effective date of the
temporary appointment as the SCD for FEHB eligibility. Since this date will
be automatically generated, verify the accuracy of the date for temporary
employees who may have had previous creditable service for FEHB
eligibility (transferred to the agency without a break in service of more than
five days).
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Financial Disclosure
Submitted Alpha, 1 position

Denotes whether the employee occupies a position subject to conflict of interest
or financial disclosure reporting requirements and whether the required
statement has been submitted. Type Y (yes) or N (no). This data displays in IRIS
Program IR123.

Flexfactor Participation
Code Alpha, 1 position

Type Y (yes) participate in the Flexfactor program, N (no) waive participation,
or C (cancel participation). Y is generated for accessions.

Section 125 of the Internal Revenue Code permits health insurance premiums to
be deducted from employees’ pay on a pre-tax basis. Flexfactor participation
allows non-Federal and Federal employees FEHB premiums to be deducted
from their pay prior to the computation of Federal income tax, social security,
medicare, and all state income taxes except New Jersey and Pennsylvania. OCC,
ARC, FDIC * *, and FCA/FCSIC employees may elect to participate in
Flexfactor at anytime.

Other than reducing participating employee’s taxable income, there is no other
impact on pay or benefits as a result of Flexfactor. The health premium amounts
will not be included in the employee’s taxable income on the W−2, Wage and
Tax Statement. This data displays in IRIS Program IR113, Flexfund.

Law Bar Membership
And State Of Bar Numeric, 3 positions max

Indicates that the employee has a law degree and is a member of the Bar. Type 0
(not applicable), 1 (has a law degree), or 2 (has a law degree and is a member
of the Bar). This data displays in IRIS Program IR123.

• Type the state abbreviation in the last two positions.

• The State of Bar must be blank if the Law Bar Membership is 0 or 1.

• If 2 is entered as the law bar membership, enter the state code also.

Longevity Date Numeric, 6 positions

The longevity SCD for employees appointed to the U.S. Secret Service
Uniformed Division (Pay Plan LE). The PPS will use this date to determine the
percentage of longevity pay the employee will receive each pay period. The
percentage of longevity pay earned each pay period will appear on Form
AD−334, Statement of Earnings and Leave, as TC 51, Suffix 2, Longevity.
When a personnel action is processed to change the pay plan from LE to another
pay plan, the PPS will place zeros in the Longevity Date field in the PPS. This
data displays in IRIS Program IR102.

• Pay plan must be LE.
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6:109Field Instructions For Payroll DocumentsUpdated 01/08

Primary Fund Code Numeric, 2 positions

Relates to specific projects within the appropriation code structure. Type the
code that is assigned to employees as they are hired and is based on the project
on which the employee is expected to work at least 50 percent of the time. This
data displays in IRIS Program IR102.

Programming Language
Code 1 Numeric, 1 position

The first computer programming language for which the employee has
experience. This data displays in IRIS Program IR123. For a list of valid codes,
see the Programming Language Code 1 Table.

• A total of five codes may be entered.

Programming Language
Code 2 Numeric, 1 position

The second computer programming language for which the employee has
experience. This data displays in IRIS Program IR123. A total of five codes may
be entered. See the Programming Language Code 1 Table.

Programming Language
Code 3 Numeric, 1 position

The third computer programming language for which the employee has
experience. This data displays in IRIS Program IR123. A total of five codes may
be entered. See the Programming Language Code 1 Table.

Programming Language
Code 4 Numeric, 1 position

The fourth computer programming language for which the employee has
experience. This data displays in IRIS Program IR123. A total of five codes may
be entered. See the Programming Language Code 1 Table.

Programming Language
Code 5 Numeric, 1 position

The fifth computer programming language for which the employee has
experience. This data displays in IRIS Program IR123. A total of five codes may
be entered. See the Programming Language Code 1 Table.

SES Recertification Date Numeric, 8 positions

The date an SES career employee was recertified for duty. This data displays in
IRIS Program IR102.

• The pay plan must be an SES pay plan and the type of appointment must be
01.
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TDY Post Differential Numeric, 2 positions

The TDY post differential percent. Valid values are 0000 through 2500. This
field is only to be used by the Department of Justice. This data displays in IRIS
Program IR102.

• If an employee is temporarily detailed to a foreign post of duty and is eligible
for post differential, enter the percentage for the post differential in whole
percentages.

• An employee cannot receive both TDY and COLA/post differential.

Note: TC 46, Post Differential, must be entered by the timekeeper on the T&A for
the pay period in which payment is to begin. After initial entry, the TC will not
have to be reentered for the subsequent pay period(s).

Type Of Investigation Numeric, 2 positions

The type of security clearance investigation completed. This data displays in
IRIS Program IR312. For a list of valid codes, see the Type Of Investigation
Table.

Non-Federal Health Benefits Window Field Instructions

The Non-Federal Health Benefits window (Figure 4:27) is used to enter non-Federal health
benefits data. For instructions on the entry process, see Steps For Entering Non-Federal
Health Benefit Documents.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken.

Enrollment Code Required, numeric, 3 positions

Type the assigned enrollment code. Specific enrollment codes are assigned by
NFC.

• Type the plan code in the first two positions; type the option code in the third
position.

Adjustment Flag Conditional

Click the Yes or No radio button to indicate the effective date is prior to the
current processing pay period and an adjustment is required. Bypass the
selection if the effective date is the same as the processing pay period

• Select Yes if the effective date is prior to the current processing pay period
and the employee is not presently enrolled in a non-Federal health plan.
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6:111Field Instructions For Payroll DocumentsUpdated 01/08

• Select No if the employee was/is enrolled in a non-Federal health plan and
requires a retroactive adjustment.

Tax Deferred Code Required

Click the Yes or No radio button to indicate if the deductions are taxable or tax
deferred. Click the down arrow to select yes or no. Select Yes (tax deferred) or
No (tax exempt).

Effective Date Required, numeric, 8 positions

Type the effective date of enrollment.

Non-Federal Life Insurance Window Field Instructions

The Non-Federal Life Insurance window (Figure 4:28) is used to enter non-Federal life
insurance data. For instructions on the entry process, see Steps For Entering Non-Federal
Life Insurance Documents. For information on non-Federal life insurance documents, see
Non-Federal Benefits: Life Insurance.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are New, Change, and Cancel.

Plan Code Required, numeric, 2 positions

Type the plan code of the insurance plan. For a list of valid codes,
see Non-Federal Life Insurance Plan Code Tables.

Coverage Code Required, numeric, 2 positions

Type the coverage code for the insurance plan. For a list of valid codes,
see Non-Federal Life Insurance Coverage Codes Table.

Enter the appropriate codes for Smithsonian Institution employees only.

Coverage Amount Required for SI only, numeric, 4 positions max.

Type the amount of coverage in whole dollars.

• The minimum coverage amount is $10,000; the maximum coverage amount
is $500,000.

• Must be in $10,000 increments.

Option 1 Optional, numeric, 4 positions max.

Type the amount of Option 1.
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• Must be in multiples of $25,000 and cannot exceed $300,000.

• Cannot exceed five times the adjusted salary.

• For FDIC only, this field cannot exceed $125,000 if the coverage amount is
less than $25,000.

• If the coverage amount is between $25,000 and $50,000, this field cannot
exceed $250,000.

Option 2 Optional, numeric, 4 positions max.

Type the amount of Option 2.

Option 3 Optional, numeric, 4 positions max.

Type the amount of Option 3.

Effective Date Required, numeric, 8 positions

Type the effective date of the non-Federal life insurance.

Adjustment Flag Conditional

Click the Yes or No radio button to indicate the effective date is prior to the
current processing pay period and an adjustment is required. Bypass the
selection if the effective date is the same as the processing pay period.

• Select Yes if the effective date is prior to the current processing pay period
and the employee is not presently enrolled in a non-Federal life plan. (The
system automatically adjusts deductions for up to 26 pay periods.)

• Select No if a retroactive adjustment is not necessary.

Biweekly Deduction
Amount Required for ATF only, numeric, 5 positions max.

The amount to be deducted each pay period. Type the appropriate amount
depending on the option(s) selected from the life insurance plan.

Non-Federal Retirement Window Field Instructions

The Non-Federal Retirement window (Figure 4:29) is used to enter non-Federal retirement
data. For instructions on the entry process, see Steps For Entering Non-Federal Retirement
Documents.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are New Enrollment, Change, and Cancel.
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6:113Field Instructions For Payroll DocumentsUpdated 01/08

Plan Code Required, numeric, 2 positions

The plan code of the retirement savings and investment plan. For a list of valid
codes, see the Non-Federal Retirement Plan Code Table.

• Plan Code 23 requires the employee to be at least 35 years of age and 3
years of service with agency 71, 73, or 77. The accession date is used to
certify the length of service requirement. However, since any prior service as
a Trust employee can be used in determining eligibility, the accession date
cannot be the sole standard for meeting the length of service requirement.
Therefore, if it has been determined that the 3-year service requirement has
been met and that the retirement plan code entered in the Plan Code field is
correct, enter Status Code C when the document rejects in PINE.

• When a Trust employee becomes eligible for the TIAA Retirement Program,
the specific retirement plan for enrollment should be determined based on the
employee being hired prior to January 3, 1988 for Plan Code 23.

• The tour or duty must exceed 39 hours for Plan Codes 23 and 24.

• Plan Codes 23, 34, and 37 apply to agencies 71, 73, and 77 only.

• Plan Code 34 requires the employee to be at least 35 years of age and have
at least 2 years of service with Agency 71, 73, or 77. The accession date is
used to certify the length of service requirement. However, since any prior
service as a Trust employee can be used in determining eligibility, the
accession date cannot be the sole standard for meeting the length of service
requirement. Therefore, if it has been determined that the 2-year service
requirement has been met and that the retirement plan code entered in the
Plan Code field is correct, enter Status Code C when the document rejects in
PINE.

• When a Trust employee becomes eligible for the TIAA Retirement Program,
the specific retirement plan for enrollment should be determined based on the
employee being hired after January 2, 1988, for Plan Code 34.

• The appointment must be at least 365 days for Plan Code 34.

• The deduction is tax deferred for Plan Codes 23, 34, and 37.

• Certain plan codes do not allow for a change in the tax deferred amount or
percent.

Coverage Code Required for SI and ARC only, numeric, 1 position

The coverage code of the retirement plan. Type 0 (no voluntary allotment),
1 (additional retirement account − taxable or tax deferred) or 2 (supplemental
retirement annuity − tax deferred only).

• Type 1 or 2 for Plan Codes 23 and 24 if the amount or percent is taxable or
tax deferred. Type 0 if it is not.

• When 1 is entered, additional retirement deductions can be either tax
deferred or taxable for plan codes 23 and 24.
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• When 2 is entered, additional retirement deductions are taxable for plan
codes 23 and 24.

• Type 2 for Plan Code 37.

• If 2 is entered in this field, the deduction must be coded tax deferred for plan
codes 23 and 24. 

Effective Date Required, numeric, 8 positions

Type the effective date of the non-Federal retirement benefit.

Enter Deferred/Non
Deferred Deduction
Amount Or Percent

The taxable or tax deferred amount or percent to be deducted. Select one option.

• Should not exceed maximum allowed. Enter Status Code D when the
document rejects in PINE and the excess is allowed.

Deferred Amount Optional, numeric, 3 positions max

Type the tax deferred amount for non-Federal benefits in whole dollars.

OR

Non Deferred Amount Optional, numeric, 3 positions max

Type the taxable amount for non-Federal benefits in whole dollars.

OR

Deferred Percent Optional, numeric, 4 positions max

Type the tax deferred percent for non-Federal benefits.

OR

Non Deferred Percent Optional, numeric, 4 positions max

Type the taxable percent for non-Federal benefits.

Non-Federal Thrift Savings Window Field Instructions

The Non-Federal Thrift Savings window (Figure 4:30) is used to enter non-Federal thrift
savings data. For instructions on the entry process, see Steps For Entering Non-Federal Thrift
Savings Documents.

Transaction Required

Click the down arrow to display the drop-down menu and select the action being
taken. Valid values are New Enrollment, Change, Cancel, and Non
Participating.
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6:115Field Instructions For Payroll DocumentsUpdated 01/08

Plan Code Required, numeric, 2 positions

Identifies the thrift savings plan. For a list of valid values, see Non-Federal
Thrift Savings Plan Code Table.

Effective Date Required, numeric, 6 positions max.

The effective date of the non-Federal TSP.

Deduction Type

The deduction amount or percent. Complete one field.

Amount Conditional, numeric, 3 positions

Type the amount to be deducted each pay period in whole dollars.

Note: A deduction amount must be entered for Plan Code 05.

OR

Percent Conditional, numeric, 5 positions

Type the deduction percent if the amount to be deducted each pay period is to be
based on a percentage. For a list of valid values, see Non-Federal Thrift Savings
Plan Deduction Code Table.

Note: A percentage can not be entered for Plan Code 05.

Owners Information Pop-up Field Instructions

The Owners Information pop-up (Figure 4:35) is used to enter owner data for a savings bond.
For instructions on the entry process, see Steps For Entering Savings Bond Documents.

Owner Name Required, alphanumeric, 31 positions max.

Type the name of the bond owner.

• Type exactly as desired to print on the savings bond. This field must be
completed even if the owner is the employee.

• Use a space to separate two-part names and to separate items such as Jr, Sr,
or III. If there is more than one space after Jr, Sr, or III, the additional item
will not print on the bond.

• Do not use any type of punctuation (e.g., dash, hyphen, period, etc.) in any
part of the name.

SSN Required, numeric, 9 positions

Type the owner’s social security number.
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Address Required, alphanumeric, 1st line−24 positions max. 2nd line−21 positions max.

Type the owner’s first line and second line mailing address.

• The only special characters allowed are the ampersand sign (&), dash or
hyphen (−), and pound sign (#).

• Do not use any type of punctuation (e.g., dash, hyphen, etc.) to separate the
two names (e.g., N First St).

City Required, alpha, 16 positions max.

Type the city name.

• Do not use any type of punctuation (e.g., dash, hyphen, etc.) to separate the
two names (e.g., St Louis).

State Required, alpha, 2 positions

Type the standardized state abbreviation.

Zip Code Required, numeric, 9 positions max.

Type the 5-digit required Zip Code plus the optional Zip+4 code.

Payroll Document Key Data Field Instructions

The payroll document key data is entered on each payroll document. For instructions on the
entry process, see Steps For Entering Payroll Documents.

Dept/Agcy Alphanumeric, 4 positions

Type the department and agency codes.

Effective Pay Period Numeric, 2 positions

Type the number of the pay period in which the payroll document is entered.

Pay Period Year Numeric, 4 positions

Type the effective year of the payroll document.

Request # No entry

The request number for a personnel action initiated in PODS.
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6:117Field Instructions For Payroll DocumentsUpdated 01/08

Name Last, First, Middle Alphanumeric, Last=17 max., First=12 max., Middle=12 max.

Type the name by which an employee is known or designated on all official
transactions.

A total of 25 characters are actually printed on the salary payment. If the name
exceeds 25 characters, the first name will be reduced and printed as an initial.

When the SF−50-B is printed, the entire name is limited to 35 characters; the
name will be adjusted as described above.

Once the employee is established in the database, the name will be generated on
all actions entered. If the name is not generated, either the Employee Name
database is unavailable, the incorrect social security number was entered, or the
employee is not established in the Payroll/Personnel database. Always verify
that the generated name agrees with the social security number that is entered.

POI (Personnel Office
Identifier Numeric, 4 positions

Type the assigned code that identifies an agency personnel office. The POI
identifies the personnel office to which the employee is assigned.

SSN Numeric, 9 positions

Type the employee’s social security number.

Status Code Alpha, 1 position

Type the code that indicates the disposition of a document. Certain status codes
are entered by the user; others are system generated. The status code also
appears on the List EPIC Document window and on each payroll document
window. The valid status codes for entering a payroll document are H (hold);
I (incomplete); R (release). For a complete list and explanation of status codes,
see Status Code Tables.

Note: The transactions in hold, waiting remarks, or incomplete status are
accessible in EPIC for modification and release. Applied actions can only be
viewed.

Performance Appraisal Window Field Instructions

The Performance Appraisal window (Figure 4:31) is used to enter performance appraisal data
(except for SES employees). For instructions on the entry process, see Steps For Entering
Non−SES Performance Appraisal Documents.

Period Rating Of Record

The inclusive dates of the rating of record period.

• Cannot be greater than current date.

• Must be greater than the last performance evaluation anniversary date in the
database by 90 days.
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From Date Required, alpha, 8 positions

Type the beginning date of the rating of record period.

To Date Required, alpha, 8 positions

Type the ending date of the rating of record period.

Note: The data entered in these fields will remain when the document is
successfully added. This will allow the consecutive entry of performance
appraisal without having to retype the date. If either date is different from the
performance appraisal previously entered, type the new date over the date
displayed in the window.

Rating Of Record

The rating of record pattern and level.

• The rating of record pattern and rating of record level must be compatible.
For a list of valid codes, see Performance Appraisal Rating Of Record Table.

Pattern Required, alpha, 1 position

Type the rating of record pattern. For a list of valid codes, see the Performance
Appraisal Rating Of Record Table.

Level Required, alphanumeric, 1 position

Type the rating of record level. For a list of valid codes, see the Performance
Appraisal Rating Of Record Table.

Pay Plan Required, alpha, 2 positions

Type the employee’s pay plan. The data entered in this field will remain when
the document is successfully added. This will allow the consecutive entry of
performance appraisal without having to retype the date. If the pay plan is
different from the performance appraisal previously entered, type the new date
over the date displayed in the window.

Summary Rating Score Required, alphanumeric, 3 positions max

Type the rating of score. For a list of valid codes, see the Performance
Appraisal Summary Rating Score Table (DoC only).

• This field is for the Department of Commerce employees only.

• Must be 10 through 70 for DoC and 10, 20, or 95 for the National
Institute of Standards and Technology.
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6:119Field Instructions For Payroll DocumentsUpdated 01/08

Restored Annual Leave Window Field Instructions

The Restored Annual Leave window (Figure 4:18) is used to enter restored annual leave data.
For instructions on the entry process, see Steps For Entering Restored Annual Leave
Documents.

Transaction Required

Click the down arrow to display the drop−down menu and select the action
being taken.

• Select New to establish restored annual leave in the database, or to add to the
existing total due to an additional restoration of leave.

• Select Replacement to replace an amount previously established. Show
the new amount for the total hours.

• Select Delete to delete an amount previously established.

Year Leave To Be Used Required, numeric, 4 positions

Type the beginning year of annual leave restoration.

Annual Leave Restored Required, numeric, 5 positions

Type the total amount of annual leave hours to be restored in whole and quarter
hours.

Payment will automatically continue until TC 48, Stop Post differential, is
entered on the T&A to discontinue the payments. Type 0000 in this field the
pay period after the T&A is coded to stop the post differential. 0000 indicates
an employee is no longer entitled to TDY Post Differential. The actual payment
of the differential is stopped via the T&A.

Savings Bond Authorization Window Field Instructions

The Savings Bond Authorization window (Figure 4:33) is used to enter savings bond data.
For instructions on the entry process, see Steps For Entering Savings Bond Documents.

Bond Series Required

Select the bond series for the bond record. The system defaults to EE for series
EE bond. Click I for the series I bond.

Bond Authorization
Number Required, numeric, 1 position

Type the bond authorization number that identifies the bond. Valid values are 1
through 9.
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Effective Date Required, numeric, 6 positions

Type the effective month and year of the savings bond authorization.

• Enter the bond data as soon as possible in the effective pay period specified
on the reverse of the bond. It is not necessary to hold bond cards with future
effective dates; these are held in the future file until the processing pay
period.

Amount Allotted Required, numeric, 5 positions max.

Type the amount in dollars and cents to be deducted each pay period for the
savings bond allotment.

Verify Amount Allotted Required, numeric, 5 positions max.

Type the amount to be deducted each pay period for verification.

Bond Denomination Required, numeric, 4 positions max.

The savings bond denomination in whole dollars. Click the arrow and select the
bond denomination amount.

Owner Number Required, numeric, 2 positions

The owner number of the bond. This data is displayed on IRIS IR108.

Coowner Or Beneficiary
Number Required, numeric, 2 positions

Type the coowner or beneficiary number of the bond as shown on IRIS IR108
for bond updates.

SES Performance Appraisal Window Field Instructions

The SES Performance Appraisal window (Figure 4:32) is used to enter SES performance
appraisals and bonuses. For instructions on the entry process, see Steps For Entering SES
Performance Appraisal/Bonus Documents.

Period Rating Of Record

The inclusive dates of the rating of record period.

• Must be greater than the last performance evaluation anniversary date in the
database by 90 days.

From Date Required, numeric, 8 positions

Type the beginning date of the rating of record period.
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To Date Required, numeric, 8 positions

Type the ending date of the rating of record period.

Type Award Required

Click the applicable radio button to select the type of award.

None If the employee did not receive an
award.

Distinguished If the employee received a
distinguished award.

Meritorious If the employee received a meritorious
award.

Retain

Select the applicable retention indicator.

Yes If the employee is retaining the position.

No If the employee is not retaining the position.

Scale Required, alpha, 2 positions max.

Type the appraisal scale rating code.

Bonus Percent Optional, numeric, 2 positions

Type the percent of the SES bonus. Valid values are 01 through 20.

• The bonus amount must also be entered.

Adjective Optional, alpha, 1 position

Type the adjective rating P, FS, or U.

• Type P only if P was entered in the Scale field; otherwise, leave blank.

Bonus Amount Optional, numeric, 7 positions max.

Type the amount of the SES bonus in dollars and cents.

• The bonus percent must also be entered.

• Cannot be greater than 20 percent of the adjusted salary.

Severance Pay Window Field Instructions

The Severance Pay window (Figure 4:37) is used to enter severance pay data. For instructions
on the entry process, see Steps For Entering Severance Pay Documents.
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Transaction Required

The code that identifies the type of action being taken. Click the down arrow to
select the action taken. Select Add, Correct, or Stop.

Total Amount Required, numeric, 7 positions max.

Type the total severance pay amount in dollars and cents the employee is
entitled to receive.

Amount (Per Pay Period) Required, numeric, 7 positions max.

Type the biweekly severance pay amount in dollars and cents the employee is
entitled to receive.

Beginning Date Required, numeric, 8 positions

Type the beginning date for severance pay.

• This date should be the same as the beginning date entered for Remarks N22.

First Payment Amount Required, numeric, 7 positions max.

Type the first severance payment amount in dollars and cents only if it differs
from the Severance Amount (Per Pay Period) field; otherwise, leave blank. If
the employee separates in the middle of a pay period, the first payment would be
a partial payment. If a late action is processed, the first payment may include
multiple payments.

Accounting Distribution Required, numeric, 27 positions max.

Type the accounting code to which the severance payments are to be charged.

Tax Certificate Window Field Instructions

The Tax Certificate window (Figure 4:38) is used to enter local and federal taxes. For
instructions on the entry process, see Steps For Entering Tax Documents.

Total Number Of
Allowances Claimed Required, alphanumeric, 3 positions max.

Type the total number of allowances claimed.

• Total Number of Allowances Claimed must be 00 except for cities in
Michigan and New York, and Philadelphia, PA.

• For Indiana counties: In the first position, type the alpha (A−Z) to represent
the number of additional exemptions claimed. (A=1, B=2, C=3, etc., up to
Z=26). Otherwise, enter 0 (zero). In the second and third positions, enter the
number of exemptions claimed. If less than 10, precede with a zero.
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• For Federal tax, type the marital status code S (single), M (married), or
X (exempt) in the first position. Type the number of exemptions claimed in
the second and third positions unless the employee claims total exemption
from Federal taxes, then type XT.

• For Arizona state tax, valid values are 100, 190, 230, 250, 310, and
370.

Additional Amount Optional, numeric, 6 positions max.

Type the amount in dollars and cents to be withheld in addition to the amount
withheld in accordance with the tax formula.

State Code Required, numeric, 2 positions

Type the state code for the city tax to be withheld.

• State code on tax document and duty station must agree to begin tax
deductions.

City Code Required, alphanumeric, 4 positions

Type the city code for the city tax to be withheld.

• City code on tax document and duty station must agree to begin tax
deductions.

County Code Required, alphanumeric, 4 positions

Type the county code for the county tax to be withheld.

• County code on tax document and duty station must agree to begin tax
deductions.

Are you a resident of city
where employed? Do
you live and work in the
same city? Required, numeric, 1 position

Click the appropriate radio button to select Yes or No. Select Yes if the
employee resides in the city where employed; select No if the employee is a
nonresident of the duty station.

Percent of annual
compensation for
services performed
outside the city? Optional, numeric, 2 positions

Type the percentage of time spent outside the city if the employee performs
25 percent or more of the work outside the duty station city.
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Is employee eligible for
Earned Income Credit? Required, alpha, 1 position

Choose Y (yes) if the employee is married, and both spouses are claiming EIC.
Choose N (no) if the employee is only claiming EIC (this field includes Single,
Head of Household and Married), spouse not claiming EIC.

Filing Status Conditional, alpha

Choose one of the following advance payment options:

• Single, Head of Household or Qualifying Widow(er)

• Married, Both Employee and Spouse Claim EIC

• Married, employee only (not spouse) Claiming EIC

If married, does spouse
have a certificate in
effect with any
employer? Optional, alpha, 1 position

Click the arrow to indicate the spouse filed a certificate with his/her employer.
Select yes if the employee is married and the spouse has filed a W−5 with
his/her employer; select no if the spouse has not filed with his/her employer or if
the employee is not married.

California, Illinois,
Indiana, Puerto Rico, and
Virginia Only

Special instructions for California, Illinois, Indiana, Puerto Rico, and Virginia.

Additional Exemptions
Claimed Required, numeric, 2 positions

Type the number of additional exemptions being claimed. If no additional
exemptions are claimed, type 00.

• For California state tax, type the number of additional exemptions claimed. If
less than 10, precede with zero. If no additional exemptions are claimed,
type 00.

• For Illinois, state tax, type in the number of additional exemptions claimed
from Line 2 on the IL-W-4. Type the number of additional allowances
chosen for the employee and/or spouse. If less than 10, precede with zero.
Valid values are 00 through 99.

• For Indiana state tax, type the number of additional exemptions claimed on
Line 5 of Form WH-4. If less than 10, precede with zero. Valid values
are 00 through 99.

• For Commonwealth of Puerto Rico income tax, type the number of
additional exemptions claimed. If the employee chooses the automatic
method (Section C, Allowances Based on Deduction, of the exemption
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form), type 00. If the employee chooses the optional method, enter the
number of allowances. If less than 10, precede with zero.

• For Virginia state tax, type the number of additional exemptions claimed on
Line 1(b) of Form VA−4. If less than 10, precede with 0. If no additional
exemptions are claimed, type 00.

Puerto Rico Only

Special entry instructions for Puerto Rico.

Personal Exemptions Required, numeric, 1 position

Type the personal exemption being claimed.

• Type 0 if the employee marked none in Section A, Personnel Exemptions, of
the exemption form.

• Type 1 if the employee marked Complete or Half. Only Martial Status N
can claim Half personal exemption.

Private Code Required, numeric, 1 position

Indicates if the employee contributes to a government retirement system.

• Type 1 for private employees who do not contribute to a government
retirement system.

• Type 2 for public employees who contribute to a government retirement
system.

Thrift Savings Plan Catchup Form Window Field Instructions

The Thrift Savings Plan Catchup Form window (Figure NO TAG) is used to enter TSP
catchup contributions for employees age 50 or older wishing to make catchup contributions
to their TSP account. For instructions on entering TSP catchup contributions, see TSP
Catchup Contributions.

Type Of Election Required

Select New Enrollment, Change Contributions, or Stop Contributions. (The
system defaults to New Enrollment.)

Contribution Per Pay
Period

Dollar Amount Required, numeric,

Enter the dollar amount that is to be deducted each pay period for the catchup
contribution. Enter only whole dollar amounts. No cents or decimals are to be
entered in this field.
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Thrift Savings Plan Election Form Window Field Instructions

The Thrift Savings Plan Election Form window (Figure 4:16) is used to enter TSP election
data. For instructions on the entry process, see Steps For Entering TSP Election Documents.

Type Of Election Required

Select New Enrollment/Change Contributions or Stop Contributions. (The
system defaults to New Enrollment/Change Contributions.)

Contributions Per Pay
Period

Enter either the percentage rate OR dollar amount that is to be deducted each
pay period for the investment fund(s).

Percent of Basic Pay Conditional, numeric, 2 positions

If you do not enter the dollar amount, type the percentage rate.

• Must be in 5-percent increments.

• Must be up to 10 percent for CSRS employees and up to 15 percent for
FERS employees.

• The total percentage between each allocation must equal 100.

Dollar Amount Conditional, numeric, 3 positions max.

If you do not enter the percentage rate, type the whole dollar amount.

• The maximum percent allowed is 15 percent of adjusted salary for FERS
employees and 10 percent for CSRS employees. When the special employee
code is 01, 02, 03, or 08, 25% is calculated into the adjusted salary before
determining the maximum deduction.

• Dollar amount must be whole dollars.

TSP Loan Allotment Window Field Instructions

The TSP Loan Allotment window (Figure 4:5) is used to enter TSP loan data. For
instructions on the entry process, see Steps For Entering TSP Loan Allotment Documents.

Repaid Plan Required

Click the non-Federal TSP radio button. NFC enters Federal TSP loans.
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Transaction Required

Click the down arrow to display the drop-down menu and select the TC that
identifies the action being taken. Valid values are Add, Change, and
Delete.

Account Number Required, alphanumeric, 17 positions

Type the TSP loan allotment account number established for the TSP loan.

Allotment Amount Per
Pay Period Required, numeric, 6 positions max.

Type the amount to be deducted each pay period in dollars and cents.

Number Of Payments Required, numeric, 3 positions max.

Type the number of payments required to repay the loan based on the
non-Federal loan agreement.

Union Dues Window Field Instructions

The Organization Dues window (see the example in Figure 4:39) is used to enter organization
dues data. For instructions on the entry process, see Steps For Entering Union (Organization)
Dues.

Organization Code

The union/association and local codes.

Union Required, numeric, 2 positions

Type the union/association code to be established, changed, or canceled/revoked
in the database. Verify the union/association code by accessing IRIS
Program IR308.

Local Required, numeric, 4 positions

Type the local code to be established, changed, or canceled/revoked in the
database.

Cancellation/Revocation Required

Click the applicable radio button to indicate a cancellation or revocation. The
system default is cancellation.

For cancellations, deductions are withheld for the effective pay period entered
and stop the following pay period.

For revocations, the union/association has an established revocation−eff−code
in TMGT; the dues stop the pay period of the authorized revocation date as
established in TMGT, Table 010.
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Deduction Amount Optional, numeric, 4 positions max.

Type the amount to be deducted each pay period for membership dues in dollars
and cents if the deduction is based on a specific amount. No entry is necessary if
the deduction amount is established in TMGT.

OR

Deduction Percent Optional, numeric, 4 positions max.

Type the percent to be deducted each pay period for membership dues in whole
numbers and two decimal places if the deduction is based on a percentage. No
entry is necessary if the percent amount is established in TMGT.

Note: Do not enter both a deduction amount and a deduction percent.

Prior Pay Period
Adjustment Conditional, numeric,1 position

Type 9 if deductions were made in error or if cancellation notification was
received after the revocation date; otherwise, leave blank.

New Local or Lodge
Code Required, numeric, 4 positions

Type the code for the new local or lodge for the transfer.

Employee Authorization
Date Required, numeric, 8 positions

Type the date the employee authorized the membership dues deduction.
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Field Instructions For Requesting Reports

This section presents field instructions for report request windows under the following topics:

Reports Window Field Instructions

JCL Requirements Pop-Up Field Instructions

Processing Status Reports Pop-Up Field Instructions

Reports Window Field Instructions

The Reports window (Figure 5:2) is displayed when you Click [OK] on the PINE Status
pop-up. The Reports window is used request reports from various originating system (i.e.,
Employee Express). For instructions on the request process, see Steps For Requesting An
EPIC Report.

Dept/Agcy Required, alphanumeric, 4 positions

Type the assigned department code and agency code.

Servicing Agency Optional, numeric, 4 positions

Type the agency code for the serviced agency if the agency is serviced by the
agency entered in the Dept/Agcy field.

POI Required, Numeric, 4 positions

Type the personnel office identifier that identifies the personnel office for
processing and reporting purposes.

Originating System Required

Select the applicable originating entry system from the list.

Front End System Interface [FESI] for an agency’s front-end entry system
whereby the data is batch transmitted to NFC.

Employee Self Service for OPM that allows current employees to enter payroll
transactions and update their payroll record via telephone, Internet, or kiosk.

Non-Front End System Interface for all other entry systems excluding a FESI
and Employee Express (EEX).

JCL Requirements Pop-Up Field Instructions

The JCL Requirements pop-up (Figure 5:3) appears when you click [OK] on the PINE status
pop-up. The JCL Requirements pop-up is used to enter the name on the JCL, the Remote
Destination, the Last Character of the Job Name, and the System Output Class. For
instructions on the request process, see Steps For Requesting An EPIC Report.
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User Name On JCL Required, alphanumeric, 15 positions max.

Type the user’s name or other information to identify the report destination.

Remote Destination Required, alphanumeric, 16 positions max.

Type the printer number where the report is to be printed.

Last Character Of Job
Name Required, alphanumeric, 1 position

The sixth character of the job name (e.g., NFC03A). Type A, B, or C to identify
the report from other reports being requested.

System Output Class Required, alpha, 1 position

A code that indicates if the report is to be viewed and/or printed. Type A to
direct the output to a designated printer and to generate a hard copy computer
printout of the report or X to direct the output to be held for viewing at the
terminal. For detailed instructions on viewing a report prior to printing, see
Title VI, Chapter 2, Section 2, Interactive System Productive Facility (ISPF).

Processing Status Reports Pop-Up Field Instructions

The Processing Status Reports pop-up (Figure 5:4) appears from the Print Reports window.
The Processing Status Reports window is used to enter selection criteria when requesting a
Processing Status report. For instructions on the request process, see Processing Status
Report Request Criteria.

Reports Required

Click the documents to be included in the report. A checkmark displays at the
selected report. If a report was inadvertently selected, click the checkmark to
cancel the selection.

A report is produced based on the selection criteria. Select Pending for
documents in hold or incomplete status or waiting remarks status and for
documents awaiting the release of a suspended transaction.

Sort By Required

Click one of the radio buttons to select the report sort. (The default is user-ID.)
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PART 7.

REFERENCE TABLES

This part contains the following topics:

A. Status Code Tables

B. Personnel Data Element Code Tables

C. Document Type Code Table

D. Grade And Pay Retention Tables

E. Payroll Document Code Tables
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A. Status Code Tables

There are two types of status codes: EPIC status codes and status codes. The EPIC status
code is system generated to indicate the status of a personnel action or payroll document after
it has been entered for processing. The status codes are entered by the user or system
generated when the transaction fails PINE edits. This appendix presents tables for each type
of status code. Each table is identified by the document type name, as follows:

EPIC Status Codes

Personnel Action Input Status Codes

Master File Change Document Status Codes

Lump Sum Leave Payments Status Codes

Performance Appraisal Status Codes

Voluntary Charitable Contributions Status Codes

TSP Loan Allotment Form Status Codes

Discretionary Allotment Status Codes

Non-Federal Health Benefits Form Status Codes

Non-Federal Life Insurance Form Status Codes

Non-Federal Retirement Benefits Status Codes

Non-Federal Thrift Savings Plan Form Status Codes

Incentive Awards Status Codes

Thrift Savings Plan Election Form Status Codes

Authorization For Restored Annual Leave Status Codes

Savings Bond Authorization − New Allotment Status Codes

Employee Address Status Codes

Status Codes For Other Payroll Documents

The following status code tables apply to Federal and state income tax documents. For a list
of tax certificate status codes, choose one of the following tables:

Federal Incomes Tax Certificate Status Codes

State Income Tax Certificate Status Codes

Note: When processing City and County Income Tax Certificates and Earned Income Credit
Advance Payment Certificate, use the following status code table for a list of valid values:

Status Codes for Other Payroll Documents

The following status code tables apply to processing health benefits documents. For a list of
health benefits status codes, choose one of the following tables:

Health Benefits Registration Form Status Codes

Change In Health Benefits Enrollment Status Codes

The following status code tables apply to the processing of financial allotment and net pay
documents. For a list of financial allotment and net pay status codes, choose one of the
following tables:

Financial Allotment Status Codes

Net Pay Status Codes
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EPIC Status Codes

Status Code Description

N
 (New)

A transaction that has not released from EPIC for PINE processing (Status Code I,
H, R, or W)

A
(Applied)

A transaction that has released and applied to the payroll/personnel database

F
(Future)

A transaction that is effective in a future pay period and is held in EPIC until the
processing of the effective pay period.

S
(Suspense)

A transaction that failed the PINE edits and is held in suspense

P
(Pending)

A transaction pending release and processing from PINE
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Input Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

H
(Hold)

Used when entering a transaction. The transaction is completed and edited but
held in EPIC until the status code is changed to R (release). If the status code is
not changed, the system will automatically delete the action after 60 days.

I
 (Incomplete)

Used when entering a transaction. The transaction is partially completed and held
in EPIC without being edited. After completing the action, change the status code
to R (release) or H (hold). If the status code is not changed, the system will
automatically delete the action after 60 days.

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

S 
(Severance

Pay)

System generated when entering a separation personnel action with Remarks
Code N22 and the severance pay information has not been entered.

W 
(Waiting)

System generated; when entering a personnel action. The action has been edited
however, the required and/or optional remark code needs the fill-in information for
the literal description to complete the remark. The action will remain in EPIC until
the remarks are completed.

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

 3 A transaction has been processed through PINE, but PEPL cannot update the
database.

4 Delete action

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

I Release error 503, Adjustment needed

Q/Z Release error 749, Personnel history record not on database

R Release error 440, Promotion more than one grade

Release error 105, Pay plan must = ES, EX, FE, IE with retirement code

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

NOTE: For a list of award status codes see Incentive Awards Status Codes.
For an explanation of the Status Code field, see Status Code under Personnel Action Key Data.
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Input Status Codes

DescriptionCode

S Release error 370, Manual payment document

U Release error 255, Pay plan or grade or step not = to data base

V Release error 190, Minimum or maximum salary invalid

Release error 253, Limitation hours invalid

X Release error 441, Salary must not equal data base

Y Release error 706, Nature or action must be 702

N Release error 088, invalid SCD leave for leave category

Z Release error 800, Invalid Performance rating for range

M Release error 445, Invalid cash award amount on document

K Release error 256, AD grade/step not valid for accession

C Release error 092, FEHBA coverage code invalid

L Release error 539, TSP Eligibility code incompatible with retirement code

T Release error 806, New base contract salary invalid − Less than 6 percent

W Release error 106, Possible residence zip code error − verify

Release error 107, Possible check mail zip code error − verify

H Release error 175, Nature of action 130 − invalid for employee

Release error 069, Cash award amount greater than $10,000

Release error 108, Invalid cash award code − must be C024

Release error 112, Spot award must be multiple of $25.00

Release error 128, Separation incentive award already processed

Release error 133, Separation incentive award invalid

Release error 118, Maximum hours per award exceeded

Release error 119, Maximum hours per award leave year exceeded

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

NOTE: For a list of award status codes see Incentive Awards Status Codes.
For an explanation of the Status Code field, see Status Code under Personnel Action Key Data.
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Master File Change Document Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

T Release error 061 − HITS tax or FICA amount over maximum

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.
For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Lump Sum Leave Payments Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 119 − Lump sum payment may not be appropriate for NOA 352

D Release error 094 − Sick leave incompatible with minus sick leave code. The use
of this override code indicates that the employee has negative sick leave that will
not be forgiven. This override code requires that the negative sick leave balance
is forwarded for entry into the special pay processing system (SPPS) so that the
collection of the funds may be made through SPPS.

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Performance Appraisal Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

J Release error 106 − Invalid pay plan for this document

M Release error 120 − Summary rating score invalid

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Voluntary Charitable Contributions Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 052, Amount of deduction must be numeric

Release error 065, Amount per pay period must be at lease $1.00

Release error 066, Verify accuracy of amount per pay period

R Release error 064, Conversion document release required

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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DD/EFT For Financial Allotment Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

 L Release error 058, Amount of financial allotment exceeds 70 percent of gross
salary

D Release error 066, TSP Loan allotment amount must be numeric

Release error 069, TSP loan allotment amount greater than 70 percent of gross
salary

Release error 072, Number of payments required invalid

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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7:12 A. Status Code Tables Updated 01/08

DD/EFT For Net Pay Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

L Release error 058, Amount of financial allotment exceeds 70 percent of gross
salary

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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7:13A. Status Code TablesUpdated 01/08

TSP Loan Allotment Form Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In

PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

L Release error 069, TSP loan allotment amount greater than 70 percent of salary

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Discretionary Allotments Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

 L Release error 065, Amount of total discretionary allotments exceeds 70 percent of
gross salary

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Non-Federal Health Benefits Form Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 060, Effective date 90 days earlier than effective pay period

I Release error 063, Enrollment invalid with type of employment

Release error 074, Plan code incompatible with type of appointment

L Release error 060, Effective date 90 days earlier than effective pay period

Release error 063, Enrollment invalid with type of employment

Release error 074, Plan code incompatible with type of appointment

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Non-Federal Life Insurance Form Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

 C Release error 064, Trust employee ineligible for disability or life insurance

 D Release error 082, Plan code and type of appointment incompatible

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Non-Federal Retirement Benefits Form Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 069, Plan code 23 requires age 35 or 3 yrs of service

Release error 075, Plan code 34 requires age 35 or 2 yrs of service

Release error 076, Plan code 23 − invalid eligibility date

Release error 077, Plan code 23 − invalid database date agency EOD

Release error 078, Plan code and entry on duty date incompatible

D Release error 082, Maximum employee contributions exceeded

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Non-Federal Thrift Savings Plan Form Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

 C Release error 068, Plan code Invalid with type of appointment code

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Incentive Awards Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

 H Release error 069, Cash award amount greater than $10,000

Release error 108, Invalid cash award code − must be C024

Release error 112, Spot award must be multiple of $25.00

Release error 133, Award amount less than $15,000

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Thrift Savings Plan Election Form Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

D Release error 050, Thrift savings plan transaction code must be 1, 2, 3, or 5

Release error 058, Employee not eligible to participate in Thrift Savings Plan

Release error 072, Effective date of TSP election form not in open season

Release error 070, Employee must wait two open seasons to re−enroll

Release error 069, Employee not eligible for Thrift Savings Plan

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Federal Income Tax Certificate Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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State Income Tax Certificate Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 070, Document will result in dual state tax deductions

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Authorization For Restored Annual Leave Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 054, Year leave to be used invalid

Release error 058, Leave restored greater than yearly accrual

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Savings Bond Authorization − New Allotment Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

 D Release error 065, Zip code error for foreign countries

W Release error 087, possible zip code error −−please verify

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 7

R
eferen

ce Tab
les

7:25A. Status Code TablesUpdated 01/08

Health Benefits Registration Form Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 060, Effective date of election 90 days earlier than effective date of
action

D Release error 051, FEHB transaction code not compatible with current
employment status status operation desert shield only

Release error 054, Employee ineligible for health benefits

 I Release error 129, Temporary appointment − method of payment required

Release error 131, Verify pay full premium indicator is correct as an “N”

 V Release error 060, Effective date of election 90 days earlier than effective date of
action

Release error 129, Temporary appointment − method of pay required

Release error 131, Verify pay full premium indicator is correct as an “N”

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Change In Health Benefits Enrollment Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

C Release error 060, Effective date of election 90 days earlier than effective date of
action

D Release error 051, FEHB transaction code not compatible with current
employment status status operation desert shield only

 I Release error 131, Verify pay full premium indicator is correct as an “N”

 V Release error 060, Effective date of election 90 days earlier than effective date of
action

Release error 131, Verify pay full premium indicator is correct as an “N”

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Employee Address Status Codes

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

F Hold document in suspense indefinitely. Positive action must be taken to release
this override.

G Send document to future file

 W Release error 106, Possible residence zip code error − please verify

Release error 107, Possible ck mail zip code error − please verify

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Payroll Document Key Data.
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Status Codes For Other Payroll Documents

This table applies to the following documents:
Allowances
Authorization of Labor Organization Dues
Cancellation/Revocation of Employee Union Dues
City Income Tax Certificate
Compensatory Time Payments
County Income Tax Certificate
Court Ordered Child Care Or Alimony Deduction

 Deductions Due To Indebtedness Document 
Dues Change Between Locals in National Lab Org
Earned Income Credit Advance Payment Certificate
Education Document
Employee Union Dues Mass Change
Flexfund Flexible Spending Account
GAO Locator Input Screen
Multielement Update Document
Professional Certification Document
Record Of Leave Data Transferred
Thrift Savings Plan Catch Up Form
Savings Bond Authorization − Change Denomination/Allotment
Savings Bond Authorization − Change Inscription/Denomination/Allotment
Savings Bond Authorization − Cancel Bond
Savings Bond Authorization − Cancel Owner/Co-Owner/Beneficiary
SES Performance Appraisal
Severance Pay
USDA Demonstration Project Record

Code Description

A System-generated code that appears on all duplicate transactions in PINE
suspense 1/

R 
(Released)

Used when entering a transaction. The transaction has cleared EPIC edits and
has been released to PINE for editing. 2/

X 
(Edited In PINE)

System generated after the transaction is coded R, has cleared all EPIC edits,
and has been edited in PINE, is pending the release of a suspended document, or
has applied to the database.

9 System-generated on all payroll document and personnel action windows and all
suspense transactions except duplicates.

4 Delete action

B Process duplicate document

E Hold document in suspense for one pass only

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Personnel Action Key Data. or Payroll Document
Key Data.
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Status Codes For Other Payroll Documents

DescriptionCode

F Hold document in suspense indefinitely. Positive action must be taken to release
this override

G Send document to future file

1/ To delete the duplicate, type 4 in the Status Code field.

2/ The transaction can be modified only if PINE has not processed. If PINE has processed, it must be corrected
using the activate option, rollback option, or by processing an official correction (or cancellation) action.

For an explanation of the Status Code field, see Status Code under Personnel Action Key Data. or Payroll Document
Key Data.
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B. Personnel Data Element Code Tables

This appendix provides the code lists for personnel action data elements that have four or
more possible values, except for certain very lengthy lists. For these exceptions, the data
element instructions in the procedure refer you to either the TMGT tables or a Federal
manual for codes and definitions.

Note: If a data element has only two or three possible values, the codes are shown in the
procedure with the instructions for that data element.

Annual Leave Category Table

Code Definition

0 Ineligible to earn annual leave

4 Earn 4 hours of annual leave per 80 hours of regular time in pay
status

6 Earn 6 hours of annual leave per 80 hours of regular time in pay
status

8 Earn 8 hours of annual leave per 80 hours of regular time in pay
status

Annuitant Indicator Table

Code Definition

A Reemployed FERS annuitant whose annuity under FERS
continues after appointment and is subject to salary offset

B Former FERS annuitant whose FERS annuity is discontinued after
appointment

C Retired uniform service officer and reemployed FERS annuitant
subject to salary offset

D Retired uniformed service officer and former FERS annuitant
whose FERS annuity is discontinued after appointment

E Retired uniformed service enlisted member and reemployed FERS
annuitant subject to salary offset

F Retired uniformed service enlisted member and former FERS
annuitant whose FERS annuity is discontinued after appointment

G Reemployed FERS annuitant whose annuity under FERS
continues after appointment and is not subject to salary reduction
under 5 U.S.C. 8468

H Retired uniform service officer and reemployed FERS annuitant
not subject to salary reduction under 5 U.S.C. 8468

J Retired uniformed service enlisted member and reemployed FERS
annuitant whose FERS annuity is discontinued after appointment
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Annuitant Indicator Table

DefinitionCode

1 Reemployed CSRS whose CSRS annuity continues after
appointment

2 Retired uniform service officer receiving retired or retainer pay as
commissioned or warrant officer

3 Retired uniform service enlisted member receiving retired or
retainer pay for nonofficer (or enlisted) service

4 Retired uniform service officer (commissioned or warrant officer)
and reemployed CSRS annuitant

5 Reemployed uniformed service enlisted member and reemployed
CSRS annuitant

6 Reemployed CSRS annuitant whose annuity under CSRS
continues after appointment and salary is not subject to reduction
under 5 U.S.C. 8344

7 Retired uniformed service officer (commissioned or warrant officer)
and reemployed CSRS annuitant whose salary is not subject to
reduction under 5 U.S.C. 8344

8 Retired uniformed service enlisted member and reemployed
CSRS annuitant whose salary is not subject to reduction under 5
U.S.C. 8344

9 Not applicable. None of the above applies.

Clear Error Codes Table

Message No Description
Clear Error
Code Value

058 Employee is under 16 or over 90 years of age 1 Y

091 SCD−leave not valid with birth date 2 Y

401 SCD−retirement must be 16 years from date of birth 3 Y

402 SCD WGI must be 16 years from date of birth 4 Y

403 SCD RIF must be 16 years from date of birth 5 Y

149 Only one alpha authority required 6 Y
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COLA/Post Differential Table

Code Definition

0 None

2 Non-foreign post differential

3 COLA − Local retail with post differential

4 Foreign post differential

5 COLA − Local retail

Education Level Table

Code Definition

01 No formal education or some elementary school−did not complete.
Elementary school means grades 1 through 8, or equivalent, not
completed.

02 Elementary school completed − no high school. Grade 8 or
equivalent completed.

03 Some high school − did not graduate. High school means grades 9
through 12, or equivalent.

04 High school graduate or certificate of equivalency.

05 Terminal occupational program − did not complete. Program
extending beyond grade 12, usually no more than 3 years; designed
to prepare students for immediate employment in an occupation or
cluster of occupations; not designed as the equivalent of the first
two or three years of a baccalaureate degree program. Includes
cooperative training or apprenticeship consisting of formal
classroom instruction coupled with on-the-job training.

06 Terminal occupational program − certificate of completion, diploma
or equivalent. See Code 05 above for definition of terminal
occupational program. Two levels are recognized: (1) the technical
and/or semi-professional level preparing technicians or
semiprofessional personnel in engineering and nonengineering
fields; and (2) the craftsman/clerical level of training artisans, skilled
operators, and clerical workers.

07 Some college − less than 1 year. Less than 30 semester hours
completed

08 1 year of college. 30−59 semester hours or 45−89 quarter hours
completed

09 2 years of college. 60−89 semester hours or 90−134 quarter hours
completed

10 Associate degree. 2-year college degree program completed

11 3 years of college. 90−119 semester hours or 135−179 quarter
hours completed
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Education Level Table

DefinitionCode

12 4 years of college. 120 or more semester hours or 180 or more
quarter hours completed − no baccalaureate (Bachelor’s) degree

13 Bachelor’s degree. Requires completion of at least four, but not
more than 5, years of academic work; includes Bachelor’s degree
conferred in a cooperative plan or program that provides for
alternate class attendance and employment in business, industry, or
government to allow student to combine actual work experience with
college studies.

14 Post-Bachelor’s. Some work beyond (at a higher level than) the
Bachelor’s degree but no additional higher degree

15 First professional. Signifies the completion of academic
requirements for selected professions that are based on programs
requiring at least two academic years of previous college work for
entrance and a total of at least six academic years of college work
for completion, e.g., Dentistry (D.D.S. or D.M.D..), Law (L.L.B. or
J.D.), Medicine (M.D.), Theology (B.D.), Veterinary Medicine
(D.V.M.), Chiropody or Podiatry (D.S.C.), Optometry (O.D.), and
Osteopathy (D.O.).

16 Post-first professional. Some work beyond (at a higher level than)
the first professional degree but no additional higher degree.

17 Master’s degree. For liberal arts and sciences customarily granted
upon successful completion of one (sometimes two) academic years
beyond the Bachelor’s degree. In professional fields, an advanced
degree beyond the first professional but below the Ph.D., e.g., the
LL.M.; M.S. in surgery following the M.D.; M.S.D., Master of Science
in Dentistry; M.S.W., Master of Social Work.

18 Post-master’s. Some work beyond (at a higher level than) the
Master’s degree but no additional higher degree.

19 Sixth-year degree. Includes such degrees as Advanced Certificate
in Education, Advanced Master of Education, Advanced Graduate
Certificate, Advanced Specialist in Education Certificate, Certificate
of Advanced Graduate Study, Certificate of Advanced Study,
Advanced Degree in Education, Specialist in Education, Licentiate in
Philosophy, Specialist in Guidance and Counseling, Specialist in Art,
Specialist in Science, Specialist in School Administration, Specialist
in School Psychology, Licentiate in Sacred Theology.

20 Post-sixth degree. Some work beyond (at higher level than) the
sixth-year degree but no additional higher degree.

21 Doctorate degree. Includes such degrees as Doctor of Education,
Doctor of Juridical Science, Doctor of Public Health, and the Ph.D.
(or equivalent) in any field. Does not include a Doctor’s degree that
is a first professional degree, per code 15.

22 Post-doctorate. Work beyond the Doctorate.
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FEGLI Coverage Table

Code Definition

A0 Ineligible for life insurance coverage

B0 Waived all life insurance

C0 Basic only

D0 Basic plus Standard Option

E1 Basic plus 1 time Family Option

E2 Basic plus 2 times Family Option

E3 Basic plus 3 times Family Option

E4 Basic plus 4 times Family Option

E5 Basic plus 5 times Family Option

F1 Basic plus Standard with 1 time Family Option

F2 Basic plus Standard with 2 times Family Option

F3 Basic plus Standard with 3 times Family Option

F4 Basic plus Standard with 4 times Family Option

F5 Basic plus Standard with 5 times Family Option

G0 Basic plus Additional with 1 time pay

H0 Basic plus Additional with 1 time pay and Standard Option

I1 Basic plus Additional with 1 time pay and 1 time Family Option

I2 Basic plus Additional with 1 times pay and 2 times Family Option

I3 Basic plus Additional with 1 times pay and 3 times Family Option

I4 Basic plus Additional with 1 times pay and 4 times Family Option

I5 Basic plus Additional with 1 times pay and 5 times Family Option

J1 Basic plus Additional with 1 time pay and Standard Option, and 1
time Family Option

J2 Basic plus Additional with 1 times pay and Standard Option, and 2
times Family Option

J3 Basic plus Additional with 1 times pay and Standard Option, and 3
times Family Option

J4 Basic plus Additional with 1 times pay and Standard Option, and 4
times Family Option

J5 Basic plus Additional with 1 times pay and Standard Option, and 5
times Family Option

K0 Basic plus Additional with 2 times pay

L0 Basic plus Additional with 2 times pay and Standard Option

M1 Basic plus Additional with 2 times pay and 1 time Family Option
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FEGLI Coverage Table

DefinitionCode

M2 Basic plus Additional with 2 times pay and 2 times Family Option

M3 Basic plus Additional with 2 times pay and 3 times Family Option

M4 Basic plus Additional with 2 times pay and 4 times Family Option

M5 Basic plus Additional with 2 times pay and 5 times Family Option

N1 Basic plus Additional with 2 times pay, Standard Option, and 1
time Family Option

N2 Basic plus Additional with 2 times pay, Standard Option, and 2
times Family Option

N3 Basic plus Additional with 2 times pay, Standard Option, and 3
times Family Option

N4 Basic plus Additional with 2 times pay, Standard Option, and 4
times Family Option

N5 Basic plus Additional with 2 times pay, Standard Option, and 5
times Family Option

90 Basic plus Additional with 3 times pay

P0 Basic plus Additional with 3 times pay and Standard Option

Q1 Basic plus Additional with 3 times pay and 1 time Family Option

Q2 Basic plus Additional with 3 times pay and 2 times Family Option

Q3 Basic plus Additional with 3 times pay and 3 times Family Option

Q4 Basic plus Additional with 3 times pay and 4 times Family Option

Q5 Basic plus Additional with 3 times pay and 5 times Family Option

R1 Basic plus Additional with 3 times pay, Standard Option, and 1
time Family Option

R2 Basic plus Additional with 3 times pay, Standard Option, and 2
times Family Option

R3 Basic plus Additional with 3 times pay, Standard Option, and 3
times Family Option

R4 Basic plus Additional with 3 times pay, Standard Option, and 4
times Family Option

R5 Basic plus Additional with 3 times pay, Standard Option, and 5
times Family Option

S0 Basic plus Additional with 4 times pay

T0 Basic plus Additional with 4 times pay and Standard Option

U1 Basic plus Additional with 4 times pay and 1 time Family Option

U2 Basic plus Additional with 4 times pay and 2 times Family Option

U3 Basic plus Additional with 4 times pay and 3 times Family Option

U4 Basic plus Additional with 4 times pay and 4 times Family Option

U5 Basic plus Additional with 4 times pay and 5 times Family Option
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FEGLI Coverage Table

DefinitionCode

V1 Basic plus Additional with 4 times pay, Standard Option, and 1
time Family Option

V2 Basic plus Additional with 4 times pay, Standard Option, and 2
times Family Option

V3 Basic plus Additional with 4 times pay, Standard Option, and 3
times Family Option

V4 Basic plus Additional with 4 times pay, Standard Option, and 4
times Family Option

V5 Basic plus Additional with 4 times pay, Standard Option, and 5
times Family Option

W0 Basic plus Additional with 5 times pay

X0 Basic plus Additional with 5 times pay and Standard Option

Y1 Basic plus Additional with 5 times pay and 1 time Family Option

Y2 Basic plus Additional with 5 times pay and 2 times Family Option

Y3 Basic plus Additional with 5 times pay and 3 times Family Option

Y4 Basic plus Additional with 5 times pay and 4 times Family Option

Y5 Basic plus Additional with 5 times pay and 5 times Family Option

Z1 Basic plus Additional with 5 times pay, Standard Option, and 1 time
Family Option

Z2 Basic plus Additional with 5 times pay, Standard Option, and 2 times
Family Option

Z3 Basic plus Additional with 5 times pay, Standard Option, and 3 times
Family Option

Z4 Basic plus Additional with 5 times pay, Standard Option, and 4 times
Family Option

Z5 Basic plus Additional with 5 times pay, Standard Option, and 5 times
Family Option
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FEHB Coverage Table

Code Definition

1 Enrolled (System generated based on processing of FEHB form) 1/

2 Ineligible (Excluded from coverage under FEHB law or by regulations)

Ineligible for FEHB program but eligible for non-Federal health
benefits

3 Waived (Transfer into the department; reemployment without a break
in service of more than 3 days and canceled or waived coverage
under prior Federal employment)
Eligible for non-Federal health benefits and elects to waive coverage.

4 Eligible − pending (Eligible−pending processing of FEHB form)

5 Canceled (Conditions same as Code 3)

6 Court Order − Enrolled

7 Court Order − Eligible Pending Family Coverage

8 Court Order − Self-Only − Pending Family Coverage

1/ This code is not entered on the personnel action. Code 1 is generated by the
PPS after the appropriate form (SF−2809 or SF−2810) is entered and applies to the
employee’s database salary record. Output SF−50−B will display code 1 even
though 4 was entered. FEHB deductions will begin during the pay period in which
the SF−2809 or SF−2810 is processed and applied to the database.

Handicap Code Table

Code Definition

No Handicap or Not Listed or Reported

01 Individual does not wish to have handicap status officially
recorded, or has misidentified himself/herself

05 No handicap

06 Handicap not listed

Speech Impairment

13 Severe speech malfunction or inability to speak, but has normal
hearing

Hearing Impairment

15 Hard-of-hearing

16 Total deafness in both ears, with understanding speech

17 Total deafness in both ears, and unable to speak clearly
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Handicap Code Table

DefinitionCode

Vision Impairment

22 Ability to read ordinary size print with glasses, but with loss of
peripheral (side) vision

23 Inability to read ordinary size print, not correctable by glasses

24 Blind in one eye

25 Blind in both eyes

Absences of Extremities (missing)

27 One hand

28 One arm

29 One foot

32 One leg

33 Both hands or arms

34 Both feet or legs

35 One hand or arm and one foot or leg

36 One hand or arm and both feet or legs

37 Both hands or arms and one foot or leg

38 Both hands or arms and both feet or legs

Nonparalytic Orthopedic impairments, chronic pain, stiffness, or weakness

44 One or both hands

45 One or both feet

46 One or both arms

47 One or both legs

48 Hip or pelvis

49 Back

57 Any combination of two or more parts of the body

61 One hand

62 One arm, any part

63 One leg, any part

64 Both hands

65 Both legs, any part

66 Both arms, any part

67 One side of body, including one arm and one leg

68 Three or more major parts of the body
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Handicap Code Table

DefinitionCode

Complete Paralysis

70 One hand

71 Both hands

72 One arm

73 Both arms

74 One leg

75 Both legs

76 Lower half of body, involving legs

77 One side of body, including one arm and one leg

78 Three or more major members of the body (arms, legs)

Other Impairments

80 Heart Disease − with no limitation or restriction of activity

81 Heart disease − with limitation or restriction of activity

82 Convulsive disorders, for example: epilepsy

83 Blood diseases, examples: sickle cell diseases, leukemia,
hemophilia, etc.

84 Diabetes − controlled diabetes with no restriction of activity

86 Pulmonary or respiratory disorders

87 Kidney dysfunctioning

88 Cancer − complete recovery

89 Cancer

90 Mental retardation

91 Mental or emotional illness

92 Severe distortion of limbs and/or spine

93 Disfigurement of face, hands, or feet

94 Learning disability
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Losing/Gaining Department Table

Code Definition

1A Military

2A University employee

3A Student

4A Self-employed

5A Retirement

6A Foreign country or corporation

7A Private industry

8A Unemployment

9A State or local government

1B Unknown

1C Death

Pay Basis Table

Code Definition

PA Per annum

PD Per day

PH Per hour

PM Per month

PW Piece work

FB Fee basis

WC Without compensation

BW Biweekly

Pay Plan Table

Plan Agency

AD Administratively determined rates not elsewhere specified

AE Determined by the Secretary

AL Administrative Law Judge, PL 101−509

CA Contract Appeals, PL 101−509

CP Capitol Police Civilian Pay

DB Davis Bacon Act
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Pay Plan Table

AgencyPlan

E Executive, FDIC

ED Experts, 5 USC 3109

EE Experts, Other

EF Consultant, 5 USC 3109

EG Consultant, Other

LP Capitol Police Law Enforcement Pay

MG

MK

MS

MX

NB Office of the Comptroller of the Currency

NF Non-Federal

NX Executive Level/Managerial −
NS PL 103-82 Subtitle G Sec195 (B)

NY All Other Positions− NS PL 103-82 Subtitle G Sec 195 (B)

OC Office of the Comptroller of the Currency only

OF Office of Federal Housing Enterprise Office

PA Attorneys under GAO’s Pay for Performance

PD Treasury Demonstration Project Positions

PE Evaluators and related occupations in professional
category 2 under GAO’s Pay for Performance

PG Printing & Lithographic (Hourly) (Washington, D.C. only)

PI

PJ

PL Printing & Lithographic (Hourly) (Washington, D.C. only)

PQ

PR

PS Printing & Lithographic (Hourly) (Washington, D.C. only)

RA Approved by the Board of Regents (No table)

RE General Schedule Positions in the United States Senate
Restaurants

RF Reading Is Fundamental Employees

RG Garage Attendants

RP

RS Senior Biomedical Service

RW U.S. Senate Restaurant Workers

SA

SB Determined by the Secretary (No table)

SL Senior Level Positions Code Definition

SP Special Pay for Local Police

SR Statutory Rates

SS Office of Federal Housing Enterprise Office
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Pay Plan Table

AgencyPlan

ST Scientific and Technical (5USC 3104 − formerly PL−313)

SV

SW

TG Office of Thrift Supervision

TF P.L. 101−73−FIRREA (Federal Housing Finance Board,
Grades 01−05)

TM P.L. 101−73−FIRREA (Federal Housing Finance Board,
Grades 13−15)

TR Police Forces − U.S. Mint and Bureau of Engraving and
Printing

TS P.L. 101−73−FIRREA (Federal Housing Finance Board,
Grades 01−12)

TW BEP Police Officers in Washington, D.C. (Bureau of
Engraving and Printing only)

UB

UT

VE Reserved for FCA

VG FCA equivalent to Pay Plan GG but at a higher rate scale

VH FCA equivalent to Pay Plan GH but at a higher rate scale

WB All other wage board positions

WD Wage board−production facilitating−nonsupervisory

WE Craft (Bureau of Engraving and Printing only)

WG Nonsupervisory pay schedules−Federal Wage System

WI Wage board−printing and lithographic pay schedules
(Washington, D.C. Metropolitan area only)

WL Wage board−leader pay schedules

WM Wage board−maritime pay schedules

WN Wage board−production facilitating supervisory

WP

WQ

WR

WS Wage board−supervisory pay schedules

WT Wage apprentice and shop trainee

WU

WW

XD Printing schedule−leader jobs 1/

XI

XJ

XK

XL Printing schedule−leader jobs

XN Printing schedule−supervisory production facilitating jobs
1/

XP Printing schedule−nonsupervisory jobs 1/

XS Printing schedule−supervisory jobs 1/
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Pay Plan Table

AgencyPlan

YV

YW

ZA National Zoological Park Police (SI)

ZP Scientific and engineering career path (NIST demo
project) 2/

ZS Administrative support career path (NIST demo project) 2/

ZT Scientific and engineering technician career path (NIST
demo project) 2/

ZZ Use only with pay basis without compensation (WC)

1/ Applicable to printing and lithographic employees in the 4400 family and
the 5330 series in the following designated wage areas:

� Kansas City, MO

� St. Louis, MO

� Philadelphia, PA

� Washington, DC

Employees in the 4400 family and the 5330 series in areas other than
those listed above are paid under the regular wage schedules for their
wage areas under GS, WL, or WS pay plans. (There are only three steps
in the regular wage schedules).

2/ Takes the place of GS and GM for the Department of Commerce,
National Institute of Standards and Technology (NIST) Personnel
Management Demonstration Project only.

Pay Rate Determinant Table

Code Definition

0 This code is used for employees, regardless of pay system, who
receive a scheduled rate and for whom none of the following codes
apply.

2 Saved Rate − Indefinite. Employee is paid, without time limitation, at
a pay rate above the maximum rate for the grade when:

� on or before June 30, 1984, the Foreign Service domestic
employee was converted to the General Schedule in accordance
with P.L.96−465

OR
� prior to January 11, 1979 (the effective date of section 801 (a) of

the Civil Service Reform Act (CSRA) P.L. 95−454,92 Stat.1111), (1)
the employee and his or her position had been converted from one
pay plan to another under appropriate authority; and (2) the
employee was not entitled to either grade or pay retention (codes
A, B, J, K, U, or V) on the effective date of the CSRA.
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Pay Rate Determinant Table

DefinitionCode

3 Retained Pay − Special Rate Adjustment. Employee is receiving
retained pay due to:

� a downward adjustment of a special rate range that left the
employee with a pay rate higher than the highest pay rate in the
new special rate range

OR
� abolishment of a special rate range that left the employee with a

pay rate in excess of the top rate of grade. References: 5 U.S.C.
5363(a)(2) and 5 CFR 536.104(a)(3).

4 Saved Rate − Other. Employee is receiving saved rate pay at a pay
rate above the regular rate and no other code is applicable. (This code
is not applicable for saved rates under the Federal Wage System and
is not applicable for saved rates under the General Schedule except
when authorized by 5 CFR 531.205(a)(3), e.g., for employees
promoted from special rate positions to non-special rate positions.)

5 Special and Superior Qualifications Rates. For use when PRD
codes 6 and 7 are both applicable. Code 5 is used only on the action
that appointed the employee at a superior qualifications rate within a
special rate range; code 6 is used on subsequent actions while the
employee continues to receive a special rate of pay.

6 Special Rate. Employee is paid at a special rate, established under
appropriate authority to recruit well qualified individuals in selected
occupations and locations. (If employee is also entitled to a retained
grade, use code E or F, as appropriate). References: 5 U.S.C. 5305, 5
U.S.C. 5343(a)(1)(A)ii), and 5 U.S.C. 5343(a)(1)(B)(ii).

7 Superior Qualifications Rate. Employee is hired at a pay rate above
the minimum rate of the grade. Note: 7 is used only on the action that
appointed the employee at a superior qualifications rate; code 0 or
another appropriate code is used on actions subsequent to the
appointment action. References: 5 U.S.C. 5333 and 5 CFR
531.203(b).

A Retained Grade − Different Position. Employee retains grade for a
2-year period, but is occupying a different position than that held
before the grade reduction. (if employee is also entitled to a special
rate in the retained grade, use code E.) References: 5 U.S.C. 5362
and 5 CFR 536.103.

B Retained Grade − Same Position. Employee retains grade for a
2-year period and continues to occupy the same position held before
the grade reduction. If employee is also entitled to a special rate in the
retained grade, use code F. References: 5 U.S.C. 5362 and 5 CFR
536.103.

E Retained Grade and Special Rate − Different Position. Employee
retains grade for a 2-year period, is entitled to a special rate in the
retained grade, but is occupying a different position than that held
before the grade reduction.
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Pay Rate Determinant Table

DefinitionCode

F Retained Grade and Special Rate − Same Position. Employee
retains grade for a 2-year period, is entitled to a special rate in the
retained grade, but is occupying the same position held before the
grade reduction.

J Retained Pay − Same Position. Employee is receiving a retained
rate of pay under 5 U.S.C. 5363(a)(1) or (3), or 5 CFR 536.104
(except S536.104(a)(3), and continues to occupy the same position
held before the reduction in grade or other action that otherwise would
have resulted in a reduction in basic pay. The employee’s pay rate
may have been reduced to 150 percent of the maximum rate of basic
pay payable for the present grade of the position.

K Retained Pay − Different Position. Employee is receiving a retained
rate of pay under 5 U.S.C. 5363(a)(1) or (3), or 5 CFR 536.104
(except S536.104(a)(3), but is currently occupying a different position
than that held before the reduction in grade or other action that
otherwise would have resulted in a reduction in basic pay. The
employee’s pay rate may have been reduced to 150 percent of the
maximum rate of basic pay payable for the present grade of the
position.

M Continued IGA/LEO Pay. Employee continues to receive an adjusted
annual rate of pay based on a nationwide or worldwide special salary
rate. The employee should be paid the dollar amount of the General
Schedule increase at the time of an ECI adjustment. Reference: 5
CFR 531.106 or 5 CFR 531.307.

R Retained Pay − SES Removal. A former career Senior Executive
Service (SES) employee is receiving a retained rate of pay under 5
U.S.C. 3594 and 5 CFR 359.705 following removal from the SES.

S Continued SES Basic Pay. A career Senior Executive Service (SES)
employee appointed to a position outside of the SES for which the rate
of basic pay is equal to or greater than the rate payable for level V of
the Executive Schedule and the employee elected to continue to
receive basic pay as if remaining in the SES in accordance with 5
U.S.C. 3392(c) and 5 CFR Part 317, Subpart H.
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U Retained Grade and Pay − Same Position. The employee: (1) has a
retained grade; (2) is receiving retained pay; and (3) continues to
occupy the same position held immediately before the action that othe
rwise would have resulted in a reduction in basic pay; i.e., use this
code only when J would be appropriate if grade retention were not
also applicable. References: 5 U.S.C. 5362, 5 U.S.C. 5363, and CFR
Part 536.

V Retained Grade and Pay − Different Position. The employee: (1) has a
retained grade, (2) is receiving pay retention, and (3) is currently
occupying a different position than that held immediately before the
action that otherwise would have resulted in a reduction in basic pay;
i.e., use this code only when K would be appropriate if grade retention
were not also applicable. References: 5 U.S.C. 5362, 5 U.S.C. 5363,
and CFR Part 536.

Position Classification Table

Code Definition

0 Leave former position vacant and active

1 Abolish former position

2 Inactivate former position

Position Occupied Table

Code Definition

1 Competitive Service

2 Excepted Service

3 Senior Executive Service − General

4 Senior Executive Service−Career Reserved

Quarter Deduction Table

Code Definition

1 Per day deduction − tax exempt

2 Per day deduction − not tax exempt

3 Per pay period deduction − tax exempt

4 Per pay period deduction − not tax exempt
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Race and National Origin (RNO) Table

Code Definition

A American Indian or Alaskan Native. A person having origins in any
of the original peoples of North America, and who maintain cultural
identification through community recognition or tribunal affiliation.
(This code must not be used for employees in Puerto Rico.)

B Asian or Pacific Islander. A person having origins in any of the Far
East, Southeast Asia, the Indian subcontinent or the Pacific
Islands. This area includes, for example, China, India, Japan,
Korea, the Philippine Islands, and Samoa. (This code must not be
used for employees in Hawaii or Puerto Rico.

C Black, not of Hispanic origin. A person having origins in any of the
black racial groups of Africa. Does not include persons of
Mexican, Puerto Rican, Cuban, Central or South American, or
other Spanish cultures or origins (see Hispanic). (This code must
not be used for employees in Puerto Rico.)

D Hispanic. A person of Mexican, Puerto Rican, Cuban, Central or
South American, or other Spanish cultures or origins. Does not
include persons of Portuguese culture or origin.

E White, not of Hispanic origin. A person having origins in any of the
original peoples of Europe, North Africa, or the Middle East. Also
includes persons not included in other categories. Does not
include persons of Mexican, Puerto Rican, Cuban, Central or
South American, or other Spanish cultures or origins (see
Hispanic). (This code must not be used for employees in Puerto
Rico.)

F Asian Indian. A person having origins in any of the original
peoples of the Indian subcontinent; i.e., India, Pakistan,
Bangladesh, Sri Lanka, Nepal, Sikkim, and Bhutan. (This code is
for use in Hawaii only.)

G Chinese. A person having origins in any of the original peoples of
China. (This code is for use in Hawaii only.)

H Filipino. A person having origins in any of the original peoples of
the Philippines. (This code is for use in Hawaii only.)

J Guamanian. A person having origins in any of the original peoples
of Guam (e.g., Chamorro). (This code is for use in Hawaii only.)

K Hawaiian. A person having origins in any of the original peoples of
Hawaii. Includes persons who are part Hawaiian and identify most
closely with the Hawaiian Category. (This code is for use in Hawaii
only.)

L Japanese. A person having origins in any of the original peoples of
Japan. (This code is for use in Hawaii only.)

M Korean. A person having origins in any of the original peoples of
Korea. (This code is for use in Hawaii only.)

N Samoan. A person having origins in any of the original peoples of
Samoa. (This code is for use in Hawaii only.)

P Vietnamese. A person having origins in any of the original peoples
of Vietnam. (This code is for use in Hawaii only.)
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Race and National Origin (RNO) Table

DefinitionCode

Q All Other Asian or Pacific Islanders. A person having origins in any
of the original peoples of Asia or the Pacific Islands not included in
codes F through P above. (This code is for use in Hawaii only.)

Y Not Hispanic in Puerto Rico. A person not of Mexican, Puerto
Rican, Cuban, Central or South American, or other Spanish
cultures or origins whose official duty station is in Puerto Rico.
(This code is for use in Puerto Rico only.)

Retirement Plan Table
Single System Deductions

Code Definition

1 Civil Service Retirement System (CSRS)

2 Social Security System (FICA)

3 Foreign Service Retirement and Disability System (FS)

4 None

5 Other Retirement System

6 Civil Service Retirement System−Special (CSRS−Special). For
law enforcement officers and firefighters (If used with Special
Employment Program Code AM (USAID), F is generated for
reporting purposes only)

7 CSRS (Congressional)

Y DC Retirement − Offset

Z DC Retirement Plan

Retirement Plan Table
FICA And Partial Deductions

Code Definition

8 CVA Judges Retirement Plan (1%). Covered by FICA and the
Court of Veterans Appeals (CVA) Retirement Plan.

9 CVA Judges Retirement Plan (4.5%). Covered by FICA and the
Court of Veterans Appeals (CVA) Retirement Plan.

C FICA and CSRS. Covered by FICA and by the Civil Service
Retirement System.

D CSRS Offset (Congressional) (FICA)

E FICA and CSRS. Covered by FICA and by the Civil Service
Retirement System. For law enforcement and firefighter
personnel.

G FICA and FS. Covered by FICA and by the Foreign Service
Retirement and Disability System
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Retirement Plan Table
FICA And Partial Deductions

DefinitionCode

I Federal Employees Retirement System (FERS) (Congressional)
(FICA)

J FICA and other retirement system. Covered by FICA and by
another Federal Government Retirement System

K FERS and FICA. Covered by the Federal Employee’s Retirement
System and FICA

L FERS and FICA − Air Traffic Controllers

M FERS and FICA − Special

N FERS and FICA − Reserve Technicians

P Foreign Service Pension Systems (FSPS) and FICA (If used with
Special Employment Program Code AM (USAID), D is generated
for reporting purposes only)

Retirement Plan Table
FICA And Full Deductions

Code Definition

R FICA and CSRS. Covered by FICA and the Civil
Service Retirement System

T FICA and CSRS − Special. For law enforcement
and firefighter personnel

W FICA and FS

X FICA and Other Retirement System

Salary Share Table

Code Definition

0 Not applicable

1 State co-operator

2 Other type co-operator

3 Annuitant under CSRS or FERS

4 Annuitant and state co-operator

5 Annuitant and other type co-operator

9 Military Hourly Rate-Used In Off-set
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Special Employee Table

Code Definition

00 Not applicable

01 Scheduled standby − nonexempt from FLSA

02 AUO − nonexempt from FLSA

03 Scheduled standby − AUO − exempt/nonexempt
from FLSA

 04 FMHA County Committeeman

05 Presidential Appointee

 06 CSRS Offset−Reemployed Annuitant

07 Experts and Consultants

08 AUO other than law enforcement personnel

09 Mixed Tour (FEHB not prorated)

10 Other employees, spec. appr/PMB, exceed band
by 6%

12 Supervisory/managerial employees, exceed band
by 6%

 13 FSIS Veterinary Medical Officer True Overtime

14 Schedule C employee

15 NOAA Field Parties

16 ZP Division Chiefs, supervisory differential 6%
NTE range 5

17 Supervisory/managerial, other employees, spec.
appr/PMB, 3% differential

18 Supervisory/managerial, other employees, spec.
appr/PMB 6% differential

19 ZP Supervisory/managerial, other than Division
Chiefs, 3% differential

 20 ZA Division Chiefs, exceed maximum rate by 6%

21 1990 Census Decennial Reemployed Annuitants

22 AFDC Recipient

23 Forest Service Job Corps

24 Panamanian National

25 FS Job Corps MT (FEHB not prorated)

26 Availability Pay

 27 OCC Geopay Rate 2

28 ASCS Committeeman
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Special Employee Table

DefinitionCode

29 Employed on U.S. Saudi Arabian Joint
Commission on Economic Cooperation

30 Overseas employee not payrolled by NFC

 31 AMS Milk Marketing Employee

32 Law Enforcement − Ineligible for AUO

33 Non-wage grade employee exempt from the
earnings limitation in Reg. 550.105

34 Travel Reimbursement

35 Manually paid employee

36 Manually paid employee paid on a semi-monthly
basis

37 Employee paid 8% Hazardous Duty Pay (Land
based work above 3900 meters)

 38 FP Contract Employee

39 Office of Technology Assessment (OTA) Board
Member Staff

40 Overseas employee payrolled by NFC

44 Other NFP − Title II and Title IV dollars (Agency 11
only)

45 Forest Service YCC enrollee

46 Older American

47 Hires into MEL position tracked in the NFMAS
database (Agency 11 only)

48 Hires into the 500 development position (Agency
11 only)

49 Alaska local hire program

52 Semi-monthly Coop

53 Paid under 2/3 rule

54 Without compensation employee paid for holidays
and overtime

55 Surface Mining Control/Reclamation Act of 1977

56 Federal Summer Intern

 57 Federal Junior Fellowship

58 Work Release Program

59 Veteran’s Readjustment

60 Entry Level Auditors − Rapid Promotion Plan

61 FCA Employee − No Differential
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Special Employee Table

DefinitionCode

62 Non-resident alien (F−1, J−1, M−1 visas)

64 Trainee for higher position

 70 Summer Aide

71 F1 Preparedness Fire Plan Position, Temporary

72 F2 Preparedness Fire Plan Position, Permanent
Career Seasonal

73 F3 Preparedness Fire Plan Position, Permanent
Full Time

74 F4 Fuel Fire Plan Position, Temporary

75 F5 Fuels Fire Plan Position, Permanent Career
Seasonal

76 F6 Fuels Fire Plan Position, Permanent Full Time

80 FMHA Economic Emergency Loan Repayment

81 Temporary Employee−FS Pilot Units

82 Employee Appt Less Than 90 Days

85 Office of Thrift Supervision employees Pay Plan
TG−Exceeds Pay Cap

89 Council Member

90 Disaster Area Cadre Employee

91 Disaster Temporary Employee

99 Library of Congress − Register of Copyrights

Special Employment Program Table

Code Definition

00 Not applicable

 01 Applied Physical Science

02 Chemical Engineering

03 Electrical Engineering

04 General Engineering

05 General Chemistry

06 Electronics

07 Mechanical Engineering

08 Organic Chemistry

09 Physics
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Special Employment Program Table

DefinitionCode

10 Civil Engineering

11 Metallurgical Engineering

12 IPA Ceiling Exempt

13 Agricultural Engineering

14 Food Technology

15 Mining Engineering

16 Industrial Engineering

17 Geological Engineering

18 Aeronautical Engineering

19 Marine Technology

20 Ceramic Engineering

21 Petroleum Engineering

22 Nuclear Engineering

23 Engineering Physics

24 Horticulture

25 Biology

26 Biomedical Engineering

39 Apprentice Trainee Program

 40 Mixed Tour

41 Schedule A 213.3102 (LL)

42 Schedule A 5 CFR 213.3102 (T)

43 Schedule A 5 CFR 213.3102 (U)

44 700−hour Trial, 5 CFR 316.402 (a) & 316

45 Temp, 5 CFR 316.402 (b) (5)

46 Schedule B, 5 CFR 213.3202 (k)

 47 Summer Intern−College

48 National Scholars Program

 54 Stay In School

55 Summer Aid

56 Federal Summer Intern

57 Federal Junior Fellowship

58 Work Release Program

59 Veterans Readjustment Program
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Special Employment Program Table

DefinitionCode

60 Appointment of Veterans (30% disabled) under 5
U.S.C. 3112

 61 Vietnam Era Veteran

62 Employee Cooperative Education Program

63 Worker Trainee Program Employee

64 Trainee

65 Rehab/Rehire

66 Reemployed Annuitant

67 Special Handicap Appointment

68 700 hour handicap appointment

69 Presidential Management Intern Program (PMIP)

 70 Worker Trainee In Development

71 Air Traffic Controller−Second Career Training

73 Cooperative Education Program−High School

74 Cooperative Education Program−Associates Degree

75 Students

76 Upward mobility − assigned to same series

77 Upward mobility − assigned to different series

 78 Summer Employment Program

80 SES Candidate Development Program

 81 SES Sabbatical

82 Development SES Mobility Assignment

88 IPA Out−Less Than 50% Reimbursable

90 Long Term Training Over 120 Days Complete

91 Secretaries and Department Heads

93 Long Term Training−Competing Agency or
Department

94 Junior Technician

95 Computer Science Fellowship Program

96 Federal Executive Institute (FEI)

97 President’s Executive Exchange Program

98 IPA−In

99 IPA−Out 50% or More Reimbursable

9A Special Government Employee
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Special Employment Program Table

DefinitionCode

9B Displaced Employee

9C Vocational Office

 9D Worker Trainee Opportunity Program

9E Worker Trainee Opportunities

9F Group III−Summer Faculty

9G Scientific Technician, Professional Aids

9H Administrative Fellowship Program (NOAA)

9I EEO Recognition

 9J Group II−Summer Noncritical 1−4

9K Group III−Summer Other

9L Group IV−Trades and Labor

9M Summer Exam Employment

9N Student Trainee

9P Public Service Career (Entry)

9Q Public Service Career (Upgrade)

 9R Graduate Intern

9S Meteorological Intern

9T Science Intern

9U Science Technician

9V 20/20 Work Study

9W Graduate Scientist

 9X Group I−Summer Clerical Group 1−4

AD Asst Director 320 Hours Ceiling

AM USAID Foreign Service Retirement (Plans D and F)

AT Assistant United States Trustee

 BC FP Contract Employee

C1 Cooperative Associates Degree−Program
Schedule A

C2 Cooperative High School Program Schedule A

C3 Cooperative Baccalaureate−Schedule B

C4 Cooperative Graduate Masters−Schedule B

C5 Cooperative Associates Degree−Schedule B

C6 Cooperative Graduate PhD−Schedule B
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Special Employment Program Table

DefinitionCode

C7 Cooperative Graduate Other−Schedule B

C8 Cooperative High School−Schedule B

C9 Cooperative VoTech−Schedule B

D1 Upward Mobility Program

D2 Detail Non−reimbursable

D3 Detail Reimbursable

D4 Detail to International Organization

D5 District Director Candidate Development Program

F1 Prepared Fire Plan Position, Temporary

F2 Preparedness Fire Plan Position, Permanent Career
Seasonal

F3 Preparedness Fire Plan Position, Permanent Full
Time

F4 Fuels Fire Plan Position, Temporary

F5 Fuels Fire Plan Position, Career Seasonal

F6 Fuels Fire Plan Position, Permanent Full Time

G1 Attorney

G2 Law Clerk

G3 Expert/Consultant

G4 Accounting Fellow

G5 Outstanding Scholar

G6 Consultant under 31 USC 731 (E) (1)

 G7 Comptroller General

G8 Student Intern

GR Retired Comptroller General

GS Survivor of Retired Comptroller General

HT Housing Technician

 IJ Immigration Judge

IP Intern Program

MC Marshals Service Contractor

 NR NAFI Retirement Coverage

OA DEA Agents hired under Sch. A (C) (1)

OB DEA Agents (1811) hired under Sch. B

OC USA/USM serving temporary court appointment
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Special Employment Program Table

DefinitionCode

OG Employee hired under SCh. A (G) − 40%/GS03/01

OH Attorneys hired under agency’s Honor Recruit
Program

OU Attorneys hired as Special Assistants to the agency

 P1 Student−Section 213.3102(P)

PC Schedule C Position Excepted FR Competitive
Service

PD Worker Trainee Opportunity Program

PN GS 16, 17, 18 Formerly Reported under Schedule C

PP Part Time Professional

PZ Presidential Appointee By/With Senate Consent

Q1 Student−Section 213.3102(Q)

S1 Faculty Member College or University

S2 High School Teacher (212.3102(A))

S4 Summer Others Including Science Competition
Winners

S7 Group III−Summer Graduate Student

S8 Mentally Retarded (Sepo) (212.3102(T))

S9 Severely Handicapped (Sepo) (212.3102(U))

SB Junior Professional Staff Training Program

SC Post Doctoral Research Program

SH Summer Hires

SL Summer Law Clerk

T2 Trained Under Initial Procurement Control

TP U.S. Secret Service Uniformed Division Technician
Pay

UT United States Trustees

V1 Volunteer−High School

V2 Volunteer−Trade School

V3 Volunteer−Vocational or Technical School

V4 Volunteer−2 Year College

V5 Volunteer−College

V6 Volunteer−Graduate School

V7 Volunteer−Other



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

P
art 7

R
eferen

ce Tab
les

7:59B. Personnel Data Element Code TablesUpdated 01/08

Special Employment Program Table

DefinitionCode

V8 Americorps Member

ZZ Unique Tax Processing

Supervisory/Managerial
Probationary Period Table

Code Definition

0 Not required

1 Required

2 Served

3 Waived

Tenure Table

Code Definition

0 Not in a retention group

1 Group I

2 Group II

3 Group III

TSP Eligibility Table

Code Definition

1 For FERS employees only. These employees are
eligible for immediate participation in the employee
contributions; however, the agency 1-percent basic
Government contribution and the Agency matching
funds will not be applied until the first open season.
(This is applied to new hires; transfers or rehires
not yet eligible for the 1-percent basic contribution.)

2 For FERS employees only. These employees are
eligible for immediate participation in the employee
contributions; however, the agency 1-percent basic
Government contribution and the agency matching
funds will not be applied until the second open
season. (This applies to new hires, transfers, or
rehires not yet eligible for the 1-percent basic
Government contribution.)
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TSP Eligibility Table

DefinitionCode

3 Applies to:
CSRS and CSRS-Offset transfers (except if they
terminated their TSP contributions).
CSRS and CSRS-Offset rehires.
FERS employees who transfer from another
Federal agency/payroll system without a break in
service who were making TSP contributions and
receiving the 1-percent basic Government
contributions and matching funds.
FERS employees who were rehired with a break
in service of less than 31 days who were making
TSP contributions, receiving the 1-percent basic
Government contributions and receiving the
1-percent matching funds immediately prior to
their separation; and,
FERS employees who transfer from another
Federal agency/payroll system without a break in
service who are not making employee
contributions but are receiving the 1-percent basic
Government contribution (except if they
terminated their TSP contribution).\
FERS employees who are rehired after a break in
service of 31 days or more, who were previously
eligible to receive agency contributions, agency
contributions will begin immediately.

Employees are eligible to participate immediately in
employee contributions.

Note: FERS, CSRS, and CSRS-Offset employees
with a break in service of less than 31 days are
considered transfers and TSP contributions must
be based on their last TSP−1.

4 Applies to:
FERS employees who had terminated TSP
contributions during the last Open Season
before transferring to a new Federal
agency/payroll system, and are eligible
immediately for the 1-percent basic
Government contribution and eligible to
contribute to TSP during the first TSP Open
Season, or,
CSRS or CSRS-Offset employees who
terminated TSP contributions during the last
TSP Open Season before transferring to a new
Federal agency/payroll system, and are eligible
to contribute to TSP during the first TSP Open
Season.
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TSP Eligibility Table

DefinitionCode

5 Applies to:
FERS employees who transferred from another
agency/payroll system and had terminated TSP
contributions after the last TSP Open Season
and are eligible immediately for the agency
1-percent basic Government contribution and
eligible to contribute to TSP during the second
TSP Open Season, or
CSRS or CSRS-Offset employees who
terminated TSP contributions after the last TSP
Open Season before transferring to a new
Federal agency/payroll system, and are eligible
to contribute to TSP during the second TSP
Open Season.

6 For employees that are ineligible. Employees with
retirement coverage codes of 2 (FICA); 4 (none,
except for re-employed annuitants who have an
annuity code of 1, 4, or 5); 5 (other retirement
system); J (FIC and other Retirement-Partial Rate);
or X (FICA and Other Retirement-Full Rate).

Note: FERS employees include FSPS employees,
and FSRS and CSRS-Offset employees include
Foreign Service Retirement and Disability Service
(FS) employees coverage codes may not be
eligible to participate in TSP.

Type Appointment Table

Code Definition

01 Competitive−Career, SES−Career

02 Competitive−Career−Conditional

03 Competitive−Term, Taper, Indefinite SES−Military
Term or Emergency

04 Competitive−Temporary, Special Need, SES−Time
Limited/Career

06 Excepted−Permanent, SES−Noncareer

07 Excepted−Conditional

08 Excepted−Indefinite, Excepted−Limited (More than
1 year)

09 Excepted−Temporary,
SES−Time−Limited−Noncareer
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Uniform Service Status Table

Code Definition

0 None

1 Ready Reserve

2 Standby Reserve

3 National Guard

 4 Retired Military−Regular

5 Retired Military−Non regular

 6 Retired Military−Regular and Reserve/National
Guard

7 Retired Military − Non regular and
Reserve/National Guard

8 Retired Military and DC National Guard

9 DC National Guard

Veterans Preference Table

Code Definition

1 None

2 5-point

3 10-point disability

4 10-point compensable

5 10-point other

6 10-point/30 percent compensable

7 Dishonorable discharge

Veterans Preference−RIF Table

 Code Definition

1 30% disabled or more

2 Veteran

3 Non-veteran (no retention rights)

4 Ineligible

5 Non−veteran (retention rights)
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Veteran Status Table

Code Definition

B Pre-Vietnam-era veteran. A veteran whose service ended before
the Vietnam era (i.e., before August 5, 1964). Use only for an
employee whose accession was after September 30, 1991.

N Not a Vietnam-era veteran. Employee may or may not be a
veteran, but is not a veteran of the Vietnam era (i.e., employee did
not serve during the period August 5, 1964 through May 7, 1975).
Use only for an employee whose accession was prior to October
1, 1991.

P Post-Vietnam-era veteran. A veteran whose service began after
the Vietnam era (i.e., May 7, 1975). Use only for an employee
whose accession was after September 30,1991.

V Vietnam-era veteran. A veteran who served during the Vietnam
era (i.e., from August 5, 1964 through May 7, 1975).

X Not a veteran. Use only for an employee whose accession was
after September 30, 1991.

Work Schedule Table

Code Definition

F Full-time. A schedule that usually requires an employee to work 40
hours as prescribed by the administrative work week for that
particular employment group or class.

G Full-time seasonal. A schedule that requires an employee to work
full-time for less than 12 months each year on an annually
recurring basis.

I Intermittent. A schedule that usually requires an employee to work
an irregular number of hours or days for which there is no
prearranged scheduled tour of duty.

J Intermittent−seasonal. A schedule that usually requires an
employee to work less than 12 months each year on an annually
recurring basis, and that requires an employee to work an irregular
number of hours or days for which there is no prearranged
scheduled tour of duty.

P Part-time. A schedule that requires an employee to work less than
full-time, but for a specific number of hours (usually 13−32 per
administrative work week) on a prearranged scheduled tour of
duty.

Q Part-time−seasonal. A schedule that requires an employee to work
part-time for less than 12 months each year on an annually
recurring basis.
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Work Schedule Table

DefinitionCode

S Part-time−job sharer. A schedule that requires an employee who is
job sharing to work less than full-time, but for a specific number of
hours (usually 16−32 per administrative work week) on a
prearranged scheduled tour of duty.

T Part-time−seasonal job sharer. A schedule that requires an
employee who is job sharing to work part-time for less than 12
months each year on an annually recurring basis.
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C. Document Type Code Table

A document type identifies the type of document being processed in the PPS. An alphabetical
list is provided by the EPIC document name for each document type. The document type is
listed on the List EPIC Document window.

EPIC Document Doc Type

Address 349

Allotment−Financial Allotment 095

Allotment−Net Pay 096

Allotment−TSP Loan Allotment 097

Allowances 127

Authorization of Labor Organization Dues 086

Cancellation Revocation of Union Dues 085

Cancellation of Employee Organization Dues 087

Charitable Contributions 088

Child Care or Alimony Deduction 195

City Tax 150

Compensatory Leave 056

County Tax 151

Deductions Due To Indebtedness 088

Discretionary Allotment 100

Dues Change Between Locals 084

Earned Income Credit 130

Education 123

Flexible Spending Account 185

Federal Tax 130

Health Change Enrollment 181

Health Registration Form 180

Professional Certification 124

Leave Data Transfer 160

Locator 121

Lump Sum Leave 054

Master File Change 031

Multi Element Update 120

Non Federal Health 101
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Non Federal Life Insurance 102

Non Federal Retirement 103

Non Federal Thrift Savings 104

Non Federal Flexible Spending Account 185

Performance Appraisal 075

Personnel Action 063

Restored Annual Leave 165

Savings Bond − New Allotment 170

Savings Bond − Change
Denomination/Allotment

171

Savings Bond − Change
Inscription/Denomination/Allotment

172

Savings Bond − Cancellation 173

Savings Bond − Cancel Owner/Coowner 174

SES Performance Appraisal 770

Severance Pay 128

State Tax 140

TSP Collection 129

TSP Election 125

Union Dues Mass Change 083
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D. Grade And Pay Retention Tables

The table below exhibits the pay rate determinant (PRD) code for grade and pay retention
related NOAC’s. It compares the PRD on the database with the PRD that should be entered
on the personnel action for the NOAC. Also, it indicates if the Rate Expired field should be
completed on the personnel action.

NOAC Database PRD
Personnel
Action PRD

Personnel Action
Rate Expired

5XX (remark X37) A, B, E, F, J, K, R, S, U, V, 0, 2, 3,
4, or 6

A, B, E, F, U,
or V

Date required

702/703 A, B, E, F, U, or V K, 4, 6 or 0 Blank

713 (remark X37) K, R, 0, 2, 3, 4, or 6 A, B, E, F, U,
or V

Date required

740 A, B, E, F, J, K, R, S, U, V, 0, 2, 3,
4, or 6

A, B, E, F, U,
or V

Date required

740 (remark X36/X65) A, B, E, F, U or V 0 or 6 Blank

740 (remark X40/X65) A, B, E, F, U, or V K, R, 2, 3, or
4

Blank

741 (remark X36) A, B, E, F, U, or V K, R, 0, 2, 3,
4, or 6

Blank

741 (remark X37) A, B, E, F, K, R, U, V, 0, 2, 3, or 4 A, B, E, F, U,
or V

Date required

770 A, B, E, F, J, K, R, S, U, V, 0, 2, 3,
4, or 6

A, B, E, F, J,
K, R, U, V, 0,
2, 3, 4, or 6

Blank

866 A, B, E, F, U, or V 0 or 6 Blank

866 (remark X37) A, B, E, F, U, or V A, B, E, F, U,
or V

Date required

866 (remark X40) A, B, E, F, U, or V J, R, S, 2, 3,
or 4

Blank
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NOAC Definition

5___ Conversion

702 Promotion

703 Promotion NTE

713 Change to Lower Grade

740 Position Change

741 Position Change−NTE

770 Extension of Position
Change−NTE

866 Termination of Grade Retention

899 Step Adjustment

 950 Change in Shift

Remarks
Code Definition

X36 Grade retention entitlement
terminated. No further entitlement
to grade or pay retention

X37 Employee is entitled to retain
grade of (pay plan and grade)
through (date)

X40 Employee is entitled to pay
retention

X65 Grade retention entitlement
terminated
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E. Payroll Document Code Tables

The following tables provide the codes for payroll documents:

Non-Federal Flexible Spending Account Table

Non-Federal Life Insurance Coverage Code Table

Non-Federal Life Insurance Plan Codes Table

Non-Federal Thrift Savings Plan Code Table

Non-Federal Retirement Savings And Investment Plan Codes Table

Performance Appraisal Rating Of Record Table (Description)

Performance Appraisal Rating Of Record Table (Level Description)

Performance Appraisal Rating Of Record Table (Pattern/Level)

Performance Appraisal Rating Of Record Table (Pattern)

Performance Appraisal Summary Rating Score Table (DoC Only)

Professional Certification Table

Event Code Table

Programming Language Code 1 Table 

Type Of Investigation Table
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Non-Federal Flexible Spending Account Table

Code Description Agcy/Dept

48 Dependent care account OCC

49 Health care account OCC

52 Dependent care expenses ARC

53 Unreimbursed medical expenses ARC

54 Dependent care account FDIC * *
55 Health care account FDIC * *
72 Health care account FCA/FCSIC

73 Dependent care account FCA/FCSIC

 82 Health care account OTS

83 Dependent care account OTS

FD Used to process DCFSA
transactions

all agencies

FH Used to process HCFSA
transactions

all agencies

Non-Federal Life Insurance Coverage Code Table

Agcy/Dept Coverage Code Plan Code

ARC 00 11

ATF 00 38

DOJ 00 38

FCA 01 through 08 44

FDIC 01 through 18 10

FDIC 00 LH

FDIC 00 LS

OCC 01 through 08 45

OCC 01 through 28 46

OTS 01 through 14 P0, P1, P2,
P3, P4, P5 

SI 01 through 04 17

SI 00 15, 16, 35

NASCOE 00 36
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Non-Federal Life Insurance
Plan Code Table

Code Description

10 FDIC

LD Long Term Care − Other
Dependents

LE Long Term Care −
Employee and/or Spouse

LH FDIC

LS FDIC

11 ARC

15 Smithsonian Institution

16 Smithsonian Institution

17 Smithsonian Institution

35 Smithsonian Institution

36 FSA−CO

38 SAMBA Life Insurance Plan

44 FCA

45 OCC

46 OCC

Non-Federal Retirement Plan Code Table

Agency Code Description

ARC 14 Pennsylvania State Retirement Fund

ARC 76 Principle Financial Group

SI 23 TIAA/CREF (employees hired on or before 1/2/1988)

SI 34 TIAA/CREF (employees hired on or after 1/3/1988)

SI 37 TIAA/CREF − SRA

TE 84 Teachers Insurance and Annuity Association-College
Retirement Equities Fund (TIAA−CREF)

Non-Federal Thrift Savings Plan
Deduction Percent Table

Deduction Percent Plan Code

01 through 10 04,13

01 through 19 77



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

7:72  E. Payroll Document Code Tables Updated 01/08

Non-Federal Thrift Savings Plan
Deduction Percent Table

Plan CodeDeduction Percent

00 through 19 78

01 through 10 75

01 through 12 79

Non-Federal Thrift Savings Plan Code Table

Agency Code Description

FDIC 04 T. Rowe Price − eligible for immediate participation in
employee contributions

FDIC 13 T. Rowe Price

ARC 77 Non-matching agency contributions

ARC 78 Matching agency contributions

OCC 75 OCC 401(k)

OTS T1 Pre-tax (FIRF)

OTS T2 Post-tax (FIRF)

OTS T3 Pre-tax (CSRS, CSRS/Offset, FERS)

OTS T4 Post-tax (CSRS, CSRS/Offset, FERS)

ARC,
FCA,
FCSIC,
FDIC,
OCC,
OTS

05 Catch-up contributions for individuals age 50 or over

FCA,
FCSIC

79 401(k)

Performance Appraisal Rating Of Record Table
(Description)

Rating of
Record Description

1 Unacceptable

2 Level between fully successful and
unacceptable

3 Fully successful or equivalent

4 Level between outstanding and fully successful

5 Outstanding or equivalent
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Performance Appraisal Rating Of Record Table
(Level Description)

Code Description

1 Unacceptable

2 Level between fully successful and unacceptable

3 Fully successful or equivalent

4 Level between outstanding and fully successful

5 Outstanding or equivalent

X Not rated−this code applies to General Schedule
(GS/GM), Prevailing Rate, and other employees
subject to the provisions of 5 CFR 430 (see
coverage at 5 CFR 430.202 and 5 CFR 430.302)
who have not yet received a rating of record under
the performance appraisal system (e.g., new hire)

Z Excludes those employees from the performance
appraisal requirements in 5 CFR 430 by law or by
OPM

Performance Appraisal Table
(Rating Of Record Pattern/Level)

Rating of Record
Pattern Rating of Record Level

A 1 or 3

B 1, 3, or 5

C 1, 3, or 4

D 1, 2, or 3

E 1, 3, 4, or 5

F 1, 2, 3, or 5

G 1, 2, 3, or 4

H 1, 2, 3, 4, or 5

Blank Z
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Performance Appraisal
Rating Of Record Table

(Pattern)

Code Rating of Record

A 1, 3

B 1, 3, 5

C 1, 3, 4

D 1, 2, 3

E 1, 3, 4, 5

F 1, 2, 3, 5

G 1, 2, 3, 4

H 1, 2, 3, 4, 5

Performance Appraisal Summary Rating Score Table
(DoC only)

Summary
Rating Rating Codes Rating

475−500 5.1, 5.3, 5.9, 7.0, 7.4, O Outstanding

460−474 5.0, 5.3, 5.8, 7.0, 7.4, O Outstanding

380−459 4.0, 4.3, 4.8, 7.1, 7.5, S Superior

350−379 3.1, 3.3, 3.9, 7.2, 7.6, FS Fully Successful

290−349 3.1, 3.3, 3.9, 7.2, 7.6, FS Fully Successful

290 3.5, 3.6, 3.7, FS Fully Successful

200−289 2.0, 2.3, 2.8, M Marginal

100−199 1.0, 1.3, 1.8, U Unsatisfactory

000 6.0, 6.1, 6.2, 6.3 Unratable

Professional Certification Table

Code Description

01 Lawyer−bar

02 Certified public accountant (CPA)

03 Certified professional manager (CPM)

04 Certified internal auditor (CIA)

05 Certified information system auditor (CISA)
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Event Code Table

Code Description

1 Employee electing to receive or receiving premium conversion tax benefits.

1A Initial opportunity to enroll

1B Open season

1C Change in family status that results in increase or decrease in number of eligible family
members.

1D Any change in employee’s employment status that could result in entitlement to coverage.

1E Any change in employee’s employment status that could affect cost of insurance.

1F Employee restored to civilian position after serving in uniformed services.

1G Employee, spouse, or dependent:

−begins nonpay status or insufficient pay

−ends nonpay status or insufficient pay if coverage continued

NOTE: If employee’s coverage is terminated, see 1D.

NOTE: If spouse’s or dependent’s coverage is terminated, see 1M.

1H Salary of temporary employee insufficient to make withholdings for plan in which enrolled.

1I Employee (or covered family member) enrolled in FEHB health maintenance organization
(HMO) moves or becomes employed outside the geographic area from which the FEHB
carrier accepts enrollments, or, if already outside the area, moves further from this area.

1J Transfer from post of duty within a State of the United States or the District of Columbia to
a post of duty outside of the United States or District of Columbia, or reverse.

1K Separation from Federal employment when the employee or employee’s spouse is
pregnant.

1L Employee becomes eligible for Medicare and wants to change to another plan or option.

1M Employee or eligible family member loses coverage under FEHB or another group
insurance plan including the following:

−Loss of coverage under another FEHB enrollment due to termination, cancellation, or
change to Self Only of the covering enrollment.

−Loss of coverage due to termination of membership in employee organization sponsoring
the FEHB plan.

−Loss of coverage under another Federally sponsored health benefits program, including
TRICARE, MEDICARE, Indian Health Service.

−Loss of coverage under Medicaid or similar State-sponsored program of medical
assistance for the needy.

−Loss of coverage under a non-Federal health plan, including foreign, state, or local
government, private sector.

−Loss of coverage due to change in worksite or residence.

1N Loss of coverage under a non-Federal group health plan because an employee moves out
of the commuting area to accept another position and the employee’s non-Federally
employed spouse terminates employment to accompany the spouse.

1O Employee or eligible family member loses coverage due to discontinuance in whole or
part of FEHB plan.
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Event Code Table

1P Enrolled employee or eligible family member gains coverage under FEHB or another
group insurance plan, including the following:

−Medicare

−TRICARE for life, due to enrollment in Medicare

−TRICARE due to change in employment status, including (1) entry into active military
service, or (2) retirement from reserve military service under Chapter 67, Title 10.

−Medicaid or similar State-sponsored program of Medical assistance for the needy.

−Health insurance acquired due to change of worksite or residence that affects eligibility
for coverage.

−Health insurance acquired due to spouse’s or dependent’s change in employment status.

!Q Change in spouse’s or dependent’s coverage option under a non-Federal health plan.

5 Employees who are not participating in premium conversion.

5A Initial opportunity to enroll.

5B Open season

5C Change in family status; for example: marriage, birth or death of family member, adoption,
legal separation, or divorce.

5D Change in employment status.

5E Separation from Federal employment when the employee is or the employee’s spouse is
pregnant.

5F Transfer from a post of duty within the United States to a post of duty outside the United
States, or reverse.

5G Employee or eligible family member loses coverage under FEHB or another group
insurance plan.

5H Enrollee or eligible family member loses coverage due to the discontinuance, in whole or
part, of a FEHB plan.

5I Loss of coverage under a non-Federal group health plan because an employee moves out
of the commuting area to accept another position, and the employee’s spouse terminates
employment to accompany the employee.

5J Employee or covered family member in an HMO moves or becomes employed outside the
geographic area from which the carrier accepts enrollments, or if already outside the area,
moves or becomes employed further from this area.

5K On becoming eligible for Medicare.

NOTE: This change may be made only once in a lifetime.

5L Temporary employee completes one year of continuous service in accordance with
5U.S.C. Section 8906a.

5M Salary of temporary employee insufficient to make withholdings for plan in which enrolled.

Programming Language Code 1
Table

Code Description
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Programming Language Code 1
Table

DescriptionCode

0 Not applicable

1 Algol

2 Fortran

3 Sleuth

4 ALC

5 Cobol

6 RPG

7 Basic

8 Other

9 Reserved

Type Of Investigation Table

Code Description

01 Preplacement investigation

02 National agency check (NAC)

03 National agency check and inquiries (NACI)

04 Minimum background investigation

05 Limited background investigation (LBI)

06 Background investigation (BI)

07 Special background investigation (SBI)

08 Reimbursable suitable investigation (RSI)

09 Periodic investigation

10 Upgrade investigation (SGI, BI upgrade/BGI)

11 Upgrade investigation (SDI, BI upgrade/BDI, LDI) 19
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Cancellation  Of Employee Organization Dues, 4:103

Change In Data Element, 2:15

Change In Duty Station, 2:15

Change In FEGLI, 2:15

Change In Health Benefits Enrollment Status Codes,
7:26

Change In Hours, 2:16
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Change In Veterans Preference, 2:23

Change In Work Schedule, 2:23

Change Password Pop−up Field Instructions, 6:3
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Changing An Inscription/Denomination/Allotment, 4:84
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Charitable Contribution Window Field Instructions,
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Instructions, 6:71

Clear Error Codes, 5:12
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Instructions, 6:75
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Correcting A Nature Of Action (NOA), 3:13
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Effective Date Of Payroll Documents, 4:6

Effective Date Of Personnel Actions, 2:3
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Employee Address Window Field Instructions, 6:79

Employee Data Pop−up Field Instructions, 6:17



Title I, Chapter 23
Entry, Processing, Inquiry, And Correction System (EPIC)

In
d

ex

Index − 3Updated 01/08

Employees In Nonpay Status, 4:33

Employment With Different Agencies Within A
Department, 3:7

Employment With Different Departments, 3:7

Entering A Personnel Action, 2:48

Entering Award Data, 2:51

Entering FEHB Free−Form Remarks And Notes, 4:41

Entering Foreign Language Bonus Data, 2:52

Entering Payroll Documents, 4:7

Entering Payroll Documents (A−E), 4:9

Entering Payroll Documents (F−O), 4:29

Entering Payroll Documents (P−Z), 4:73

Entering Personnel Actions, 2:47

Entering Remarks Data, 2:52

Entry And Release Of Data By The Agency, 1:6

Entry Guidelines For Accession Actions, 2:9
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Entry Guidelines For Allowances, 4:21

Entry Guidelines For Authorization Of Labor
Organization Dues, 4:104

Entry Guidelines For Awards, 2:10

Entry Guidelines For Charitable Contributions, 4:23

Entry Guidelines For Coding The Personnel Action For
TSP Elections, 4:43

Entry Guidelines For Conversions, 2:24

Entry Guidelines For Discretionary Allotments, 4:14
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Entry Guidelines For Financial Allotments, 4:16

Entry Guidelines For Personnel Actions, 2:8

Entry Guidelines For Position Changes, 2:37

Entry Guidelines For Puerto Rico Tax, 4:99

Entry Guidelines for Return To Duty Actions, 2:38

Entry Guidelines For Separations, 2:39

Entry Guidelines For Severance Pay, 4:89

Entry Guidelines For State Tax, 4:98

Entry Guidelines For Tenure Group, 2:22

Entry Guidelines For Territorial Tax, 4:99

Entry Guidelines For Within−Grade Increases, 2:45

EPIC Functional/Directional Keys, 1:21

EPIC Menu Bar, 1:18

EPIC Navigation Window, 1:15

EPIC Operating Features, 1:18

EPIC Overview, 1:3

EPIC Pop−Up Command Buttons, 1:21

EPIC Status Codes, 7:4

EPIC Toolbar, 1:19

Exception Actions, 3:8

Exceptions To Restricted Enrollment Changes, 4:33

Exiting EPIC, 1:17

Extensions, 2:25

F

Family Member Window Field Instructions, 6:81

Federal Benefit Documents, 4:29

Federal Benefit Forms, 4:29

Federal Benefit: Health Document, 4:30

Federal Benefit: TSP Election Document, 4:42

Federal Income Tax Certificate Status Codes, 7:21

Federal Pay Increase And Locality Pay, 2:34

Federal Wage System Area Increase, 2:37

FEGLI Coverage Table, 7:35

FEHA Children’s Equity Act, 4:31

FEHB Coverage Table, 7:38

FEHB Open Season, 4:35

FEHB Premiums During Nonpay Status, 4:37

FEHB Remarks Codes, 4:39

Field Instructions For EPIC Windows, 6:1

Field Instructions For Getting Started In EPIC, 6:3

Field Instructions For Payroll Documents, 6:65

Field Instructions For Personnel Actions, 6:7

Field Instructions For Requesting Reports, 6:127

Field Instructions For Rollback Documents and
Correcting History Data, 6:57

Financial Allotment Window Field Instructions, 6:81

Flexible Spending Account Window Field Instructions,
6:82

Foreign Language Bonuses, 2:13
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Getting Started In EPIC, 1:13

Grade And Pay Retention Tables, 7:61

Grade Retention, 2:28, 3:9

H

Handicap Code Table, 7:38

Health Benefits Coverage , 2:12

Health Benefits Processing, 4:31

Health Benefits Registration Form Status Codes, 7:25

Health Benefits Window Field Instructions, 6:84

History Correction List Window Field Instructions, 6:61

History Correction Navigation Window Field
Instructions, 6:59
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Input Status Codes, 7:5

Insert New Action Pop−up Field Instructions, 6:63

Installation, 1:11
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Introduction, 1:1

J

JCL Requirements Pop−Up Field Instructions, 6:127
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Leave Data Transferred Window Field Instructions, 6:88

Leave Documents, 4:48

Leave Payment Documents, 4:52

Leave Payment: Annual Leave Payment Document,
4:55

Leave Payment: Compensatory Leave Payment
Document, 4:53

Leave: Leave Data Transfer Document, 4:49

Leave: Restored Annual Leave Document, 4:50

Living Benefits, 2:12

Locator Document, 4:57

Locator Window Field Instructions, 6:90

Losing/Gaining Department Table, 7:41

Lump Sum Leave Payment Window Field Instructions,
6:90

Lump Sum Leave Payments Status Codes, 7:8

M

Master File Change Document, 4:58

Master File Change Document Status Codes, 7:7

Master File Change Window Field Instructions, 6:94

Merger Or Takeover Of A Financial Organization, 4:12

Miscellaneous Pop−up Field Instructions, 6:20

Modifying EPIC Transactions, 1:25

Multi Element Update Document, 4:60

Multi Element Update Window Field Instructions, 6:100

N

Name Change, 2:23

Nature of Action Code/Authority Codes, 4:34

Nature Of Action Codes, 2:3

Net Pay Document, 4:61

New/Transfer Enrollment , 4:36

NFC Logon Banner Field Instructions, 6:3

Non−Federal Benefit Documents, 4:61

Non−Federal Benefit: Flexible Spending Account
Document, 4:62

Non−Federal Benefit: Health Document, 4:65

Non−Federal Benefit: Life Insurance Document, 4:67

Non−Federal Benefit: Retirement Document, 4:69

Non−Federal Benefit:Thrift Savings Document, 4:70

Non−Federal Flexible Spending Account Table, 7:63

Non−Federal Health Benefits, 4:33
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Non−Federal Health Benefits Form Status Codes, 7:15

Non−Federal Health Benefits Window Field
Instructions, 6:107

Non−Federal Life Insurance Coverage Code Table, 7:63

Non−Federal Life Insurance Form Status Codes, 7:16

Non−Federal Life Insurance Plan Code Table, 7:64

Non−Federal Life Insurance Window Field Instructions,
6:108

Non−Federal Retirement Benefits Form Status Codes,
7:17

Non−Federal Retirement Plan Code Table, 7:64

Non−Federal Retirement Window Field Instructions,
6:109

Non−Federal Thrift Savings Plan Code Table, 7:65

Non−Federal Thrift Savings Plan Deduction Percent
Table, 7:64

Non−Federal Thrift Savings Plan Form Status Codes,
7:18

Non−Federal Thrift Savings Window Field Instructions,
6:112

Nonpay Status For On−The−Job Injury, 4:36

Nonpay/Nonduty, 2:26

O

Official And Unofficial Personnel Actions, 2:3

Online Help, 1:14

Online Tutorial, 1:13

Order Of Precedence For Payroll Deductions, 4:3

Other Separations , 2:41

Owners Information Pop−up Field Instructions, 6:112

P

Part 2. Personnel Actions

Part 4. Payroll Documents

Pay, 2:26

Pay Basis Table, 7:41

Pay Rate Determinant Table, 7:43

Payroll Document Code Tables, 7:63

Payroll Document Key Data Field Instructions, 6:113

Payroll Document Transaction Field, 4:5

Payroll/Personnel External Processing Systems, 1:3

Payroll/Personnel Internal Processing Systems, 1:5

Payroll/Personnel Processing Cycle, 1:6

Performance Appraisal Documents, 4:73

Performance Appraisal Rating Of Record Table, 7:66

Performance Appraisal Rating Of Record Table
(Description), 7:65

Performance Appraisal Rating Of Record Table
(Pattern), 7:67

Performance Appraisal Status Code, 7:9

Performance Appraisal Summary Rating Score Table,
7:67

Performance Appraisal Table, 7:66

Performance Appraisal Window Field Instructions,
6:115

Performance Appraisal: Non SES, 4:74

Performance Appraisal: SES, 4:75

Personnel Action Window Key Data Field Instructions,
6:30

Personnel Data Element Code Tables, 7:31

Position Changes, 2:37

Position Classification Table, 7:46

Position Data Pop−up Field Instructions, 6:35

Position Occupied Table, 7:46

Premium Conversion, 4:35

Processing Functions, 1:22

Processing Of Data By NFC, 1:7

Processing Rollback Documents, 3:4

Processing Status Report Request Criteria, 5:5

Processing Status Reports Pop−Up Field Instructions,
6:128
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